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After ACID software is installed and you start it for the first time, the registration wizard appears. This wizard offers easy steps that allow 
you to register the software online with Sony Creative Software Inc. Alternatively, you may register online at http:// 
www.sonycreativesoftware.com/ at any time. 

Registering your product will provide you with access to a variety of technical support options, notification of product updates, and 
special promotions exclusive to registered ACID users. 

Registration assistance 

If you do not have access to the Internet, registration assistance is available during normal weekday business hours. Please contact our 
Customer Service department by dialing one of the following numbers: 

Telephone/Fax Country

1-800-577-6642 (toll-free) US, Canada, and Virgin Islands


+608-204-7703 for all other countries


1-608-250-1745 (Fax) All countries


Customer service/sales 

For a detailed list of customer service options, we encourage you to visit 
http://www.sonycreativesoftware.com/support/custserv.asp. Use the following numbers for telephone support during normal weekday 
business hours: 

Telephone/Fax Country

1-800-577-6642 (toll-free) US, Canada, and Virgin Islands


+608-204-7703 for all other countries


1-608-250-1745 (Fax) All countries


Technical support 

For a detailed list of technical support options, we encourage you to visit

http://www.sonycreativesoftware.com/support/default.asp. To listen to your support options by telephone, please call 608-256-5555.


About your rights in ACID software 

ACID is licensed to you under the terms of the End User License Agreement. The End User License Agreement is first presented to you 
when you install the software. Please review the End User License Agreement carefully as its terms affect your rights with respect to the 
software. For your reference, a copy of the End User License Agreement for ACID is located at 
http://www.sonycreativesoftware.com/. 

http://www.sony.com/mediasoftware
http://www.sony.com/mediasoftware
http://mediasoftware.sonypictures.com/support/custserv.asp
http://mediasoftware.sonypictures.com/support/default.asp
http://www.sony.com/mediasoftware


About your privacy 

Sony Creative Software Inc. respects your privacy and is committed to protecting personal information. Your use of the software is 
governed by the Software Privacy Policy. A copy of this policy is incorporated into the registration process and you are asked to agree to 
its terms prior to accepting the terms of the End User License Agreement. Please review its contents carefully as its terms and conditions 
affect your rights with respect to the information that is collected by the software. For your reference, a copy of the Software Privacy 
Policy is located at http://www.sonycreativesoftware.com/corporate/privacy.asp. 

Proper use of software 

ACID is not intended and should not be used for illegal or infringing purposes, such as the illegal copying or sharing of copyrighted 
materials. Using ACID for such purposes is, among other things, against United States and international copyright laws and contrary to 
the terms and conditions of the End User License Agreement. Such activity may be punishable by law and may also subject you to the 
breach remedies set forth in the End User License Agreement. 

Legal notices 

ACID, ACIDized, ACIDplanet.com, ACIDplanet, the ACIDplanet logo, ACID XMC, Artist Integrated, the Artist Integrated logo, Beatmapper, 
Cinescore, CD Architect, DVD Architect, Jam Trax, Perfect Clarity Audio, Photo Go, Sound Forge, Super Duper Music Looper, Transparent 
Technology, Vegas, Vision Series, and Visual Creation Studio are the trademarks or registered trademarks of Sony Creative Software Inc. in the 
United States and other countries. All other trademarks or registered trademarks are the property of their respective owners in the United States 
and other countries. 

Apple QuickTime 

Apple® QuickTime® application is a trademark of Apple, Inc. in the United States and other countries. 

Apple Macintosh Audio Interchange File Format (AIFF) file format. 

Apple® Macintosh® Audio Interchange™ File Format (AIFF) is a trademark of Apple, Inc. in the United States and other countries. 

ATRAC 

“ATRAC,” “ATRAC3,” “ATRAC3plus,” “ATRAC Advanced Lossless,” and the ATRAC logo are trademarks of Sony Corporation. 
http://www.sony.net/Products/ATRAC3/ 

Dolby, Dolby Digital AC-3, and AAC encoding 

This product contains one or more programs protected under international and U.S. copyright laws as unpublished works. They are confidential 
and proprietary to Dolby Laboratories. Their reproduction or disclosure, in whole or in part, or the production of derivative works therefrom 
without the express permission of Dolby Laboratories is prohibited. Copyright 1992 – 2008 Dolby Laboratories. All rights reserved. 

Dolby Digital 5.1 Creator technology is not intended for use in content creation for commercial or broadcast distribution, or content that displays 
Dolby trademarks and logos. Only Approved Dolby Digital Professional Encoders may be used for content that is commercially distributed or 
carries the Dolby Digital trademark and logo. 

Dolby®, the double-D symbol, AC-3®, and Dolby Digital® are registered trademarks of Dolby Laboratories. AAC™ is a trademark of Dolby 
Laboratories. 

élastique Pro 

Portions of this product use zplane élastique Pro V2 audio time-stretching technology. 

FLAC/Ogg File Formats 

©2008, Xiph.org Foundation


Neither the name of the Xiph.org Foundation nor the names of its contributors may be used to endorse or promote products derived from this 

software without specific prior written permission. 


This software is provided by the copyright holders and contributors “as is” and any express or implied warranties, including, but not limited to, 

the implied warranties of merchantability and fitness for a particular purpose are disclaimed. In no event shall the foundation or contributors be

liable for any direct, indirect, incidental, special, exemplary, or consequential damages (including, but not limited to, procurement of substitute

goods or services; loss of use, data, or profits; or business interruption) however caused and on any theory of liability, whether in contract, strict

liability, or tort (including negligence or otherwise) arising in any way out of the use of this software, even if advised of the possibility of such 

damage.


Gracenote 

CD and music-related data from Gracenote, Inc., copyright © 2000-2008 Gracenote. Gracenote Software, copyright 2000-2008 Gracenote. This 
product and service may practice one or more of the following U.S. Patents: #5,987,525; #6,061,680; #6,154,773, #6,161,132, #6,230,192, 
#6,230,207, #6,240,459, #6,330,593, and other patents issued or pending. Services supplied and/or device manufactured under license for 
following Open Globe, Inc. United States Patent 6,304,523. 

Gracenote and CDDB are registered trademarks of Gracenote. The Gracenote logo and logotype, MusicID, and the "Powered by Gracenote" logo 
are trademarks of Gracenote. 

http://mediasoftware.sonypictures.com/corporate/privacy.asp
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Macromedia Flash 

Macromedia and Flash are trademarks or registered trademarks of Macromedia, Inc. in the United States and/or other countries. 

Microsoft DirectX programming interface 

Portions utilize Microsoft® DirectX® technologies. Copyright © 1999 – 2008 Microsoft Corporation. All rights reserved. 

Microsoft Windows Media Technologies 

Portions utilize Microsoft Windows Media® technologies. Copyright © 2008 Microsoft Corporation. All rights reserved. 

PCRE LICENCE 

PCRE is a library of functions to support regular expressions whose syntax and semantics are as close as possible to those of the Perl 5 language. 

Release 7 of PCRE is distributed under the terms of the “BSD” licence, as specified below. The documentation for PCRE, supplied in the “doc” 

directory, is distributed under the same terms as the software itself.


The basic library functions are written in C and are freestanding. Also included in the distribution is a set of C++ wrapper functions.


THE BASIC LIBRARY FUNCTIONS


Written by: Philip Hazel


Email local part: ph10


Email domain: cam.ac.uk


University of Cambridge Computing Service,


Cambridge, England.


Copyright (c) 1997-2008 University of Cambridge


All rights reserved.


THE C++ WRAPPER FUNCTIONS 

Contributed by: Google Inc.


Copyright (c) 2007-2008, Google Inc.


All rights reserved.


THE “BSD” LICENCE 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 

•	 Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 

•	 Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution. 

•	 Neither the name of the University of Cambridge nor the name of Google Inc. nor the names of their contributors may be used to endorse or 
promote products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE. 

PNG file format 

Copyright © 2008. World Wide Web Consortium (Massachusetts Institute of Technology, European Research Consortium for Informatics and 
Mathematics, Keio University). All rights reserved. This work is distributed under the W3C Software License in the hope that it will be useful, but 
WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTIBILITY or FITNESS FOR A PARTICULAR PURPOSE. 
http://www.w3.org/Consortium/Legal/2002/copyright-software-20021231. 

Propellerhead Software 

ReWire™ is a trademark of Propellerhead Software. 

Real, RealMedia, RealAudio, and RealVideo applications 

2008 RealNetworks, Inc. Patents Pending. All rights reserved. Real®, Real Media®, RealAudio®, RealVideo®, and the Real logo are trademarks or 
registered trademarks of RealNetworks, Inc. in the United States and other countries. 

Steinberg Media Technologies 

http://www.w3.org/Consortium/Legal/2002/copyright-software-20021231


Cubase®, VST®, and Nuendo® are registered trademarks of Steinberg Media Technologies GmbH.


ASIO™ is a trademark of Steinberg Media Technologies GmbH.


Tagged Image File Format (TIFF) 

Adobe Tagged Image™ File Format is a registered trademark of Adobe Systems Incorporated in the United States and other countries. All rights 
reserved. 

Targa file format 

The Targa™ file format is a trademark of Pinnacle Systems, Inc. 

Thomson Fraunhofer MP3 

MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson.


Supply of this product does not convey a license nor imply any right to distribute content created with this product in revenue generating 

broadcast systems (terrestrial, satellite, cable and/or other distribution channels), streaming applications (via internet, intranets and/or other 

networks), other content distribution systems (pay-audio or audio on demand applications and the like) or on physical media (compact discs,

digital versatile discs, semiconductor chips, hard drives, memory cards and the like).


An independent license for such use is required. For details, please visit: http://mp3licensing.com.


Sony Creative Software Inc. 
1617 Sherman Avenue 
Madison, WI  53704 
USA 

The information contained in this manual is subject to change without notice and does not represent a guarantee or commitment on 
behalf of Sony Creative Software Inc. in any way. All updates or additional information relating to the contents of this manual will be 
posted on the Sony Creative Software Inc. Web site, located at http://www.sonycreativesoftware.com/. The software is provided to you 
under the terms of the End User License Agreement and Software Privacy Policy, and must be used and/or copied in accordance 
therewith. Copying or distributing the software except as expressly described in the End User License Agreement is strictly prohibited. 
No part of this manual may be reproduced or transmitted in any form or for any purpose without the express written consent of Sony 
Creative Software Inc. 

Copyright © 2008. Sony Creative Software Inc. 

Program Copyright © 2008. Sony Creative Software Inc. All rights reserved. 

http://mp3licensing.com
http://www.sony.com/mediasoftware
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Chapter 1 
Introducing ACID Software 

Welcome 

Congratulations on purchasing a revolutionary software application for Microsoft® Windows®. With ACID® from Sony 
Creative Software Inc., you can create great music by simply picking, painting, and playing. 

System requirements 

The following lists the minimum system requirements for using ACID: 

• Microsoft® Windows® XP (SP 2 or later) or Windows Vista™. 

• 1.8 GHz processor (2 GHz or faster recommended). 

• 1 GB RAM (2 GB or more recommended). 

• 150 MB hard-disk space for program installation. 8 GB of hard-disk space for installation of all optional components. 

• Microsoft Windows-compatible sound card. 

• DVD-ROM drive for installation. 

• Supported CD-recordable drive (for CD burning only). 

• Microsoft .NET Framework 3.0 (included on application disc). * 

• Internet connection (for Gracenote® MusicID™ service). 

*.NET 3.0 adds functionality to .NET 2.0. After installing the .NET Framework 3.0, versions 2.0 and 3.0 will be displayed 
in the Windows Add or Remove Programs listing. Do not attempt to uninstall version 2.0; it is required by version 3.0. 

Installing ACID 

Prior to installing the software, we recommend that you exit all open applications and temporarily turn off any virus 
protection. 

1. Insert the application disc. The setup screen appears (if AutoPlay is enabled for your DVD-ROM drive). 

Note: If you have disabled the AutoPlay feature, click the Start button and choose Run. In the Run dialog that the 

DVD-ROM drive letter and add :\setup.exe. Click OK to start the installation.


2. Click Install. The installation process begins. 

3. Follow the on-screen prompts to install the appropriate version of the software for your computer. 

Using online help 

You can access three varieties of help within ACID: 

• Online help 

•  Context-sensitive help  

• Help on the Web 

Online help


To access online help, choose Contents and Index from the Help menu or press F1. 
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Toolbar 

Tabs 

Information 

pane 

Context-sensitive help 

To use context-sensitive help in a dialog box, click the question mark button  in the upper-right corner of the dialog box. 

Help on the Web 

Additional ACID information is available on the Sony Creative Software Inc. Web site. From the Help menu, choose Sony on the Web, 
and choose the desired location from the submenu. The software starts your system’s Web browser and attempts to connect to the 
appropriate page on the Web site. 

Overview of ACID software 

ACID software is designed to be powerful and flexible, yet easy to use. Many of the ACID operations, menu items, and shortcut keys are 
common to other Sony Creative Software Inc. applications. 

The following sections provide a tour of the ACID work area. 

Main window 

The ACID workspace includes three main areas: the track list, the track view (or timeline), and the window docking area. The other parts 
of the interface are tools and features used while creating and working with your project. You can resize the track list, track view, and 
window docking area by dragging the dividers between them. 
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Divider Timeline 

Track view 
Track list 

Divider 

Window 
docking 
area 

Toolbar 

The toolbar allows you to quickly access the most commonly used functions and features in ACID. 

Opens a new project. You will be prompted to save any 
changes to the current project. 

Displays the Open File dialog. From this window, you can 
browse all of the available drives to select an ACID project or 
audio file to open. 

Saves any changes to the current project.

The first time you save a project, the Save As dialog appears.


Opens the Publish wizard so you can share your ACID creation 
on the Web. 

Opens a dialog where you can download media from the 
Internet. 

Clears the selected items from the track view and places them 
on the ACID clipboard. You can then paste them to a new 
location. 

Creates a copy of the selected items from the track view on 
the ACID clipboard. You can then paste them to a new 
location. 

Inserts the contents of the ACID clipboard at the current 
cursor position. The pasted items cover any existing events. 
To make room for pasted events, choose Paste Insert from the 
Edit menu. 

Reverses the last action performed. ACID supports unlimited 
undos, allowing you to restore the project to any state since 
the last save. 

Locks envelope points so they move with an event when it is 
moved along the timeline. 

Allows editing of MIDI events directly on the timeline. In this 
mode, you can draw and erase notes in a piano roll or drum 
grid view. 

Activates the Draw tool to add and edit events. 

Activates the Selection tool to select multiple events. 

Activates the Paint tool to insert events across multiple 
tracks.When used in conjunction with the Ctrl key, the Paint 
tool can paint an entire one-shot, MIDI, or Beatmapped media 
file to an event with one click. 

Activates the Erase tool to erase events or parts of events. 
When used in conjunction with the Ctrl key, the Erase tool can 
erase an entire one-shot, MIDI track, or Beatmapped track 
event with one click. 

Activates the Envelope tool to select and modify envelope 
points. 

Activates the Time Selection tool to quickly select all events 
within range of time. 

Activates the Groove tool to apply a groove to a track. You 
can use grooves to manipulate the timing of tracks by 
quantizing media to predefined grooves or by applying the 
feel of one track to another. 
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Reverses an undo. Activates the Groove Erase tool to erase grooves or parts of 
grooves. When used in conjunction with the Ctrl key, the 
Groove Erase tool can erase an entire groove event. 

Turns the snapping feature on or off. With snapping enabled, Activates context-sensitive help to obtain information about 
you can decide whether to snap to the grid or to all elements a specific option, menu, or part of the ACID window. 
(markers, regions, etc.). 

Allows you to automatically create crossfades when you 

overlap two audio events.


Track list 

This list identifies the track order in your project and contains the track’s controls. The following sections identify and briefly explain the 
controls located in the track list. 

Track name 

Track number 

Volume slider 

Track FX 

Mute 
Solo 

Pan slider 

Arm for Record 

Paint Clip Selector 

Automation 

Settings 

Minimize Track Height 

Maximize Track Height 

AUDIO TRACKS 

MIDI TRACK 

MIDI Input 

MIDI Output 

MIDI controller data 

Program 

Insert controller envelopes 

Controller data sliders 

Invert Track Phase 
Bus Assignment 

Audio Meter 

Record Device Selector 

Minimize/Maximize Track Height buttons 

These buttons control the track’s appearance (size) on the track list and the track view. 

Track number 

This area identifies the track’s number in the project. You can quickly change the track order by dragging selected tracks within the 
track list. 

Track name 

When you add a file to a project, the track name is initially the same name as the file’s name. Right-click the track name and choose 
Rename from the shortcut menu (or double-click) to change the track name. 
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Bus assignment/Device selection 

Clicking the Bus Assignment button  and selecting a letter from the menu allows you to assign the corresponding track to the 
specified output bus. However, the button is only available in projects containing multiple busses. 

MIDI Input button 

Clicking the MIDI Input button  allows you to choose a MIDI input device for recording MIDI. For more information, see Recording 
MIDI on page 189. 

MIDI Output button 

Clicking the MIDI Output button allows you to select soft synths and MIDI devices and the channel you want to use to play MIDI data on 
the track. For more information, see Setting up a MIDI controller for recording into a track on page 190. 

Program button 

Clicking the Program button allows you to change the settings of your soft synth and show/hide keyframes. For more information, 
see Changing the track voice on page 203 and Adding a program change keyframe on page 210. 

Invert Track Phase button 

Clicking the Invert Track Phase button  reverses the phase of all events on an audio track. 

Although inverting data does not make an audible difference in a single file, it can prevent phase cancellation when mixing or 
crossfading audio signals. 

Track FX button 

The Track FX button accesses the Audio Plug-In window from which you can add, edit, and apply effects to the track. For more 
information, see Using clips with tracks on page 101. 

Freeze Track button 
The Freeze Track button on a MIDI track converts a MIDI track to .wav file, effectively taking your soft synths offline and conserving 
processing and disk resources. 

Mute button 

Clicking the Mute button  temporarily suspends playback of the corresponding track, allowing you to focus on the project’s 
remaining tracks. A muted track appears grayed out in the track view. For more information, see Muting or unmuting tracks on page 42. 

Solo button 

Clicking the Solo button isolates the track during playback by muting the project’s remaining tracks. For more information, see Soloing 
tracks on page 43. 

Record Device Selector button 

Click the Record Device Selector button to turn input monitoring on or off and choose a recording device. 
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Surround panner 

In 5.1 surround projects, the surround panner allows you to view and edit surround panning settings for a track. Double-click a 
surround panner to view the Surround Panner window and make fine panning adjustments. 

Volume fader 

This dedicated volume fader controls how loud a track is in the mix. A value of 0 dB means that the track plays with no boost or cut from 
the software. Dragging the fader to the left cuts the volume; dragging to the right boosts the volume. For more information, see 
Adjusting the mix on page 41. 

Pan slider 

This dedicated pan slider controls the position of a track in the stereo field. Dragging the slider to the left places the track in the left 
speaker more than the right, while dragging the slider to the right places the track in the right speaker. 

You can choose among five panning types to determine how a track is panned. For more information, see Choosing stereo pan types on 
page 113. 

Multipurpose slider 

This multipurpose slider allows you to control the following: 

• The level of the track’s signal being routed to each of the project’s busses. 
• The level of the track’s signal being routed to an assignable effect control. 

Each track’s slider position is independent from the others; however, you can move sliders simultaneously by selecting multiple tracks 
before making your adjustment. If you do not see this slider, expand the track. 

For MIDI tracks, four multipurpose sliders are displayed to allow you to adjust MIDI controller data. For more information, see Controller 
automation on page 202. 

You may choose what the slider controls by clicking the slider label. Changing the slider type for one track changes it for all tracks so you 
can compare levels of the same control across the project. For more information, see Adjusting the mix on page 41. 

Paint Clip Selector button 

Clicking the Paint Clip Selector button  displays all the clips available for the track, allows the user to add clips, and opens the Clip 
Pool. 

The Paint Clip Selector button shows the clip type icons. For more information, see Understanding clip types on page 34. 

Clip type icons 

Loop 

One-shot 

Beatmapped 

MIDI (if Loop button  is selected in the Clip Pool) 

MIDI (if Loop button is not selected  in the Clip Pool) 

Track view 

In the track view, you can view and edit the events in a track. The area in which events display is the timeline. The track view contains 
other elements which are described in the following sections. 
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Transport 
bar 

Marker bar 

Beat ruler 

Zoom 
controls 

Time ruler 
(if displayed) 

Marker bar 

The marker bar runs the length of your project and contains the tags for markers and regions positioned along the project’s timeline. 

Beat ruler 

The beat ruler allows you to place events in reference to the musical time of bars and beats. This ruler is fixed and does not update when 
you change the tempo. This allows the events in the tracks to maintain their size when you adjust the tempo. 

Time ruler 

The time ruler provides a timeline for your project. This ruler can show real time in many different formats. For more information, see 
Changing the time ruler format on page 249. The ruler changes with tempo, since the number of beats and beats per second of real time 
changes with tempo. 

Transport bar 

The transport bar contains the playback and cursor positioning buttons frequently used while working on your project. 

Record new track Move cursor to start of project 

Loop playback Move cursor to end of project 

Play from beginning of project MIDI step record 

Play project from cursor position MIDI merge record 

Pause playback Toggle metronome for playback and recording 

Stop playback Toggle metronome countoff and set countoff options 

The software also includes keyboard shortcuts for these playback commands. For more information, see Playback commands on page 309. 
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Zoom controls


To the right of the horizontal scroll bar are the time zoom controls. Clicking the Zoom In Time button (
 ) increases the horizontal


magnification of the project. To decrease the level of magnification, click the Zoom Out Time button (
 ).


Directly below the vertical scroll bar are the dedicated track height zoom controls. Clicking the Zoom In Track Height button (
 ) 

increases the vertical magnification of the project. To decrease the level of magnification, click the Zoom Out Track Height button ( ). 

Note: Double-clicking the horizontal or vertical scroll bars adjusts the magnification so that as much of the project (either horizontally 
or vertically) is displayed as possible. 

Click the Zoom Tool button ( ) in the corner of the track view to temporarily change the cursor into the Zoom tool. After you select an 
area of the track view to magnify, the cursor reverts to the previously active tool. 

Note: Double-clicking the Zoom tool adjusts both the horizontal and vertical magnification so that as much of the project is displayed 
as possible. 

Window docking area 

This area allows you to keep frequently used windows available while working on a project. Windows can be docked side by side or in 
stacks in the window docking area. For more information, see Docking and floating ACID windows on page 247. 

Click the Close button to 

remove a window from a

floating dock or the window 

docking area.


Click the Maximize/Minimize 

button to control the size of

the window in the window 

docking area.


Click the handle to drag a 

window to a different 

location or dock.


Click a tab to 
view a window. 

The default windows display in the window docking area when you start ACID for the first time. Additional windows can be displayed by 
clicking the window’s tab or by choosing the desired window from the View menu. 

Tip: You can quickly hide or show the window docking area by pressing F11. 

The available windows can be docked anywhere at the bottom of the ACID window or floated over the ACID window or on a secondary 
monitor (this setup requires a dual-monitor video card). You can also create floating docks anywhere by dragging more than one 
window to the same area. 

Explorer window 

The Explorer window works similarly to the Windows® Explorer. You can use the Explorer window to locate, preview and select media 
files to be added to your project. You can also use the Explorer window to perform common file management tasks, such as renaming 
files or creating folders. Display the Explorer by choosing Explorer from the View menu or pressing Alt+1. 
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Chopper 

The Chopper™ isolates audio events so that you can dissect them and reinsert them into a project to produce elaborate slice-n-dice 
effects with minimal effort. Display the Chopper by choosing Chopper from the View menu or pressing Alt+2. For more information, see 
Using the Chopper on page 95. 

Mixing Console 

The Mixing Console provides an integrated view of all tracks and busses in your project using the appearance of a traditional hardware-
based mixer. Display the Mixing Console window by choosing Mixing Console from the View menu or pressing Alt+3. For more 
information, see Using the Mixing Console on page 151. 

Video Preview 

This window displays prerendered video files that can be imported and synchronized with an ACID project. The video file displays 
during project playback and can be rendered with the project to an appropriate format. Display the Video Preview window by choosing 
Video Preview from the View menu or pressing Alt+4. For more information, see Using the Video Preview window on page 232. 

Media Manager 

This window displays the Media Manager™, which you can use to search for, manage, and tag your media files. Display the Media 
Manager window by choosing Media Manager from the View menu or pressing Alt+5. For more information, see Using the Media 
Manager on page 69. 

Track Properties 

This window allows you to change track attributes. Display the Track Properties window by double-clicking a track’s icon or by pressing 
Alt+6. For more information, see Configuring track properties on page 115. 

Surround Panner 

This window allows you to control panning in a 5.1 surround project. Display the Surround Panner window by double-clicking the 
surround panner on a track or by pressing Alt+7. For more information, see Working with 5.1 Surround on page 235. 

Soft Synth Properties 

This window allows you to route soft synths to DLS soft synths, VST instruments, or ReWire 2.0 devices, and you can configure soft 
synths for external input from a MIDI controller. Display the Soft Synth Properties window by double-clicking a soft synth control’s icon 
or by pressing Alt+8. 

Audio Plug-In 

This window displays plug-ins and settings for track, assignable, bus, and soft synth effects chains. Display the Audio Plug-In window by 
clicking a track’s Track FX button ( ), by choosing Audio Plug-In from the View menu, or by pressing Alt+9. For more information, see 
Using clips with tracks on page 101. 
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Plug-In Manager 

This window allows you to view and choose effects plug-ins to be added to a track, bus, or assignable effects chain. Display the Plug-In 
Manager window by choosing Plug-In Manager from the View menu or by pressing Ctrl+Alt+1. For more information, see Organizing 
Plug-Ins and ReWire Devices on page 131. 

Tips: 

•	 To add an effect quickly, drag a plug-in from the Plug-In Manager window to a track, bus, assignable effects chain, or soft synth bus. 
•	 If the VST plug-in you want to use isn't displayed in the list, you can use the VST Effects tab in the Preferences dialog to add the plug-in's 

folder and then click the Refresh button to scan for plug-ins. For more information, see Using the Video tab on page 261. 
•	 If the DirectX plug-in you want to use isn't displayed in the list, hold Ctrl+Shift while restarting ACID and then select the Delete all cached 

application data check box to reset your preferences and rescan for DirectX plug-ins. 

Groove Pool 

This window allows you to view and edit the grooves in your project. Display the Groove Pool by choosing Groove Pool from the View 
menu or by pressing Ctrl+Alt+2. The upper half of the Groove Pool window shows all of the groove maps currently in your project. The 
lower half of the window displays the selected groove map in the Groove Editor, which allows you to make changes. For more 
information, see Working with grooves on page 123. 

Clip Properties 

For audio (non-MIDI) clips, this window allows the user to change clip types (loop, one-shot, and Beatmapped), and adjust time 

stretching, pitch, root notes, tempo, and downbeat.


For more information, see Configuring clip properties on page 115.


For MIDI clips, you can use the Clip Properties window to edit data using the OPT list editor or piano roll. 


For more information, see Using the piano roll editor on page 213. For more information, see Using the list editor on page 216.
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Audio signal flow 
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Notes on audio signal flow 

•	 This diagram describes non-MIDI audio events. For MIDI events, see MIDI signal flow on page 27. 

•	 In 5.1 surround projects, tracks routed to the Surround Master bus send surround panning (six-channel) information. Tracks routed 
to busses (e.g., Bus A) send stereo panning (two-channel) information. 

•	 Assignable effect chain panning is available only in 5.1 surround projects. In 5.1 surround projects, assignable effect chains routed 
to the Surround Master bus send surround panning (six-channel) information. Assignable effect chains routed to busses (e.g., Bus 
A) send stereo panning (two-channel) information. 

•	 Bus panning is available only in 5.1 surround projects. In 5.1 surround projects, busses routed to the Surround Master bus send 
surround panning (six-channel) information. Busses routed to hardware send stereo panning (two-channel) information. 
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MIDI signal flow 
INTRODUCING ACID SOFTWARE | 27




Notes on MIDI signal flow 

•	 Soft synth panning is available only in 5.1 surround projects. In 5.1 surround projects, soft synth controls routed to the Surround 
Master bus send surround panning (six-channel) information. Soft synth controls routed to busses (e.g., Bus A) send stereo panning 
(two-channel) information. 

•	 Bus panning is available only in 5.1 surround projects. In 5.1 surround projects, busses routed to the Surround Master bus send 
surround panning (six-channel) information. Busses routed to hardware send stereo panning (two-channel) information. 
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Chapter 2 
Getting Started 

Now that you have an understanding of the interface and controls found in ACID® software, you are ready to begin 
learning the techniques needed to pick, paint, and play in ACID projects. In this chapter you will learn the skills that will 
allow you to create music, from locating media files to writing the finished project to CD. 

Starting projects 

Double-clicking the ACID icon on the desktop starts the software. You can immediately begin building your ACID project 
using the application’s default project properties. However, you may prefer to customize the project properties prior to 
beginning the project. 

Setting project properties 

ACID allows you to configure project properties and add summary information prior to beginning a project. Choosing 
New from the File menu displays the New Project dialog. This dialog contains two tabs: Summary and Audio. Selecting 
the Start all new projects with these settings check box configures the software to use the parameters and information 
in both tabs as defaults when starting all subsequent projects. 

Note: You can edit project audio properties and summary information at any time. Choose Properties from the File 
menu to display the Project Properties dialog, which contains the identical tabs and parameters as the New Project dialog. 

Using the Summary tab 

This tab allows you to enter information about the project. These boxes may be left blank or if information exists, you 
may change it at any time. 

Item Description 
Title Enter the name or title of the project. 
Artist Enter the name of the narrator, band, or artist(s) being recorded into the 

project. 
Engineer Enter the name(s) of the people who mixed and edited the project. 
Copyright Enter the date and ownership rights of the project. 
Comments Enter information that identifies and describes the project. 
Universal Product Code/Media Enter the Universal Product Code (UPC) and the Media Catalog Number (MCN) 
Catalog Number to be written to your CD for identification purposes. 
Start all new projects with these Select this check box if your projects’ requirements do not change or you want 
settings consistent settings for future projects. 

Using the Audio tab 

This tab allows you to set different characteristics the project uses to handle the audio. 

Item Description 
Master bus mode Choose either Stereo for a standard audio project or 5.1 Surround for a surround 

project. 
Number of additional stereo Enter the number of stereo busses that you want in your project. You may add up to 
busses 26 busses. The busses appear in the Mixing Console window. For more information, 

see Using audio bus channel strips on page 164. 
Sample rate Choose a sample rate from the drop-down list or enter your own rate. The sample rate 

range is 2,000 Hz to 192,000 Hz. Higher sample rates result in better quality sound, but 
also mean larger audio files. 

Bit depth Choose a bit depth from the drop-down list. A higher bit depth results in better quality 
sound, but also means larger audio files. 

Enable low-pass filter on LFE Select this check box to limit the audio sent to the LFE channel in a 5.1 surround 
project. For more information, see Working with 5.1 Surround on page 235. 
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Item	 Description 
Cutoff frequency for low-pass filter	 Enter a low-pass cutoff frequency value for 5.1 surround projects. Audio sent to the 

LFE channel is limited to frequencies lower than the value you enter. Applying a low-
pass filter approximates the bass-management system in a 5.1 decoder and ensures 
that you’re sending only low-frequency audio to the LFE channel. 

Available only in ACID. 
Low-pass filter quality Choose a setting from the drop-down list to determine the sharpness of the low-pass 

filter’s rolloff curve. Best produces the sharpest curve. 

Available only in ACID. 
Recorded files folder This box displays the path to the folder that will be used when you record new audio 

or MIDI tracks. Choose <Project> to save recorded files in the same folder as your ACID 
project file, or click the Browse button to choose a different folder. 

The recorded files folder from the Folder tab of the Preferences dialog is used by 
default unless you choose a project-specific location. If you select the Start all new 
projects with these settings check box, the setting on the Folder tab of the 
Preferences dialog will be updated to use the folder specified in the Project Properties 
dialog. 

Start all new projects with these Select this check box if your project requirements do not change or you want 
settings consistent settings for future projects. 

Opening existing projects 

1.	 From the File menu, choose Open. The Open dialog appears. 

2.	 Choose a drive and folder from the Look in drop-down list. 

3.	 Select a file in the browse window or type a name in the File name box. Detailed information about the selected file appears at the 
bottom of the dialog box. 

4.	 Choose a file type from the Files of type drop-down list to limit the files displayed in the dialog box. 

5.	 Click Open. 

Note: If one of the media files cannot be located when you open an ACID project, you can choose to leave the media offline and 

continue to edit events on the track. The events point to the location of the source media file. If you restore the source media file at a

later time, the project opens normally.


Opening ACID projects with embedded media 

When you open an .acd-zip project, the project file and all media files are copied to the temporary files folder. 

Note: You can customize the location of the temporary files folder. For more information, see From the Options menu, choose 

Preferences to display the Preferences dialog. on page 253.


Any changes you make to the project are saved to the files in this temporary folder until you save the .acd-zip file again. For more 
information, see Saving projects on page 46. 

Getting media files 

Now that you’ve created a new project or opened an existing project, the next step is to add media to the project. You can use the 
Explorer window to locate, preview and add media to your project. You can also extract audio from a CD or download media from the 
Web. If you have ACID, you can also use the Media Manager to locate and add media files. 

Previewing media from the Explorer window 

The Explorer window allows you to preview files in looped playback at the current project tempo before adding them to your project. 
You can also preview files in the Explorer in conjunction with playing your project, thereby allowing you to preview how a file will sound 
in the project. 

To preview files, use the Start Preview (  ),  Stop Preview (  ), and  Auto Preview ( ) buttons at the top of the Explorer window. 
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Previewing a media file 

1.	 Select the media file in the Explorer window that you want to preview. 

2.	 Click the Start Preview button ( ). The media file begins looped playback. You can monitor its levels on the preview bus. 

3.	 Click the Stop Preview button ( ) to end playback. 

Previewing multiple media files 

You can use the Explorer’s multiple-selection preview feature to preview a group of files in the order that you select them. 

1.	 From the Options menu, choose Preferences. 

In ACID, click the Other tab of the Preferences dialog and select the Enable multiple-selection preview in Explorer window check 
box. 

If you want, you can enter values in the Number of times to repeat each Loop box, Seconds of each One-Shot to play box, and 
Number of Beatmapped measures to play box to specify how different file types are previewed. 

2.	 Click OK to close the Preferences dialog. 

3.	 In the Explorer, select the media you want to preview. Hold Shift while clicking to select multiple, adjacent files or hold Ctrl while 
clicking to select multiple, nonadjacent files. 

4.	 Click the Start Preview button ( ). The first selected file in the list is previewed, followed by each file in the list. A file’s icon 
changes to a Play icon ( ) to indicate which file is currently previewing. 

Note: To add the currently previewing file to your project, press Ctrl+Enter. Press Enter to add all selected files to your project. 

Using Auto Preview 

Click the Auto Preview button ( ) to toggle automatic playback of media files when you select them in the Explorer. If your project is 
currently playing when you select a new file, the new file plays back along with your project. This feature allows you to listen to the 
media file in the context of your project. 

Adding media to the project 

You must add media files to a project before you can paint, arrange, and process them. When you add a file to a project, a new track is 
created to accommodate it. New tracks are added at the current volume of the Preview fader in the Mixing Console window, unless you 
have set a default track volume level. For more information, see Setting default track properties on page 252. 

There are several methods of adding media files to a project. 

Notes: 

•	 Proxy files may be created for media whose compression scheme may cause working with them to be inefficient and slow. For more

information, see Proxy File on page 315.


•	 Before using long Beatmapped or long one-shot files from CDs or shared network folders, copy the media to your local drive for the best 
possible performance. 

ACID temporary files 

When you add a media file to a project from a removable device, a copy of the media file is stored in the temporary files folder. This 
keeps the media file available for use even if the source of the media is no longer accessible. 

Be aware that the temporary files folder is cleared when you close the ACID application. However, files are not cleared from the folder if 
the software closes inappropriately. 

Note: You can customize the location of the temporary files folder. For more information, see From the Options menu, choose 

Preferences to display the Preferences dialog. on page 253.
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Adding media files from the Explorer window 

You can use the Explorer window, which operates similarly to the Windows® Explorer, to locate media files for use in projects. Display 
the Explorer, if needed, by choosing Explorer from the View menu, or by pressing Alt+1. 

There are three ways to add media files from the Explorer window: 

•	 Double-click the desired file. 

•	 Drag the file from the Explorer to the track view or track list. Dragging a file from the Explorer to the track name of an existing track 
allows you to replace the original file with the new file, while all events remain in place. 

•	 Right-click and drag a file to the track view or track list to specify the type of track to be created. When you drop the file, a shortcut 
menu appears that allows you to choose whether to treat the file as a loop, one-shot, Beatmapped track, or as an autodetected 
type. 

Adding MIDI files from the Explorer window 

You can add MIDI files to your project just as you would add audio files. You can right-click a MIDI in the Explorer window, you can 
choose how you want to add it to your project: 

•	 Add to Project. 

•	 Add to Project with Events. 

•	 Add to Project with Events Rippled. 

•	 Open as New Project. 

For more information, see Adding MIDI files to a project on page 187. 

Adding media files from the Media Manager window 

If you have ACID, you can use the powerful Media Manager feature to locate, catalog, and add media files to your ACID projects. Within 
the Media Manager window, you can build media libraries of your media that include file attributes, ACID metadata, and tags that you 
can assign to classify your media. You can also search for, purchase, and access reference libraries from outside sources to build your 
media file base. Display the Media Manager, if needed, by choosing Media Manager from the View menu, or by pressing Alt+5. 

For more information on the Media Manager feature, see Using the Media Manager on page 69. 

Adding media files from the Open dialog 

There are three ways to add media files from the Open dialog: 

•	 Select the desired file and click Open. 

•	 Right-click the selected file and choose Select from the shortcut menu. 

•	 Double-click the selected file. 

Adding media files from outside the application 

You can also add a media file to a project by dragging it from Windows® Explorer to the track view. 

Adding multiple media files simultaneously 

To add multiple media files to the project, Ctrl+click (or Shift+click) to select the files and drag them to the track view or the track list. 

Extracting media files from CD 

You can extract 44,100 Hz, 16-bit, stereo data from CDs. Extracted CD tracks are added to new tracks in your ACID project. 

1.	 Insert a CD in the CD-ROM drive. 

2.	 From the File menu, choose Extract Audio from CD. The Extract Audio from CD dialog appears. 

3.	 If you have more than one CD drive, choose the CD drive that contains the audio you want to extract from the Drive drop-down list. 
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4.	 From the Action drop-down list, choose how you want to extract 
audio: 

•	 Choose Read by track and select each track you want to 

extract. Each track is extracted to a new track in your project.


•	 Choose Read entire disc to extract the current CD to a single 

file.


•	 Choose Read by range and enter a starting time and ending 

time (or a starting time and length). The time range is 

extracted to a new track in your project.


Click Play to preview your selection. In order to preview, your CD 

drive’s audio output must be connected to your sound card, or 

you can connect headphones to the front of the CD drive.


5.	 Click the MusicID button if you want to obtain CD information 
using Gracenote MusicID. 

If CD information is not available, you can click the CD Info button 
to display a dialog box where you can edit the CD information and 
submit it for inclusion in the Gracenote Media Database. For more 
information, see Obtaining or editing CD information using Gracenote on page 33. 

6.	 From the Speed drop-down list, choose the speed at which you want to extract audio. 

7.	 Click OK. The Save As dialog appears. 

8.	 Enter a file name and choose a location for the new file(s). 

Tip: Extracted tracks can be automatically named for you. From the Options menu, choose Preferences, and on the General tab, select 
the Autoname extracted CD tracks check box. For more information, see From the Options menu, choose Preferences to display the 
Preferences dialog. on page 253. 

9.	 Click Save to start extracting audio. 

CD data extraction begins and a progress meter is displayed. If the file is longer than 30 seconds, the Beatmapper™ Wizard appears. 

10. Use the Beatmapper Wizard or choose to open the file as a one-shot. The extracted file is added to a track. For more information, see 
Using the Beatmapper on page 113. 

You can also double-click a CDA file in the Explorer window (or drag it to the track view) to extract a CD track without opening the 
Extract Audio from CD dialog. 

Note: When adding media from multiple CDs, you may need to press F5 to refresh the Explorer window to view the new CD’s contents. 

Obtaining or editing CD information using Gracenote 

If ACID can access information about a track or CD (either from the file or CD itself, or from a local cache), it automatically reads and 
displays this information when you insert a CD or browse your computer. However, if this information is not available, the software can 
retrieve information over the Internet from Gracenote MusicID. 

Once ACID obtains information from Gracenote MusicID, it is saved to a local cache so the information displays more quickly the next 
time the tracks are displayed. 

If the software cannot connect to the Gracenote Media Database and the appropriate CD information is not available on your computer, 

the tracks are simply listed numerically. In this case, you can edit CD information and submit it to the Gracenote Media Database. 

Note: Using Gracenote MusicID requires an active Internet connection. For more information on using Gracenote MusicID, refer to 
www.gracenote.com/. 
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Obtaining CD information 

1.	 Insert a CD in your drive. 

2.	 Click the MusicID button in the in the Extract Audio from CD dialog, or browse to the CD and click the  button in the Explorer 
window. For more information, see Extracting media files from CD on page 32. For more information, see Explorer window on page 22. 

Gracenote MusicID attempts to obtain matching CD information and displays artist, album, and track data: 

•	 If the service locates an exact match, this information is automatically displayed. No additional action is necessary. 

•	 If the service locates multiple possible matches, the Match dialog is displayed. Proceed to step 2. 

3.	 Choose a method for completing the CD information: 

•	 If none of the possible matches is appropriate, click the Submit New button. The Gracenote CDDB Disc Information dialog is 
displayed, allowing you to complete information for the CD and submit it for inclusion in the Gracenote Media Database. For 
help on submitting CD information, click the Help/Guidelines button in this dialog. 

When you are finished typing information, click the OK button to submit your data. 

•	 Select the appropriate match from the list and click the Accept Match button. The artist, album, and track information is 
displayed based on your selection in the right side of the PC pane. 

4.	 You’re now ready to extract tracks. 

Editing and submitting CD information 

1.	 Insert a CD in your drive. 

2.	 Select a track and click the CD Info button in the Extract Audio from CD dialog, or browse to the CD and click the button in the 
Explorer window. The Gracenote CDDB Disc Information dialog is displayed. For more information, see Extracting media files from CD 
on page 32. For more information, see Explorer window on page 22. 

3.	 Use the Gracenote CDDB Disc Information dialog to edit information about the CD. For help on submitting CD information, click 
the Help/Guidelines button in this dialog. 

4.	 When you are finished entering the information, click the OK button to submit it for inclusion in the Gracenote Media Database. 

Understanding clip types 

When you add media to a project, a new track is created for the file. Depending on the type of media you add, one of four clip types is 
created to accommodate it: loop, one-shot, Beatmapped, or MIDI. You can identify a track’s type by looking at the paint clip selector 
icon in the track header. For more information, see Using clips with tracks on page 101. 

Loops 

Loops are small chunks of audio that are designed to create a continuous beat or pattern when played repeatedly. They are usually one 
to four measures long. Loops are the type of file that you will use most frequently. 

One-shots 

One-shots are chunks of audio that are not designed to loop, and they are streamed from the hard disk rather than stored in RAM if they 
are longer than three seconds. Things such as cymbal crashes and sound bites could be considered one-shots. 

Unlike loops, one-shots do not change pitch or tempo with the rest of a project. 

Beatmapped 

When you add a file that is longer than thirty seconds to a project, the Beatmapper Wizard starts, allowing you to add tempo 
information to the file. As a result, these clips respond to tempo and key changes just like loops. For more information, see Using the 
Beatmapper on page 113. 

Tip: You can change the length of the file that starts the Beatmapper in the Audio tab of the Preferences dialog. For more

information, see Using the Audio tab on page 255.
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MIDI 

A MIDI clip is automatically created when you open a MID, SMF, or RMI file. You can use MIDI clips to record data from and play back 
through synthesizers and other MIDI-compliant equipment. For more information, see Working with MIDI on page 187. 

Folder tracks 

Folder tracks can contain any combination of tracks. Use folder tracks to group related tracks or sections of a project so they can be 
easily expanded or minimized. For example, if you have many drum tracks in your project, you can add a folder track to consolidate 
drum tracks and minimize their vertical space in the track list. 

When the folder track is minimized, you can also perform edit operations on clustered events in the group, but you cannot create events 
with the Draw or Paint tools or perform edge-trimming. Expand the folder track to edit individual events. 

For more information, see Using folder tracks on page 128. 

Adding and editing events 

You have added media to the project, and tracks have been created for the media files. Now you can add events to the track view. The 
following sections describe three basic techniques used when working with audio events: painting, deleting, and moving. 

Painting events 

After you add a media file to your project, you must paint it on the timeline in order to hear it. When you paint on the media file’s track, 

you create an event that displays the file’s waveform. You can paint events on the timeline using either the Draw tool  or the Paint 

tool . 

Clips can also be painted on the timeline with the Draw and Paint tools. For more information, see Adding clips to tracks on page 101. 

Note: Media files must be added to the project before either of these tools can be used to paint events. 

Placing events with the Draw tool 

The Draw tool is the most common method of placing events on the timeline. This tool allows you to add events one at a time. In 
addition, you can use the Draw tool to select, edit, and move events. For more information, see Adding and editing events on page 35. 

1.	 Click the Draw Tool button ( ) or choose Editing Tool from the Edit menu and choose Draw from the submenu. The pointer 
displays as a pencil icon. 

2.	 Place the Draw Tool at the left edge of any track containing a media file. 

3.	 Click and hold the mouse button while dragging the Draw tool to the right. A waveform representing the event appears on the 
timeline as you drag the mouse. 

Notice that if you are placing a loop file on the timeline, small indentations appear along the top and bottom edges of the event 
indicating the start and end points of each individual loop. 

Tip: Events can be also be drawn from right (end) to left (beginning). 

4.	 Release the mouse button to end the event. 

5.	 Click the Play from Start button ( ) on the transport bar. The event plays back. 
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Painting events with the Paint tool 

Unlike the Draw tool, the Paint tool allows you to quickly paint multiple events across several tracks. This can be useful when you need 
to quickly add several seemingly random events to a project. The Paint tool is also best used for painting multiple one-shot events that 
will be evenly spaced on the grid lines. 

When painting MIDI or one-shot clips, you can click the down arrow next to the Paint tool to set the length of events that will be 
created when you drag with the Paint tool. 

1.	 Click the Paint Tool button ( ) or choose Editing Tool from the Edit menu and choose Paint from the submenu. The mouse 
pointer displays as a brush icon. 

2.	 Click and hold the mouse button while dragging the Paint tool randomly across the several tracks. Notice that events are painted in 
every grid space the Paint tool contacts. 

3.	 Release the mouse button to stop adding events. 

4.	 Click the Play from Start button ( ) on the transport bar. All new events play back. 

Tip: With the Paint tool selected, you can use Ctrl+click to paint an entire event for one-shot, Beatmapped, and MIDI tracks. 

Inserting events at the play cursor 

You can also insert events at the cursor during playback. You can use this feature to create rhythms on one-shot tracks while listening to 
the track you’re editing in the context of the rest of your project. When you’re done creating events, you can use the Render to New 
Track command (on the Edit menu) to save the rhythm to a new track, or you can copy and paste your new events across the timeline. 

1.	 Create a time selection in the portion of the project you want to edit. 

2.	 Select the Loop Playback button ( ). 

3.	 Click the Play button ( ) to start playback. 

4.	 Click a track header in the track list to set the focus track. 

5.	 Press Y to add an event at the play cursor (during playback, the edit cursor remains fixed, and the play cursor follows playback). 

If snapping is enabled, events are created at the next snap point. You can use snapping to quantize your events. 

6.	 Repeat step 5 as needed. 

7.	 You can press the up and down arrow keys to change the focus track. 

8.	 Click the Stop button ( ) when you’re finished creating events. 

9.	 Edit event positions as necessary. 

Tip: If you're using this feature to tap rhythms with one-shot tracks, try applying a groove to adjust the timing of your rhythm.For more 
information, see Working with grooves on page 123. 

Changing the length of events 

After an event is painted on the track view, you may discover that it is too long or not long enough; however, it is easy to change the 
length of an event. You may find it helpful to turn snapping options on by choosing Snapping from the Options menu and choosing 
Enable from the submenu. 

To alter an event’s length, click the Draw Tool button ( ) and drag either end of the event. When you drag the event past the end of 
the file, looped files repeat, but one-shot and Beatmapped tracks draw silence. 

Original event Drag the end of ...to increase its length. 
the event... 
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Erasing sections of events 

Occasionally you may need to delete only specific sections of an event and leave the rest of it intact. The easiest method of deleting a 
section of an event is to use the Erase tool. 

1. Click the Erase Tool button ( ) or choose Editing Tool from the Edit menu and choose Erase from the submenu. The pointer 
displays as an eraser icon. 

2. Drag in the track view to delete event data. 

Tip: With the Erase tool, you can delete an entire one-shot, Beatmapped, or MIDI event. Just hold Ctrl while you click the event. 

Moving events 

The position of the left edge of an event indicates when the event becomes audible during playback. You can move events along the 
timeline either individually or as a group. 

In addition, you can stack events on top of one another. A longer event placed over a smaller event conceals the smaller event and 
makes it inaudible. A smaller event placed over a larger event is audible and renders the section of the longer event it covers inaudible. 

1. Click the Draw Tool button ( ). 

2. Click the event to be moved. The event is highlighted to indicate that it is selected. 

Tip: You can hold Ctrl or Shift to select multiple events. 

3. Drag the event to a new location on the track. 

Note: Multiple selected events move in relation to the event being dragged. 

Editing MIDI events 

You can use the inline MIDI editing mode to edit MIDI events directly in the timeline. In this mode, you can draw and erase notes in a 
piano roll or drum grid view. For more information, see Editing MIDI on the timeline on page 193. 

Using the cursor 

The ACID cursor is a flashing vertical line that spans the track view of the entire project. The cursor position determines where events 
split, where playback/recording starts, and where clipboard contents are pasted. In addition, the positioning of the cursor is essential to 
the creation of time selections. 

Positioning the cursor with the mouse 

1. Click the Draw Tool button ( ). 

2. Click in the track view to position the cursor. 

Positioning the cursor with the keyboard 

While using the mouse to position the cursor in the timeline is quick and intuitive, it is not always precise. For example, you may want 
the beginning of a guitar solo to coincide with a snare drum hit, or background vocals to enter exactly 3 minutes and 24 seconds into a 
song. For these reasons, you can also position the cursor using your keyboard. For more information, see Cursor placement, loop region 
and time selection commands on page 307. 
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Positioning the cursor with the Go To command 

The Go To command is used to place the cursor at a specific location in the ACID project. 

•	 Press Ctrl+G to position the cursor based on the position displayed on the beat ruler. Specify a position (in measures.beats.ticks 
format) in the box that appears in the time display and press Enter. 

• Press Shift+G to position the cursor based on the time displayed on the time ruler. Specify a time in the box that appears in the 
time display and press Enter. 

Tip: You can also open the boxes in the time display by double-clicking the desired value. 

Making selections 

You must select events before you can move or edit them. 

Selecting an event 

1.	 Click the Draw Tool button ( ). 

2.	 Click an event. The event is highlighted. 

Selected event 

Selecting multiple events 

You have several methods of selecting multiple events: 

• Press Ctrl or Shift while clicking events. 

•  Use the  Select All on Track command. 

•  Use the  Select Events to End command. 

• 	Use the  Select All command. 

• 	Use the Selection tool.  

Note: Unless stated otherwise, selections can only be made using the Draw tool. 

Selecting multiple events using the keyboard and mouse 

Holding Ctrl while clicking events allows you to select multiple, nonadjacent events that reside on any track. This method is useful when 
you need to move several scattered events by an equal amount within the project. 

Holding Shift allows you to select multiple, adjacent events. Selecting any two events while holding Shift automatically selects all events 
located between the selected events. Events may be selected from the same track or across tracks. This method is useful when you want 
to move several adjacent events by an equal amount within the project. 

Selecting multiple events using the Select All on Track command


Right-clicking any track in the track view and choosing Select All on Track from the shortcut menu selects every event on the track.
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Selecting multiple events using the Select Events to End command 

Right-clicking an event in the track view and choosing Select Events to End from the shortcut menu selects every event on the track 
after the selected event. 

You use this command across multiple tracks by holding Ctrl to click events on several tracks and then right-clicking and choosing 
Select Events to End from the shortcut menu. 

Selecting events that use a specified clip 

Perform any of the following actions to select events created from a clip: 

•	 Right-click an event in the timeline and choose Select Events Using This Event's Clip from the shortcut menu to select all events 
on the track that use the same clip as the selected event. 

•	 Right-click the timeline, choose Select Events Using Clip, and then choose a clip from the submenu to select all events on the track 
that use the specified clip. 

•	 Right-click a clip in the Clip Pool window and choose Select Timeline Events from the shortcut menu. 

Selecting events using the Select All command 

Choosing Select All from the Edit menu selects all events in a project. 

Selecting multiple events using the Selection tool 

You can drag the Selection tool across the track view to select events across multiple tracks. This tool allows you to select events using 
three methods: vertical, horizontal, and free selection. 

Method	 Description Displays as... 
Vertical Allows you to select all events on all Parallel dashed line spanning the 

tracks within an interval of time. vertical length of the project. 
Horizontal Allows you to select all events on a track Parallel dashed line spanning the 

or several adjacent tracks. horizontal length of the project. 
Free selection	 Allows you to select a group of adjacent Dashed line box. 

events on adjacent tracks. This is the 
default selection method. 

1.	 Click the Selection Tool button ( ) or choose Editing Tool from the Edit menu and choose Selection from the submenu. 

2.	 Place the pointer on the track view. The pointer displays as an arrow with an adjacent dotted box ( ). 

3.	 Drag the mouse on the track view. A dashed rectangular box appears on the track view and all events within and adjacent to it are 
selected. 

4.	 While holding the left mouse button, click and release the right mouse button (referred to as toggle-clicking). The selection 
method changes to vertical and again, all events within and adjacent to the selection area are selected. 

5.	 Toggle-click the mouse once more. The selection method changes to horizontal and all events within and adjacent to the selection 
area are selected. 

Creating time selections 

You are not limited to selecting events. Frequently, you may want to select only audio events occurring within a time selection. You can 
do this using the Time Selection tool. 

1.	 Click the Time Selection Tool button ( ) or choose Editing Tool from the Edit menu and choose Time Selection from the 
submenu. The pointer displays with an adjacent cursor ( ). 

2.	 Drag the mouse in the track view. The selection area is highlighted on the track view. 

3. Release the mouse button. A time selection is created and all events within it are selected. 

Note: If the selection area is automatically snapping to the track view’s grid lines, the ACID snapping feature is turned on. You can turn 
snapping off by pressing F8. 
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Creating event selections within time selections 

You can select specific events within a general time selection. This technique is useful for selecting individual instruments from a 
particular section of a song. For example, you may want to copy all percussion events from a song’s bridge and re-use them in the coda. 

1.	 Click the Time Selection Tool button ( ) or choose Editing Tool from the Edit menu and choose Time Selection from the 
submenu. The pointer displays with an adjacent cursor ( ). 

2.	 Drag the mouse in the track view. The selection area is highlighted on the track view. 

3.	 Release the mouse button. A selection is created and all events within it are selected. 

4.	 Hold Ctrl and click any event that extends beyond the time selection. The entire event appears highlighted; however, only the 
section of the event contained within the time selection is actually selected. 

Tip: You can select additional events within the time selection by continuing to hold Ctrl while clicking events. In addition, holding Shift 
allows you to select the events of multiple adjacent tracks within a selection. 

Working with tracks 

The following sections explain several basic track functions and features. For more in-depth information on tracks, see Working with 
Tracks on page 101. 

Reordering tracks 

When building an ACID project, you may want to reorder the tracks to place similar instruments in proximity to one another. For 
example, placing all drum loops together in the track view makes it easier for you to fine-tune the mix of the song’s overall drum sound. 

1.	 Drag the track header to a new location in the track list. A heavy black horizontal line appears on the track list to indicate where the 
track will be placed. 

2.	 Release the mouse button. The track is dropped in the new location and the entire track list/track view adjusts accordingly. 

Tip: You can reorder multiple tracks by holding Ctrl or Shift while selecting tracks and dragging the tracks as a group. 

Resizing tracks 

You can change the height of a track, thereby affecting how many tracks display in the track view. This is especially useful when building 
a project with a large number of tracks. In addition, you can decrease the track’s height until only the multipurpose slider, Track FX 
button, Mute button, and Solo button are visible. 

1.	 Drag the bottom edge of a track up or down in the track list. The pointer displays as a vertical stretch icon ( 

2.	 Release the mouse button to establish the track’s new height. 

Tip: You can set the default height for all new tracks by right-clicking the newly resized track in the track list and choosing Set Default 
Track Properties from the shortcut menu. For more information, see Setting default track properties on page 252. 

Changing track colors 

As mentioned previously, tracks are automatically created to accommodate new media files. These tracks are assigned a default color. 
However, you can change track colors to organize the tracks in your project. To change the color, right-click the track in the track list, 
choose Color from the shortcut menu, and choose the desired color from the submenu. 

Renaming tracks 

To rename a track, right-click the track name and choose Rename from the shortcut menu, or double-click the track name. Renaming a 
track applies to the project only and does not change the file associated with the track. 

). 
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Duplicating tracks 

To duplicate a track, right-click it and choose Duplicate Track from the shortcut menu. An exact copy of the track is created and its 
events and adds it below the original track in the project. The words “Copy of” appear before the name of the duplicate track to identify 
it in the track list. 

For creative ways to use duplicate tracks, see Playing with duplicate tracks on page 297. 

Deleting tracks 

You can delete unnecessary tracks from a project by selecting the track and using any of the following methods: 

• Choose Delete from the Edit menu. 

• Right-click a track and choose Delete Track from the shortcut menu. 

• Press Delete. 

Copying, cutting, and pasting tracks 

Copying a track places an exact copy of the selected track on the clipboard, but leaves the track view unchanged. To copy a track, select 
the track and do one of the following: 

•  Click the  Copy button ( ) on the toolbar. 

• Choose Copy from the Edit menu. 

• Right-click the track header and choose Copy Track from the shortcut menu. 

• Press Ctrl+C. 

Cutting a track removes it from the track view and places it on the clipboard. To cut a track, select it and do one of the following: 

•  Click the  Cut button ( ) on the toolbar. 

• Choose Cut from the Edit menu. 

• Right-click the track header and choose Cut Track from the shortcut menu. 

• Press Ctrl+X. 

Tracks that are copied or cut to the clipboard can be pasted back into the current project or into a different project an unlimited number 
of times. This is a useful way to share tracks between different compositions. You can paste a track in one of the following ways: 

•  Click the  Paste button ( ) on the toolbar. 

• Choose Paste from the Edit menu. 

• Right-click the track view and choose Paste Track from the shortcut menu. 

• Press Ctrl+V. 

Adjusting the mix 

You can adjust the mix of a specific track in the track header. Volume and pan each have dedicated sliders to make adjustments. 

Assignable effects and busses share a multipurpose slider. Click the multipurpose slider to choose what you want to adjust. 

Multipurpose slider 

Multipurpose slider mode 
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Once you have chosen what you want to adjust, drag the slider to adjust the level. You can hold Ctrl or Shift to select multiple tracks and 
move the sliders together as a group. 

Function	 Description 
Volume	 This dedicated volume slider controls how loud a track is in the mix. A value of 0 dB means that the track 

plays with no boost or cut from the software. Dragging the fader to the left cuts the volume; dragging to the 
right boosts the volume. 

Pan	 This dedicated pan slider controls the position of a track in the stereo field. Dragging the slider to the left 
places the track in the left speaker more than the right, while dragging the slider to the right places the track 
in the right speaker. 

Because true stereo panning is used, you can introduce clipping when panning a track to the left or right. 
Unlike a left/right balance control—which simply decreases the volume of one channel—the default 
panning mode actually adds the audio from one channel to the other. When panning a track, adjust the 
track volume accordingly. 

You can choose among five panning types to determine how a track is panned. For more information, see 
Choosing stereo pan types on page 113. 

FX	 With the multipurpose slider, you can control the level of the track sent to each of the assignable effect 
chains that you have created. Dragging the fader to the left cuts the volume; dragging to the right boosts 
the volume. 

Bus	 With the multipurpose slider, you can control the level of the track sent to each of the additional busses that 
you have created for your project. Dragging the fader to the left cuts the volume; dragging the fader to the 
right boosts the volume. 

Note: When adjusting the mix of your tracks, remember to look at the meters on the Mixing Console. Because you are adding the 
volumes of all the tracks together, it is easy to clip the audio output. Make sure that the meters never display the red clip indicator during 
playback. 

Muting or unmuting tracks 

Each track has a Mute button ( ). Clicking this button renders the corresponding track inaudible during playback and shades it to 
indicate that it is muted. Toggle-muting a track is an effective way of determining whether a track contributes to the overall sound of a 
project. 

Note: Muting a track mutes its main output and post-fader sends only unless the Track prefader sends listen to mute check box on 
the Audio tab of the Preferences dialog is selected. For more information, see Using the Audio tab on page 255. 

1. Deselect the Automation Settings button ( )  to toggle trim mode. 

2. Click the Mute button (or press Z). Repeat this step on additional tracks to add them to the mute group, if desired. 

Tip: Press Ctrl and click the Mute button to mute only the selected track (and restore any other muted tracks). If the selected track is 
already muted, press Ctrl and click the Mute button to restore all tracks. 

Adjusting mute automation 

When you select the Automation Settings button ( ), the Mute button is displayed as a , and you can use the control to edit volume 
automation. 
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Soloing tracks 

Located next to the Mute button, the Solo button ( ) allows you isolate tracks in a project during playback. When you click this button 
during playback, the corresponding track remains audible and all other tracks are muted. Clicking the Solo button a second time returns 
all tracks to their original levels in the mix. Toggle-soloing a track is an effective method of configuring and previewing isolated track 
effects against how they sound in the project. 

You can also press X to solo a track or group of tracks. 

Tip: Press Ctrl and click the Solo button to solo only the selected track (and restore any other soloed tracks). If the selected track is already 
soloed, press Ctrl and click the Solo button to restore all tracks. 

Choosing a track’s input/recording device 

The Record Device Selector button  in a track header chooses the audio input that will be used to record to a track. 

You can click the Record Device Selector button to turn input monitoring on or off and choose a recording device: 

For more information, see Recording Audio on page 179. 

Monitoring track output levels 

During playback, a responsive meter is displayed in the track header to monitor the track's output. 

Horizontal meter 

Vertical meter 
(Right-click and choose 
Use Vertical Meters 
from the shortcut menu) 

When clipping is detected, the peak meter displays a red Clip indicator. 

Right-click the meters and choose a command from the shortcut menu to adjust the display of the meters. This shortcut menu allows 
you to reset clip indicators, choose a display scale, toggle vertical display, or turn output meters off. 

Working with groups of tracks 

Select a group of tracks by holding the Ctrl key while you click the track header of the desired tracks. Now you can adjust the volume, 
panning, track color, and other track attributes simultaneously. 

Using undo and redo 

You have unlimited undo and redo capabilities in ACID. Each edit you perform in the project is added to an undo history, which allows 
you to quickly restore the project to any of its previous states. In addition, undoing an edit automatically places it in the project’s redo 
history where it can be quickly re-performed. However, any new edit performed on the project overwrites the redo history. 

Note: The undo and redo histories are cleared when you close the project or exit the application. 
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Using undo 

To undo an edit, click the Undo button ( ) on the toolbar or press Ctrl+Z. Edits are undone in the reverse order they were performed. 

Tip: You can also undo the most recent edit by choosing Undo from the Edit menu. 

Undoing a series of edits 

Clicking the down arrow next to the Undo button ( ) displays the project’s undo history. The history displays as a drop-down list with 
the most recent edit located at the top. Undoing an edit in the list requires all subsequent edits to be undone as well. 

1.	 Click the arrow to the right of the Undo button ( ). The undo history appears. 

2.	 Locate the edit to be undone. Notice that all subsequent edits are automatically selected and the total number of edits to be 
undone is indicated at the bottom of the drop-down list. 

3.	 Click the edit to be undone. The project is restored to the state it was in prior to the selected edit. 

Undoing all edits 

Choosing Undo All from the Edit menu undoes all project edits and automatically adds them to the redo history. 

Using redo 

To redo an edit, click the Redo button ( ) on the toolbar or press Ctrl+Shift+Z. Edits are re-performed in the reverse order they were 
undone. 

Tip: You can also redo the most recent undone edit by choosing Redo from the Edit menu. 

Redoing a series of edits 

Clicking the down arrow next to the Redo button ( ) displays the project’s redo history. The history displays as a drop-down list with 
the most recently undone edit located at the top. Redoing an edit in the list requires all subsequently undone edits to be re-performed 
as well. 

1.	 Click the arrow to the right of the Redo button ( ). The redo history appears. 

2.	 Locate the edit to be redone. Notice that all subsequently undone edits are automatically selected and the total number of edits to 
be redone is indicated at the bottom of the drop-down list. 

3.	 Click the edit to be redone. The project is restored to the state it was in prior to the selected undone edit. 

Tip: Clicking the desktop outside the drop-down list cancels the redo operation. 

Clearing the undo history 

You can clear the undo and redo histories without closing the project or exiting the application. After the histories are cleared, new ones 
are created as you continue building the project. 

1.	 From the Edit menu, choose Clear Undo History. A confirmation dialog appears, alerting you that this action permanently deletes 
the current edit histories. 

2.	 Click Yes to clear the edit histories or No to retain the current edit histories. 
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Playing the project 

You have several methods for playing your projects. 

Using the transport bar 

All buttons required to play your project are located on the transport bar. The transport bar should look somewhat familiar to you, as it 
contains buttons found on most home CD and cassette players. For more information, see Transport bar on page 21. 

Using playback options 

As you build a project, you will likely have different playback needs. For example, you may want to hear the project in its entirety when 
checking the final mix, but not when you are working on the ending. Because of this, you have three playback options: 

• Playing the entire project. 

• Playing from the cursor position. 

• Playing in looped playback. 

Playing the entire project 

To begin playback from the beginning of the project, click the transport bar’s Play From Start button ( ) or press Shift+Space. To stop 

playback, click the transport bar’s Stop button ( ) or press Space. 

Playing from the cursor position 

To begin playback from the current cursor position, click the transport bar’s Play button( ) or press Space. To stop playback, click the 

transport bar’s Stop button ( ) or press Space. 

Playing in looped playback 

You can also limit playback to a specific loop region on the track view. This playback method uses the transport bar’s Loop Playback 

button ( ) and allows you to fine-tune mixes and effects while continually listening to the selected area. For more information, see 
Transport bar on page 21. 

1. Drag the handles of the loop bar to create the desired loop region. 

Handle Loop bar 

2. Click the Loop Playback button ( ) to turn on looped playback. 

3. Click the transport bar’s Play button ( ) or press Space. Playback of the selected area begins. To stop playback, click the transport 
bar’s Stop button ( ) or press Space. 
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Bypassing audio effects during playback 

If you want to hear your project without your applied audio effects (track, bus, and assignable effects), you can quickly bypass these 
effects during playback. From the Options menu, choose Bypass All Audio FX. This option can also conserve processing power to avoid 
playback problems. 

Note: When effects are bypassed, you can choose whether bypassed effects remain open. When the Keep bypassed FX running check 
box on the General tab of the Preferences dialog is selected, effects remain open so you can bypass/enable effects with no pause for A/B 
testing. When the check box is cleared, effects are fully bypassed, conserving processing power. 

Saving, rendering, and delivering projects 

Though you are provided with the tools to quickly build impressive musical projects, you may find yourself building elaborate projects 
over a period of weeks or even months. While you are working on a project, you should save it in the ACID native format: the ACID 
project file (.acd). 

Important: If you save a project originally created in an earlier version of ACID software in ACID version 7.0, it will be unusable in earlier 
versions of the software. Use the Save As dialog to save the project with a new name after editing it in version 7.0. 

When you are finished building a project, you can render projects in a variety of formats. You should determine the project’s final format 
(or formats) based on how you will deliver the media. For example, you would render your project to a streaming media format if you 
plan to publish it to the Internet. 

Note: Be aware that projects containing MIDI files that are routed to external MIDI ports must be rerouted to internal DLS sets or VST 

instruments (VSTi) to be included in the rendered mix. For more information, see Rendering projects with MIDI tracks on page 222.


Saving projects 

An ACID project file (.acd) is the default file format for saving a new project and should be used for saving unfinished projects. There are 
two ACID project file types. 

Format Extension Description 
ACID Project File .acd Contains all information regarding the project including track layout, envelope settings, and effects 

parameters. However, this type of file does not contain actual audio, only references to the audio files. 
ACID Project with .acd-zip Contains all information regarding the project including track layout, envelope settings, and effects 
Embedded Media parameters. In addition, all audio files used in the project are embedded into the project file. 

If you save a project in .acd-zip format, the project file and all media files are copied to a temporary files folder. 
If you continue to work on your project after saving the .acd-zip file, your changes are saved to the files in this 
temporary folder. 

You can customize the location of the temporary files folder. For more information, see From the Options 
menu, choose Preferences to display the Preferences dialog. on page 253. 

1.	 To save a file, display the Save As dialog using any of the following options: 

• 	Click the  Save button ( ) on the toolbar. 

• 	From the  Edit menu, choose Save. 

•	 Press Ctrl+S. 

2.	 From the Save in drop-down list, choose the drive and directory where the file will be saved. 

3.	 Enter a name for the project in the File name box. 

4.	 From the Save as type drop-down list, choose the desired ACID project file type. 

5.	 If you want to save a copy of each of the project’s media files to the same location as your project file, select the Copy all media 
with project check box. This is available when saving as an ACID project file. 
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6.	 Click Save. The project is saved. 

Tip: Once the project is saved, you can use the Save As command from the File menu to create a copy of the project with a new name or 
save to a different ACID project file format. 

Rendering projects 

Rendering refers to the process of converting the ACID project into a 
file that is formatted for a specific playback method. Possible playback 
methods include media player applications, Internet streaming 
media, CD-ROM, and CD audio. When an ACID project is rendered, it is 
not overwritten, deleted, or altered and you are able to return to the 
original project to make changes and re-render. 

1.	 From the File menu, choose Render As. The Render As dialog 
appears. 

2.	 From the Save in drop-down list, choose the drive and folder 
where the file will be saved. 

3.	 Enter a new name for the project in the File name box. 

4.	 From the Save as type drop-down list, choose the desired file 
format. 

5.	 If the selected file type supports it, you can choose an encoding 
template from the Template drop-down list, or click Custom to 
create a new template. For more information, see Creating custom 
rendering settings on page 49. 

6.	 Select or clear the following check boxes as needed: 

•	 Select the Save project as path reference in rendered 
media check box if you want to save the project path 
information with the rendered file to easily return to your source project if you use your rendered file in another project. 

Note: If you modify the project file after rendering, the project data will no longer match the rendered file. To edit a project using a 

path reference, the project file and all media must be available on your computer.


•	 Select the Render loop region only check box if you want to save only the portion of the project that is contained within the 
loop region. The loop region does not need to be active for this option to work. 

•	 If the selected file type supports it, you can select the Save project markers with media file check box to include markers and 
regions in the rendered media file. 

•	 If the selected file type supports it, you can select the Save sections as regions with a media file check box to include sections 
in the rendered media file. If the information cannot be saved to your media file, an .sfl file will be created (using the same 
base name as your media file). 

•	 Select the Save each track as a separate file check box to save each track in your project to a separate file. All of the volume 
adjustments, panning, FX, and events are saved with the track. You can also use this feature to create tracks that you can use in 
multitrack recording software or Macromedia® Flash®. 

•	 If your project contains video, you can select the Stretch video to fill output frame (do not letterbox) check box to have your 
video reformatted so that it fills the output frame size listed in the Description box. When the check box is cleared, the current 
aspect ratio is maintained and black borders are added to fill the extra frame area (called letterboxing). 

•	 If your project contains video and you see unacceptable artifacts in the rendered video, you can clear the Fast video resizing 
check box. Turning off this option can correct the artifacts, but your rendering time will increase significantly. 

7.	 Click Save. A progress dialog appears. 
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8. When rendering is complete, you can choose one of the following options: 

•  Click  Open to start the associated media player and play the newly rendered file. 

•  Click  Open Folder to open Windows Explorer and display the location of the newly rendered file. 

•  Click  Close to close the progress dialog and return to the ACID window. 

Note: MIDI tracks must be routed to DLS or VSTi soft synths to be included in the rendered output. For more information, see 
Routing tracks to MIDI devices or soft synths on page 222. 

Supported formats for rendering 

The following table briefly describes the file formats available for rendering a project. 

Format Extension Description 
ATRAC .aa3 A Sony proprietary audio compression technology. 
AIFF File .aif The standard audio file format for audio used on Macintosh 

computers. 
Dolby Digital AC-3 Pro/ .ac3 A Dolby Laboratories proprietary audio compression format. 
Dolby Digital AC-3 
Studio 
FLAC audio .flac A nonproprietary, lossless audio compression format. 
MPEG-1 and MPEG-2 .mpg	 MPEG files are a format used when burning audio and video to a 

Video CD, Super Video CD, or DVD. MPEG-1 and MPEG-2 file 
creation is supported through the use of the MainConcept 
MPEG plug-in. 

Note: This format requires a separate purchase of the 

MainConcept MPEG plug-in. 

MPEG-1 Layer 3 .mp3	 A highly compressed format used for portable digital players 
and Internet sharing of media. 20 free MP3 encodes are 
provided. After you have used the free encodes, you must 
register the plug-in to continue rendering MP3s. 

Ogg Vorbis .ogg A patent-free audio encoding and streaming technology. 
QuickTime .mov QuickTime® for Microsoft Windows. 
RealMedia .rm The RealNetworks® standard for streaming media via the Web. 

This option renders both audio and video into one file. 
Perfect Clarity Audio .pca A Sony proprietary lossless audio compression format. 
Wave64 .w64	 A Sony proprietary wave format that does not have a restricted 

file size (unlike Windows standard WAV format which is limited 
to ~2GB). 

Video for Windows .avi The standard video file format used on Windows-based 
computers. 

Wave .wav The standard audio file format used on Windows-based 
computers. 

Windows Media Audio .wma The Microsoft® audio format used to create files for streaming or 
downloading via the Web. 

Windows Media Video .wmv The Microsoft audio and video format used to create files for 
streaming or downloading via the Web. 

Note: Some plug-ins, such as MP3, may require registration. 
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Creating custom rendering settings 

The Custom Settings dialog appears when you click Custom in the Save As dialog. You can use the Custom Settings dialog to create 
custom encoding templates for many of the file formats available in the software. 

1.	 From the File menu, choose Render As. The Render As dialog appears. 

2.	 Choose your preferred file format from the Save as type drop-down list. If the format allows you to create custom settings, the 
Custom button becomes active. 

3.	 Click Custom. The Custom Template dialog appears. 

4.	 Make the appropriate setting changes for the chosen file format. For information about specific controls in each file type’s Custom 
Template dialog, click the Help button . 

Tip: To save the custom settings for future use, enter a name for the template in the Template box and click the Save Template button 

( ).  

5.	 Click OK. The Custom Template dialog closes. 

Copying rendering templates between computers or user accounts 

You can make your customized rendering templates available on another computer or user account by copying .sft2 files to the 
appropriate location in the new account or computer. 

Rendering templates are stored in the following folders: 

•	 C:\Documents and Settings\<username>\Application Data\Sony\Render Templates ACID 7.0\<plug-in name>\ in 
Windows XP. 

•	 C:\Users\<username>\AppData\Roaming\Sony\Render Templates ACID 7.0\ in Windows Vista. 

Notes: 

•	 The Application Data folder is not visible unless the Show hidden files and folders radio button is selected on the View tab of the 
Windows Folder Options control panel. 

•	 You can find a plug-in’s name by clicking the About button in the Render As dialog. 

To make a template available on another computer or user account, copy the .sft file to the same location in another account. 

For example, to make JSmith’s custom wave template available for the AJones user account, copy the appropriate .sft2 file from this 
folder: 

•	 C:\Documents and Settings\JSmith\Application Data\Sony\Render Templates ACID 7.0\wave 

to this folder: 

•	 C:\Documents and Settings\AJones\Application Data\Sony\Render Templates ACID 7.0\wave. 

Note: If you’re copying templates from an older Sony Creative Software application, templates are saved as .sft files in the following 
folder: C:\Documents and Settings\<username>\Application Data\Sony\File Templates\<plug-in name>\<plug-in 
GUID>. 
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Rendering in real time 

Real-time rendering is a playback mode that renders your project to .wav (or .w64) format. Real-time rendering allows you to include the 
output from an external input source such as a hardware synth or effects processor with your project. For more information, see Using 

input busses with hardware-based effects on page 172 or Using input busses with hardware-based synthesizers on page 174. 

Notes: 

•	 When you start real-time rendering, any track that is armed for recording will be unarmed. You cannot arm a track for recording or start 
recording in real-time rendering mode. For more information, see Arming the track for recording on page 180. 

•	 When rendering a project that does not use external audio hardware, real-time rendering and normal rendering will produce the same 
output. Real-time rendering will take longer to complete, allowing you to monitor the rendered file as it is created. 

•	 If metronome count in is enabled, it will be turned off before real-time rendering begins. If the metronome is enabled for playback, it will 
not be included in the rendered output. For more information, see Using the metronome to count off for playback or recording on page 
181. 

1.	 From the File menu, choose Real-Time Render. 

2.	 Choose a drive and folder from the Save in drop-down list, or use the browse window to locate the folder where you want to save 
your file. 

Important: When using real-time rendering, render your project to a local hard drive. Rendering to a network folder or removable drive 
can result in gapping. 

3.	 Type a name in the File name box, or select a file in the browse window to replace an existing file. 

4.	 Click Save to start rendering your project from the beginning of the timeline. 

Publishing to the Internet 

When your project is finished, you have the option of publishing it to the Internet. The most common place to publish your project is 
ACIDplanet.com, a virtual community of ACID users. ACIDplanet.com allows you to do the following: 

•	 Share your music. 

•	 Listen to projects built by other ACID enthusiasts. 

•	 Download free loops. 

•	 Enter remix contests co-sponsored by Sony and major record labels. 

Publishing your project to the Internet involves two distinct procedures: creating a personal account and uploading the project. 

Creating a personal account 

You can create accounts at Web sites where you can publish your song files. Each Web site that offers publishing directly through ACID 
software will guide you through its own account creation process. If you haven’t created an account and you attempt to publish a song, 
you will be directed to complete the Publish Setup utility. 

1.	 From the File menu, choose Publish. The Publish Setup dialog displays. 

2.	 Follow the on-screen instructions to create an account. 

At any time, you can go back and create another account at a different Web site. The Web site you are currently logged into in the 
Publish Setup utility is where your song is published when you choose Publish from the File menu. 

Uploading a project 

Publishing a project file copies your media to the Web so you can share it with other Web users. The following procedure assumes you 
already have an account set up with a publish provider. If not, you will first be redirected to set up an account. After successfully creating 
an account, you will be directed back to the Publish feature. 

1.	 From the File menu, choose Publish. The Publish Setup dialog displays. 

2.	 Log into your publishing account, or follow the on-screen instructions to create one. 
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3.	 Select the appropriate radio button to specify whether the song to be published is the current ACID song or a different song. 

•	 To publish your current ACID song, choose a streaming format and bit rate. 

•	 To publish a different song, enter the path to the song or click Browse to locate the file. This song must already be in a 
streaming format. 

4.	 Click Next. If you are publishing the current ACID song, it is rendered in the format and bit rate you specified. A window appears 
from the publish provider with directions for completing the publishing process. 

5.	 Follow the instructions provided by the publish provider. The file begins uploading to the provider. A progress dialog informs you 
when the upload is finished. 

6.	 Click OK. The publish provider provides a link to the song on their Web site; however, this may vary depending on provider. 

Writing to CD 

You can burn your projects to CD using supported CD-R/CD-RW drives. You can burn CDs for multiple- or single-track projects and build 
audio CD layouts automatically or manually. You can also create video CDs that can be played in many home DVD players and on 
computers with a CD-ROM drive and VCD player software, and multimedia CDs that can be played in any computer with the 
appropriate player. 

Understanding track-at-once and disc-at-once 

ACID provides two ways to record audio to a CD-R disc: track-at-once and disc-at-once. 

Track-at-once 

Track-at-once writing records individual tracks to the disc and results in a partially recorded disc. However, the CD-R disc remains 
unplayable on most systems until you close the disc. The advantage of track-at-once writing is that you can record tracks onto the disc 
as you finish them versus waiting until you have finished your whole album. Track-at-once writing burns the entire project as a single 
track. 

Disc-at-once (Single Session or Red Book) 

Disc-at-once writing is the most common burning method in the music industry. This writing mode is used when creating a master disc 
to be sent to a disc manufacturer for mass replication. Disc-at-once works just as it sounds. Multiple tracks of audio are written to the CD 
in one recording session. 

Burning single tracks (track-at-once) 

Note: The entire project length is written to a CD track. If your project has events on muted tracks that extend beyond the end of the 
audible material, the muted events burn as silence at the end of your CD track. To burn just a portion of a project, create a loop region and 
select the Burn loop region only check box. 

1.	 Insert a blank CD in a supported CD-R/CD-RW drive. 

2.	 From the Tools menu, choose Burn Track-at-Once Audio CD. 

Notice that the Burn Track-at-Once Audio CD dialog indicates the amount of time that the current project will fill on the CD as well 
as the total amount of time remaining on the CD. If the Time needed for audio value exceeds the Time available on disc value, you 
are not allowed to write the track to the CD. 

Note: If there is no CD in the CD-R/CD-RW drive, only the Cancel button is available in this dialog. 
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3.	 Choose a setting from the Action drop-down list: 

• 	Choose  Burn audio to begin recording audio to your CD when you click Start. You must close the disc before it can be played 
in an audio CD player. 

• 	Choose  Test, then burn audio to test whether your files can be written to the CD without encountering buffer underruns. 
Recording begins after the test if it is successful. 

• 	Choose  Test only to test whether your files can be written to the CD without encountering buffer underruns. No audio is 
recorded to the CD. 

• 	Choose  Close disc to close your disc without adding any audio when you click Start. Closing a disc allows your files to be 
played on an audio CD player. You cannot add tracks to a CD once it has been closed. 

• 	Choose  Erase RW disc to erase a rewritable CD when you click Start. 

4.	 Select your burning options: 

•	 Select the Buffer underrun protection check box if your CD recorder supports buffer underrun protection. Buffer underrun 
protection allows a CD recorder to stop and resume burning. 

Buffer underrun protection can create a disc that can be played in CD players but may contain a bit error where burning 
stopped and restarted. Consider clearing this check box when creating a premaster disc. 

•	 Select the Erase RW disc before burning check box to erase a rewritable CD before you begin burning. 

•	 Select the Close disc when done burning check box to close the CD after burning. Closing a disc allows your files to be played 
on an audio CD player. You cannot add tracks to a CD once it has been closed. 

•	 Select the Eject disc when done check box to eject the CD automatically when burning is complete. 

•	 Select the Burn selection only check box to burn only the selected region. Clear the check box to burn the entire project. 

•	 Select the Render temporary image before burning check box if you want to render your CD project to a temporary file 
before recording. Prerendering can prevent buffer underruns if you have a complex project that cannot be rendered and 
burned in real time. 

Note: The rendered temporary file will remain until you modify your project or exit. If an image file exists when you Open the Burn 
Disc-at-Once Audio CD dialog, the check box is displayed as Use existing rendered temporary image. 

5.	 From the Drive drop-down list, choose the drive for burning CDs. 

6.	 From the Speed drop-down list, choose the speed at which you want to burn. Choosing Max uses your drive’s fastest possible 
speed; decrease the setting if you have difficulty burning because of buffer underruns. 

7.	 Click Start. 

Important: Once the CD writing begins, cancelling the write operation renders the CD unusable. 
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Disc-at-once (DAO) CD burning 

The DAO burning process involves arranging your media on the timeline, adding pauses between tracks as necessary, inserting track 
markers, and burning your CD. 

Adding pauses 

Each CD track in your project should have a two-second pause following it. This default setting is based on the Red Book specification 
for audio CDs. The exception to this standard is a continuous recording, such as a live concert CD. For a continuous recording, you can 
omit the pauses after tracks for continuous playback. You can manually insert silence between your audio files to create a pause. 

Note: The Red Book specification also requires a two-second pause at the beginning of an audio CD. This pause is automatically added 
when you burn your CD. 

1.	 Position your audio files on the timeline in the order in which you want them to play on your CD. 

2.	 Position the cursor where you want to insert the pause between files. 

3.	 From the Insert menu, choose Time. The Insert Time dialog appears. 

4.	 Enter two seconds in the Amount of time to insert box. 

5.	 Click OK. Two seconds are inserted in the timeline at the cursor position. 

Inserting CD track markers 

You can use CD track markers in your project to indicate to the CD-R device where to mark the beginning and ending of a track during 
the writing process. A Red Book CD can contain up to 99 tracks. 

1.	 Position your audio files and add pauses between them as necessary. For more information, see Adding pauses on page 53. 

2.	 Position the cursor at the start of an audio file. 

3.	 From the Insert menu, choose CD Track Marker. The marker appears in the marker bar and is automatically numbered. 

Important: You must place your first CD track marker at the beginning of your project. Audio placed before the first marker will 
not be burned to CD. 

Tip: Once you have inserted a marker, you can move or delete them as needed. 

4.	 Repeat step 3 until you have marked all CD tracks. 

Burning a disc (disc-at-once) 

1.	 Insert a blank CD in a supported CD-R/CD-RW drive. 

2.	 From the Tools menu, choose Burn Disc-at-Once Audio CD. The Burn Disc-at-Once Audio CD dialog appears. 

3.	 From the Drive drop-down list, use the CD drive that you want to use to burn your CD. 

4.	 From the Speed drop-down list, choose the speed at which you want to burn. Max will use your drive’s fastest possible speed; 
decrease the setting to prevent the possibility of buffer underruns. 

5.	 Select the Buffer underrun protection check box if your CD recorder supports buffer underrun protection. 

Buffer underrun protection allows a CD recorder to stop and resume burning. 

Note: Buffer underrun protection can create a disc that can be played in CD players, but may contain a bit error where burning 
stopped and restarted. Consider clearing this check box when creating a premaster disc. 

6.	 Choose a radio button in the Burn mode box: 

•	 Burn CDs begins recording audio to your CD immediately. 

•	 Test first, then burn CDs performs a test to determine whether your files can be written to the CD recorder without 
encountering buffer underruns. No audio is recorded to the CD during the test, and recording begins after the test if it is 
successful. 

•	 Test only (do not burn CDs) performs a test to determine whether your files can be written to the CD recorder without 
encountering buffer underruns. No audio is recorded to the CD. 
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7.	 Select the Render temporary image before burning check box if you want to render your CD project to a temporary file before 
recording. Prerendering can prevent buffer underruns if you have a complex project that cannot be rendered and burned in real 
time. 

Note: The rendered temporary file will remain until you modify your project or exit. If an image file exists when you Open the Burn 

Disc-at-Once Audio CD dialog, the check box is displayed as Use existing rendered temporary image.


8.	 Select the Automatically erase rewritable discs check box if you’re burning to rewritable media and want to erase the disc before 
burning. 

9.	 Select the Eject when done check box if you want the CD to eject automatically when burning has completed. 

10. Click OK to start burning. 
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Chapter 3 
Editing Events 

In this chapter, you’ll learn about basic event editing techniques such as cutting, copying, pasting, trimming, splitting, 
and joining events. You’ll also learn how to use ripple editing to expand the possibilities of timeline editing. Finally, you’ll 
take a look at advanced editing techniques such as slipping and sliding events, changing event properties, and adding 
event envelopes. 

Note: For the basic event editing topics in this chapter, make sure that ripple editing is turned off. Verify that the Ripple 
Edits command in the Options menu is not selected. For more information, see Ripple editing on page 61. 

Copying events 

Copying an event, a time selection, or event within a time selection places an exact copy of the selected event(s) on the 
clipboard, but leaves the track view unchanged. Events copied to the clipboard can be pasted in the project an unlimited 
number of times. In addition, clipboard content remains on the clipboard until replaced by new content. 

1. Select the event data you want to copy or make a time selection. For more information, see Making selections on page 
38. 

2. Copy the event data using any of the following methods: 

•  Click the  Copy button ( ) on the toolbar. 

• Choose Copy from the Edit menu. 

• Right-click the selection and choose Copy from the shortcut menu. 

• Press Ctrl+C. 

Pasting events 

The clipboard’s contents can be pasted in a project an unlimited number of times. However, an event is always pasted in 
the track it was copied/cut from. In addition, pasting the contents of the clipboard over an existing event results in the 
pasted event overlapping the existing event. To avoid pasting over existing events, you have two options: 

•  Use the  Paste Insert command. For more information, see Using Paste Insert on page 56. 

• Turn on ripple editing. For more information, see Ripple editing on page 61. 

When events are cut/copied to the clipboard and subsequently pasted into a project, the time data inherent in the cut/ 
copied events is maintained and pasted. For example, if you select two events on the same track that are separated by 
five seconds of silence, copying and pasting these events results in the five seconds of silence also being pasted into the 
project. 

Original events Pasted events 

Taking this concept a step further, if you select discontinuous events from several tracks, copying and pasting these 
events results in any selected time data being pasted into the project as well. This maintains the relative position of 
events in the project. 

Original events Pasted events 

Note: You can also paste events across tracks using clips. For more information, see Copying clips and events across 
tracks on page 102. 
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Using the Paste command 

1.	 Place the cursor at the desired position on the timeline. 

2.	 Paste the clipboard contents using any of the following methods: 

• 	Click the  Paste button ( ) on the toolbar. 

• 	Choose  Paste from the Edit menu. 

•	 Right-click the track view and choose Paste from the shortcut menu. 

•	 Press Ctrl+V. 

Using Paste Repeat 

When building projects, you often need to paste the contents of the clipboard several times. Rather than repeatedly pasting and 
moving the content, the Paste Repeat command allows you to specify the number of times and at what interval the clipboard’s 
contents are pasted on the track view. This is a useful way of quickly building a project that uses a repetitive riff or structure. For 
example, you can build the backing tracks for a twelve-bar blues, copy them, and use Paste Repeat to paste several copies of it in the 
project. 

1.	 Click the Time Selection Tool button ( ). 

2.	 Drag the mouse in the track view to create a time selection spanning several events and copy it to the clipboard. 

3.	 Click the Go To End button ( ) on the transport bar or press Ctrl+End to send the cursor to the end of the project. 

4.	 From the Edit menu, choose Paste Repeat or press Ctrl+B. The Paste Repeat dialog appears. 

5.	 Enter a number in the Number of times to paste box. 

6.	 Select the End to end radio button and click OK. The events are pasted end to end the number of times specified in step five, 
starting at the cursor position. 

Using Paste Insert 

To insert the contents of the ACID clipboard at the current cursor position and force existing events to move in time to accommodate 
the pasted events, choose Paste Insert from the Edit menu. 

If the cursor is in the middle of an event, the event splits at the cursor position where the new events are pasted. For more information, 
see Splitting events on page 58. 

Pasting events at the play cursor 

You can also paste the contents of the clipboard at the cursor during playback. You can use this feature to create rhythms on one-shot 
tracks while listening to the track you’re editing in the context of the rest of your project. When you’re done creating events, you can use 
the Render to New Track command (on the Edit menu) to save the rhythm to a new track, or you can copy and paste your new events 
across the timeline. 

1.	 Create a time selection in the portion of the project you want to edit. 

2.	 Select the Loop Playback button ( ). 

3.	 Copy the one-shot you want to use. 

4.	 Click the Play button ( ) to start playback. 

5.	 Press Shift+Y to paste at the play cursor (during playback, the edit cursor remains fixed, and the play cursor follows playback). 

If snapping is enabled, events are pasted at the next snap point. You can use snapping to quantize your events. 

6.	 Repeat step 5 as needed. 

7.	 Click the Stop button ( ) when you’re finished creating events. 

8.	 Edit event positions as necessary. 

Tip: If you're using this feature to tap rhythms with one-shot tracks, try applying a groove to adjust the timing of your rhythm. For 
more information, see Working with grooves on page 123. 
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Cutting events 

Cutting an event, a time selection, or an event within a time selection removes the audio data from the track view and places it on the 
clipboard. Once data is placed on the clipboard, it can be pasted back into the project an unlimited number of times. Clipboard content 
remains on the clipboard until it is replaced by new data. 

1. Select the event data you want to cut or make a time selection. For more information, see Making selections on page 38. 

2. Cut the event data using any of the following methods: 

•  Click the  Cut button ( ) on the toolbar. 

• Choose Cut from the Edit menu. 

• Right-click the selection and choose Cut from the shortcut menu. 

• Press Ctrl+X.


All selected events are removed from the track view and placed on the clipboard.


Deleting events 

Deleting an event, a time selection, or an event within a time selection removes the data from the track view and discards it. Deleted 
events are not placed on the clipboard and do not replace or interfere with current clipboard content. In addition, deleted events 
cannot be pasted back into a project. 

Note: Deleted data can only be replaced in a project using the Undo command. For more information, see Using undo on page 44. 

1. Select the event data you want to delete or make a time selection. For more information, see Making selections on page 38. 

2. Delete the event data using any of the following methods: 

• Choose Delete from the Edit menu. 

• Right-click the selected event and choose Delete from the shortcut menu. 

• Press Delete. 

All selected events are removed from the track view and discarded. 

Tip: To remove the unused media from your project, choose Remove All Unused Clips from the Tools menu. To remove unused clips 

from individual tracks, click the Remove Unused Clips button in the Clip Pool window. For more information, see Using the Clip Pool 
to manage clips on page 104. 

Reversing events 

You can select events in the timeline and reverse their audio and peak data. Select an event in the timeline, right-click, and 
choose Reverse (or press U) from the shortcut menu. An arrow appears on the event in the timeline to indicate that it has 
been reversed. 

Trimming events 

Whereas deleting allows you to select event data to be removed from the project, trimming allows you to select the data that remains. 
Trimming is performed by creating a time selection or selecting an event within a time selection and subsequently deleting all 
unselected data. 

1. Create a time selection or select specific events within a time selection. For more information, see Creating time selections on page 39. 

2. Press Ctrl+T to trim the data within the selection. All unselected event data is removed from the track view and discarded. 
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Splitting events 

Splitting is a quick way to create independently functioning events from a single one. You might consider splitting an event if you want 
to adjust a small part of the track. For example, you may want to apply pitch shift to a guitar track for a few measures and then return the 
track to its original setting. 

Splitting occurs at the cursor position or at the in and out points of a time selection. When you split an event, a new ending point is 
created for the original event and creates a starting point for the newly created event. 

When you split an event, the newly created events abut each other. If Quick fade edges to prevent clicks is selected in the Event 
Properties dialog, fades are added at the split point. For more information, see Changing event properties on page 64. 

Split position Two events 

However, you may move either of the events, which creates a gap. 

Split position Two events 

Splitting at the cursor position splits all selected events that the cursor crosses on all tracks. 

1. Select the event(s) that you want to split. 

2. Place the cursor where you want the split to occur or make a time selection. 

3. From the Edit menu, choose Split or press S. The result of the split depends on how events were selected. 

Splitting at the cursor position 

Splitting at the cursor position splits all events that the cursor crosses on all tracks. 

Events before splitting Events after splitting 

Cursor position After the split, the three events become 
and split point six events 
58 | CHAPTER 3 



Splitting one event 

Selecting a single event prior to splitting prevents other events from being split at the cursor’s position. 

Events before splitting Events after splitting 

Cursor position 

and split point 

Event to Only the selected 
be split event splits at the 

cursor position 

Splitting multiple events 

Selecting multiple events splits only the selected events at the cursor’s position. Be sure to set your cursor position before selecting 
events. Attempting to set your cursor after selecting events causes you to lose your event selection. 

Events before splitting Events after splitting 

Cursor position 

and split point 

Events to 
be split 

Only the selected 
events split at the 
cursor position 

Splitting a time selection 

Making a time selection allows you to split events at the time selection’s in and out points across all tracks. 

Events before splitting Events after splitting 

Loop bar 

Out pointIn point 

Loop bar 

Split point Split point 
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Splitting events within a time selection 

When selecting events within a time selection, only the selected events in the time range split at the in and out points. 

Events before splitting Events after splitting 

In point Out point 

Selection bar 

Event to split at the 
time selection’s in 
and out points 

Split point Split point 

Selection bar 

Only the selected 
event splits at the in 
and out points 

Joining events 

You may join events on ACID tracks that have been segmented along the timeline. Joining events is an efficient way to redraw an event 
and remove any splits or silent regions between events. 

You would want to join events if you decided that the event should play uninterrupted over the specified time range. 

1.	 Select the events or range of events that you want to join. For more information, see Selecting multiple events on page 38. 

2.	 From the Edit menu, choose Join or press J. The selected events are joined. 

Select all the events that you want to join. 

You can also select the first and last events you 
want to join, creating an event selection range. 

After you join the events, a single event appears. 

Joining events is similar to dragging the edge 
of an existing event 

Automatic crossfades 

From the Options menu, choose Automatic Crossfades if you want to automatically create crossfades when you overlap two audio 
events. 

Note: Event crossfades are not available for MIDI events. 

Creating crossfades 

You can easily create crossfades between events by simply dragging an event. 

1.	 From the Options menu, choose Automatic Crossfades to turn on automatic crossfades. 

2.	 Drag and event so that it overlaps another event on the same track. 

A crossfade is automatically added to transition smoothly between the two events. 
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Changing fade types 

You can change a crossfade to use one of many combinations of fast, slow, linear, smooth, and sharp fade curves. 

1.	 Right-click the overlapping area to display a shortcut menu. 

2.	 Choose Fade Out Type from the shortcut menu and choose a fade curve from the submenu to set the curve for the first event’s 
fade out. 

3.	 Choose Fade In Type from the shortcut menu and choose a fade curve from the submenu to set the curve for the first event’s fade 
in. 

Ripple editing 

ACID includes a ripple editing feature. This feature allows you to cut, delete, and paste events or portions of events within a time 
selection and simultaneously adjust the position of all later events on a selected track. The existing events’ timeline position adjusts by 
the total amount of the time selection that is being cut, deleted or pasted from the clipboard. 

You may turn on ripple editing mode by choosing Ripple Edits from the Options menu or pressing Ctrl+L. 

Note: Ripple edit mode is not available unless you're using the Time Selection tool ( ). 

Cutting events in ripple editing mode 

Cutting events or portions of events removes them and their time information from their respective tracks. This information is placed on 
the clipboard, from which you may paste the information back into your project. 

1.	 From the Options menu, choose Ripple Edits to enter ripple editing mode. 

2.	 Click the Time Selection Tool button ( ). 

3.	 Select the events you want to cut. If you want all events within a time selection to be cut, do not select any events and continue to 
step 4. 

To cut multiple events, use the Ctrl key, the Shift key, or the Selection ( ) tool to select the events. For more information, see 
Selecting multiple events on page 38. 

4.	 Drag along the marker bar to make a time selection. All events, and/or portions of events within the region are highlighted. 

5.	 Click the Cut button ( ) on the toolbar to cut the event(s) to the clipboard. 

The cut events and their time information are removed from the selected track(s) and placed on the clipboard. Existing events in 
the selected track(s) move forward to occupy the space created by the cut. 

Cutting time selections in ripple editing mode 

Events within the time selection are reproduced and placed on the clipboard. Also, the time information is placed on the clipboard. 
Existing events occurring after the time selection move forward in the project by the length of the time selection. 

Events before cut Clipboard contents Events after cut 
Existing events 
adjust to occur 
sooner in the project 
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Cutting time and event selections in ripple editing mode 

Events and portions of events within the time selection are reproduced and placed on the clipboard. Also, the time information is 
placed on the clipboard. Existing events occurring later than the time selection move forward by the length of the time selection. Only 
tracks containing selected events are affected by the ripple edit. 

Events before cut Clipboard contents Events after cut 

Existing events on the top 
track adjust to occur 
sooner in the project 

Deleting events in ripple editing mode 

Deleting events or portions of events removes them and their time information from their respective tracks. However, this information 
is not placed on the clipboard. Existing events move forward when you delete material from a selected track. 

1.	 From the Options menu, choose Ripple Edits to enter ripple editing mode. 

2.	 Click the Time Selection Tool button ( ). 

3.	 Select the events you want to delete. If you want all events within a time selection to be deleted, do not select any events and 
continue to step 4. 

To delete multiple events, use the Ctrl key, the Shift key, or the Selection ( ) tool to select the events. For more information, see 
Selecting multiple events on page 38. 

4.	 Drag along the marker bar to make a time selection. All events, and/or portions of events within the region are highlighted. 

5.	 Press Delete to delete the event(s). 

Deleting time selections in ripple editing mode 

Events within the time selection and their time information are removed from the project. Existing events occurring after the time 
selection move forward in the project by the length of the time selection. When information is deleted, it is not placed on the clipboard. 

Events before delete Clipboard contents Events after delete 

Existing events 
adjust to occur 
sooner in the 
project 

Deleting time and event selections in ripple editing mode 

Events within the time selection and their time information are removed from the project. Existing events occurring after the time 
selection move forward in the project by the length of the time selection. When information is deleted, it is not placed on the clipboard. 

Events before delete Clipboard contents Events after delete 

Existing events on the top 
track adjust to occur 
sooner in the project 
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Pasting events in ripple editing mode 

Once information is copied to the clipboard, you may choose a variety of ways to paste the clipboard items into tracks. For more 
information, see Pasting events on page 55. The following procedures explain pasting information in ripple editing mode. 

Note: Events are always pasted into their own tracks at the cursor position. 

1. From the Options menu, choose Ripple Edits to enter ripple editing mode. 

2. Move the cursor to the desired timeline location. 

3. Place the cursor within the track where you want to paste the event. 

4. Click the Paste button ( ) on the toolbar to paste the event into the track. 

Clipboard information is pasted at the cursor’s position on the track. Existing events or portions of events after the cursor adjust to occur 
later in the project. The amount of adjustment is based on the total length of the information being pasted. 

Pasting single track information in ripple editing mode 

The information on the clipboard determines how many tracks are affected when you paste. If you have copied or cut information from 
one track, only the selected track is affected by the pasted event and time information. 

Clipboard contents Events before paste Events after paste 

Paste Newly pasted 

Existing event adjusts 
to move later in the 
project. 

position event 

Pasting multitrack information in ripple editing mode 

Multiple events can be pasted as easily as single events.  

Clipboard contents Events before paste Events after paste 

These events will 
be pasted 

Paste 
position 

Existing events on the tracks adjust later in 
the project 

Newly pasted event 

Note: Pasting in ripple editing mode ripples only the events on the tracks that receive the clipboard contents. If you want to ripple all 
tracks at the paste position, use the Paste Insert command from the Edit menu. 

Slipping and sliding events 

To help you picture what happens when you slip and slide events, think of an event as a window to a media file. The window can display 
the entire media file or a small section. When the window displays only a portion of the media file, you can move either the window or 
the underlying media to adjust the media played by an event: 

• When you slip an event, your event maintains its place on the timeline, but the media file moves in the direction you drag. 

• When you slide an event, the media file maintains its place on the timeline, but the event moves in the direction you drag. 
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Original loop event 

Slipping the event two measures to the right 

Slip-trimming the event two measures to the right 

Sliding the event two measures to the right 

Shifting the contents of (slipping) events 

Hold Alt while dragging an event. The slip cursor appears ( ). 

As you drag the event, the contents of the event shift, but the event does not move. You can use this technique when you want to 

maintain an event’s length and position but want the to event play a different section of the source media file.


For creative ways to use event slipping, see Duplicating with offset on page 298.


Slip-trimming events 

Hold Alt while dragging the right or left edge of an event. The slip-trim cursor appears ( ). 

As you drag the event edge, the media moves with the event edge. 

Sliding events 

Hold Ctrl+Alt while dragging an event. The slide cursor appears ( 

As you drag, the relative position of the media remains fixed on the track, and the event position changes. You can use this technique 
when you want to maintain an event’s length but want the event to play a different section of the source media file at a different point 
in your project. 

Changing event properties


To access event properties, right-click the event and choose Properties from the shortcut menu.


These properties are saved in the project but are not saved into the file when you save changes to a clip in the Clip Properties window. 

For more information, see Saving file properties on page 123.


The following table describes each of the settings in the Event Properties dialog.


). 

Item Description 

Start offset The Start offset for an event specifies a playback starting position that is different than the beginning of the file. This is 
especially useful for loops; you can change the feel of a loop by simply starting on beat two rather than beat one. 

Pitch shift The Pitch shift value specifies a pitch shift for the selected event. Event-based pitch shift is calculated after the project key 
and any pitch shift assigned to a track. For more information, see Changing tempo, time signature, and key on page 90. 
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Item Description 

Quick fade edges to 
prevent clicks 

When you add an offset to an event so that it does not end on a loop point, you can introduce an audible click at the edges 
of the event. Select the Quick fade edges to prevent clicks check box, and a quick fade-in or fade-out is performed on the 
event edges. 

To adjust a quick fade, zoom into the event and hover over the upper-left or upper-right corner of an event until the cursor 
is displayed as . Drag the edge of the fade to adjust its duration. For more information, see Setting an event’s fade-in and 
-out envelope curve on page 66. 

Reverse Select the Reverse check box to reverse the event’s audio and peak data. An arrow appears on the event in the timeline to 
indicate that it has been reversed. 

Muting and locking events


Right-click an event, choose Switches from the shortcut menu, and then choose a command from the submenu to mute or lock the 

selected event.


Hold Ctrl or Shift while clicking to select multiple events.


Muting events 

Muting an event excludes it from playback while preserving its position on the timeline. 

1.	 Select the events you want to mute. 

2.	 Right-click a selected event, choose Switches from the shortcut menu, and then choose Mute from the submenu. 

If you want to unmute an event, choose Mute again. 

Muted events are dimmed on the timeline. 

Muted event 

Locking events 

Locking an event prevents it from being edited on the timeline. 

Notes: 

• Locked events cannot be dragged on the timeline. 
• When adding events to the timeline, you cannot draw or paint past a locked event. 
• Erasing in the timeline will not erase a locked event. 
• Event envelopes cannot be modified for locked events. 
• Ripple edits and automatic crossfades will not be applied to locked events. 

1.	 Select the events you want to lock. 

2.	 Right-click a selected event, choose Switches from the shortcut menu, and then choose Lock from the submenu. 

If you want to unlock an event, choose Lock again. 

Using event envelopes 

You can use envelopes on individual events. Envelopes give you the ability to control each event’s fade-in, fade-out, and overall volume. 
Envelopes are useful for transitional effects between events by subtly fading out one event’s volume while another fades in. 

These envelopes are different than track envelopes because they affect only the event whereas track envelopes can affect multiple 
events on the track. For more information, see Using track automation envelopes on page 112. 

The event’s volume level and fade curves are represented by a line on the event. 
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Setting an event’s volume envelope 

You can control an event’s overall volume by setting an envelope at the desired decibel (dB) level. 

1. Place the mouse pointer at the top of the event. The envelope cursor ( ) appears. 

2. Drag the volume line to the desired level. As you drag the volume line, the event’s decibel level is displayed. 

3. Release the mouse to set the event’s dB level.


After you set the event volume level, you may change it later by dragging the envelope line.


Setting an event’s fade-in and -out envelope curve 

You can control an event’s envelope fade-in and -out characteristics by adjusting the event’s envelope handles. These handles allow 
you to control the length and dB level of fade-ins and fade-outs. Also, you can change the type of curve that the event uses to control 
the volume’s fade characteristics. 

1. Place the mouse pointer on the upper corner of the event. The envelope cursor ( ) appears. 

2. Drag the envelope cursor and position the envelope curve. As you drag the cursor, the following information is displayed: 

• The event decibel level. 

• The length (in measures.beats.ticks) of the fade-in or fade-out. 

3. Release the mouse to set the fade-in or fade-out characteristics. 

Changing the event’s fade curve type 

You can set an event’s fade curves (fast, linear, slow, smooth, or sharp) that are used to raise or lower the volume over time. Right-click 
the fade region, select Fade In Type or Fade Out Type from the shortcut menu, and choose the appropriate fade curve from the 
submenu. 

Using sections 

With sections, you can create different arrangements using simple drag-and-drop operations. 

Each section header above the timeline represents a segment of your project. When you drag a section header to a new location of the 
timeline, all events, envelopes, regions, markers, and commands within the section follow. 
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Inserting a section 

1.	 Create a time selection that includes the portion of the timeline that you want to use as a section. 

2.	 From the Insert menu, choose Section (or press Shift+S). A section label is added above the marker bar. 

3.	 Type a name to identify the section and press Enter. 

Adjusting a section's length 

1.	 Hover over the end of a section label. The mouse pointer is displayed as a 

2.	 Drag the end of the section:  to extend or shorten it. 

. 

Tips: 

• Hold Shift to override snapping. 
• As you drag the edge between two adjacent sections, both will be adjusted simultaneously. 

Renaming a section 

1.	 Right-click the section label and choose Rename from the shortcut menu. The section label changes to an edit box. 

Tip: Press F2 to rename the selected section. 

2.	 Type a new name in the edit box. 

3.	 Press Enter. 

Changing a section’s color 

1.	 Right-click the section label and choose Color from the shortcut menu. 

2.	 Choose a color from the menu. The color of the section header is updated, but event colors do not change. 

Moving (shuffling) sections 

Shuffling sections allows you to move all events, envelopes, regions, commands, and markers within a section in a single operation. For 
more information, see Ripple editing on page 61. 

1.	 Drag a section label to a new position on the timeline. A is displayed to indicate where the section will be moved. 

2.	 When you drop the section, events are split at each end of the section, and all events within the section are moved to the position 
where you dropped the section. Downstream events ripple to make room for (or fill the space of ) the section you dragged. 

Notes: 

•	 Hold Ctrl or Shift to select and shuffle multiple selections 
•	 When shuffling envelope points, the shape of the envelope is copied to the new location and additional points are created at each end of 

the section if necessary. 
•	 The tempo, time signature, and key of the section will be preserved during shuffling, and tempo, time signature, and key markers will be 

created if necessary. 
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Copying a section 

Copying sections lets you copy all events within a section in a single operation. For more information, see Ripple editing on page 61. 

1. Hold Ctrl and drag a section header, or multiple section headers, to a new position on the timeline. A  is displayed to indicate 
where the section will be copied. 

2. When you drop the section, it is copied to the position where you dropped it. 

Note: Hold Ctrl or Shift to select and copy multiple selections. 

Deleting a section 

Deleting a section removes the section and all events are removed from the timeline. 

Right-click a section label and choose Delete from the shortcut menu. Events are split at each end of the section, and all events, 
envelope points, regions, commands, and markers within the section are deleted. Downstream events ripple to fill the space of the 
section you deleted. For more information, see Splitting events on page 58. 

Moving a section label 

Hold Alt while dragging a section label to move the selected labels without affecting the contents of the timeline.


Hold Ctrl+Alt while dragging a section label to create copies of the selected labels without affecting the contents of the timeline.


Removing a section label 

Removing a section label removes the section label from the timeline without affecting the section's events. 

Right-click a section label and choose Remove Label from the shortcut menu. 

Clearing all events from a section 

Clearing events removes the events from a section while leaving the section label intact. 

Right-click a section label and choose Clear Events from the shortcut menu. Events are split at each end of the section, and all events 
within the section are deleted. For more information, see Splitting events on page 58. 
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Chapter 4 
Using the Media Manager 

This chapter covers the management and tagging of your media files in ACID using the Media Manager feature. 

Creating a new media library 

You can create multiple media libraries as necessary to organize your media. Each media library is maintained by the 
Media Manager software as a separate database that stores information about the media contained within it. 

1. From the Media Manager window, click the Media Library actions button ( ) and choose New Media Library 
from the menu. The New Media Library dialog is displayed. 

2.	 In the Name box, type the name you want to use to identify the library. 

3.	 The Folder box displays the path to the folder where the library will be created. Click Browse to choose a different 
location. 

4.	 Click the Create button to create the new library. 

Opening a media library 

The Media Manager window displays the contents of the current media library. You can open a different library at any 
time. 

Important: When you open a media library, the Media Manager tool creates a transaction log file. This file is created in 
the same folder as the .medialib file and uses the same base name as the .medialib file. For example, the transaction log 
file for default.medialib would be default_log.ldf. 

Do not delete these log files. Doing so will prevent you from opening the associated library. When the Media Manager tool 
closes, it automatically removes the log file. If the application terminates inappropriately, close all running ACID windows, 
restart ACID, and close the application to clear the log file. 

1. In the Media Manager window, click the Media Library Actions button ( ) and choose Open Media Library from 
the menu. The Open Media Library dialog is displayed. 

2.	 Choose the folder where the library you want to open is stored: 

• Choose a drive and folder from the Look in drop-down list.


—or—


•	 Use the bar on the left side of the window to browse to a folder. 

3.	 Select a library from the list. 

4.	 Click the Open button to open the selected library. The name of the current library is displayed in the upper-right 
corner of the Search Results pane: 
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Adding media files to a library 

Before you can search or organize your media files, you’ll need to add them to a media library. 

When the Sony Sound Series Loops & Samples™ reference library is installed and set as the active reference library in the Media Manager 
Options dialog, tags and custom properties from the reference library will be applied to media from existing Sony Sound Series Loops & 
Samples or Loops for ACID collections when you add media to your library. For more information on Media Manager options, see Setting 
Media Manager options on page 81. 

Note: The Sony Sound Series Loops & Samples reference library is not installed by default, but you can install it from the ACID CD or 
download it from the Sony Creative Software Inc. Web site (http://www.sonycreativesoftware.com/reference). After installing the library, 
go to the Media Manager Options dialog and choose the reference library from the Reference library drop-down list. 

Tip: If the Save media-usage relationships in active media library check box is selected on the General tab of the ACID Preferences dialog, 
you can add individual files to a library by previewing the files in the ACID Explorer window. 

1.	 Click the Add Files to Media Library button ( ). The Add Files to Media Library dialog is displayed. 

2.	 Choose the folders that will be searched for media: 

a.	 If it isn’t displayed automatically, click the Add Folder button ( ) to display the Browse for Folder dialog. 

b.	 Select the folder you want to search. 

c.	 Click OK. 

Tips: If you want to change an item in the folder list, select it and click the Browse button ( ) in the Folders column. If you want to


remove a folder from the list, select it and click the Remove Folder button (
 ). 

3.	 Repeat step 2 for each folder you want to search. 

4.	 Select the Include subfolders check box if you want to search folders within the selected folders. 

5.	 Select the Audio, Video, Images, or MIDI check boxes to indicate the types of media you want to add. Clear a check box to exclude 
that type of media file. 

Files that contain audio and video streams will be added if either or both of the Audio or Video check boxes are selected. 

6.	 Specify whether you want to search for new files or all files: 

•	 Select the New files only radio button if you want to search only for new media files. Files that already exist in the media 
library will be skipped.


—or—


•	 Select the All files radio button if you want to search for all media files in the specified folder. New media files will be added, 
and files that already exist in the media library will be searched to determine whether their properties have changed. 

7.	 Select the Add tags and custom properties from files check box if you want to add tags and custom columns saved in the media 
files to your library. For more information about tagging media, please see Tagging media files on page 71. For information about 
adding custom columns to the Search Results pane, see Adding custom columns on page 80. 

8.	 Select the Use file and folder names to apply tags automatically check box if you want to automatically tag files based on the file 
path. 

For example, when this check box is selected, a loop saved in the d:\loops\drums\hi-hats\ folder would have the tags Drums and 
Hi-Hats applied when it is added to the library. Some synonyms (and variant spellings) will be resolved automatically. If you need to 
modify the pattern-matching, you can edit the AutoTagPatterns.xml file, which is created in your My Documents\Sony Media 
Libraries folder the first time the application starts. 

Note: Changing the selection of the Add tags and custom properties from files and Use file and folder names to apply tags 

automatically check boxes also changes the settings in the Media Manager Options dialog.
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9.	 Click the Search button to start adding files to the library. 

10. Click the Close button when you’re finished. 

A tag is automatically added to the tag tree when you search. The tag name will include the date and time of the search, and all files 
that were added or updated in the library are marked with this tag. 

Removing media files from a library 

You can remove a reference to a media file from a library without affecting the media file itself. 

1.	 Select files in the Search Results pane to choose the files you want to delete: 

• To select a single file, click the file.


—or—


• To select multiple consecutive files, click the first file, hold the Shift key, and then click the last item.


—or—


•	 To select multiple files that are not consecutive, hold the Ctrl key and click each file. 

2.	 Right-click a selected file and choose Remove from Library from the shortcut menu (or press the Delete key on your keyboard). A 
confirmation dialog is displayed. 

3.	 Click OK to remove the selected files from the library. 

Tagging media files 

Tagging helps you classify your media files. For example, if you wanted to keep track of loops played by a specific instrument, you could 
create a tag with the name of the instrument and apply it to the appropriate loops. Similarly, you could create tags for genres, moods, 
seasons, client names, locations, scenes, performer names, and so on. 

When you create a new library, a default tag tree is displayed in the Tags pane. You can create your own tags to customize the tags for 
your needs. Tags are the fastest way to search a media library, and they require very little disk space. 

Tags are saved in your media library. If a media file exists in multiple libraries, tagging the media file in one library has no effect on the 
other libraries unless you save the tags to the files and use the Add Files to Media Library dialog to update tags and custom properties 
for all files. 

Tip: If you want to see which tags are associated with a file as you’re adding or removing tags, drag the Tags column in the Search

Results pane to the left so you can see the Name and Tags columns at the same time.


Creating a tag 

Adding tags creates new tags in the current library only. 

1.	 Click the Add Tag button ( ) to add a new tag to the tree. 

If a tag is selected, the new tag will be added below the selected tag. If no tag is selected, the new tag will be added to the bottom 
of the tag tree. 

2.	 Type a name for the tag. 

3.	 Press Enter. 

4.	 If you want to change the icon used to display the tag, right-click it and choose Edit from the shortcut menu to display the Tag 
Editor dialog. 

5.	 If you want to change the tag’s location, drag it to a new location in the tag tree. 
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Applying a tag to a media file 

You tag media by dragging a tag from the tag tree to a media file in the Search Results pane (or by dragging a media file to a tag) when 

the Add Tag Mode button ( ) is selected. 

1. Select media files to tag in the Search Results pane: 

• To select a single file, click the file.


—or—


• To select multiple consecutive files, click the first file, hold the Shift key, and then click the last item.


—or—


• To select multiple files that are not consecutive, hold the Ctrl key and click each file. 

2. Click the Add Tag Mode button ( ) in the Search pane. 

3. Drag a tag from the tag tree to the selected file(s). 

Tip: You can also right-click a selection in the Search Results pane and choose Add Tag from the shortcut menu to add a tag to all 
selected media. The Tag Chooser dialog will be displayed. Select the tag you want to add, and then click the OK button. 

When you add a subtag to a media file, the tag’s hierarchical position in the tag tree is applied 
implicitly. 

In this example, adding the “Snare” tag to a media file would mean that a search for “Audio,” “Drum 
One-Shots,” or “Snare” would find your tagged media. If the user rearranged the tag tree so that the 
“Snare” tag did not appear below the “Audio” and “Drum One-Shots” tags, searching for “Audio” or 
“Drum One-Shots” would not find your tagged media. 

If you add all three tags to your media file, a search for “Audio,” “Drum One-Shots,” or “Snare” would 
find your tagged media even if the tag tree had been rearranged, though this behavior is not always 
desirable. 

Removing a tag from a media file 

You remove tags from media by dragging a tag from the tag list to a media file in the Search Results 

pane (or by dragging a media file to a tag) when the Remove Tag Mode button ( ) is selected. 

1. Select media files in the Search Results pane: 

• To select a single file, click the file.


—or—


• To select multiple consecutive files, click the first file, hold the Shift key, and then click the last item.


—or—


• To select multiple files that are not consecutive, hold the Ctrl key and click each file. 

2. Click the Remove Tag Mode button ( ) in the Search pane. 

3. Drag a tag from the tag tree to the selected file(s). The tag is removed from the file(s). 
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). 

Deleting a tag from a library 

Deleting the selected tag(s) affects the current library only. 

1.	 In the Search pane, select the tag(s) to be removed: 

• To select a single tag, click the tag.


—or—


• To select multiple consecutive tags, click the first tag, hold the Shift key, and then click the last tag.


—or—


•	 To select multiple tags that are not consecutive, hold the Ctrl key and click each tag. 

2.	 Click the Delete Selected Tag button ( ) to delete the tag from the current library. A confirmation dialog is displayed. 

3.	 Click OK to remove the selected tags from the library. 

Merging subtags 

Merging tags combines a selected tag with its subtags and removes the subtags from your library permanently.


To merge a tag with its subtags, right-click the tag and choose Merge Subtags into Selected Tag from the shortcut menu.


All subtags are combined with the main tag, and the subtags are removed from the library. All media formerly associated with the 

subtags is associated with the main tag. 

Arranging tags in the tag tree 

Tags are displayed in a tree view in the Media Manager window. You can organize tags hierarchically: click the Expand button ( ) in the 

Search pane to expand a list, or click the Collapse button ( ) in the Search pane to hide an expanded list. 

You can drag, copy, and paste tags within the list to arrange them and create parent and child tags. 

You can also display tags in a palette view by clicking the Change Tags View button ( 

Editing tag names or images 

1.	 Double-click a tag (or right-click a tag and choose Edit from the shortcut menu) to display the Tag Editor dialog. 

2.	 In the Tag name box, type the name you want to display for the tag. 

3.	 Select a thumbnail image to choose the icon that will be displayed for the tag in the Search pane and in the Search Results pane 
when the tag is added to a media file. 

4.	 Click the OK button to apply your changes and close the Tag Editor dialog. 

Viewing or creating palettes 

The palette view provides another way of working with tags that can be useful for more focused searching. You can use a palette to 
concentrate on a portion of the current tag tree. 

In the palette view, tags are displayed as a grid of buttons instead of the standard hierarchical tag tree. 

1.	 Click the Change Tags View button ( ) to toggle the display of the tag tree and palette view. 

2.	 Click the down arrow  next to the button to choose a saved palette or create a new palette. 

Creating a palette 

1.	 Click the down arrow  next to the Change Tags View button ( ) and choose New Palette from the menu. The New Palette 
dialog is displayed. 

2.	 In the Name box, type the name you want to use to identify the palette. 

3.	 In the Rows box, specify the number of rows of buttons you want to display in the palette. 

4.	 In the Columns box, specify the number of columns of buttons you want to display in the palette. 

5.	 Click OK to create the palette. The palette is displayed as a grid with empty buttons. 
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Assigning palette buttons 

1. Perform either of the following actions to display the Tag Chooser dialog: 

• Click an empty palette button.


—or—


• Click an existing button and choose Choose Tag from the shortcut menu. 

2. Select the tag you want to assign to the button. 

3. Click the OK button. 

Clearing a button 

Right-click a palette button and choose Clear from the shortcut menu. 

Deleting a saved palette 

1. Right-click a palette button and choose Delete Current Palette from the shortcut menu. 

2. Click the OK button when prompted to delete the palette from your library. 

Saving tags and properties to media files 

Saving tags and properties to files makes all your organization portable: if tags and custom properties are saved to files, that information 
will be preserved in the files and can be added to the library by selecting the Add tags and custom properties from files check box in 
the Add Files to Media Library dialog. 

Saving tags and properties to files affects only the current media library and libraries that you create after saving the information. If you 
have multiple libraries, you can add embedded tags and custom columns to existing libraries by opening the desired library and 
rescanning your media folders with the Add tags and custom properties from files check box selected in the Add Files to Media Library 
dialog. Embedded file properties are also updated when you preview or add media to a project. 

The following file formats can store this type of information internally: 

•  MP3  

• Windows Media Format (WMA and WMV) 

•  WAV  

•  WAV64  

•  SFA  

•  PCA  

• Scott Studios 

For other file types, the Media Manager tool will save metadata to an .sfl file (using the same base name as your media file). 

Follow these steps to save tag and property information in your media file(s): 

1. In the Search Results pane, select media files for which you want to save tags and properties: 

• To select a single file, click the file.


—or—


• To select multiple consecutive files, click the first file, hold the Shift key, and then click the last item.


—or—


• To select multiple files that are not consecutive, hold the Ctrl key and click each file. 

2. Click the Save Tags and Properties to File(s) button ( ) in the top right corner of the Search Results pane. Tags and other 
information from the Search Results pane is saved for the selected file(s). 
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Backing up your media libraries 

Media Manager software automatically saves your library as you make changes, so you don’t need to tell the application explicitly to 
save your library as you're working. 

However, you can create a backup of the current library as a restore point or as a template to create new libraries. 

1.	 Click the Media Library Actions button ( ) and choose Back Up Media Library from the menu. The Back Up Media Library 
dialog is displayed. 

2.	 Choose a drive and folder from the Save in drop-down list, or use the browse window to locate the folder where you want to save 
your backup. 

3.	 In the File name box, type the name you want to use to identify the library. 

4. Click the Save button. 


To restore the backup at a later time, open the backup file.


Opening a Reference Library 

A reference library contains information about media from an outside source or vendor.


You can also use a reference library to search media files that you aren’t part of your collection. For example, if you’re unable to find the 

perfect loop for an ACID project in your own collection, you could use the Sony Sound Series Loops & Samples reference library to 

search the entire Sony Sound Series Loops & Samples catalog and purchase a new loop library.


You can use the Media Reference Library drop-down list in the Media Manager Options dialog to determine which library is opened 


when you click the Switch to Media Reference Library button (
 ). 

1.	 Click the Switch to Media Reference Library button ( ). The reference library specified in the Media Manager Options dialog is 
opened. Media in a reference library is displayed in gray text to indicate that the files are not available on your computer. 

2.	 Find the media you’re looking for with a standard or advanced search. 

3.	 Tag media from the reference library as needed. For more information on tagging, see Tagging media files on page 71. 

4.	 When you select a file in a reference library, the Product Information pane displays information about the selected file and a link 
you can use to purchase the media. 

Using the Sony Sound Series Loops & Samples reference library 

If you have the Sony Sound Series Loops & Samples reference library loaded when you search your computer for media, media from 
existing Sony Loops and Samples or Loops for ACID collections will inherit tags and custom properties from the reference library. 

The Sony Sound Series Loops & Samples reference library is not installed by default, but you can install it from the ACID CD or download 
it from the Sony Creative Software Inc. Web site 
(http://www.sonycreativesoftware.com/reference). After installing the library, go to the Media Manager Options dialog (click the Media 

Library Actions button ( ) and choose Options from the menu) and choose the reference library from the Reference library drop-
down list. 

Searching for media files 

You can use the Media Manager tool to search the current media library for media files using keywords or tags. 

Tips: You can use the Search Results Limit box in the Media Manager Options dialog to determine the maximum number of media files 
you’d like to have returned in the results of your searches. Increasing the Search Results Limit setting increases the amount of time 
required to search a library and can significantly decrease performance if set excessively high. 

When performing complex searches, consider creating temporary tags to classify the results. If you apply a tag to the files found by a 

complex search, you can return to those files easily by searching on the tag. The Media Manager tool can search for tags more quickly 

than it can perform keyword or advanced searches.
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Searching using a keyword 

1.	 Select the Quick text search check box in the Search pane and type a keyword (or keywords) in the edit box. 

Tip: You can separate search terms using quotation marks and other operators. If quotes or wildcard characters are not applied, an * is 
automatically added before and after each search term. 

2.	 Press Enter. 

The Media Manager tool searches your media files and displays the results in the Search Results pane on the right side of the 
window. Any file that contains your keywords in the file name or attributes is displayed (tags are not searched as keywords). 

Your search terms are displayed in the yellow bar below the Search Results toolbar. 

Keyword 
Search terms 

Search results 

3.	 You can refine the search results using any of the following methods: 

•	 Select tag check boxes. 

•	 Use the Advanced search controls. For more information, see Using advanced search options on page 77. 

• 	Choose  Match Any from the Match Any/Match All drop-down list to display all media that matches any of your keyword, tag, 
or advanced search criteria. Using this option in the search displayed in step 2, the Search Results pane would display all files 
that contain the keyword “EBow” OR the “Guitar” tag. 

• 	Choose  Match All from the Match Any/Match All drop-down list to display only media that matches all of your keyword, tag, 
and advanced search criteria. Using this option in the search displayed in step 2, the Search Results pane would display all files 
that contain the keyword “EBow” AND the “Guitar” tag. 
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Searching using tags 

In the Search pane, select the check box for each tag you want to find. The Media Library searches 
your media files and displays the results in the Search Results pane on the right side of the window. 

Choose Match Any from the Match Any/Match All drop-down list if you want to display all media 
that contains any keyword, tag, or advanced search criteria. In the example to the right, the Search 
Results pane would display all files that contain the tag “High Tom” OR the tag “Floor Tom.” 

Choose Match All from the Match Any/Match All drop-down list if you want to display only media 
that includes all keyword, tag, and advanced search criteria. In the preceding example, the Search 
Results pane would display only files with tags “High Tom” AND “Floor Tom.” 

Note: If you have check boxes selected for parent and child tags, those tags 

will be treated as an OR relationship regardless of whether Match Any or 

Match All is selected. 


Sorting search results 

Click a column heading to sort the results in ascending or descending order based on that column. 

Viewing previous searches 

Click the Previous Search button ( ) in the top left corner of the Search Results pane to navigate 
through your recent searches and update the contents of the Search Results pane. 

After viewing previous searches, click the Next Search button ( ) in the top left corner of the Search Results pane to navigate back to 
your current search. 

Using advanced search options 

If your media library contains many files and you’re searching for a very specific media file, the Advanced section of the Search pane can 
help you zero in on exactly the file you want. 

If you want to perform an advanced search to refine the results of a previous search, start by creating a quick search or tag-based search 
and then perform the following steps. 

Tips: You can use the Search Results Limit box in the Media Manager Options dialog to determine the maximum number of media files 
you’d like to have returned in the results of your searches. Increasing the Search Results Limit setting increases the amount of time 
required to search a library and can significantly decrease performance if set excessively high. 

When performing complex searches, consider creating temporary tags to classify the results. If you apply a tag to the files found by a 

complex search, you can return to those files easily by searching on the tag. The Media Manager tool can search for tags more quickly 

than it can perform keyword or advanced searches.


1. Add your search criteria: 

a. Click the Add New Search Criteria button ( ) in the Search pane. The Search Criteria Chooser is displayed. 
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b. Double-click an item in the Search Criteria Chooser or drag it to the Advanced section of the Search pane. 

Tips: If an item in the Search Results pane displays a  button, you can click it to find related media. For example, clicking the 

button in the following example adds an item to the Advanced section to help you find other media with a beat count of 16.


You can also drag a column heading from the Search Results pane to the Advanced section of the Search pane. 

2.	 Set parameters for each of your search criteria. If the item displays an edit box, type the parameter you want to search for. If the 
item is displayed as a hyperlink, click the value to display a control you can use to set the value. 

3.	 Choose whether you want to display files that match any or all of your search criteria: 

• 	Choose  Match Any from the Match Any/Match All drop-down list if you want to display all media that matches any of your 
keyword, tag, or advanced search criteria.


—or—


• 	Choose  Match All from the Match Any/Match All drop-down list if you want to display only media that matches all of your 
search criteria. 

4.	 Select the check boxes for the advanced search criteria you want to include in your search, or clear a check box to exclude that 
item. 

Previewing media 

You can use the transport controls in the Media Manager window to preview media files. 

1.	 Select files in the Search Results pane to choose the files you want to preview: 

• To select a single file, click the file.


—or—


• To select multiple consecutive files, click the first file, hold the Shift key, and then click the last item.


—or—


•	 To select multiple files that are not consecutive, hold the Ctrl key and click each file. 

2.	 Start playback: 

• 	If the  Auto Preview button ( ) is selected, playback will begin automatically. 

• 	If the  Auto Preview button is not selected, click the Start Preview button ( ) to begin playback. 

If you have multiple files selected, they will be played back sequentially. Each file’s icon will change to a play icon ( ) during 
playback. 

3.	 Click the Stop Preview button ( ) to stop the preview, or turn off the preview feature by deselecting the Auto Preview button. 

If the file is offline, you’ll be prompted to locate the file or choose a replacement. 

Tip: To preview a media file in its associated media player, right-click the file and choose Open with Player from the shortcut menu. 
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Adding media to your project 

After you’ve added media to your library, tagged it, and searched for specific files or related media, you’ve probably found just the right 
piece of media for your current project. 

You can add media to your project from the Search Results pane by performing any of the following actions: 

•	 Dragging a file from the Search Results pane to the project timeline. The file is added wherever you drop it. 

Tip: You can also drag files from the Search Results pane to the Windows desktop, a folder, or to another application that is an OLE 
(object linking and embedding) drop target. 

•	 Double-clicking a media file in the Search Results pane (if the Double-click in Search Results pane adds media to project check 
box is selected in the Media Manager Options dialog). The file is added to the bottom of the track list. 

•	 Right-clicking a media file in the Search Results pane and choose Add to Project from the shortcut menu. The file is added to the 
bottom of the track list. 

If the file is offline, you’ll be prompted to locate the file or choose a replacement. For more information, see Resolving offline media files 
below. 

Resolving offline media files 

An offline media file is a file that is no longer available to the Media Manager. Media may be classified as offline if you eject removable 
storage after adding a file to your library or change a file’s name or location. 

1.	 Add media to your project or preview media files. If any of the files are not accessible, the Resolve Offline Media dialog is displayed 
with a listing of offline files and their status: 

Icon Status Description 

Offline The file listed in the Offline File column cannot be found. The status will be Offline if you did 
not search or browse for a replacement file. 

Probable 
Match 

The file listed in the Offline File column will be replaced by the file listed in the Replacement 
File column. A status of Probable Match indicates that the Media Manager tool found a 
likely replacement file when you clicked Smart Search. 

Found The file listed in the Offline File column will be replaced by the file listed in the Replacement 
File column. A status of Found indicates that you chose the file you want to use after 
clicking the Browse button. 

2.	 Select the files you want to resolve: 

• To select a single file, click the file.


—or—


• To select multiple consecutive files, click the first file, hold the Shift key, and then click the last item.


—or—


•	 To select multiple files that are not consecutive, hold the Ctrl key and click each file. 

3.	 Specify how you want to resolve the selected files: 

• 	Click the  Smart Search button to search quickly and allow the Media Manager tool to suggest the replacement file. 

• 	Click the  Browse button to choose a specific replacement file. 

• 	Click the  Leave Offline button to leave the file offline. The file will not be added to your project. 

• 	Click the  Remove button to remove the file from the media library. The file will not be added to your project. The original 
media file is not deleted. 

4.	 Repeat step 3 for each file in the list. 

5.	 Click the OK button to preview the files or add the files to your project and update the media library with the replacement files. 
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Customizing the Media Manager window 

Much of what you see in the Media Manager window can be customized to suit your preferences. 

Automatically hiding the Search pane 

Click the push pin button ( ) in the title bar of the Search pane if you want to save space in the Media Manager window by 
automatically hiding the search pane: 

• The push pin is displayed as a ( ) when the Search pane is anchored in the Media Manager window. 

• The push pin is displayed as a ( ) when the Search pane is set to hide automatically. 

When the Search pane is set to hide automatically, you can hover over the Search tab on the left edge of the Media Manager window to 
show the pane. When you move your mouse away from the Search pane, it hides automatically. 

Docking and undocking the Search pane 

You can undock the Search pane from its location in the Media Manager window to float it over the ACID window, or you can change 
the docking position of the pane within the Media Manager window. To undock and move the Search pane, drag its title bar to the 
desired location. 

Resizing columns 

You can resize the columns in the Search Results pane by dragging the splitter between columns to the desired size. To resize a column 
automatically, double-click a splitter. 

Moving columns 

To move a column in the Search Results pane to a different location, drag the column header to the desired location. A red indicator 
shows where the column will be dropped. 

Showing or hiding columns 

1. Right-click the column headings and choose Column Chooser from the shortcut menu. 

2. Drag the columns you want to see from the Column Chooser dialog to the Search Results pane. 

3. To hide a column, right-click a column heading and choose Remove this Column from the shortcut menu. 

Adding custom columns 

You can add custom columns to the Search Results pane to store additional information about media files. When you add custom 
columns, they are added to the current library only. 

For example, if you wanted to keep track of which removable hard drive contained a media file, you could create a custom Drive 
Number column to assign any numeric rating to a media file. You could then use the Advanced section of the Search pane to search 
using the Drive Number value. 

When adding media to a library, you can choose to add this information by selecting the Add tags and custom columns from files 
check box in the Add Files to Media Library dialog. 

1. Right-click the column headings and choose Custom Columns from the shortcut menu. 

2. Click the Add New Column button ( ) to add a custom column. A new entry is added to the list. 

3. In the Name box, type the name you’d like to display as a column heading. 
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4.	 Select the Type box and choose Text or Integer from the drop-down list to indicate whether you’ll store text or numeric data in the 
column. 

5.	 If you want to remove a custom column, select an entry in the list and click the Delete Selected Columns button ( ). The column 
and all data stored in the column is removed from the library. 

6.	 Click the OK button. The column is added to the media library, and the Search Results pane is scrolled to the right to display your 
new column. 

Setting Media Manager options 

Use the Media Manager Options dialog to set options for working with the Media Manager tool.


1. Click the Media Library Actions button (
 ) and choose Options from the menu. The Media Manager Options dialog is

displayed.


2.	 From the Reference library drop-down list, choose the library you want to load when you click the Switch to Media Reference 
Library button in the upper left corner of the Search Results pane. For more information about using reference libraries, see Opening a 
Reference Library on page 75. 

3.	 In the Search results limit box, type the maximum number of media files you’d like to have returned in the results of your searches. 

Note: Increasing the Search Results Limit setting increases the amount of time required to search a library and can significantly 

decrease performance if set excessively high.


4.	 Select the Double-click in Search Results pane adds media to project check box if you want to add files to the current project by 
double-clicking a file in the Search Results pane. 

5.	 Select the Shut down database service on exit check box if you want to stop the database service when you close ACID. 

Note: Stopping the service can conserve system resources when you aren’t using any applications that use the Media Manager tool. 

However, the application will take longer to start when the check box is selected.


6.	 Set your options for adding media to a library: 

a.	 Select the Add tags and custom properties from files check box if you want to add tags and custom columns saved in the 
media files to your library. For more information about tagging media, see Tagging media files on page 71. For information about 
adding custom columns to the Search Results pane, see Adding custom columns on page 80. 

b.	 Select the Use file and folder names to apply tags automatically check box if you want to automatically tag files based on the 
file path. 

For example, when this check box is selected, a loop saved in the d:\loops\drums\hi-hats\ folder would have the tags Drums and 
Hi-Hats applied when it is added to the library. Some synonyms (and variant spellings) will be resolved automatically. If you need to 
modify the pattern-matching, you can edit the AutoTagPatterns.xml file, which is created in your My Documents\Sony Media 
Libraries folder the first time the application starts. 

7.	 Click the OK button to close the dialog. 
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Chapter 5

 Working in the Track View


This chapter introduces you to several ACID® features that increase your productivity, such as markers, regions, and 
snapping options. You’ll also learn about the different ways to change a project’s tempo, key, and time signature. Finally, 
you’ll learn several options for adjusting the project timeline. 

Using project markers and regions 

ACID markers and regions identify areas of your project and provide navigational cues for quickly finding those areas. 
After you insert markers and regions, you may adjust their position along the project’s timeline and label them with 
meaningful names for your reference. 

Marker type	 Description 

Marker (standard)
 Markers identify specific reference points in your project. Points that you 

may want to identify are introductions, bridges, refrains, choruses, or 

whatever you choose.


Time marker Time markers are fixed to the time ruler and mark absolute time in your 
project. They are very useful when scoring video. 

Command marker Command markers indicate when an instruction or function occurs in a 
streaming media file. 

Region Regions subdivide your project into time segments. Regions have in and out 
points, which allow them to function as permanent time selections. 

Working with standard markers 

Markers are tools that can make creating music easier by identifying specific points along the project’s timeline. They can 
be named, moved, and serve as snap and navigational points for the cursor and events. When you place markers, they are 
automatically numbered (up to 99) in the order that you place them. 

Placing markers 

Markers are placed at the cursor position. You may place a marker in one of the following ways: 

• 	From the  Insert menu, choose Marker. 

•	 Right-click the marker bar, choose Markers/Regions from the shortcut menu, and choose Insert Marker from the 
submenu. 

•	 Press M. You may use this method to place a marker while the project is playing. 

Marker Marker bar 

Moving markers 

1.	 Place the mouse pointer on the marker to be moved. The hand cursor ( ) appears. 

2.	 Drag the marker to the desired position. 
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Naming markers 

You can name markers in your project. You may want to name markers based on parts of the project. For example, you may want to 
identify choruses, refrains, bridges, or instrument solos as reference points along the timeline. 

1. Place the mouse pointer on the marker to be named. The hand cursor ( ) appears. 

2. Right-click the marker and choose Rename from the shortcut menu. A box appears next to the marker. 

3. Type a marker name in the box and press Enter to save the name. 

Tip: You can use the same steps to rename a marker. Alternately, you can double-click the marker and enter a new name. 

Navigating to markers 

While you are working on your project, you may have scrolled to a portion of the project where the cursor is not visible. There are two 
ways to move the cursor directly to the selected marker: 

• Right-click the marker and choose Go To from the shortcut menu. 

• Click the marker once. 

• Press the number key (not on the numeric keypad) corresponding to the marker number. 

Tip: You may also navigate from one marker to the next by pressing Ctrl+left/right arrow key. 

Adjusting tempo to match cursor to marker 

Position the cursor, right-click the marker tab, and choose Adjust tempo to match cursor to marker from the shortcut menu. The 
project tempo changes so that the cursor position matches the selected marker. 

Deleting markers 

You may remove markers from the project at any time. Because markers are automatically numbered (up to 99) when they are placed, 
the remaining markers are not renumbered when one is deleted. Rather, the remaining markers retain their numbers. However, if you 
add markers later, numbering begins to fill the sequence gap. 

For example, if you have five markers in your project and delete markers three and four, the remaining markers are listed as one, two 
and five. When you add markers again, the markers are numbered as three and four. 

1. Place the mouse pointer on the marker to be deleted. The hand cursor ( ) appears. 

2. Right-click the marker and choose Delete from the shortcut menu. The marker is removed from the project. 

Working with time markers 

Unlike standard markers, time markers are tied to absolute time within your project. They are added differently than standard markers 
and appear on the time ruler at the bottom of the track view. Otherwise, time markers can be manipulated just like other markers. 
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Placing time markers 

Time markers are placed at the cursor position. You may place a time marker in one of the following ways: 

•  From the  Insert menu, choose Time Marker. 

• Press H. You may use this method to place a time marker while the project is playing back. 

Time marker 

Note: Time markers are not numbered. 

Adjusting tempo to match marker to cursor 

Using this function with time markers is particularly useful when scoring video. For more information, see Scoring video on page 234. 

Position the cursor, right-click the marker tab, and choose Adjust tempo to match marker to cursor from the shortcut menu. The 
project tempo changes so the time marker matches the cursor position. 

You can also align the marker and cursor by holding Alt while dragging the marker. For example, hold Alt while dragging a time marker 
to a location on the beat ruler. The project tempo adjusts so the time at the marker occurs on a specific beat. For example, if you place a 
time marker at 10 seconds on the time ruler and hold Alt while dragging the marker to 5.1 on the beat ruler, the project’s tempo is 
adjusted so the first beat of measure five occurs at ten seconds. 

Working with command markers 

Command markers add interactivity to a multimedia presentation streamed over the Internet. As your media plays, any number of other 
actions can be programmed to execute. These commands are a part of the Windows Media® and RealMedia™ streaming formats. Most 
frequently, these actions add text or open a related Web site. The specific commands available vary depending on the final format of 
your project. 

Note: Streaming media files can be played back from a hard drive or CD-ROM, but in order to stream properly across the Internet, the file 
must be on a streaming media server. Check with your internet service provider for details and availability of this service. 

Placing command markers 

Command markers appear on the command ruler, which is above the marker bar. 

Marker bar 

Command ruler 

URL command marker 

1. Position the cursor where you want to place the command marker. 

2. From the Insert menu, choose Command. 
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3.	 Complete the Command Properties dialog: 

• 	From the  Template drop-down list, choose a custom template. For more information, see Saving command properties as a 
custom template on page 86. 

• 	From the  Command drop-down list, choose the type of command. For more information, see Defining streaming media 
commands on page 87. 

•	 Enter parameters in the Parameter box to define the behavior of the command. 

•	 Enter your own notes or comments in the Comment box. 

•	 Specify the timing of the command in the Position box. Command markers are automatically set to the current cursor position 
unless you change this value. 

4.	 Click OK. The new command marker appears on the command bar. 

After you create a command marker, you can move the marker by dragging it to a new location. 

Editing command marker properties 

Double-click any command marker to open the Command Properties dialog and edit its contents. You can also right-click a command 
marker and choose Edit from the shortcut menu. 

Saving command properties as a custom template 

If you plan to use a command more than once, you can save command properties as a template. You can then reuse the command 
properties by selecting the template from the Template drop-down list. 

1.	 Create a command and complete the Command Properties dialog. 

2.	 Click in the Template box and enter a name for the template. 

3.	 Click the Save Template button ( 

Tip: Your metadata command templates are saved in the cmdtemp.xml file in the ACID program folder. You can edit this file directly to 
modify your templates. 

). 
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Defining streaming media commands 

In a streaming media file, command markers can be used to display headlines, show captions, link to Web sites, or any other function 
you define. 

Several command types are included that you may add to a streaming media file. Some command types are exclusive to either the 
Windows Media or the RealMedia file types. 

Command Player Type Description 
URL Windows Media 

and RealMedia 
Indicates when an instruction is sent to the user’s Internet browser to change the content being 
displayed. With this command, you enter the URL that displays at a specific time during the 
rendered project’s playback. 

TEXT Windows Media Displays text in the captioning area of the Windows Media Player located below the video 
display area. You enter the text that displays during playback. 

Note: To view captions during playback in Windows Media Player 9, choose Captions and 
Subtitles from the Windows Media Player Play menu, and then choose On if Available from the 
submenu. 

WMClosedCaption Windows Media Displays the entered text in the captioning window defined by an HTML layout file. 
WMTextBodyText Windows Media Displays the entered text in the text window defined by an HTML layout page. 
WMTextHeadline Windows Media Displays the entered text in the headline window defined by an HTML layout file. 
Title RealMedia Displays the entered text on the player’s title bar. 

Note: When rendering Windows Media files, title information is based on the settings on the 
Summary tab of the ACID Project Properties dialog or the Index/Summary tab of the Custom 
Template dialog. The summary information from the Project Properties dialog will be used if 
information has been specified in both places. 

To view this information during playback, choose Now Playing Options from the Windows 
Media Player View menu and select the items you want to display. 

Author RealMedia Displays the entered text (author’s name) when a user selects About this Presentation from 
the RealPlayer shortcut menu or Properties from the Windows Media shortcut menu. 

Note: When rendering Windows Media files, author information is based on the settings on the 
Summary tab of the ACID Project Properties dialog or the Index/Summary tab of the Custom 
Template dialog. The summary information from the Project Properties dialog will be used if 
information has been specified in both places. 

To view this information during playback, choose Now Playing Options from the Windows 
Media Player View menu and select the items you want to display. 

Copyright RealMedia Displays the entered copyright information when a user selects About this Presentation from 
the RealPlayer shortcut menu or Properties from the Windows Media shortcut menu. 

Note: When rendering Windows Media files, copyright information is based on the settings on 
the Summary tab of the ACID Project Properties dialog or the Index/Summary tab of the Custom 
Template dialog. The summary information from the Project Properties dialog will be used if 
information has been specified in both places. 

To view this information during playback, choose Now Playing Options from the Windows 
Media Player View menu and select the items you want to display. 

Adjusting tempo to match cursor to marker 

Position the cursor, right-click the marker tab, and choose Adjust tempo to match cursor to marker from the shortcut menu. The 
project tempo changes so that the cursor position matches the selected command marker. 

Deleting command markers 

To delete a command marker, right-click the marker and choose Delete from the shortcut menu. 

Working with regions 

Regions are useful tools that allow you to subdivide your project into time sections by designating in and out points along the timeline. 
Regions can function as permanent time selections for playback and editing purposes. Like markers, regions can serve as reference 
points and may be moved, named, and provide snap points for the cursor and events. 

When you place regions, they are automatically numbered in the order that you place them. 
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Placing and moving regions 

Regions are placed at the start and end points of a loop region (time selection). You may place a region in one of the following ways: 

•  From the  Insert menu, choose Region. 

• Right-click the marker bar, choose Markers/Regions from the shortcut menu, and choose Insert Region from the submenu. 

• Press R. 

Region start 
Loop region 

Region end 

After you place a region, you may change its position by dragging the region tag to the desired position. 

Tip: You can move a region without changing its size by holding Alt while dragging either region tag. 

Naming regions 

You can name the placed regions in your project. You may want to name regions based on parts of the project or to define the amount 
of time that the regions encompass. For example, you may want to identify introductions, solos, or special time-related features in your 
project as reference points. 

1. Right-click the region’s start tag and choose Rename from the shortcut menu. A box appears next to the tag. 

2. Type a region name and press Enter to save the name. 

Navigating to regions 

While you are working on your project, you may have scrolled to a portion of the project where the cursor is not visible. You may click in 
the track view to move and view the cursor or you may use region tags to bring the cursor into view. 

To move the cursor to the selected region tag, right-click the region tag and choose Go To from the shortcut menu. 

Tip: You may also navigate between regions in your project by pressing Ctrl+left/right arrow key or the number key (not on the numeric 
keypad) corresponding to the region number. 

Selecting regions 

You may use the region’s start and end tags to make a time selection across all tracks in your project. The information within the time 
selection can then be used for playback or editing. 

To select a region, right-click a region tag and choose Select Region from the shortcut menu. The loop bar appears between the region 
tags and the tracks are highlighted. 

Deleting regions 

You may remove regions from the project at any time. Because regions are automatically numbered when they are placed, the existing 
regions are not renumbered when one is removed. Rather, the existing regions retain their numbers. However, if you add regions later, 
numbering begins to fill the sequence gap that exists. 

For example, if you have six regions in your project and delete regions four and five, the remaining regions are listed as one, two, three 
and six. When you add regions again, the regions are numbered as four and five. 

To remove a region from a project, right-click the region tag marker and choose Delete from the shortcut menu. 
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Using snapping 

Snapping helps you to align events in your project with other items. Event edges are preset to snap to the project’s grid lines as you 
drag an event along the track. If snapping is enabled and the Grid Only option is turned off, the event’s edges automatically align to 
these designated snap points: 

• Cursor position 

•  Grid lines  

•  Markers  

• Regions start and end points 

• Loop region (time selection) in and out points 

You may turn on snapping for these elements in the project or limit snapping to grid lines. 

Choosing snapping options 

If the snap function is preventing you from placing an event precisely where you want it, you may turn snapping off. Turning off 
snapping prevents events from automatically aligning to the cursor, grid lines, markers, regions, and time selections. 

The Options menu allows you to toggle snap functions. The button image next to the Enable command indicates when snapping is 
turned on. The button image next to the Grid Only command indicates the type of snapping in use. 

Select to turn all snapping on/off 

Select to toggle between snapping 
to grid lines only and snapping to all 
elements. 

Tip: You can temporarily suspend snapping while dragging by holding down the Shift key. 

Turning snapping on and off 

You may turn snapping on and off in one of the following ways: 

•  Click the  Enable Snapping button ( ) on the Toolbar. 

•  From the  Options menu, choose Snapping, and choose Enable from the submenu. 

• Press F8. 

Snapping to grid lines 

With snapping turned on, you may choose to snap only to grid lines. From the Options menu, choose Snapping, and choose Grid Only 
from the submenu. The button image next to the command indicates that it is active. 

Snapping to all elements 

With snapping turned on, you may choose to snap to all elements. From the Options menu, choose Snapping, and choose Grid Only 
from the submenu. The button image next to the Grid Only command appears deselected when snapping to all elements. 

Tip: Press Ctrl+F8 to toggle between grid only and all elements. 
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Changing tempo, time signature, and key 

You can set a tempo, time signature, and key for your ACID project. You can also make adjustments during playback. 

You can add specific tempo, time signature, and key changes within a project using tempo/key/time signature change markers. These 
markers appear on the marker bar above the track view. When the cursor passes over one of these markers, the master project tempo, 
key, and/or time signature changes in real time. 

Set the tempo, time signature, and key for the whole project...	 ...or change these elements dynamically in 
the timeline. 

Project Tempo slider Project Tempo 

Project Key 

Project Time 

Signature 

Changing project tempo 

You can change the tempo of a project without affecting the project’s key. 

Changing tempo using the Project Tempo slider 

Drag the Project Tempo slider at the bottom of the track list. Dragging the slider to the left slows the tempo, while dragging it to the 
right speeds the tempo. 

Tip: Double-click the tempo value next to the Project Tempo slider to enter 
an exact value. Press Enter when you are finished. 

As you drag the Project Tempo slider, a colored bar appears under each track’s name to represent the amount a track is being stretched 
to match the project tempo. The mark in the center of the bar represents the original tempo of a file. When the bar appears to the right 
of the mark, the project tempo is faster than the original file; when the bar appears to the left of the mark, the project tempo is slower 
than the original file. The amount of change also displays as a percentage at the right end of the bar. 

As you drag the slider, a colored bar appears for each track. 

Project tempo is faster than 
file tempo. 

Project tempo is slower 
than file tempo. 

Project Tempo slider 

Changing project tempo to match file tempo 

Each track’s shortcut menu contains the option Use Original Tempo. The original tempo of the file used on the track appears to the 
right of this option in the shortcut menu. To change the project’s tempo to match the original file tempo, simply choose Use Original 
Tempo from the shortcut menu. 
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Changing project time signature 

Click the Project Time Signature control and select a time signature from the menu to adjust a project’s time signature. Select Other 
from the menu to enter a custom time signature. 

Changing project key


Click the Project Key control and select a key from the menu to adjust a project’s key.


Project Key control 

This feature makes it possible to use media that are in different keys in the same project: each loop that has a specified root note is 
transposed to the key indicated by the Project Key control. 

For example, if three loops have root notes of A, B, and C, and your Project Key control is set to D, the loops are pitch-shifted by five, 
three, and two semitones, respectively. 

Note: If the root note for a track is set to Don’t Transpose in the Clip Properties window, the track does not pitch shift with the rest of the 
project. 

Working with tempo/key/time signature change markers 

Tempo/key/time signature change markers allow you to make changes to the tempo, key, and/or time signature at specified points in 
your project. 

Note: Time signature changes must occur on the first beat of a measure. 

Adding tempo/key/time signature change markers 

1.	 Position the cursor where you want the change to occur. 

2.	 From the Insert menu, choose Tempo/Key/Time Signature Change. The Tempo/ 
Key/Time Signature Change dialog appears. 

3.	 Select the Key Change check box and choose a key from the menu to change the 
key of all tracks from the cursor position until another key change marker is 
encountered. 

4.	 Select the Tempo Change check box and enter a new tempo (in beats per minute) 
in the edit box to change the tempo of all tracks from the cursor position until 
another tempo change marker is encountered. 

When you add a tempo change marker, you can choose an setting from the 
Transition type drop-down menu to determine how the tempo is changed between markers. For more information on using 
tempo curves, see Using a tempo curve to change tempo between markers on page 92. 
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5.	 Select the Time Signature Change check box and make your Beats per measure and Beat value selections to change the time 
signature at the marker position. The time ruler divisions and grid spacing will be updated accordingly. 

Note: Time signature changes must occur on the first beat of a measure. If your cursor is not on the first beat of a measure, the marker is 
placed at the nearest measure. 

6.	 Click OK. A marker appears in the marker bar at the cursor position that displays the change information. 

New marker and 
marker text 

Editing tempo/key/time signature change markers 

There are several ways to edit a tempo/key/time signature change marker: 

•	 Position the cursor on or after the marker and adjust the Project Tempo, Project Time Signature, or Project Key controls. The 
marker’s text reflects the change. 

•	 Right-click the marker, choose Edit from the shortcut menu, and enter the appropriate change in the Tempo/Key/Time Signature 
Change dialog. 

•	 Double-click the marker text and type the new value. 

•	 Double-click the marker and enter the appropriate change in the Tempo/Key/Time Signature Change dialog. 

Adjusting tempo to match cursor to marker 

Position the cursor, right-click the marker tab, and choose Adjust Tempo to Match Cursor to Marker from the shortcut menu. The 
project tempo changes so that the cursor position matches the selected marker. 

Deleting tempo/key/time signature change markers 

To delete a marker, right-click the marker and choose Delete from the shortcut menu. 

Using a tempo curve to change tempo between markers 

When you add a tempo change marker to the timeline, you can choose to change tempo gradually between markers. Tempo curves are 
perfect for ramping tempo up or down. 

1.	 Add a tempo change marker to the timeline or double-click a tempo-change marker to edit an existing marker. 

2.	 Choose a setting from the Transition type drop-down list to indicate how ACID will interpolate tempo between markers: 

Option Description Looks Like 

Hold No tempo change will take place. The tempo settings will be 
maintained until the next tempo change marker. 

Linear 

Fast 

Slow 

Tempo change parameters are interpolated in a linear path. 

Tempo change parameters are interpolated in a fast logarithmic 
path. 

Tempo change parameters are interpolated in a slow 
logarithmic path. 

Smooth 

Sharp 

Tempo change parameters are interpolated along a smooth, 
natural curve. 

Tempo change parameters are interpolated along a sharp 
curve. 
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Changing a clip’s key 

You can change the key of a clip on a track without affecting the project’s key. For creative ways to use track key changes, see Detuning 
paired tracks on page 297. 

1.	 Right-click the track and choose Properties from the shortcut menu. The Track Properties window appears. 

2.	 Double-click the event you want to edit. 

3.	 On the General tab of the Clip Properties window, enter the number of semitones by which to adjust the key in the Pitch Shift box 
or use the spinner control. Use the minus (-) key for negative values. 

4.	 Close the Track Properties window. The pitch shift displays in the event. 

Pitch shift display 

Tip: Another way to change the key of the track is to select the track in the track list and press + (plus) or - (minus) on the numeric keypad. 

Changing an event’s key 

You can change the key of an individual event without affecting the pitch of the track or project. 

Right-click the event in the track view, choose Pitch Shift from the shortcut menu, and choose Up 
Semitone or Down Semitone from the submenu. The pitch shifts one semitone in the direction specified, 
and the amount of shift displays on the event itself. 

You can also change an event’s key using keyboard shortcuts. For more information, see Event editing 
commands on page 308. 

Adjusting time


Two commands are provided for adjusting your project’s timeline: Insert Time and Fit to Time.


Inserting time 

Use the Insert Time command to insert a specified amount of blank space into the project at the current cursor position. This feature 
can be used to create space in the project for new events. 

1.	 Position the cursor where you want to insert time. 

2.	 From the Insert menu, choose Time. The Insert Time dialog appears. 

3.	 Enter the amount of time you want to insert and click OK. 

Note: The Insert Time dialog uses the measures.beats.ticks format used by the beat ruler. 
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Fitting to time


The Fit to Time command allows you to adjust the project’s overall length to a specified amount of time.


Note: The maximum and minimum length is limited to reduce the possibility of creating audible artifacts through the compression/

expansion process.


1.	 From the Edit menu, choose Fit to Time. The Fit to Time dialog appears with the current project length displayed in the New 
length box. 

2.	 Enter the new project length in the New length box. The length is always entered in time format, regardless of the format used on 
the time ruler. 

3.	 Click OK. The dialog closes and the tempo is adjusted to alter the project’s length. 
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Chapter 6 
Using the Chopper 

The Chopper™ feature in ACID® allows you to quickly create slice-and-dice effects. For creative ways to use the Chopper, see 
Slicing and dicing in the Chopper on page 302. 

Working in the Chopper window 

Selecting an event loads its clip in the Chopper. 

Toolbar 

Beat ruler 

Transport bar 

Time ruler 

Viewing the Chopper


To display the Chopper, choose Chopper from the View menu or press Alt+2.


Changing the Chopper grid 

The Chopper’s grid uses the same increments available on the track view. To change the grid display, right-click the 
waveform area of the Chopper, choose Grid Spacing from the shortcut menu, and choose the desired display from the 
submenu. 

Changing Chopper snapping options 

The snapping behavior of the track view and Chopper are linked. To enable snapping in both components, choose 
Snapping from the Options menu and choose Enable from the submenu, or press F8. 

When snapping is turned on, you can choose between snapping only to the grid or snapping to all elements. For more 
information, see Using snapping on page 89. 

Magnifying the Chopper 

There are three ways of adjusting the magnification of the Chopper. 

•  Click the  Zoom In Time and Zoom Out Time  buttons located in the lower-right corner of the window. 

• Click within the Chopper and use the mouse wheel. 

• Quickly magnify a selection by right-clicking and choosing Zoom to Loop Region from the shortcut menu. 

Previewing in the Chopper 

The Chopper contains a dedicated transport bar that can be used to preview selections prior to inserting them into the 
project. 
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Using Chopper toolbar and keyboard commands 

In addition to the transport bar, the Chopper contains a toolbar that is designed to make creating selections quick and easy. The 
following table briefly describes the toolbar buttons and the associated keyboard commands. 

Button Keyboard Function 
/ (front slash) or A Inserts the Chopper selection as an event in the track view at the 

current cursor position. 

Y 

Ctrl + , (comma) 

Inserts the Chopper selection as an event in the track view at the play 
cursor position. 

Shifts the track view’s cursor position to the left by the length of the 
increment arrow. 

Ctrl + . (period) 

N 

; (semicolon) 

Shifts the track view’s cursor position to the right by the length of the 
increment arrow. 

Links the length of the increment arrow with the length of the 
selection. When toggled on, the length of the increment remains equal 
to the length of the selection. When toggled off, you can configure the 
increment independently of the Chopper selection. 

Halves the length of the Chopper selection. 

’ (apostrophe) Doubles the length of the Chopper selection. 

< or , (comma) Shifts the Chopper selection to the left by the length of the selection. 

> or . (period) Shifts the Chopper selection to the right by the length of the selection. 

Ctrl + Shift + , (comma) Shifts the selection left by the increment length. 

Ctrl + Shift + . (period) Shifts the selection right by the increment length. 

Ctrl + ; (semicolon) Doubles the length of the increment arrow. 

Ctrl + ’ (apostrophe) Halves the length of the increment arrow. 

R Inserts a region. 

M Inserts a marker. 

I Marks the start point of a loop region. 

O Marks the end point of a loop region. Once the endpoint is established, 
the loop region becomes highlighted. 

Inserting markers and regions in the Chopper 

When working with events in the Chopper, you can drop markers and create regions just like in the track view. For more information, see 

Using project markers and regions on page 83.


These markers and regions are saved with the project when it is saved. They can also be saved back to the original media file by clicking 


the Save File button ( ) in the Track Properties window. For more information, see Saving file properties on page 123.


Creating selections in the Chopper 

After you place a file in the Chopper, you can use the toolbar, transport bar, and mouse (or their keyboard equivalents) to create and 
preview selections within the file. When have made the selection you want, you can insert the selection into the track view. 
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Placing files in the Chopper 

To place a file in the Chopper, do any of the following: 

•	 Select a track in the track list. 

•	 Select an event. 

•	 Right-click an event and choose Select in Chopper from the shortcut menu. 

Note: If you choose Select in Chopper on an event that contains only a portion of a file, the entire contents of the file are placed in the 
Chopper. The part of the waveform selected, however, matches the contents of the selected event. This allows you to see the event in the 
context of the entire media file. 

Creating selections 

To create a selection, drag the mouse, or hold Shift while pressing the arrow keys. A shaded region appears in the Chopper to indicate 
the current selection, and its start point, end point, and length display at the bottom-right corner of the window in measures.beats.ticks 

format. You can preview the selection at any time by clicking the Play button ( ) on the Chopper’s transport bar or pressing Space. 

Increment arrow 

Start  End Length 

Note: In addition, an increment arrow appears on the track view above the selected block. For more information, see Inserting 

increments on page 98.


As you make a selection in the Chopper, a colored block appears in the track view. This block indicates where the selection will be placed 
on the track view when you insert it from the Chopper. 

Creating selections of a specific musical length 

You may want to create a selection with a length corresponding to a musical value. You can easily do this in the software using the 
Chopper’s selection shortcut menu. 

1.	 Create a selection or place the cursor in the Chopper. For more information, see Creating selections on page 97. 

2.	 Right-click and choose the desired musical length from the shortcut menu. A selection is created equal to the specified musical 
length. 
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Inserting increments


In addition to creating selections, the Chopper feature allows you to configure the sections of silence between selections painted on a 

track. When you click the Link Arrow to Selection button ( ), the increment arrow length is incremented with the selection length. 
This forces the increment and selection lengths to remain equal, thereby allowing you to insert selections seamlessly, end-to-end, in the 
project. 

Selection and increment length linked Chopper selection inserted end-to-end three times 

When the Link Arrow to Selection button is toggled off, the increment arrow is displayed in black and you are able to establish a 
increment length that is independent of the selection length. The increment arrow can be set by dragging either end of the arrow or by 
using the increment shortcut menu. 

When the increment length is greater than the length of the selection, an appropriate amount of silence is inserted following the 
selection when you insert it in the track view. This affects the track’s insert position and allows you to paint selections separated by the 
specified increment. 

Increment greater than selection Selection inserted with specified increment three times 

When the increment length is less than the length of the selection, the selections are overlapped as you insert them in the track view. 

Increment less than selection Selection overlaps when inserted three times 

Creating increments 

1. Verify that the Link Arrow to Selection button ( ) is toggled off and the increment arrow is displayed in black. 

2. Drag the point of the arrow to configure an increment of the desired length. 

Tip: While dragging the increment arrow, the Chopper’s middle status value temporarily displays the length of the increment. 
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Creating increments of a specific musical length 

The increment shortcut menu, like the selection shortcut menu, allows you to create increments that correspond to the specified 
musical length. 

1.	 Verify that the Link Arrow to Selection button ( ) is toggled off and the increment arrow is displayed in black. 

2.	 Right-click the increment arrow and choose the desired musical value from the shortcut menu. The increment length is 
automatically configured to the selected value in both the Chopper and the track view. 

Creating increments of a custom musical length 

1.	 Verify that the Link Arrow to Selection button ( ) is toggled off and the increment arrow is displayed in black. 

2.	 Right-click the increment arrow and choose Custom from the shortcut menu. The Custom Length dialog appears. 

3.	 Choose the desired increment format from the drop-down menu. 

4.	 Enter an appropriate value in the adjacent box and click OK. The increment length is automatically configured to the selected value 
in both the Chopper and the track view. 

Note: It is possible to set an increment value that results in the increment arrow extending beyond the scope of the Chopper. If this 
occurs, an accurate depiction of the increment still appears in the track view. 

Inserting selections in the track view 

You can add selections from the Chopper to your project in several ways. 

Using the Insert Selection button 

After you create the desired selection and increment, you can insert the selection in the project at the track view’s cursor position by 

clicking the Insert Selection button ( ). After the Chopper inserts the audio, the cursor moves to the end of the increment. 

•	 If the increment length is equal to the selection length, selections are painted end-to-end. 

•	 If the increment length is greater than the selection length, an appropriate amount of silence is painted prior to the next insert 
position. 

•	 If the increment length is less than the selection length, selections overlap. 

Using copy and paste 

You can right-click the selection in the Chopper and choose Copy from the shortcut menu to copy the current selection to the 
clipboard. You can then use the Paste command to insert the selection in the track view. After the event is pasted, the cursor advances 
to the end of the pasted event. 

Note: When you paste a selection from the Chopper to the track view, the increment setting is ignored. 

Dragging selections 

You can drag a Chopper selection from the Chopper to the track view. Release the mouse at the location where you want to insert the 
selection. 

Moving the insert position in the track view 

Click the Move Track View Cursor Left button ( ) and the Move Track View Cursor Right button ( ) to move the current insert 
position in the track view left/right by the increment length. 
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Saving Chopper selections as new files 

You can quickly create a new loop by making a selection in the Chopper and saving the selection as a new file. The file is added to your 
project as a new track. 

1.	 Make a selection in the Chopper. 

2.	 Right-click the selection and choose Chop to New Track or Chop to New Clip from the shortcut menu. The Chop to New dialog 
appears. 

Tip: You can also drag a selection from the Chopper to the track list. 

3.	 In the File name box, enter a name for the new file. 

4.	 From the Save as type box, choose a file format for the new file. 

5.	 From the Template drop-down list, choose a template for rendering the file, or click Custom to create custom rendering settings. 
For more information, see Creating custom rendering settings on page 49. 

6.	 Click Save. 

If you chopped to a new clip, a new clip is added to the original track. For more information, see Using clips with tracks on page 101. 

If you chopped to a new track, the file is added as a new track in the project. 

Using the Chopper with one-shots 

Selections of loops and Beatmapped files transfer flawlessly between the Chopper and the track view because the beats are clearly 
identified. However, one-shot files present more of a problem. You can use the following method to create accurate single-hit selections 
in one-shot files. 

1.	 Verify that the snapping options are active. If snapping is not active, choose Snapping from the Options menu and choose Enable 
from the submenu, or press F8. 

2.	 Verify that the Link Arrow to Selection button ( ) is selected. 

3.	 Create a selection of the desired musical length in the Chopper. For more information, see Creating selections of a specific musical 
length on page 97. 

4.	 From the Options menu, choose Snapping, and choose Enable from the submenu, or press F8 to toggle all snapping options off. 

5.	 Click the Link Arrow to Selection button ( ) to toggle the linking option off. You can now adjust the selection without changing 
the increment. 

6.	 Drag the middle of the increment arrow to reposition selection length in the Chopper. 

7.	 Use the mouse and/or keyboard to fine-tune the selection. The increment arrow does not change. 

8.	 Insert the desired selection data in the track view. For more information, see Inserting selections in the track view on page 99. 

9.	 Repeat steps six through eight to insert all desired selections in the track view. 
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Chapter 7 
Working with Tracks 

This chapter covers advanced track features including using clips, track effect chains, track envelopes, groove mapping™, 
and stereo panning modes. You’ll also learn more about track types, track properties, track folders, and rendering tracks 
to new files. 

Using clips with tracks 

In previous versions of ACID®, each track in your project corresponded to a single media file. If you’re comfortable with 
the track-equals-media model, this version of ACID can behave in much the same way: when you add media to your 

project, a new track is created for the media file. You can use the Draw and Paint tools to create events using the 
track’s media. 

In this version of ACID, you can now add multiple media files — or clips — to one track. Think of clips as the palette you 
can dip your paintbrush in when you paint on the timeline. For example, if you want to use one track for all the guitar 
loops in your project, you can create a single guitar track and add each guitar loop as a separate clip. When a track has 
multiple clips, the Draw and Paint tools create events using the active clip. 

A single audio track can contain any combination of loops, one-shots, or Beatmapped clips. MIDI tracks can contain only 
MIDI clips. For more information, see Understanding clip types on page 34. 

On a track with a single clip, events are always created using the track's media. 

On a track with multiple clips, each event can point to a different media file. In this example, each

event represents one of the track's three clips. 


The banner at the top of each event (i.e. Bongo 01, Bongo 02, and Bongo 03) displays the name of 

the event's source clip. 


Adding clips to tracks 

Drag a file from the Windows Explorer, Explorer Window, or Media Manager window to an existing track in the timeline to 
add a clip to the track and add an event where you drop the clip. The new clip is set as the active clip for creating events 

with the Draw or Paint tool. 

You can also record into a track to create a new clip. 

Notes: 

•	 You can drag single-stream MIDI files to a track to add clips. When you drag multistream MIDI files to a track, tracks and 
events are created. 

•	 You can also drag events across tracks. When you drag an event to a new track, the event is added to the new track where 
you drop it, and a clip is added to the track’s clip pool. 

•	 You can use the Chopper window to create new clips from the track’s existing media. For more information, see Using the 
Chopper on page 95. 

•	 If you want to add a clip to a track without creating an event, drag a file from the Windows Explorer, Explorer Window, or 
Media Manager window and drop it on the Paint Clip Selector button. 

• Hold Shift while clicking the Paint Clip Selector button to display the Open dialog, where you can add a new clip. 
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Setting the active clip and creating events 

It is simple to set active clips and create events with ACID. 

1.	 Click the Paint Clip Selector button in the track header. A menu is displayed to list the track’s current clips. 

2.	 Choose a clip from the menu. The selected clip is used for creating events with the Draw  or Paint tool. 

Copying clips and events across tracks 

In previous versions of ACID, you could only copy and paste events within the same track. Now you can use clips to copy events 
between tracks. 

Tips: 

• You can also use the Cut , Copy , and Paste  buttons in the Clip Pool tab in the Track Properties window to cut, copy, and 
paste clips across tracks. 

• Hold Ctrl while dragging an event to a different track to copy the event and clip to the destination track. 

1. Select the events you want to copy. 

Tip: Hold Ctrl or Shift to select multiple events. You can select multiple events that use different clips. 

2.	 Click to position the cursor where you want to paste the events. 

3.	 Click the track header of the track where you want to paste the contents of the clipboard. 

4.	 From the Edit menu, choose Paste. Events are added at the cursor position, and clips are added to the track for the pasted events 
as needed. 

If you copy an event from track 1. .. . . . and paste it into track the same track, a new event is created on the 
same track. No clips are created. 

If you copy an event from track 1. . . ... and paste it into track 2, the event from track 1 is added to track 2, and a new 
clip is created for the new event. 
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If you copy events from tracks 1 and 3. . . .. . and paste them into track 2, the event from track 1 is added to track 2, and a new 
clip is created for the new event. A new track is created for the event from track 3. 

Copying clips across tracks without copying events 

You can use the Cut , Copy , and Paste buttons on the audio Track Properties or MIDI Track Properties window to cut, copy, 
and paste clips across tracks: 

1. Click the Paint Clip Selector button on the track header and select Clip Pool. 

2. In the Clip Pool, select the clip you want to cut or copy, and then click Cut or Copy. 

3. Click the Paint Clip Selector button in the track header where you want to paste clips, and then choose Clip Pool from the menu. 

4. Click the Paste button in the Clip Pool. 

Creating new MIDI clips 

Right-click a MIDI clip and choose Copy to New Clip from the shortcut menu to copy the selected clip to a new, separate clip. Copying 
an event to a new clip allows you to edit a single MIDI event without affecting other events that use the same clip. 

Right-click a MIDI track and choose Create Empty Clip from the shortcut menu to create a new, empty clip and set it as the track’s active 
clip. 

Tip: You can also use the Chopper window to create new clips from a track’s existing media. For more information, see Working in the 
Chopper window on page 95. 

Previewing clips 

Select a clip in the clip list, and then click the Play button  to play it. Click the Stop button  to stop playback. 

Changing an event’s clip 

1. Select the events you want to change. 

2. Right-click a selected event and choose Event Clip. The track’s current clips are displayed in a submenu. 

3. Choose the clip you want to use from the submenu. All selected events are updated to use the new clip. 

Tip: Press C or Shift+C to change the selected event's clip by cycling forward or backward through the track's clips. 
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Pitch shifting audio clips 

You can use the Clip Properties window to pitch-shift all events on the track associated with a specific clip. For more information, see 
Adjusting pitch shift on page 117. 

Using the Clip Pool to manage clips 

You can use the Clip Pool to organize each track's media. In the track header, click the Paint Clip Selector button and then choose Clip 
Pool. 

The clip list displays each track's clips, the number of times the clip is used on the track, and the path to the media file. 

Clear a clip's check box to remove it from the Paint Clip Selector menu without removing it from the track. To make the clip available 
again, select the check box. 

To set the active clip, click the space next to a clip's check box. The  icon indicates which clip will be used for creating events with the 

Draw or Paint tool.


Click the Remove Unused Clips
 button to remove all unused clips from the track. 

Tip: To remove the unused media from your project, choose Remove All Unused Clips from the Tools menu. 

Click the Open  button to display the Open dialog, where you can browse to clips you want to add to the track. 

Select a clip in the Clip Pool and click the Delete button. Only clips with a Use Count of 0 can be deleted. 

You can use the Cut , Copy , and Paste  buttons in the Clip Pool window to cut, copy, and paste clips across tracks. 

Selecting events that use a specified clip 

Right-click an event and choose Select Events Using This Event's Clip from the shortcut menu to select all events on the track that use 
the same clip as the selected event. 

Right-click the timeline, choose Select Events Using Clip, and then choose a clip from the submenu to select all events on the track that 
use the specified clip. 

Changing an event’s clip settings 

To change settings for an event’s clip, right-click an event in the timeline, choose Event Clip from the shortcut menu, and then choose a 

command from the submenu: 

Tip: Editing a clip affects all events on the track that use the clip. 

Command 
Rename 

Description 
Allows you to type a new name for the selected event's clip. 

Color 
Loop 

The new name is displayed in the Clip Pool and in the event when Event Information is selected on the View menu. 
Choose a color from the submenu to change the color used to draw a clip's events. 
Select this command if you want a MIDI clip to repeat when painted on the timeline. 

When the command is not selected, the MIDI clip will be treated as a one-shot. 

For more information about ACID types, please see Understanding clip types on page 34. 

Note: This command is available only for MIDI clips. 

Use Original 
Tempo 

Sets the project tempo to match the clip's original tempo. 
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Command 
Edit in Audio 
Editor 

Description 
Opens the clip's media in your selected audio editor. 

After you have edited and saved the file, ACID automatically detects the updated file and updates the events in the project. 
However, if you change the media file’s name or location (by using Save As), you must import the edited (new) file into your 
project. 

Note: When you edit a clip in an external editor, audio, MIDI, and external control hardware is released regardless of the 
Close audio and MIDI ports when ACID is not the active application check box setting (for more information, see Using 
the General tab on page 254.). The ports are re-enabled when focus is restored to ACID. 

Edit Source 
Project 

If a clip's media was created from an ACID project and rendered with the project path reference in the file, this command 
opens the source project in a new ACID window. 

If you render the edited file using the same file name and location as the track's original media, your project will automatically 
be updated to use the latest rendered media file. 

Note: This command is available only for audio clips. 

Add to Groove 
Pool 

Makes the selected clip available in the Groove Pool so you can apply its timing to other tracks. 

Notes: 

•Groove cloning can extract grooves from loop tracks only. 

•This command is available only for audio clips. 

Invert Phase 

Normalize 

Channels 

Reverses the phase of the sound data. Although inverting data does not make an audible difference in a single file, it can 
prevent phase cancellation when mixing or crossfading audio signals. 

Note: This command is available only for audio clips. 

Maximizes a clip's volume without clipping. 

The Normalize peak level setting on the Audio tab of the Preferences dialog sets the level to which the largest peak in the clip 
will be normalized. 

Note: This command is available only for audio clips. 

Specifies how to treat the channels in a clip: 
Both Treats the clip as a normal stereo file. 

Note: This command is available only for audio clips. 

Clip List Displays the track's available clips. Choose a clip from the menu to set the event's clip. 
Next Clip Updates the event's contents to use the next clip in the clip list. 

Tip: Select an event and press C to switch to the next clip quickly. 

Previous Clip Updates the event's contents to use the previous clip in the clip list. 

Tip: Select an event and press Shift+C to switch to the previous clip quickly. 

Left Only Creates a mono clip using only the left channel of your media file. 
Right Only Creates a mono clip using only the right channel of your media file. 
Combine Creates a mono clip by mixing the channels of your media file. After mixing the channels, the amplitude is 

divided by two to prevent clipping. 
Swap Exchanges the right and left channels in a stereo file. 
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Using bus tracks 

From the View menu, choose Show Bus Tracks to toggle the display of bus tracks at the bottom of the track view. A bus track exists for 
each bus, input bus, assignable effects chain, and soft synth in your project. 

You can use bus tracks to automate volume, panning, and effect parameters using envelopes. If a bus track has envelopes applied, its 
icon will include a fader  in the bus track and in the Mixing Console window. 

For example, if you wanted to adjust the volume of all tracks in your project, you could apply a volume envelope to the Master bus track 
instead of adjusting each track individually. 

Adding envelopes to a bus track 

Adding volume, panning, and effect automation envelopes to a bus track is just like adding an envelope to a standard track. For more 
information, see Working with track envelopes on page 142. 

Adding effects to a bus track 

1. Click the Bus FX button ( ) in the bus track header to add or edit bus effects. If there are no effects on the bus, the button is 
displayed in gray, and clicking this button displays the Plug-In Chooser. If a bus already has effects assigned, clicking this button 
displays the Audio Plug-In window. 

2. Select each plug-in you want to add and click the Add button or browse to a packaged effects chain. 

Tip: To reorder the plug-ins within the chain, drag a plug-in button to a new location or click the Shift Plug-In Left ( ) or Shift Plug in 

Right ( ) buttons. 

3. Once you have added all of the plug-ins and specified the plug-in chain order, click on the OK button to close the Plug-In Chooser 
and return to the Audio Plug-In window. 

4. Adjust the settings for the effects. For more information about using specific plug-ins, click the Plug-In Help button ( ). 

Muting a bus track 

Click the Mute button ( ) to prevent a bus track from being played in the mix. Click the Mute button on additional tracks to add them 
to the mute group. To unmute a track, click the Mute button again. 

Muting or unmuting a bus track 

Deselect the Automation Settings button ( ) to toggle trim mode. 

Click the Mute button ( ). 

When you have a group of tracks muted, hold Ctrl while clicking the Mute button on an unmuted track to remove all other tracks from 
the mute group. Hold Ctrl while clicking the Mute button on a muted track to reset all Mute buttons. 

Adjusting mute automation 

When you select the Automation Settings button ( ), the mute button is displayed as a , and you can use the control to edit 
volume automation. 

Soloing a bus track 

Click the Solo button ( ) to solo all selected audio bus tracks. Click the Solo button on additional tracks to add them to the solo group. 
To remove a track from the solo group, click its Solo button again.


Hold Ctrl while clicking a Solo button to solo a single track and remove all other tracks from the solo group.
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Monitoring bus track output levels 

During playback, a responsive meter is displayed in the bus track header to monitor the bus’s output. 

Horizontal meters 

Vertical meters 
(Right-click and 
choose Use Vertical 
Meters from the 
shortcut menu) 

When clipping is detected, the peak meter displays a red Clip indicator. 

Right-click the meters and choose a command from the shortcut menu to adjust the display of the meters. This shortcut menu allows 
you to reset clip indicators, choose a display scale, toggle vertical display, or turn output meters off. 

Automating VSTi parameters in soft synth bus tracks 

You can use the soft synth bus track to control parameter automation for VST instruments using envelopes. For more information, see 
Automating VSTi parameters on page 211. 

Resizing bus tracks 

You can drag the horizontal splitter between the track list and bus tracks to increase or decrease the space allocated to bus tracks. 
Perform any of the following actions to resize individual bus tracks: 

•	 Drag a bus track’s bottom border to set its height. 

• 	Click  Minimize  to minimize a track vertically. 

• 	Click  Maximize  to zoom in vertically so a bus track fills the lower portion of the timeline. 

•	 After minimizing or maximizing a bus track, click the Minimize or Maximize button again to return a bus track to its previous 
height. 

•	 Press Ctrl+Shift+Up/Down Arrow when the bus track area has focus to resize all bus tracks at once. 
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Using track effects 

ACID allows you to use DirectX® and VST plug-ins at the track level. Track-level plug-ins process everything on the selected track.


You can create plug-in chains, adjust the order of plug-ins on a chain, bypass plug-ins, remove plug-ins, and save frequently used chains 


as presets.


Tips: 

•	 If the VST plug-in you want to use isn't displayed in the Plug-In Chooser, you can use the VST Effects tab in the Preferences dialog to add the 
plug-in's folder and then click the Refresh button to scan for plug-ins. For more information, see Using the Video tab on page 261. 

•	 If the DirectX plug-in you want to use isn't displayed in the Plug-In Chooser, hold Ctrl+Shift while restarting ACID and then select the 

Delete all cached application data check box to reset your preferences and rescan for DirectX plug-ins.


Using track effects 

The Sony Track EQ plug-in effect is assigned to all tracks by default; however, it does not use CPU power or affect the sound until you 
adjust its settings. You can remove the EQ plug-in if desired. For more information, see Removing plug-ins from chains on page 110. 

In addition, you can use effect plug-ins in the Mixing Console window by applying effect chains to busses or soft synths, or by creating 
assignable effect chains and routing tracks to them. For more information, see Using the Mixing Console on page 151. 

Important: Be aware that using non-in-place plug-ins (such as Time Stretch, Pitch-Shift without preserving duration, and some 

Vibrato settings) will cause audio to play out of synchronization with the waveform display in the timeline and with other tracks. If an 


effects chain includes non-in-place plug-ins, the effects chain icon will be displayed as a 


When using ACID as a ReWire device, any effects chain that includes non-in-place plug-ins will be automatically bypassed to prevent


synchronization problems with the ReWire mixer application. The effects chain icon will be displayed as a 
 . Apply the plug-ins within 
the ReWire mixer application. 

Creating or adding to track plug-in chains 

A plug-in chain can contain one or more plug-ins. When you add multiple plug-ins, you may set the processing sequence that the 
track’s events go through when the project is played back. Moreover, the plug-ins that you add to the chain may be added more than 
once. For example, a plug-in chain could look something like this: Track EQ, Track Compressor, Track EQ, and Track Noise Gate. 

After you create a plug-in chain, the track’s events are processed by each plug-in in its respective order on the chain. The events’ effects 
processing is cumulative, so in some cases, you may want to rearrange the order of plug-ins to achieve the desired sound. For more 
information, see Arranging plug-in chain order on page 109. 

1. Click the Track FX button ( ) in the track header. The Audio Plug-In window appears. 

2. Click the Edit Chain button ( ) to display the Plug-In Chooser dialog. 

Chain area 

. 
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3.	 Select the plug-ins that you want to add. There are three ways to add a plug-in to the chain: 

•	 Double-click the plug-in. 

•	 Drag the plug-in to the chain area. 

•	 Select the plug-in and click the Add button. 

4.	 Rearrange the order of plug-ins as needed by dragging plug-ins to different locations in the chain or by selecting a plug-in and 
clicking the Shift Plug-In Left (  ) and  Shift Plug-In Right ( ) buttons. 

5.	 Once you have added all of the plug-ins and specified the plug-in chain order, click on the OK button to close the Plug-In Chooser 
and return to the Audio Plug-In window. 

6.	 Adjust the settings for the effects. For more information about using specific plug-ins, click the Plug-In Help button ( ).. 

Tips: 

• You can save an effect’s parameters as a preset to be used in other projects. To save a preset, enter a name in the Preset box and click the 
Save Preset ( ) button. 

• You can also use the Insert FX control region in the Mixing Console window to add, remove, or configure track effects. For more 
information, see Adding or editing track (insert) effects on page 156. 

7. Click the Close button ( ) to close the Audio Plug-In window. 


You can use a track effect chain as a default for all new tracks you create. For more information, see Setting default track properties on page 

252. 

Automating plug-in parameters 

You can automate the parameters of certain plug-ins by adding envelopes to the track. For more information, see Adding or removing 
track effect automation on page 140. 

Arranging plug-in chain order 

The plug-ins are cumulative during playback. For example, when the track’s signal passes through the EQ, it carries the EQ’s settings as 
it passes through the compression plug-in, then the signal carries both those plug-in settings to the next plug-in. 

Because of this cumulative effect, you may need to arrange plug-ins in a certain order so that one plug-in’s processing does not 
adversely affect the next plug-in on the chain. There is no right or wrong way to order plug-ins, although some plug-ins work better 
when they follow another. However, the plug-in order in the chain is strictly based on your preferences and desired output. 

1.	 Click the Track FX button ( ). The Audio Plug-In window appears. 

2.	 There are three ways to arrange plug-ins in your chain: 

•	 Drag the plug-in to a new location in the chain. 

•	 Right-click the plug-in and choose Move Left or Move Right from the shortcut menu. 

•	 Click the plug-in and then click the Shift Plug-In Left (  ) and  Shift Plug-In Right ( ) buttons. 

3.	 Click the Close button ( ) to close the Audio Plug-In window. 

Bypassing plug-ins in a chain 

You can bypass a plug-in without removing it from the chain by clearing the check box for the plug-in. Alternately, right-click the plug-
in and choose Bypass from the shortcut menu. 

Tip: To bypass (or re-enable) all plug-ins in a chain, right-click the Track FX button ( ) and choose Bypass All or Enable All. 
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Bypassing effect automation 

For plug-in chains that include effect automation using envelopes, you can bypass automation by clicking the Bypass FX Automation 

button ( ) on the Audio Plug-In window. This does not remove any effect automation envelopes from the track, but rather 
temporarily bypasses processing of the effect automation. You can toggle this button on and off to hear the difference between the 
plug-in chain as a standard (non-automated) effect versus an automated effect. 

Removing plug-ins from chains 

1.	 Click the Track FX button ( ). The Audio Plug-In window appears. 

2.	 Right-click the plug-in and choose Remove from the shortcut menu, or click the Remove Selected Plug-In button ( ). 

3.	 Click the Close button ( ) to close the Audio Plug-In window. 

Tip: To remove all plug-ins in a chain, right-click the Track FX button ( ) and choose Delete All. 

Removing or bypassing all effects on tracks 

You can clear a track of all effects by right-clicking the Track FX button ( ) and choosing Delete All from the shortcut menu. 

You can bypass all of a track’s effects without removing them by right-clicking the Track FX button ( ) and choosing Bypass All from 

the shortcut menu. To apply them again, right-click the Track FX button ( ) and choose Enable All from the shortcut menu. 

Routing tracks to an assignable effects chain 

Routing tracks to an assignable effects chain allows you to assign multiple tracks to a plug-in chain. 

In order to route tracks to an assignable effects chain, you must first add an assignable effects chain to your project. For more 
information, see The Mixing Console toolbar on page 151. 

1.	 Click the label on the multipurpose slider label and choose the desired assignable effects chain from the submenu. The label 
changes to reflect the name of the assignable effects. 

Tip: If you can’t see the multipurpose slider, drag the bottom edge of the track header to increase its height. 

2.	 Drag the fader to adjust the level of the track sent to the assignable effects chain. 

If you set the Dry Out faders in your effects chain to -inf, you can adjust the wet/dry balance using the Volume and FX settings on 
the multipurpose slider: Volume will adjust the dry signal and FX will control the effect signals. 
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You can also use the Sends control region in the Mixing Console window to configure bus sends. For more information, see Using audio 
and MIDI track channel strips on page 155. 

Tips: 

•	 FX sends are post-volume by default. To change to pre-volume, right-click the fader handle and choose Pre Volume from the shortcut 
menu. 

•	 If you want to apply track panning (including pan position and panning mode) to FX sends, right-click the FX fader and choose Link to 
Main Track Pan from the shortcut menu. 

•	 When Link to Main Track Pan is not selected, the track sends a center-panned stereo signal using the track's current panning mode. 
•	 Select the Use legacy track send gain check box on the Audio page of the Preferences dialog if you want to configure audio track sends 

to behave as they did in ACID 6.0 and earlier. When the check box is selected, you can open projects created with earlier versions of ACID 
and be assured they will sound the same as they did in earlier versions of ACID. For more information, see Using the Audio tab on page 
255. 

Assigning tracks to busses 

Assigning tracks to busses allows you to apply settings to a series of tracks or route tracks to a hardware output. 

For example, if you wanted to apply the same three effects to several tracks, you could apply the effects to a bus and assign the tracks to 
that bus. If you wanted to send several tracks to a single hardware output, you could assign the tracks to a bus and then route the bus to 
a hardware output. 

Assigning a track to a bus 

The bus button in a track header chooses the track’s primary output. Assigning tracks to busses is especially useful for creating submixes 
that allow you to adjust the levels of multiple tracks at once or apply an effect to multiple tracks. 

1. Click the bus button on the track. 

The button is displayed as a  when the track is routed to the master bus, and the bus letter is displayed ( , , and so on) when 
a track is routed to another bus. 

2. Select the desired bus from the submenu. The Bus button changes to display the selected bus. 

Notes: 

•	 If the Bus button does not appear on the track, then you have not specified more than one bus in your project settings. For more 

information, see The Mixing Console toolbar on page 151.


•	 If you want to send a track to multiple outputs — for creating cue mixes or effects sends — you can use the multipurpose fader to control 
the level of the track sent to each bus or assignable effects chain. 

•	 Bus sends are pre-volume by default. In Post Volume mode, the following settings are applied to the track before it is sent to the bus: track 
volume, track volume envelopes, track panning, and track panning envelopes. To change to post-volume, right click the fader handle and 
choose Post Volume from the shortcut menu. 
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Adjusting a bus send level 

1.	 Click the label on the multipurpose slider and choose the desired bus from the menu. The label changes to reflect the name of the 
bus. 

Tip: If you can’t see the multipurpose slider, drag the bottom edge of the track header to increase its height. 

2.	 Drag the fader to adjust the level of the track sent to the bus. 

You can also use the Sends control region in the Mixing console window to configure bus sends. For more information, see Using audio 
and MIDI track channel strips on page 155. 

Tips: 

•	 Bus sends are pre-volume (and pre-mute) by default. When bus sends are pre-volume, you can create a cue mix that is independent of 
your main mix. To change to post-volume, right-click the bus fader and choose Post Volume from the shortcut menu. 

•	 If you want to apply track panning to bus sends (including pan position and panning mode), right click the bus fader and choose Link to 
Main Track Pan from the shortcut menu. 

•	 When Link to Main Track Pan is not selected, the track sends a center-panned stereo signal using the track's current panning mode. 
•	 Select the Use legacy track send gain check box on the Audio page of the Preferences dialog if you want to configure audio track sends 

to behave as they did in ACID 6.0 and earlier. When the check box is selected, you can open projects created with earlier versions of ACID 
and be assured they will sound the same as they did in earlier versions of ACID. For more information, see Using the Audio tab on page 
255. 

Using track automation envelopes 

Track envelopes allow you to control volume, panning, assignable effect send levels, bus send levels, and effect parameters (for effects 
that support automation) for a specific track. You can distinguish the various envelopes by their color. 

For more information, see Using Automation on page 137. 
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Choosing stereo pan types 

When you pan a track using the pan slider or a pan envelope, you can choose among several pan types to determine how the track is 
panned. 

Note: When applying stereo pan types, a monaural track is interpreted as a stereo track with the same data in both channels. 

1.	 Click the pan slider label and choose a pan type from the submenu: 

• 	The Add Channels pan type is most useful for panning stereo source material. This pan type makes the stereo image appear 
to move as a unit between the speakers. As the fader is moved from the center to a side, more and more of the signal from the 
opposite side is folded into the side you are panning towards, until at the extreme, both channels are fed at full intensity into 
a single channel. This pan type uses a linear panning curve. 

• 	The  Balance pan type is most useful for adjusting the relative signal levels of the right and left channels in stereo source 
material. In this pan type, moving from the center to a side, the opposite side starts at a base dB level (either 0 dB, -3 dB, or ­
6 dB) and decays to no signal level. The signal in the side you are panning towards starts at the base dB level (either 0 dB, -3 dB, 
or -6 dB) and increases to 0 dB. When the stereo source is panned fully to one side, that side plays at 0 dB while the other side 
provides no signal at all. This pan type uses a linear panning curve. 

• 	The  Constant Power pan type is most useful for panning mono source material. As you move the fader from side to side, this 
pan type creates the illusion of the source moving around the listener from one side to the other, in a semi-circle. This pan 
type uses the constant-power panning curve. 

• 	The  Film pan type allows you to pan between pairs of adjacent speakers using a constant power model. This mode is 
optimized for theater-style speaker placement. In stereo projects, Film mode functions identically to Constant Power. As you 
drag the pan point to the center speaker, the sound becomes diffused through the front and rear speakers. When the track is 
panned fully to the center speaker, there is no output from the front and rear speakers. Dragging the pan point to the center of 
the surround panner sends the signal to all speakers. 

You can choose a pan type as a default for all new tracks you create. For more information, see Setting default track properties on page 252. 

Using the Beatmapper 

When a long file is added to a project, the Beatmapper Wizard starts to allow you to add tempo information to the file. 

Notes: 

•	 The Beatmapper Wizard is started by default for files longer than 30 seconds. Use the Open files as loops if between (seconds) setting 
on the Audio tab of the Preferences dialog to determine the file length. 

•	 Support for multitempo clips is available for clips that are recorded or rendered in ACID or by adding Beatmap markers on the Clip 
Properties dialog. 

1.	 Perform either of the following actions to start the Beatmapper Wizard: 

•	 Add a long file to your project. If tempo information is not detected in the file, the Beatmapper Wizard starts. 

Select the Yes radio button and click Next to detect measures and downbeats. The file will be able to stretch/compress with 
the project's tempo. 

Select the No radio button and click Finish if you want to add the file as a one-shot. The file will maintain its original length 
regardless of the project tempo.


—or—


•	 Open the Clip Properties window for a Beatmapped track, switch to the Stretch tab, and click the Beatmapper Wizard button. 

2.	 The Beatmapper Wizard will draw the file's waveform and place a marker to locate the first beat of the first measure. 

Click the Play button ( ) to verify the marker’s position. If the marker is positioned on a downbeat, click Next. Otherwise, drag the 
marker to the appropriate location and click Next. 

Tip: Click the Reset button to set the downbeat marker to its original position. 

3. The Beatmapper Wizard will draw the file's waveform and place a region to indicate the length of the first measure. 
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Click the Play button ( ) to verify the measure’s length. If the region is positioned correctly, click Next. Otherwise, drag the ends 
of the loop region to the appropriate locations and click Next. 

•	 Select the Metronome check box if you want to play a click track at the detected tempo. 

• 	Click the  Halve Selection (  ) or  Double Selection ( ) buttons or drag the ends of the loop region to adjust the measure 
length. 

4.	 The waveform is displayed with markers at the end of the measure. Drag the Measure slider to scroll through the song, and click 
the Play button ( ) to verify that the detected measure length is accurate throughout the song. 

The Beatmapper Wizard uses a single measure length for the entire song. You can drag the end of the measure selection to change 
the measure's length. However, changing the length will affect the entire song; if adjusting the last measure of the song causes the 
first measure to be incorrect, the downbeat may not be positioned correctly or the song's tempo may not be consistent enough for 
the Beatmapper Wizard. 

5.	 Click Next when the measure lengths are correct. Tempo information is added to your file. 

6.	 Select the desired check boxes: 

•	 Select the Change project tempo to match Beatmapped track check box if you want to set your project tempo to match the 
tempo calculated by the Beatmapper Wizard. Selecting the check box ensures that your Beatmapped track plays at its original 
tempo. 

•	 Select the Preserve pitch of the Beatmapped track when tempo changes check box if you want your track to maintain its 
pitch when your project tempo changes. Clear the check box to create DJ-style remixes: the track's pitch will raise and lower 
with tempo changes as it would when a turntable's speed is manipulated. 

•	 Select the Save Beatmapper information with file check box if you want to save tempo information in the file. When the 
check box is selected, you can add the file to other ACID projects without starting the Beatmapper Wizard every time. 

Note: If the information cannot be saved to your media file, an .sfl file will be created (using the same base name as your media file) to 
store tempo information. If you move your media file, you should also move its associated .sfl file. 

7. .Click Finish to close the Beatmapper Wizard. 

Notes: 

• To paint the entire track, select the Paint tool ( ) and Ctrl+click in the track. 
• If a track has an intro before its downbeat, the intro will not be included when you draw or paint events. Drag the left edge of the event to 

expose the intro. 

Understanding stretching properties 

All loops on the ACID installation disc (as well as all loop collection CD-ROMs) contain stretching properties. This means that tempo and 
key information is stored in the loops, allowing the application to accurately perform its time stretching/compressing and pitch-shifting 
functions on these loops when placed in a project. 

Keep in mind that you do not need to designate stretching properties for loops that you create for ACID projects. The application 
typically makes an accurate estimate regarding the loop file’s tempo. In addition, you can temporarily assign a root note to the file to 
allow it to be transposed to the project’s key. However, when creating custom loops for use in multiple projects, you should define 
stretching properties. 

You can set the stretching properties for loops and Beatmapped clips. For more information, see Adjusting stretching properties for loops 
on page 118. 
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Configuring track properties 

From the View menu, choose Track Properties to display the Track Properties window. The contents of the Track Properties window 
reflect the currently selected audio or MIDI track. 

Double-click a 
clip to modify clip 
properties 

If you want to edit media properties and stretching information, use the Clip Properties window. 

Audio track properties 

For audio tracks, the Track Properties window displays the Clip Pool. The Clip Pool is used to organize each track's media. 

For more information, see Using the Clip Pool to manage clips on page 104. 

MIDI track properties 

You can use the Output Settings tab to adjust MIDI controllers, voices, and drum maps. You can use the Input Filters tab to set up MIDI 
message, velocity, or quantize filters. You can use the Clip Pool tab to organize each track's media and enable looped or one-shot 
drawing for MIDI events. By right-clicking a clip in the Clip Pool, you may access the Clip Properties window to use the Piano Roll Editor 
and List Editor tabs. The Piano Roll Editor and List Editor tabs allow you to view and edit all MIDI data. 

Configuring clip properties 

1. Double-click a track icon (such as ) to display the Track Properties window and the clips used on the track. 

Note: This section addresses clip properties for non-MIDI clips. For information on MIDI clip properties, see Processing and filtering MIDI 
events on page 198. 

2. Double-click a clip to open the Clip Properties window. 

Tip: You can also display the Clip Properties window using either of the following methods: 

• From the View menu, choose Clip Properties. 
• Right-click a clip in the timeline and choose Clip Properties from the shortcut menu. 

The contents of the Clip Properties window will change to display properties for the currently selected clip in the timeline. 
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Notes: 

•	 If you adjust a clip's properties and do not click the Save button ( ), the new properties are saved in your ACID project only (the media 
file is not modified). 

•	 If you adjust a clip's properties and click the Save button ( ), the modified properties are embedded in the media file if possible (you will 
be prompted to save to a different file if necessary). 

•	 When you load a project, the clip properties saved in the ACID project are displayed first. If clip properties have been edited since the 

project was saved or if the clip was modified in an external editor, you can click the Reload button 
 to load the properties saved 
in the file. 

Managing a track’s clips 

Each track in your ACID project can contain multiple, distinct media files, called clips. Use the Clip Pool tab in the Track Properties 
window to add, remove, and preview clips. For more information, see Using clips with tracks on page 101. 

Adjusting general clip properties 

The General tab displays information about the file associated with a track and allows you to change the ACID type, apply pitch shifting 
to all events on the track that use the same clip, and adjust time-stretching for Beatmapped clips. 
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Changing clip type


Choose a setting from the ACID type drop-down list to change the way the clip is handled.


Track Type Description 
Loop When Loop is selected, the clip is transposed to the project key and stretches to fit 

the project tempo. Loops can be drawn across the track and will repeat end-to-end. 
One-Shot When One-Shot is selected, the clip is streamed from the hard disk rather than being 

stored in RAM. One-shot files do not change tempo with the rest of the loops and are 
not transposed to the project key. 

The Stretch tab is not available when One-Shot is selected. 
Beatmapped When a file that is longer than 30 seconds is added to a project, the Beatmapper 

Wizard starts to allow you to add tempo information to the file. 

You cannot choose Beatmapped for very short media files. A file must be at least one 
measure long at 300 BPM to be Beatmapped. 

Use the Open files as loops if between (seconds) setting on the Audio tab of the 
Preferences dialog to determine the file length. 

Adjusting pitch shift


Enter a value in the Pitch shift box (or use the spinner control) to adjust the pitch of all events that use the same clip.


Note: Track pitch shifting is not saved to the media file when you click the Save button ( ). 

Adjusting time stretching (Beatmapped tracks only) 

ACID provides two time-stretching methods for Beatmapped tracks: Classic and élastique. Classic is the standard time-stretch method 
used by ACID. 

1.	 Select the Preserve pitch when stretching check box if you want your track to maintain its pitch when your project tempo 
changes. When the check box is cleared, the clip’s pitch will raise and lower with tempo changes. When the check box is cleared, 
you cannot change the pitch of a Beatmapped event. 

2.	 Choose a setting from the Method drop-down list to determine the time-stretch method to use. 

•	 Classic is the standard time-stretch method used by ACID. 

•	 The élastique method uses technology from zplane.development and provides enhanced real-time time stretching and pitch-
shifting capabilities. The élastique method also allows you to preserve and shift a clip’s formants, which are the characteristic 
resonant frequencies of a sound. 

Note: If you experience gapping during playback while using the élastique stretching methods, you may need to switch to the Classic 
time-stretch method. 

3. Choose a setting from the Mode drop-down list to choose the stretching method best suited to your media. 

Tip: The élastique Pro mode provides the highest quality stretching but requires more RAM usage and CPU power. The élastique 
Efficient mode uses fewer resources while still producing great time-stretching quality for polyphonic audio. The Soloist (Monophonic) 
and Soloist (Speech) provide good quality for monophonic audio with little effect on system resources. 

4.	 Select the Preserve formants when stretching check box if you want your track to maintain its characteristic resonance when your 
project tempo changes. Formant preservation is most often used to avoid vocal performances that sound as if they’ve been sped 
up (sometimes referred to as the “chipmunk effect”). 

This option is only available for élastique Pro and Soloist (Monophonic) modes. 
WORKING WITH TRACKS | 117 



5.	 Enter a value in the Formant Shift (semitones) box (or use the spinner control) to adjust the formants of all events that use the 
same clip. Formant shifting can be used to deepen the tone of a vocal performance without changing the pitch. 

For élastique Pro, this amount represents the number of semitones to shift the timbre in addition to the offset required to 
compensate for any pitch shifting. For example, a setting of 0.000 applies formant correction with no additional shifting, while a 
setting of -7.000 will apply formant correction and deepen a sound by 7 semitones. 

This option is only available when the Preserve formants when stretching check box is selected. 

Adjusting stretching properties for loops 

The Stretch tab in the Clip Properties window allows you to specify how pitch shifting and time stretching is handled for loop tracks. 

Beat anchor Beat marker 

Stretch marker Combination beat/ 
stretch marker 

Tip: Click the Redetect Beats button to apply the ACID beat-detection algorithm to existing media. 

You'll notice that the Stretch tab looks similar to the Groove Editor window. Both windows contain beat anchors  and markers; 
however, the markers on these windows perform complementary functions: 

•	 On the Stretch tab of the Clip Properties window, the beat markers indicate beats in the media, and the beat anchors indicate 
the adjustment that is required to quantize the media to straight time before applying a new groove. 

•	 In the Groove Editor window, a beat anchor represents the beat that will be adjusted, and a groove marker  represents the 
point in time when that beat will be played when the groove is applied. A groove marker  can occur before or after the beat 
anchor. A line connects a groove marker to its associated beat anchor. 

If you want to hear the results of editing beat anchors and markers, select the Play Quantized button ( ) at the bottom of the Clip 
Properties window and use the Clip Properties transport controls to preview the loop. Playing the clip in Play Quantized mode 

demonstrates how the track sounds when the Quantize to Straight groove is applied. Click the Play button ( ) to hear the original 
loop. 
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After you have edited a clip’s properties, click the Save button ( ) to embed ACID information in the file. 

Notes: 

•	 To save to a different file, click the Save File As button ( ). 
•	 If you save stretching properties to a new file, the changes will also be applied to the current clip and saved with the ACID project; the 

changes are not saved to the original file. 
•	 If you edit a file in another audio-editing program, it is possible that the ACID data will be removed. Simply edit the settings on the Stretch 

tab to optimize the file again. 

The following table describes the settings on the Stretch tab for loop files. 

Item Description 

Root note Choose a note from the drop-down list to set the base note for loops that you want to 
conform to the project key. 

If you do not want a clip transposed to the project key (a clip that contains a drum sample, 
for example) choose Don’t transpose. 

Number of beats Choose a setting from the drop-down list to specify the length of the original file. Selecting a 
value that does not match the actual file causes the loop to play at a different speed. For 
example, specifying a length of 8 beats for a 4-beat loop causes the loop to play at half-
speed at any given tempo. 

You can misinform the software regarding the beat length of a loop for creative ends. For 
more information, see Playing double time/half time on page 299. 

Stretching method Stretching properties determine how time compression and expansion is performed on 
audio events. If you hear audio anomalies due to time compression, try editing the 
stretching properties of the track. 

Looping segments is the default stretching method, and it works well with most types of 
material. The clip media is divided into sections that are crossfaded, and some sections may 
be looped if necessary to achieve the necessary length. 

Combination beat/stretch markers  and stretch-only markers  represent the divisions in 
the clip media. 

Choose Nonlooping segments for sustaining material such as synthesizer pads and held 
notes. The clip media is divided into sections that are crossfaded, but no sections are 
looped. 

Combination beat/stretch markers  and stretch-only markers  represent the divisions in 
the clip media. 

Choose Pitch shift segments to shift the pitch of the clip to adjust for increases or decreases 
in tempo. Using this option, you can eliminate some of the problems that occur with 
extreme tempo changes just create new sounds from existing loops. For example, if you 
have slowed the project tempo down and hear echo artifacts, choosing Pitch shift 
segments can eliminate these artifacts. 

Combination beat/stretch markers  and stretch-only markers  represent the divisions in 
the clip media. 

Choose Sliced segments for material such as drum loops where silence exists between 
notes. Instead of crossfading the segments, silence is added between beats to reduce 
warbling or other artifacts. 

When you set the stretching method to Sliced segments, beat markers represent 
divisions in the clip media where silence will be inserted to accomplish stretching. Stretch-

only markers are not used in this mode and are displayed in gray . 

Transient sensitivity	 Type a value in the box or use the spinner control to adjust the sensitivity for beat detection. 
Higher settings increase sensitivity and lower settings decrease sensitivity. 

When you set the control to 100, beat markers ( ), stretch markers (  or ), and beat 


anchors ( ) are created for every transient.


As you decrease the setting, markers are created for only strong transients.


Increasing this setting can be advantageous when working with audio that has complex 
rhythms. Lower settings are more suitable for synthesizer pads and other basic material. 
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Item Description 

Timing tightness Choose a setting from the drop-down list to specify the resolution for beat anchors ( ). For 
example, if you wanted to quantize beat anchors to sixteenth notes, choose Sixteenth 
Notes from the drop-down list. 

Quantized beat anchors are displayed as . If the you choose a resolution from the Timing 
tightness drop-down list that is too coarse, you'll notice that not all beat markers will be 
quantized. 

Stretch spacing Choose a setting from the drop-down list to specify how many stretch markers ( or ) will 
be displayed along the bottom of the waveform display. 
Audio that contains rapid notes such as drum rolls will benefit from setting the divisions at a 
smaller fraction of a beat. Slower-paced material, however, may actually suffer from high 
resolution. 

Redetect Beats Click to automatically detect the beats in the current file. Use this button to apply the ACID 
beat-detection algorithm to existing media. 

Adjusting stretch markers for loop clips 

Stretch markers correspond to subdivisions of beats in the audio file. These markers tell ACID where to divide the audio when 
performing time stretching to match tempo. Accurately detecting these beats is the key to making the time-compression process 

sound good.. 

Marker Description 

Indicates a stretch-only marker that was detected by the software or added manually. 

Indicates a combination beat/stretch marker. Each beat marker on the beat ruler corresponds to a combination beat/stretch marker on the timeline. 

If you want to convert a combination beat/stretch marker to a stretch-only marker, double-click the marker (or right-click the marker and choose 
Convert to Stretch Marker from the shortcut menu). 

Indicates an inactive stretch marker.


When Sliced segments is selected from the Stretching method drop-down list, beat markers 
  represent the points where silence 

will be inserted to accomplish stretching. Stretch-only markers  are not used in this mode and are displayed in gray. 

Tip: Use the Zoom In Time (Up) ( ) and Zoom Out Time (Down) ( ) buttons to change the magnification of the waveform. 

As a general rule, markers that are excessively close to each other may cause clicks in the audio. However, markers should not be more 
than one second apart, or pitch and echo artifacts may result. 

You can add, move, and delete stretch markers on the Stretch tab. If snapping is enabled, markers will snap to the current grid spacing. 

Moving stretch markers 

You can drag any marker to a new location. If you move a combination stretch/beat marker ( ), its associated beat marker ( ) will also be 
moved. 

Adding stretch markers 

Double-click the marker bar at the bottom of the waveform display to create a new marker. It is advantageous to add new markers if the 
software does not detect any quick subdivisions in beats. 

The biggest cause of audio artifacts due to time compression is a lack of beat detection. Make sure that you add markers anywhere the 
application fails to put one on a pronounced beat. 

Deleting markers 

You can remove a user-defined marker by right-clicking and choosing Delete from the shortcut menu (or by double-clicking a disabled 
marker). 

Double-click a combination stretch/beat marker  to remove the beat marker , or double-click a stretch marker  to delete it. 

Resetting stretch markers 

Click the Reload button ( ) to reset the markers to their last-saved positions. 
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Beat anchors and markers for loop clips 

Beat anchors ( ) correspond to musical beats on the ruler at the top of the waveform display. Beat markers ( ) correspond to points in 

time on the ruler at the bottom of the waveform display. Each beat marker corresponds to a combination beat/stretch marker ( ) on the 
timeline. If you want to convert a combination beat/stretch marker to a stretch-only marker, double-click the marker (or right-click the 
marker and choose Convert to Stretch Marker from the shortcut menu). 

Beat anchors and markers are used only when a groove is applied to a track. 

Offsets between beat anchors and beat markers indicate that the beat represented by an anchor is actually played at the marker 
position, which may occur before or after the beat. This mapping represents the difference required to remove an existing groove from 
a media file and return the media to straight machine time so that grooves can be applied accurately. 

If you want to hear the results of editing beat anchors and markers, select the Play Quantized button ( ) at the bottom of the Clip 
Properties window and use the Clip Properties transport controls to preview the loop. Playing the clip in Play Quantized mode 

demonstrates how the clip sounds when the Quantize to Straight groove is applied.


In most cases, you won’t need to edit beat anchors.


Tip: Use the Zoom In Time ( ) and Zoom Out Time ( ) buttons to change the magnification of the waveform. 

Important: Grooves are not applied using the markers on the Stretch tab. Autodetected stretch markers are used to establish a 
baseline for applying other grooves with the Groove Pool window and Groove tool. User-defined markers have no effect on groove 
quantization. 

You can add, move, and delete beat anchors and markers on the Stretch tab. 

Moving anchors 

You can drag beat anchors and stretch markers to map the sample data in the waveform to a specific beat: 

• Moving a beat marker ( ) changes the audio that will be played at a beat anchor location. 

• Moving a beat anchor ( ) changes the beat on which the audio represented by a stretch marker will be played. Beat anchors snap 
to the current grid spacing. Hold Shift while dragging to bypass snapping (press Shift after you click). 

Adding anchors 

Double-click the marker bar (above or above the beat ruler) to create a new anchor and marker. 

Deleting anchors 

You can remove a marker by right-clicking and choosing Delete from the shortcut menu (or by double-clicking it). 

Resetting beat anchors 

Right-click the beat marker bar and choose Reset All from the shortcut menu to reset the markers to their last-saved positions. 

Adjusting stretching properties for Beatmapped clips 

Use the Stretch tab in the Clip Properties window to quickly edit Beatmapper information for a clip without starting the Beatmapper 

Wizard. After you've edited a clip’s properties, click the Save button ( ) to embed ACID information in the file. 

Notes: 

• To save to a different file, click the Save File As button ( ). 
• If you save stretching properties to a new file, the changes will also be applied to the current clip and saved with the ACID project; the 

changes are not saved to the original file. 
• If you edit a file in another audio-editing program, it is possible that the ACID data will be removed. Simply edit the settings on the Stretch 

tab to optimize the file again. 
• Support for multitempo clips is available for clips that are recorded or rendered in ACID or by adding Beatmap markers on the Clip 

Properties dialog. 
• The ruler on the General tab is fixed, and the ruler on the Stretch tab is stretched to represent measures of varying lengths. 
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The following table describes the settings on the Stretch tab for Beatmapped clips. 

Item Description 

Initial root note Choose a note from the drop-down list to set the first root note for tracks that you want to 
conform to the project key. 

If you do not want a track transposed to the project key, choose Don’t transpose. 

Initial tempo Displays the starting tempo of the clip as determined by the Beatmapper Wizard. Enter a 
value in the box or use the spin control to adjust the tempo. 

Initial time signature Choose settings from the Beats per measure and Beat value controls to set the starting 
time signature of your clip. Time signature changes in the clip will be marked by Beatmap 
markers. 

Ignore root note Select this check box if you do not want to transpose the Beatmapped clip when stretching. 
changes When the check box is cleared, pitch-shifting will be applied so the clip will conform to your 

project key 

Beatmapper Wizard Click the Beatmapper Wizard button to adjust a track's tempo information. For more 
information, see Using the Beatmapper on page 113. 

The waveform display shows tempo changes and measures using markers: 

Marker Description 

Represents the first downbeat. 

Indicates a tempo change. These markers can be added manually or are added by ACID when recording or 
rendering 

Represent measures. 

You can adjust tempo by dragging measure or Beatmap markers: 

•	 Dragging a measure marker that occurs before the first Beatmap marker sets the clip's initial tempo. 

•	 Measure markers between Beatmap markers cannot be moved. 

•	 Dragging a Beatmap marker adjusts the tempo of the Beatmap marker you drag and the previous marker. The length of the 
measures between the Beatmap markers is adjusted as you drag. 

•	 Dragging a measure marker that occurs after the last Beatmap marker sets the clip's final tempo. 

You can add Beatmap markers to signal a tempo change: just double-click a measure marker or a blank area of the Beatmap marker bar 

to add a marker.


To remove a Beatmap marker, double-click an existing marker.


To edit a Beatmap marker, right-click it and choose a new setting from the Root Note or Time Signature submenu.


Reloading files 

Clicking the Reload button ( ) located on the Stretch tab of the Clip Properties window restores all settings from the media file. 
Any setting changes made on the Stretch tab are discarded. 

Clicking this button also updates the Clip Properties window when changes are made to the properties from an external editor. 

Replacing files 

Clicking the Replace File button ( ) located on the Stretch tab of the Clip Properties window displays the Replace File dialog 
and allows you to replace the audio file on the current clip with a new audio file. This feature only replaces the actual audio. All track 
timing, effects, and envelopes remain. 

Tip: You can also replace a file by dragging an audio file from the Explorer and dropping it on the track name of an existing track. 
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Adding a clip to the Groove Pool


Click the Add to Groove Pool button ( ) located on the Stretch tab of the Clip Properties window to make the selected clip available in 

the Groove Pool so you can apply its timing to other tracks.


Groove cloning can extract grooves from loop tracks only.


Saving file properties 

When you make changes in the Clip Properties window, the changes you have made are saved in the project file, but does not alter the 
original media file. To save clip property changes in the media file, click the Save File button ( ). 

You can also click the Save File As button ( ) to save the changes to a new file. The media is saved with the modified track properties to 
a new file, and renames the track in the track list to reflect the change. 

All the information in the Clip Properties window is saved to your file except for any pitch-shifting you have applied. Any regions or 
markers you have created in the Chopper™ are also saved. For more information, see Inserting markers and regions in the Chopper on page 
96. 

Adjusting clip properties for MIDI tracks


From the View menu, choose Clip Properties to display the Clip Properties window. The contents of the Clip Properties window will 

change to display properties for the currently selected clip in the timeline.


You can use the Clip Properties window to edit MIDI data using the OPT list editor or piano roll.


For more information, see MIDI Track Envelopes and Keyframes on page 208.


For more information, see Editing duration on page 201.


Working with grooves 

From the View menu, choose Groove Pool to toggle the display of the Groove Pool window. The top portion of the Groove Pool 

window displays the available groove maps in your project. The bottom portion shows the selected groove map so you can edit it. 

Available groove 
maps 

Selected groove 
map 

Note: The grooves listed in the Groove Pool are specific to your project. If you’ve deleted grooves and saved your project, those grooves 
will be unavailable unless you import the grooves again. For more information, see Importing a groove on page 126. 
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A groove refers to the rhythmic pattern of a piece of music. Groove maps in ACID expand on the software’s ability to match the rhythm 
and timing of files nondestructively and in real time: 

•	 Breathe new life into your collection of loops and MIDI files by creatively applying grooves to change the rhythmic feel. 

•	 Adjust the timing of a track to add or remove a human feel. 

•	 Quantize and map multiple tracks or loops to a common groove. 

•	 Extract the groove from an existing audio file. 

•	 Create new grooves from scratch. 

•	 Different grooves can be applied to an entire track or portions of a track so you can easily match loops with incompatible feels and 
tighten/loosen grooves nondestructively. 

Note: Grooves cannot be applied to tracks that contain Beatmapped clips. 

Applying or removing grooves


From the View menu, choose Groove Pool to toggle the display of the Groove Pool window.


With the Groove Pool and Groove tool (
 ) on the main ACID toolbar, you can use groove maps to adjust the timing of entire tracks or 
portions of tracks. 

Tips: 

•	 If you want to get really creative, try setting a clip’s stretching method to Pitch shift segments (on the Stretch tab of the Clip Properties 
window). When a groove adjusts a beat so it plays early, the pitch will be raised. When a beat is played late, its pitch will be lowered. 

•	 If a groove map does not seem to work correctly on a loop, the beats in the file may not be properly detected. Click the Redetect Beats 
button on the Stretch tab of the Clip Properties window to apply the ACID beat-detection algorithm to the loop. 

Note: Groove maps are applied nondestructively. If you want to change a media files's inherent groove, use the Render to new 
track command to render a new, grooved media file. 

Important: Grooves cannot be applied to Beatmapped clips. 

Applying a groove to an entire track 

1.	 From the View menu, choose Groove Pool to display the Groove Pool window if it isn’t already visible. 

2.	 Drag a groove from the Groove Pool window to a track. You can drop the groove in the track list or on the timeline. 

A groove event is displayed at the bottom of the track to indicate that a groove has been applied to the track. 

To toggle the height of the groove strips, choose Show Full-Size Groove Strips from the View menu. 

Tips: 

• Drag a groove from the Groove Pool to an existing groove event to change the event's groove. 
• Right-click and drag with the Groove tool ( ) to erase a groove event. 
• Hold Ctrl and right-click a groove event with the Groove tool to erase the entire event. 
• Hold Ctrl and click a groove event with the Groove Erase tool ( ) to erase the entire event. 
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Setting a default groove for new tracks 

If you have a groove that you’d like to use to set the overall feel of a project, you can set it as a default for your project. 

1.	 From the View menu, choose Groove Pool to display the Groove Pool window if it isn’t already visible. 

2.	 Choose a setting from the Default groove for new tracks drop-down list. 

When you add a new loop, one-shot, or MIDI track to your project, the selected groove will be applied to the entire track. Existing 
tracks are not affected. 

Applying multiple groove events to a track 

Groove events allow you to apply grooves to portions of tracks or apply different grooves to various portions of a track. The groove is 
applied where the groove event overlaps the media event. 

The edges of groove events are boundaries for grooves, and audio cannot be grooved beyond the event edges. 

1.	 Select the Groove tool ( ) on the main ACID toolbar. 

2.	 Click the down arrow  next to the Groove toolbar button and choose a groove from the menu (or double-click a groove in the 
Groove Pool). 

3.	 Click and drag over a track to paint groove events in the same way you create other events on the timeline. 

Groove events are displayed at the bottom of the track to indicate where a groove will be applied. 

4.	 Repeat steps 2 and 3 to paint groove events as needed. 

To toggle the height of the groove strips, choose Show Full-Size Groove Strips from the View menu 

Tips: 

•	 Drag a groove from the Groove Pool to an existing groove event to change the event's groove. 
•	 Drag a groove from the Groove Pool to a space between two groove events to create a new groove event to fill the space between the 

events. 
•	 Hold Ctrl while clicking the space between two groove events to create a new groove event to fill the space between the events. 
•	 Right-click and drag with the Groove tool to erase a groove event. 
•	 Hold Ctrl and right-click a groove event with the Groove tool to erase the entire event. 
•	 Hold Ctrl and click a groove event with the Groove Erase tool ( ) to erase the entire event. 
•	 Zoom in to see groove markers in the groove events. The markers represent the amount and direction of offset applied to beats. 

Erasing groove events 

1.	 Select the Groove Erase tool ( ) on the main ACID toolbar. 

2.	 Click and drag the Groove Erase tool to erase a groove, or hold Ctrl while clicking a groove event to erase the entire event. 

Tips: 

•	 Right-click and drag with the Groove tool ( ) to erase a groove event. 
•	 Hold Ctrl and right-click a groove event with the Groove tool to erase the entire event. 
•	 Hold Ctrl and click a groove event with the Groove Erase tool ( ) to erase the entire event. 
•	 Zoom in to see groove markers in the groove events. The markers provide a visual cue to the mapped groove. 
•	 You can also right-click a track header and choose Remove Groove from Track from the shortcut menu to remove all groove events 

from a track. 

Removing unused grooves from your project 

1.	 From the View menu, choose Groove Pool to display the Groove Pool window if it isn’t already visible. 

2.	 Click the Remove All Unused Grooves from Project button ( ) to remove any grooves that have not been used in your project. 
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Removing a groove from your project 

1.	 Select a groove in the Groove Pool window. 

2.	 Click the Remove Selected Grooves from Project button ( ). The selected groove is removed from your project. 

If the groove is in use, a confirmation will be displayed if the Confirm groove deletion when still in use check box is selected on 
the General tab of the Preferences dialog. 

Creating grooves 

You can add grooves to your project by using an existing track, duplicating existing grooves, importing grooves, or by creating an 
entirely new groove from scratch. 

Using Groove Cloning to create a new groove using a track in your project 

ACID can analyze a clip’s audio to extract its groove so you can apply its feel to other clips. 

Note: Groove cloning can extract grooves from loop clips only. 

1.	 Right-click a track header in the track list and choose Paint Clip from the shortcut menu. 

2.	 Choose Add to Groove Pool from the submenu. 

A new groove will be added to the Groove Pool window using the name of the clip you selected in step 1. 

Note: Grooves that you create from existing clips will be available only in the project where they were created. If you want to make a 
groove available to other projects, export it to a .groove file. 

Tip: You can also click the Add to Groove Pool button ( ) in the Clip Properties window to add a loop groove to the Groove Pool. 

Duplicating a groove 

Existing grooves can serve as templates for creating your own grooves. 

1.	 Select the grooves you want to duplicate. Hold Ctrl or Shift to select multiple grooves. 

2.	 Click the Duplicate Selected Grooves button ( ). The duplicated grooves are added to the Groove Pool. 

3.	 To change the name of a duplicated groove, right-click a groove and choose Rename from the shortcut menu. 

4.	 You can then edit the duplicated grooves as needed. 

Importing a groove


You can use the Import Grooves button to add grooves from .groove files or other media files to the Groove Pool of your project.


1.	 Click the Import Grooves button ( ) in the Groove Pool window. The Import Groove dialog is displayed. 

2.	 Select the .groove or media file you want to add. Information about the file is displayed at the bottom of the dialog. 

3.	 Click the Open button to add the new groove to the Groove Pool. 

Tip: You can extract a groove quickly by dragging a file from the Explorer window or Media Manager window to the Groove Pool. 
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Exporting a groove 

Grooves are stored with your ACID project. Exporting a groove allows you to save a groove in a file that you can use in other projects or 
share with other ACID users. 

1.	 Select a groove in the Groove Pool window. 

2.	 Click the Export Selected Grooves button ( ). The Export Groove to File dialog is displayed. 

3.	 Choose a drive and folder from the Save in drop-down list, or use the browse window to locate the folder where you want to save 
your groove. 

Note: By default, grooves will be saved in the folder specified in the Default groove folder box on the Folders tab of the Preferences 

dialog. Grooves in this folder will be available in the Groove Pool window when you create a new ACID project.


4.	 Type a name in the File name box, or select a file in the browse window to replace an existing groove. 

5.	 Click the Save button to save your groove. 

Creating a new groove 

1.	 Click the New Groove button ( ). A new groove is added to the Groove Pool window. 

2.	 Type a name for your groove in the edit box, and then press Enter. 

Use the Groove Editor at the bottom of the Groove Pool window to adjust the length and feel of your groove. For more information 
about editing grooves, please see below. 

Editing grooves 

You can use the bottom portion of the Groove Pool window to edit grooves. 

Your edits are saved with your project. If you want to use the edited groove in other projects, you’ll need to export it as a .groove file and 
import the edited groove in each project where you want to use it. 

1.	 From the View menu, choose Groove Pool to display the Groove Pool window. 

2.	 Select a groove in the top portion of the window. 

Tip: If you want to audition your edits in real-time, apply the groove to an event and start looped playback before you start editing the 
groove. 

The bottom half of the Groove Pool window displays your groove as a timeline with beat anchors and groove markers to represent 
how beats will be adjusted. 

You’ll notice that this view is similar to the Stretch tab in the Clip Properties window. Both windows contain beat anchors ( ); 

however, the markers on these windows perform opposite functions: the beat markers ( ) on the Stretch tab are used to remove an 

existing groove from a file, and the groove markers ( ) on the Groove Editor window represent a new groove that can be applied 
with the Groove Pool window and Groove tool. 

•	 In the Groove Editor window, a beat anchor ( ) represents the beat that will be adjusted, or the source of your groove 
adjustment. 

•	 A groove marker ( ) represents the point in time when a beat will be played. This is the destination of your groove 
adjustment. A groove marker can occur before or after the beat anchor. A line connects a groove marker to its associated beat 
anchor. 

3.	 Use the Length spinner control to adjust the length of the groove. Decreasing the setting will remove beat anchors and groove 
markers from the file; increasing the setting will add anchors and markers. 
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4.	 Add or remove markers as needed: 

•	 If you want to add a marker, press M or double-click the beat ruler. A beat anchor and groove marker are added to the nearest 
division on the beat ruler. 

•	 If you want to delete a marker, right-click it and choose Delete from the shortcut menu. 

Tip: Use a single beat anchor/groove marker to adjust all beats forward or back equally. This produces an effect similar to slipping 
an event. 

5.	 Adjust beat anchors and groove markers as necessary. Adjusting anchors and markers during looped playback helps you hear the 
results of your edits. 

a.	 Drag a beat anchor ( ) (or insert a new one) to indicate which beat you want to adjust. 

If snapping is enabled, beat anchors snap to the current grid spacing. Hold Shift while dragging to bypass snapping (press 
Shift after you click). 

b.	 Drag a groove marker ( ) to adjust when the beat will be played. Drag to the left if you want a beat to be played early, or drag 
left if you want it to be played late. 

You cannot drag groove markers past each other, but multiple markers can exist at the same point in time. 

When the Allow snapping for Post-Groove Markers check box is selected on the General tab of the Preferences dialog, 
groove markers will snap to the current grid spacing if snapping is enabled. Hold Shift while dragging to bypass snapping. 

c.	 Double-click a beat anchor or groove marker to reset the marker to the beat anchor position. 

Tip: Hover over a beat anchor or groove marker to display a ToolTip that explains the effect of groove marker adjustments. 

Using folder tracks 

You can use the folder track feature to help organize your track list and timeline by grouping tracks so they can be quickly and easily 
minimized or expanded. 

When the folder track is minimized, you can perform edit operations on clustered events in the group, but you cannot create events 
with the Draw or Paint tools or perform edge-trimming. Expand the folder track to edit individual events. 

Tip: You can also use folder tracks to maintain alternate mixes of a project. For example, create two distinct drum parts and move the 
tracks to separate folder tracks. Mute one of the drum folder tracks to choose which beat is used when you play or render your project. 

Creating a folder track


From the Insert menu, choose Folder Track. A folder track is added below the currently selected track.


You can create nested folder tracks by dragging a folder track to an existing folder track.


Adding existing tracks to a folder track 

To add an existing track to a folder track, drag the track to the folder track. When the folder track is expanded, you can specify the 
location of the track by dragging it to the desired position. When the folder track is minimized, dragging the track to the folder track 
header places the track at the top of the list within the folder track. 
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Removing tracks from a folder track 

To remove a track from the folder track, expand the folder track and drag the track to another location in the track list. 

Muting a folder track 

To mute all tracks in a folder track, click the Mute button ( ) on the folder track’s header. To unmute the folder track, click the Mute 
button again. 

Soloing a folder track 

To solo only the tracks in a folder track, click the Solo button ( ) on the folder track’s header. To unsolo the folder track, click the Solo 
button again. 

Editing events in a folder track 

When the folder track is minimized, you can also perform edit operations on clustered events in the group. The following edit 
operations will affect clustered events: 

• Pitch-shifting events. 

• Dragging events. 

• Cutting, copying, pasting, and deleting events. 

Click to select a clustered group of events, or hold Ctrl or Shift while clicking to select multiple clusters of events. Selected events are 
displayed in a darker color than unselected events. 

Events that overlap are treated as a single event when the folder track is minimized. 

Mixing multiple tracks to a single track 

You can mix a selected group of tracks or an entire project to a single-track stereo event. If your project includes any muted tracks, 
however, those events are not mixed into the new track. The original tracks and their events are unaffected when you mix to a single 
track. 

Typically, you would use this feature when you are finished refining a few tracks and want to combine them to conserve processing 
power. Also, when you mix multiple tracks to a single stereo track, any envelope or track effects that you applied are rendered into the 
newly mixed-down track. You can also use this feature to downmix 5.1 surround projects to stereo. 

This option also allows you to destructively process any track effect plug-ins. 

1. Solo the tracks you want to mix. To mix down the whole project, skip to step two. 

2. From the Tools menu, choose Render to New Track or press Ctrl+M. The Render to New Track dialog appears. 
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3.	 Complete the Render to New Track dialog: 

• 	From the  Save in drop-down list, choose the location where you want to save the new media file. 

•	 Enter a name for the track in the File name box. 

• 	From the  Save as type drop-down list, choose a file format. 

• 	From the  Template drop-down list, choose an audio format from the template list, or click Custom to create custom rendering 
settings. 

Note: If you want to downmix a 5.1 surround project, choose a stereo rendering format. 

•	 Select the Render loop region only check box if you want to render only the loop region to the new mixed down track. Clear 
the check box to render the full length of the project. 

4.	 Click Save. The time selection or project is mixed down to a new track and a copy of the file is saved in the folder specified. 

As the tracks are being mixed down, a status bar appears in the lower-left corner of the ACID window. 

Tip: You may cancel the rendering process by clicking the Cancel button ( ) on the 
status bar. 

Cancel button 

After the new track is mixed down, it appears at the bottom of the track view. If you mixed down the entire project, you may delete 
or mute the other tracks from the project, as they are all contained on the new track. 

5.	 Use the Draw ( ) tool to paint the waveform on the new track. 

Note: MIDI tracks must be routed to DLS or VSTi soft synths to be included in the rendered output. For more information, see 
Routing tracks to MIDI devices or soft synths on page 222. 

Exporting loops


From the File menu, choose Export Loops to create new loops using the original loop media files in your ACID project.


A new loop file is created for every tempo change in the project, which can result in multiple loop files being created from a single loop 

media file.


1.	 From the File menu, choose Export Loops. The Export Loops dialog appears. 

2.	 From the Save in drop-down list, choose the drive or folder to which the new files will be saved. 

3.	 From the Save as type drop-down list, choose the file format. 

4.	 From the Template drop-down list, choose an audio format, or click Custom to create custom rendering settings. 

5.	 Click Save. A progress dialog appears for each track as it is rendered to a file. Tempo information is included in the file name of each 
loop file created (e.g., bass 120.000 BPM. wav). 
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Chapter 8 
Organizing Plug-Ins and ReWire Devices 

You can use the Plug-In Manager to organize your DirectX and VST plug-ins (VST effects and instruments) and ReWire

devices.


From the View menu, choose Plug-In Manager to toggle the display of the Plug-In Manager window.


With this window, you can access effects and effects packages and apply them to tracks, busses, assignable effects chains, 

and soft synth busses. You can also rename and reorganize plug-ins. 


For information about adding effects to your project, see Working with Tracks on page 101.


Tip: To add an effect quickly, drag a plug-in from the Plug-In Manager window to a track, bus, assignable effects chain, or 
soft synth bus. 

Scanning your computer for plug-ins 

Scanning your computer for VST plug-ins is a two-stage process: first, you need to tell ACID where your plug-ins are 
installed, and then you can scan those folders for plug-ins. 

Note: You don't need to scan for DirectX or ReWire plug-ins. These plug-ins are registered with Windows and are detected 
automatically. 

1.	 From the View menu, choose Plug-In Manager if the window isn’t already visible. 

2.	 Click the Configure VST button ( ) at the top of the Plug-In Manager window. The Plug-In Configuration dialog is 
displayed. The dialog displays a list of folders where ACID looks for VST plug-ins. 

3.	 Indicate where your plug-ins are installed: 

•	 If you want to add a new folder, click the Add button and then browse to the folder where your plug-in is 
installed. 

•	 If you want to edit an existing folder path, select a folder in the Search Folder column, click the Edit button, and 
then browse to the folder where your plug-in is installed. 

•	 If you want to remove an existing folder, select a folder in the Search Folder column and click the Remove 
button. 

4.	 Click the Scan button to start scanning your folders for plug-ins. 
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Viewing plug-ins 

When you open the Plug-In Manager window, an Explorer view is displayed with separate folders for your plug-ins. 

Folder Description 
Audio FX	 Displays all your DirectX and VST audio plug-ins. 

You can drag plug-ins to tracks or Mixing Console channel strips to add effects to your project. 

Select the All folder to display all audio plug-ins. 

• The  Failed folder contains plug-ins that did not scan correctly or timed out during scanning. These plug-
ins cannot be used in ACID. You can right-click a plug-in and choose Rescan from the shortcut menu to 
attempt to rescan the plug-in for use in ACID. 

• The  Ignored folder contains plug-ins that you want to prevent ACID from using without uninstalling the 
plug-in. You can right-click a plug-in and choose Ignore from the shortcut menu or drag it to the Ignored 
folder. 

• The  Unavailable folder contains plug-ins that you have uninstalled since running ACID. ACID preserves 
information about uninstalled plug-ins so settings can be restored if the plug-ins are reinstalled. 

The Audio FX folder also contains additional folders you can use to organize and categorize your plug-ins. 
For more information, see Organizing plug-ins with folders on page 133. 

ReWire Devices	 Displays your ReWire device (client) applications. 

Select the All folder to display all ReWire clients. 

The Ignored folder contains plug-ins that you want to prevent ACID from using without uninstalling the 
plug-in. You can right-click a plug-in and choose Ignore from the shortcut menu or drag it to the Ignored

folder.


The ReWire Devices folder also contains a Favorites folder you can use to keep your most-often-used ReWire

clients handy.  You can right-click a plug-in and choose Add to Favorites from the shortcut menu or drag it

to the Favorites folder.


To create custom folders for organizing your plug-ins, you can right-click a folder and choose New Folder

from the shortcut menu.


Soft Synths	 Displays all your software synthesizers, including the DLS soft synth and VST instrument (VSTi) plug-ins. 

Select the All folder to display all soft synths. 

The Failed folder contains plug-ins that did not scan correctly or timed out during scanning. These plug-ins 
cannot be used in ACID. 

The Ignored folder contains plug-ins that you want to prevent ACID from using without uninstalling the 
plug-in. You can right-click a plug-in and choose Ignore from the shortcut menu or drag it to the Ignored 
folder. 

The Unavailable folder contains plug-ins that you have uninstalled since running ACID. ACID preserves 
information about uninstalled plug-ins so settings can be restored if the plug-ins are reinstalled. 

The Soft Synths folder also contains subfolders you can use to organize and categorize your plug-ins by 
instrument type and vendor. For more information, see Organizing Plug-Ins and ReWire Devices on page 
131. 
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The toolbar at the top of the window helps you navigate the Plug-In Manager window and adjust its display. 

Item Name Description 
Address Bar Displays the current folder. You can choose a folder from this drop-down list or click a 

folder in the tree view to navigate the Plug-In Manager. 

Tree View Displays all of the folder that you can use to organize your plug-in. 

Contents Pane 
Up 

Displays the contents of the selected folder. 
Opens the folder one level above the selected folder. 

Refresh Refreshes the contents of the active folder. 

New Folder Adds a new folder where you can drag plug-ins. 

Delete Deletes a user-created folder or removes the selected plug-in from a user-created folder. 
When you delete a folder, only the folder is deleted. The plug-ins remain on your system. 

Views 
Only user-created folders can be deleted. 
Click the down arrow next to the Views button and choose a command from the menu to 
change the way the plug-ins are displayed. 
Tree View Displays all of the available folders on the left side of the window. 
Details Displays detailed information about each plug-in. 

Organizing plug-ins with folders 

The Audio FX, ReWire Devices, and Soft Synths folders contain subfolders to help you organize your plug-ins. Several folders are 
displayed by default, and you can add your own folders. Each plug-in can be assigned to multiple folders, but audio plug-ins and soft 
synths can be assigned to only one category. 

If you want to create a folder to group your plug-ins, select a folder and click the New Folder button ( ) on the toolbar (or right-click a 
folder and choose New Folder from the shortcut menu). To add a plug-in to a folder, perform either of the following actions: 

•	 Drag the plug-in from the right-hand pane to a folder. 

•	 Right-click a plug-in in the right-hand pane, choose Folder Assignments from the shortcut menu, and then choose a folder from 
the menu. All user-created group folders are displayed in the menu, and a check mark is displayed next to each folder the plug-in is 
associated with. 

The Folder Assignments menu is available only after you’ve created folders for your plug-ins. 

Note: Subfolders act as filters on parent-level folders: if you create a folder named Dynamics and add the Wave Hammer and Wave

Hammer Surround plug-ins to that folder, you'll see both plug-ins when you select the Dynamics folder.


Next, create subfolders named Stereo and 5.1 Surround and drag Wave Hammer to the Stereo folder and Wave Hammer - Surround to 
the 5.1 Surround folder. 

• When you select the Dynamics folder, no plug-ins are displayed—the contents are filtered by the Stereo and 5.1 Surround folders. 
• When you select the Stereo folder, only the Wave Hammer plug-in is displayed. 
• When you select the 5.1 Surround folder, only the Wave Hammer Surround plug-in is displayed. 

To remove a plug-in from a folder, perform either of the following actions: 

•	 Navigate to the folder, select the plug-in, and click the Delete button ( ) on the toolbar. 

•	 Right-click a plug-in in the right-hand pane, choose Folder Assignments from the shortcut menu, and then choose a folder from 
the menu to clear the check mark. 
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Viewing a plug-in’s folder assignments 

You can see a plug-in’s folder assignments by right-clicking the plug-in and choosing Folder Assignments from the shortcut menu. A 
submenu displays all available folders. 

Select a folder from the submenu to change a plug-in’s folder assignments, or choose Remove from All Folders to clear all folder 
assignments. 

Displaying audio plug-in folders in the Mixing Console window 

You can use folders and categories to organize plug-ins in the Mixing Console window.


When you click the Insert FX button in the Mixing Console, plug-ins are grouped into submenus. 


If you want to use folders and categories to organize plug-ins in the Mixing Console window, right-click a folder in the Plug-In Manager

and choose Show in Insert FX Submenu from the shortcut menu.


If you want to remove a folder or category from the Mixing Console window, right-click a folder in the Plug-In Manager and choose 

Show in Insert FX Submenu from the shortcut menu to deselect the Show in Insert FX Submenu command.


Classifying audio plug-ins and soft synths with categories 

Categories help you organize your plug-ins by type. The Audio FX folder contains several default categories, and the Soft Synths folder 
contains an Instruments folder with default instrument categories. You can also create your own categories to help you organize your 
plug-ins. 

Each plug-in can be assigned to only one category. 

If you want to create a new category, select the Categories or Instruments folder and click the New Folder button ( ) on the toolbar. 
To add a plug-in to a category, perform either of the following actions: 

•	 Drag the plug-in from the right-hand pane to a category. 

•	 Right-click a plug-in in the right-hand pane, choose Set Category or Set Instrument from the shortcut menu, and then choose a 
category from the menu. 

To change a plug-in’s category, perform either of the following actions: 

•	 Navigate to the folder, select the plug-in, and drag it to a different category folder. 

•	 Right-click a plug-in in the right-hand pane, choose Set Category or Set Instrument from the shortcut menu, and then choose a 
category from the menu. 

If you want to edit a category, right-click its folder and choose Edit Audio FX Category or Edit Soft Synth Instrument Category from the 
shortcut menu. You can edit the category’s name (only for user-created categories), short name, and description. 
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Renaming a plug-in


If you want to change a plug-in’s name, right-click the plug-in in the Plug-In Manager window and choose Rename from the shortcut

menu. You can then type a new name in the edit box.


To reset a plug-in’s default name, right-click the plug-in and choose Reset Default Name from the shortcut menu.


Ignoring a plug-in 

If you want to prevent ACID from using a plug-in, but you don’t want to uninstall the plug-in, you can ignore it: just right-click a plug-in 
and choose Ignore from the shortcut menu. 

To re-enable an ignored plug-in, right-click a plug-in and choose Ignore from the shortcut menu to deselect the Ignore command. 

Using audio plug-ins 

When viewing plug-ins in the Audio FX folders, the following icons are used to represent your plug-ins: 

Icon Description 
Represents a DirectX audio plug-in. 

Represents a DirectX audio plug-in that supports automation. 

Represents a VST audio plug-in. 

Represents a locked VST plug-in.


When you use a VST plug-in in your project, ACID will lock it for the remainder of your ACID session. A lock is 

displayed to indicate that the plug-in cannot be removed until you close and restart the application.


To add plug-ins to your project, you can drag them from folders in the Plug-In Manager window to tracks or channel strips in the Mixing 
Console window. For more information, see Channel strips on page 154. 

Using ReWire devices 

When viewing ReWire devices in the ReWire Devices folders, the following icons are used to represent your plug-ins: 

Icon Description 
Represents a ReWire device that is not currently in use. 

Represents a ReWire device that is currently in use by a soft synth bus. 

When you select a ReWire device, its outputs are displayed on the right side of the Plug-In Manager window. 
This icon represents an unused ReWire output.
 Represents a ReWire output that is in use. 

To add a ReWire device to your project, select a ReWire device ( ) in the left-hand pane to display its outputs. You can then right-click 

an output ( ) and choose Insert Rewire Device Bus from the shortcut menu to add a soft synth bus to the Mixing Console window. 
ORGANIZING PLUG-INS AND REWIRE DEVICES | 135 



Using soft synths 

When viewing soft synths in the Soft Synths folders, the following icons are used to represent your plug-ins: 

Icon Description 
Represents a soft synth. 

Represents a locked VSTi plug-in.


When you use a VSTi plug-in in your project, ACID will lock it for the remainder of your ACID session. A lock is

displayed to indicate that the plug-in cannot be removed until you close and restart the application.


To add a soft synth to your project, right-click a soft synth ( ) in the right-hand pane and choose Insert Soft Synth from the shortcut 
menu. A soft synth bus is added to the Mixing Console window. 
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Chapter 9 
Using Automation 

. 

Automation allows you to control audio and video levels, panning, and effect parameter automation over time. You can 
create fades, apply stereo panning, and vary effect parameters throughout your project. Automation is represented on 
the ACID® timeline as an envelope or set of keyframes. You can create automation by adding envelopes or keyframes to 
your tracks (including bus tracks), or you can record automation parameters by adjusting controls in the ACID interface 
(or on a control surface) during playback. 

For more information, see Connecting a control surface on page 267. 

Showing or hiding automation controls 

The controls in the track list can function as trim controls or automation controls for track volume, panning, assignable 
effects send, and bus send levels. Adjusting the trim control affects the level of the entire track. 

To display trim controls in the track header, deselect the Automation Settings button 

Track automation 

Track automation will always affect all events on the track. This means that any event envelopes will be calculated after 
the track automation. For more information, see Using event envelopes on page 65. 

Tip: Choose a fade type from the Audio default drop-down list on the Editing tab of the Preferences dialog to set the 
default fade type that will be used when you add volume and panning envelopes. This setting is used only when you 
create new envelopes—when you add a point to an existing envelope, the new point always uses the same fade type 
as the preceding envelope point. Also, this setting is not used for event envelopes. 

Mute automation 

Mute automation changes a track’s mute state throughout your project. Mute automation is either on or off with no fade 
between. If you want to use fades, apply volume automation. 

When you apply mute automation to a track, it’s possible to have a track that is muted and soloed simultaneously. The 
mute state overrides the solo state: 

• 	If a track’s  Solo button  is selected, the track is included in the solo group, but it will be muted whenever the mute 
automation is set to mute the track. 

• 	If the  track’s  Mute button  is selected, the track is muted regardless of the mute automation settings. 

Adding or removing mute automation 

1.	 Select a track. 

2.	 From the Insert menu, choose Audio Envelopes or Video Envelopes, or right-click in the track list and choose 
Insert/Remove Envelope from the shortcut menu. 

3.	 From the submenu, choose Mute. A check mark is displayed next to the command, and an envelope is added to the 
timeline. 

4.	 You can adjust the automation by editing the envelope in the timeline or by using the Mute button  in the track 
header when the Automation Settings button  is selected. 
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Adjusting mute automation settings 

1.	 Select the Automation Settings button . The Mute button is displayed as . 

2.	 Click the Mute button to change the track's mute automation state at the cursor position. 

The button behaves differently depending on the track automation recording mode: 

•	 When the track automation mode is set to Off, the button mutes the entire track. 

•	 When the track has a mute envelope and the track automation mode is set to Read, the button changes state to reflect the 
envelope setting during playback but cannot be adjusted. 

•	 When the track has a mute envelope and the track automation mode is set to Touch or Latch, the button edits the envelope 
setting at the cursor position. 

If you click the Mute button during playback, the behavior varies depending on the selected automation recording mode. For 
more information, see Automating 5.1 surround projects on page 146. 

Volume or pan automation 

You can change a track’s volume or position in the stereo field throughout a project using automation envelopes. 

Adding volume or pan envelopes 

1.	 Select the track to which you want to add the envelope. (You may select multiple tracks.) 

2.	 Add the envelope to the selected track(s) in one of following ways: 

• 	From the  Insert menu, choose Envelopes, and choose Volume or Pan from the submenu. 

•	 Right-click the track header in the track list, choose Insert/Remove Envelope from the shortcut menu, and choose Volume or 
Pan from the submenu. 

• Press Shift+V (volume envelope) or Shift+P (pan envelope).


A blue line appears across the track(s) for a volume envelope, and a red line appears across the track(s) for a pan envelope.


Envelope line 

Note: Because the default panning mode is additive, you can introduce clipping when panning a track to the left or right. Choose an 

appropriate pan type and adjust the track volume accordingly. For more information, see Choosing stereo pan types on page 113.


Adjusting volume or pan automation settings 

1.	 If you want to change volume or pan settings by recording automation, select the Automation Settings button . The fader/slider 
handle is displayed as a  in automation mode. 

2.	 Drag the Vol fader to control how loud a track is in the mix or drag the Pan slider to control the position of the track in the stereo 
field. 

The fader and the slider behave differently depending on the track automation recording mode: 

•	 When the track automation mode is set to Off, the fader adjusts the volume of the entire track and the slider pans the entire 
track. In this mode, the automation control acts as a second trim control. 

•	 When the track has a volume envelope and the track automation mode is set to Read, the fader/slider will follow the envelope 
during playback but cannot be adjusted. 

•	 When the track automation mode is set to Touch or Latch, the fader/slider edits the envelope setting at the cursor position. If 
the track does not have a volume/pan envelope, an envelope will be added when you adjust the fader/slider. 

If multiple tracks are selected, all selected tracks are adjusted. 

If you adjust the fader/slider during playback, the behavior varies depending on the selected automation recording mode. For more 
information, see Automating 5.1 surround projects on page 146. 
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Bus automation 

You can use bus automation envelopes to vary the level of a track sent to a bus. 

Adding bus envelopes 

A bus envelope controls the level of a track sent to a particular bus. Before you can add a bus envelope, you must add busses to the 
project. For more information, see The Mixing Console toolbar on page 151. 

1.	 Select the track to which you want to add the bus envelope. (You may select multiple tracks.) 

2.	 Add the envelope to the selected track(s) in one of the following ways: 

• 	From the  Insert menu, choose Envelopes, and choose the bus for which you want to add an envelope from the submenu. 

•	 Right-click the track header in the track list, choose Insert/Remove Envelope from the shortcut menu, and choose the 
appropriate bus from the submenu. 

A purple line representing the envelope appears across the track(s). 

Adjusting bus automation levels 

1.	 Select the Automation Settings button . The fader handle is displayed as a  in automation mode. 

2.	 Click the label on the multipurpose slider and choose a bus from the menu. 

3.	 Drag the fader to control the level of the track sent to each of the assignable FX chains that you have created. Dragging the fader to 
the left cuts the volume; dragging to the right boosts the volume. 

The fader behaves differently depending on the track automation recording mode: 

•	 When the track automation mode is set to Off, the fader adjusts the send level of the entire track. In this mode, the automation 
control acts as a second trim control. 

•	 When the track has a bus envelope and the track automation mode is set to Read, the fader will follow the envelope during 
playback but cannot be adjusted. 

•	 When the track has a bus envelope and the track automation mode is set to Touch or Latch, the fader edits the envelope 
setting at the cursor position. If the track does not have an envelope, one will be created when you adjust the fader. 

If multiple tracks are selected, all selected tracks are adjusted. 

If you adjust the fader during playback, the behavior varies depending on the selected automation recording mode. For more 
information, see Automating 5.1 surround projects on page 146. 

Assignable effects automation 

You can use assignable effects automation to vary the level of a track sent to an assignable effects chain. 

Adding assignable effect envelopes 

An assignable effect envelope controls the level of a track sent to a particular assignable effect chain. Before you can add an assignable 
effect envelope, you must add an assignable effect chain to the project. 

1.	 Select the track to which you want to add the assignable effect envelope. (You may select multiple tracks.) 

2.	 Add the envelope to the selected track(s) in one of following ways: 

• 	From the  Insert menu, choose Envelopes, and choose the assignable effect chain for which you want to add an envelope 
from the submenu. 

•	 Right-click the track header in the track list, choose Insert/Remove Envelope from the shortcut menu, and choose the 
appropriate assignable effect chain from the submenu. 

A green line representing the envelope appears across the track(s). 
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Adjusting assignable effects automation levels 

1.	 Select the Automation Settings button . The fader handle is displayed as a  in automation mode. 

2.	 Click the label on the multipurpose slider and choose an assignable effects chain from the menu. 

3.	 Drag the FX fader to control the level of the track sent to each of the assignable FX chains that you have created. 

The fader behaves differently depending on the track automation recording mode: 

•	 When the track has an assignable effects envelope and the track automation mode is set to Off, the fader adjusts the send 
level of the entire track. In this mode, the automation control acts as a second trim control. 

•	 When the track has an assignable effects envelope and the track automation mode is set to Read, the fader will follow the 
envelope during playback but cannot be adjusted. 

•	 When the track has an assignable effects envelope and the track automation mode is set to Touch or Latch, the fader edits the 
envelope setting at the cursor position. If the track does not have an envelope, one will be created when you adjust the fader. 

If multiple tracks are selected, all selected tracks are adjusted. 

If you adjust the fader during playback, the behavior varies depending on the selected automation recording mode. For more 
information, see Automating 5.1 surround projects on page 146. 

Adding or removing track effect automation 

If a plug-in supports automation, you can dynamically adjust effect parameters over time. 

Adding effect automation envelopes 

If a plug-in supports automation, you can use envelopes to adjust effect parameters over time. The appearance of the plug-in in the 

Plug-In Chooser window indicates whether the plug-in supports automation. Plug-ins with this icon  support automation, while 

plug-ins with this icon  do not. In addition, you can quickly locate plug-ins that support automation in the Automatable subfolder. 

For creative ways to use effect automation envelopes, see Creating wah-wah effects with automated Track EQ on page 300 and Turning 
automated effects on and off on page 300. 

1.	 Click the Track FX button ( ) on a track to open the Audio Plug-In window. 

If no track effects exist, clicking the Track FX button displays the Plug-In Chooser. Use the Plug-In Chooser to create an effect chain 
including an automatable plug-in. For more information, see Creating or adding to track plug-in chains on page 108. 

2.	 Click the Configure FX Automation button ( ) on the Audio Plug-In window to display the FX Automation Chooser. 

3.	 Click a plug-in at the top of the FX Automation Chooser. A list of the effect’s automatable parameters appears. 

4.	 Select the check box for each parameter that you want to control with an envelope. You can use the Select All and Select None 
buttons to quickly change your selections to all or none of the parameters. 

5. Click OK to close the FX Automation Chooser. 
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Envelopes display on the track for parameters that you selected in the FX Automation Chooser. To control which effect parameter 

envelope displays on the track, click the arrow adjacent to the Track FX button ( ) and choose an envelope from the menu. 

Tip: Press E to toggle through the display of all effect parameter automation envelopes. 

Adjusting effect automation settings 

You can adjust automated effect parameters by editing the envelopes in the timeline or by recording automation with the controls in 
the Audio Plug-In Window. 

If you’ve enabled the Bypass parameter for a plug-in, you can click the Bypass button in the plug-in's banner to toggle the Bypass 
envelope at the cursor position. 

Note: When you automate an effect’s frequency parameter, such as the frequency parameters in the track EQ effect, you may notice 
that the frequency changes are more apparent when moving through the lower frequencies. This is because frequency scales in track 
EQ and other plug-ins use a logarithmic scale, but effect automation uses linear interpolation. To make the automated frequency 
changes sound more natural, change the fade curve types to change the interpolation rates between envelope points. For high-to­
low frequency sweeps, use a fast fade curve; for low-to-high frequency sweeps, use a slow curve. For more information, see Changing 
envelope fade curves on page 144. 

MIDI controller automation 

You can use envelopes to adjust MIDI controllers throughout a project. 

Adding or removing MIDI controller automation 

1.	 Right-click the track header, choose Insert/Remove Envelopes, and then choose Configure Controllers from the menu. The MIDI 
Track Controllers Automation dialog is displayed. 

2.	 Select the check box for each controller you want to automate with an envelope. 

If the controller you want to automate isn't displayed, select the Show all controllers check box at the bottom of the dialog. 

3.	 Click the down arrow  in the Envelope box and choose a command from the menu: 

• 	Insert Envelope  

• 	Show/Hide Envelope  

•	 Reset All Envelope Points 

•	 Delete Envelope 

For more information, see You can use the Output Settings tab on the configure which controllers can be automated; add, remove, or hide 
envelopes; set default values, and set each envelope's default fade curve. on page 202. 
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Adjusting MIDI controller automation settings 

Track-level MIDI input filters—available on the Input Filters tab in the Track Properties window—allow you to control exactly which

MIDI messages you want to record or exclude.


For more information, see Setting up MIDI message input filters on page 205.


You can also use an external MIDI controller (or the keyboard/drum list between the track header and timeline) to record MIDI into your

ACID project.


For more information, see Using MIDI merge recording on page 192. 

MIDI program change automation 

You can use keyframes to change the track voice throughout your project. 

For more information, see Adding a program change keyframe on page 210. 

Working with track envelopes 

Envelopes represent volume, audio panning, bus send levels, effect send levels, MIDI controllers, and effect parameter automation 
settings in the timeline. 

Envelope type Description Color 

Volume Controls track volume. Blue 

Bus send volume Controls track level sent to bus. Lilac 

Assignable effects send Controls track level sent to assignable effects control. Green 
volume 

Pan Controls the position of a track in the stereo field (pan). Red 

MIDI controller Adjusts MIDI controller values Various 

Adjusting envelopes 

To adjust the overall level of an envelope, simply drag the envelope line up or down. A tooltip displays the amount of the adjustment as 
you drag. You can adjust envelopes in real time. 

You can also change the level of an envelope over time by adjusting individual envelope points that you place along the envelope line. 

Tip: If you have multiple envelopes on a track, hover over an envelope to display a 
tooltip indicating the name of the envelope. 

Adding envelope points 

After you have inserted an envelope, you can add envelope points to control the level of signal or amount of panning at specific points 
in time. 

1. Place the mouse pointer on the envelope line. The envelope cursor ( ) appears. 

2. Add an envelope point in one of the following ways: 

• Double-click the envelope. 

• Right-click the envelope and choose Add Point from the shortcut menu. 

Tip: If you add too many points, you may delete a point by right-clicking it and choosing Delete from the shortcut menu. You may also 
clear all envelope points by selecting Reset All from the shortcut menu. 
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Drawing envelope points 

To create an envelope quickly, you can draw freehand envelope curves in the timeline. 

1. With the Draw , Envelope , or Time Selection tool active, hover over an envelope. 

2. Hold Shift, and then click and drag over the envelope. As you drag, a trail of envelope points is created. 

3. Release the mouse button when you're finished drawing. 

If the Smooth and thin automation data after recording or drawing check box is selected on the External Control and 
Automation tab of the Preferences dialog, the number envelope points will be reduced when you release the mouse. 

Unthinned envelope 

Thinned envelope 

Thinning envelope points 

Thinning envelope points decreases the number of points on an envelope while retaining the envelope’s overall settings. Right-click an 
envelope and choose Thin All Points from the shortcut menu to thin the entire envelope. 

To apply thinning to a section of the envelope, create a time selection, right-click the envelope, and then choose Thin Selected Points 
from the shortcut menu. 

Note: Thinning is intended to reduce the number of envelope points created through automation recording and will have little or 
no effect if you create envelopes by adding and editing points manually. 

Deleting envelope points 

You can delete a point by right-clicking it and choosing Delete from the shortcut menu. If you want to delete all envelope points, right-
click a point and choose Reset All from the shortcut menu. 

Adjusting individual envelope points 

You can set the level of each envelope point by dragging it up or down. As you move an envelope point, a tooltip displays both the 
point’s occurrence on the timeline and its level. 

Other ways to set the level include: 

• Right-click an envelope point and choose a setting from the shortcut menu. 

• Choose Select All from the shortcut menu to raise or lower all points on the envelope. 

• Right-click an envelope point and choose Set To from the shortcut menu. This displays a box in which you can specify a setting. 

You can adjust an envelope point’s location on the timeline by dragging it right or left. If snapping is enabled, the envelope point snaps 
to time divisions as you drag. Hold Shift while dragging to override snapping (press Shift after you click). For more information, see Using 
snapping on page 89. 
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Flipping envelopes 

You can flip an envelope to invert the envelope around its center. 

1. Right-click an envelope. A shortcut menu appears. 

2. From the shortcut menu, choose Flip All Points. 

Tip: If you want to flip only particular points on an envelope, select the points using the Envelope tool, right-click, and choose Flip

Selected Points from the shortcut menu. For more information on the Envelope tool, see Using the Envelope tool on page 144.


Changing envelope fade curves 

You may set the type of fade curve that occurs between envelope points: linear, fast, slow, smooth, sharp, or hold. To change the fade 
curve, right-click an envelope between two envelope points and choose the appropriate fade curve from the shortcut menu. 

Locking envelope points to an event 

From the Options menu, choose Lock Envelopes to Events if you want envelope points to move with an event when it is moved along 
the timeline. 

Using the Envelope tool 

The Envelope tool ( ) is designed to manipulate multiple envelope points. Use the Envelope tool when you want to edit envelope 
points but do not want to change other elements of the project. With the Envelope tool selected, events cannot be moved or edited. 

Selecting and moving envelope points 

To select multiple envelope points using the Envelope tool, click the track that contains the envelope and drag your cursor in the track 
view to select the points you want to move. Selected points display in an alternate color. Click any selected point and drag it to the new 
position; all selected points will follow. 

To deselect the points, click anywhere outside the selection. 

Cutting, copying, and pasting envelope points 

1. Select the Envelope tool using one of the following methods: 

•  From the  Edit menu, choose Editing Tool, and choose Envelope from the submenu. 

•  Click the  Envelope Tool button ( ) on the toolbar. 

2. Click within a track to select it. 

3. Drag along the timeline to select envelope points. 

4. From the Edit menu, choose Cut or Copy. 

5. Position the cursor where you want to paste envelope points across a track. 

6. From the Edit menu, choose Paste. 

Copying envelopes to another track 

1. Select the Envelope tool using one of the following methods: 

•  From the  Edit menu, choose Editing Tool, and choose Envelope from the submenu. 

•  Click the  Envelope Tool button ( ) on the toolbar. 

2. Click within a track to select it. 

3. From the Edit menu, choose Select All. 

4. From the Edit menu, choose Cut or Copy. 

5. Click within a track to select it. 
144 | CHAPTER 9 



6.	 Click the Go to Start button ( ) if you want the envelope to appear exactly as it was in the original track, or click to position the 
cursor where you want the envelope to start. 

7.	 From the Edit menu, choose Paste. 

Locking envelopes to events 

Track envelopes extend for the length of a track and are independent of the events on the track. This means that the envelope remains 
in place when you move the events in the track. However, track envelopes can be set to move with the underlying events, thus 
preserving the timing of envelope points in relation to events. 

To lock all of the envelopes in a project to the events in which they occur, click the Lock Envelopes to Events button ( ) or, from the 
Options menu, choose Lock Envelopes to Events. You can turn this feature off by clicking the button again. 

The original event 

Moving the event with 
Lock Envelopes to Events 
turned on 

Moving the event with 
Lock Envelopes to Events 
turned off 

Hiding track envelopes 

After you have created your envelope and set your envelope points, you may hide the envelope. Hiding an envelope does not affect the 
envelope point settings or track playback. 

Hiding volume, pan, bus, or assignable effect envelopes 

1.	 Select the track(s) whose envelope(s) you want to hide. 

2.	 From the View menu, choose Show Envelopes. A submenu appears. A check mark next to an envelope type indicates that it is 
visible in the track view. 

3.	 From the submenu, choose the type of envelope you want to hide. The specified envelope type no longer appears in the track view 
for the selected track. 

You can use the same steps to display the envelope again. 

Tip: Select a track and press V to hide a volume envelope or P to hide a panning envelope. Press the key again to display the envelope. 

Hiding effect automation envelopes on a track


To hide effect parameter envelopes, click the arrow adjacent to the Track FX button (
 ) and choose Hide All FX Automation 

Envelopes from the menu. To display envelopes again, click the arrow adjacent to the Track FX button ( ) and choose Show All FX 
Automation Envelopes from the menu. 

Tip: Press E to toggle through the display of all effect parameter automation envelopes. 

Removing track envelopes 

You can remove envelopes from tracks quickly and easily. 

Note: When you remove an envelope from a track and then add it again, you must recreate its envelope points. 
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Removing volume, pan, bus, or assignable effect envelopes 

1. Select the track(s) from which you want to remove the envelope(s). 

2. From the Insert menu, choose Envelopes. A submenu appears showing a check mark next to the envelopes being used. 

3. From the submenu, choose the type of envelope you want to remove. The envelope type is removed from the selected track(s). 

Tip: Press Shift+V to remove a volume envelope or press Shift+P to remove a pan envelope. 

Deleting MIDI controller envelopes 

Click the down arrow next to the Insert/Hide Envelope button  next to the controller's slider in the track header and choose 
Delete Envelope. 

If you want to show or hide an envelope without deleting its settings, click the Insert/Hide Envelope button 

You can also remove continuous controller envelopes on the Output Settings tab in the Track Properties dialog. 

Removing effect automation envelopes 

1. Click the arrow adjacent to the Track FX button ( ) and choose FX Automation from the menu. The FX Automation Chooser 
appears. 

2. Click the plug-in whose automation envelopes you want to remove. The parameters for the effect appear in the dialog. 

3. Clear the check boxes for the envelopes to be removed. 

4. Click OK. 

. 

Tip: You can bypass effect automation without removing envelopes. For more information, see Bypassing effect automation on page 
110. 

Automating 5.1 surround projects 

In a 5.1 surround project, you can automate the center channel’s volume and surround panning using keyframes. For more information, 
see Automating panning on page 242. 
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Automation recording modes 

Automation recording allows you to edit envelope and keyframe settings by using the controls in the ACID interface. When combined 
with a control surface, you can create fades and adjust control parameters with a level of control that only a tangible control can 
provide. 

For more information, see Connecting a control surface on page 267. 

Automation recording is available for the following settings: 

•	 Audio track envelopes (using the controls in the track header). For more information, see Working with track envelopes on page 
142. 

•	 MIDI track envelopes (using the controls in the track header). For more information, see MIDI Track Envelopes and Keyframes on 
page 208. 

•	 Audio track effect parameters for automatable effects (using the controls in Audio Plug-In window). For more information, see 
Adding effect automation envelopes on page 140. 

•	 Bus, soft synth, and assignable effects output and panning levels (using the controls in the Mixing Console window or bus 
track header). 

•	 VSTi parameters (using the controls in the Soft Synth Properties window). 

•	 Surround panning keyframes. For more information, see Using the Surround Panner window on page 240. 

Tips: 

•	 If you want to record MIDI controller envelopes into a track using a hardware controller, you can use MIDI merge recording to record the 
envelopes. 

•	 If you want to thin envelope points after recording automation, you can select the Smooth and thin automation data after recording 
or drawing check box on the External Control & Automation tab of the Preferences dialog or right-click the envelope and choose Thin All 
Points or Thin Selected Points from the shortcut menu. 

Recording automation settings 

1.	 Add an envelope or automatable/keyframeable effect to a track. 

For automatable audio track effects, you must add and effect automation envelope for each parameter you want to automate. 

2.	 Select the Automation Settings button  in the track header. 

3.	 Click the Automation Settings button and choose Automation Write (Touch) or Automation Write (Latch) from the menu. 

Automation Recording 
Mode 

Track Icon Description 

Automation Write (Touch) Envelope points or keyframes are created only while a control is being 
adjusted. When you stop adjusting the control, automation recording stops 
and the existing envelope points/keyframes are unaffected. 

Automation Write (Latch) Envelope points or keyframes are created when you change a control setting, 
and recording continues until you stop playback. When you stop adjusting the 
control, the control's current setting overwrites the existing envelope points/ 
keyframes. 

4.	 Click to position the cursor in the timeline, and click the Play button  to start playback. 

5.	 Adjust the control that corresponds to the envelope point or keyframe you want to adjust. 

During playback, adjusting a control will create envelope points or keyframes at the cursor position. As long as you're adjusting the 
control, new envelope points/keyframes will be created for each change of the play cursor's position. 

6.	 Click Stop  to end playback and stop recording automation. 
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Editing sections of your recorded settings in Touch mode 

In Touch recording mode, envelope points or keyframes are created only while a control is being adjusted. When you stop adjusting the 
control, automation recording stops and the existing envelope points/keyframes are unaffected. 

Use Touch mode for touching up sections of your recorded automation settings. 

1.	 Select the Automation Settings button  in the track header. 

2.	 Click the Automation Settings button  and choose Automation Write (Touch) from the menu. The icon in the track header is 
displayed as a 

3.	 Click to position the cursor in the timeline, and click the Play button  to start playback. 

4.	 When you're ready to start editing, adjust the control that corresponds to the envelope point or keyframe you want to adjust. 
Envelope points/keyframes are updated at the cursor position, and when you stop adjusting the control, the original settings are 
preserved. 

5.	 Click Stop to end playback and stop recording automation. 

Overwriting recorded settings in Latch mode 

In Latch mode, envelope points or keyframes are created when you change a control setting, and recording continues until you stop 
playback. When you stop adjusting the control, the control's current setting overwrites the existing envelope points/keyframes. 

Use Latch mode to overwrite automation settings with new values. 

1.	 Select the Automation Settings button  in the track header. 

2.	 Click the Automation Settings button  and choose Automation Write (Latch) from the menu. The icon in the track header is 
displayed as a 

3.	 Click to position the cursor in the timeline, and click the Play button  to start playback. 

4.	 When you're ready to start editing, adjust the control that corresponds to the envelope point or keyframe you want to adjust. 

Envelope points/keyframes are updated at the cursor position until you stop playback. 

5.	 Click Stop to end playback and stop recording automation. 

Editing individual envelope points or keyframes 

Editing individual envelope points or keyframes gives you fine control over your recorded settings. 

1.	 Select the Automation Settings button  on the track you want to edit. 

2.	 Click the Automation Settings button  and choose Automation Write (Touch) or Automation Write (Latch) from the menu. 

3.	 Select the parameter you want to edit: 

•	 For a track envelope, select the envelope tool  and click the envelope point you want to edit. You can right-click a point and 
choose Properties from the shortcut menu to display an effect's property page. 

•	 For a keyframe, double-click a keyframe to open its property page. 

4.	 Adjust the control that corresponds to the envelope point or keyframe you want to adjust. The selected envelope point/keyframe 
is edited, and all others are unaffected. 

For track envelopes, you can also edit the envelope directly in the timeline. 

. 

. 
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Setting the automation recording mode for a track 

1. Select the Automation Settings button  in the track header. 

2. Click the Automation Settings button  and choose a command from the menu to choose the automation mode. 

Mode Track Icon Description 

Off Automated parameters are ignored during playback. 

When you switch to Off mode, the control setting from the cursor position is 
used as a static setting, and the envelope/keyframe is dimmed to indicate that 
it is unavailable. 

Read The envelope/keyframe value is applied during playback, and the control 
reflects the envelope/keyframe settings at the cursor position. 

Adjustments to the control are not recorded. 

Automation Write (Touch) The envelope/keyframe value is applied during playback, and the control 
follows the envelope/keyframe settings during playback and when you 
position the cursor. 

Envelope points or keyframes are created only while a control is being 
adjusted. When you stop adjusting the control, automation recording stops 
and the existing envelope points/keyframes are unaffected. 

Automation Write (Latch) The envelope/keyframe value is applied during playback, and the control 
follows the envelope/keyframe settings during playback and when you 
position the cursor. 

Envelope points or keyframes are created when you change a control setting, 
and recording continues until you stop playback. When you stop adjusting the 
control, the control's last setting overwrites the existing envelope points/ 
keyframes. 
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Chapter 10 
Using the Mixing Console 

The Mixing Console provides an integrated view of all tracks and busses in your project using the appearance of a 
traditional hardware-based mixer. You can use the Mixing Console to mix your project in much the same way you work 
with a hardware-based mixer. 

Understanding the Mixing Console window 

From the View menu, choose Mixing Console to toggle the display of the Mixing Console window. 

Toolbar 

Channel List 

View pane Channel strips 

The Mixing Console window is explained in the following sections. 

The Mixing Console toolbar 

The Mixing Console toolbar is displayed at the top of the Mixing Console window and allows you to quickly configure the 

window’s display; downmix audio; dim the output; or add tracks, assignable effects, or busses. 

Item	 Description 
Properties and Click the  button to open the Audio tab in the Project Properties dialog, or click the down 
Layout arrow and choose a command from the menu: 

Audio Properties Displays the Audio tab in the Project Properties dialog. 

Show Channel	 Displays or hides the Channel List on the left side of the Mixing Console 
List	 window. 

Select a channel strip’s check box to display it in the Mixing Console, or clear 
a check box to hide a channel strip without removing it from your project. 
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Item	 Description 
Show Channels	 Choose a command to configure which channel strips are displayed in the 

Mixing Console window. 

• Show All Channels: Displays all channel strips in the Mixing Console. 

• Audio Tracks: Shows or hides audio track channel strips. 

• MIDI Tracks: Shows or hides MIDI track channel strips. 

• Audio Busses: Shows or hides auxiliary bus channel strips. 

• Input Busses: Shows or hides input bus channel strips. 

• Soft Synth Busses: Shows or hides soft synth bus channel strips. 

• Assignable FX Busses: Shows or hides assignable FX channel strips. 

• Master Bus: Shows or hides the Master bus channel strip. 

• Preview Bus: Shows or hides the Preview bus channel strip. 

Show Control Choose a command to configure which portions of the channel strips are 
Regions displayed in the Mixing Console window. 

• Show All Control Regions: Displays all control regions. 

• Insert FX Control Region: Shows or hides the Insert FX control region. 

• Sends Control Region: Shows or hides the Sends control region. 

• I/O Control Region: Shows or hides the I/O control region. 

• Peak Meters Control Region: Shows or hides Peak Meters. 

• Faders Control Region: Shows or hides volume faders. 

Show Control Choose this command to show or hide control region labels in channel 
Region Labels strips. 

Show Fader Ticks Choose this command to show or hide the fader ticks next to the faders. 

Channel Width Choose a setting to indicate whether you want to view narrow, medium 
(default), or wide channel strips in the Mixing Console window. 

Meter Layout	 Choose Meter Defaults, and then choose a command from the submenu to 
reset clip indicators; set the display range; or display labels, peaks, or valleys 
in the channel meters. 

Downmix Output	 Downmixes your audio from 5.1 surround to stereo or from stereo to mono so you can ensure 
your mix will sound the way you intended it — even when your audience’s hardware has fewer 
channels than the original mix. 

The button represents the current playback mode: 

5.1 surround output 

Stereo output 

Mono output 

Dim Output 

Insert Audio Track 

Insert MIDI Track 

Attenuates the volume of all busses that are routed to hardware outputs by 20 dB so you can 
check your mix at a lower level (or answer the phone). Click again to restore volume. 

Adds an audio track to your project. 

Adds a MIDI track to your project. 

Insert Assignable FX 

Insert Bus 

Creates an assignable FX chain that you can route to one or more tracks in your project. 

To delete an assignable FX chain, right-click the assignable FX channel strip and choose Delete 
from the shortcut menu. 

Adds a bus to your project. The Audio tab in the Project Properties dialog is updated to reflect 
the new number of busses. 

To delete a bus, right-click the channel strip for the bus and choose Delete from the shortcut 
menu. 

Insert Input Bus Adds an input bus to your project. 

To delete a bus, right-click the channel strip for the bus and choose Delete from the shortcut 
menu. 

Insert Soft Synth Adds a soft synth to your project. 

To delete a soft synth, right-click the channel strip for the soft synth and choose Delete from 
the shortcut menu. 
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The Channel List pane 

The Channel List pane is displayed on the left side of the Mixing Console window. 

To show or hide the window, click the down arrow next to the Properties and Layout button and 
choose Show Channel List from the menu (or right-click the Mixing Console window and choose Show 
Channel List from the shortcut menu). 

The top of the Channel and Group List pane displays a listing of all tracks, busses, and assignable effects 
chains in your project. Select a channel’s check box to include it in the Mixing Console display, or clear a 
check box to hide the channel without removing it from your project. 

Clicking a track, bus, soft synth, or assignable effects chain in the Channel List pane selects that channel. 
You can hold Ctrl or Shift to select multiple channels to perform ganged edits. 

The View pane 

The View pane is displayed on the left side of the Mixing Console window. If the Channel List pane is 
visible, the View pane is displayed between the Channel List pane and the Channels pane. 

You can use the buttons in this pane to show or hide components in the Mixing Console. 

Item Description 
Show All Click to show channel strips for all tracks, busses, and assignable effects chains. 
Audio Tracks Click to show or hide channel strips for audio tracks.


If your project does not contain any audio tracks, this button is unavailable.

MIDI Tracks Click to show or hide channel strips for MIDI tracks.


If your project does not contain any MIDI tracks, this button is unavailable.

Audio Busses Click to show or hide channel strips for busses.


If your project does not contain any busses, this button is unavailable.

Soft Synths Click to show or hide channel strips for soft synths.


If your project does not contain any soft synths, this button is unavailable.

Assignable FX Click to show or hide channel strips for assignable effects chains.


If your project does not contain any assignable effects chains, this button is unavailable.

Master Bus Click to show or hide the channel strip for the Master bus. 
Preview Bus Click to show or hide the channel strip for the Preview bus. 
Insert FX Click to show or hide the insert effects control region in channel strips. 
Sends Click to show or hide the sends control region in channel strips. 
I/O Click to show or hide the I/O control region in channel strips. 
Meters Click to show or hide the peak meters control region in channel strips. 
Faders Click to show or hide the Faders control region in channel strips. 
Meter Range Drag the slider to adjust the range of all meters in the Mixing Console.


Tip: You can also right-click a meter and choose a range from the shortcut menu.

Channel Width Click to display narrow , default , or wide channel strips. 
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Channel strips 

Tracks, busses, soft synths, and assignable effects chains are displayed as channel strips in the Mixing Console. 

When a control surface is enabled, an indicator is displayed in the Mixing Console to indicate which channels are under external control. 
Multiple bars are displayed if a channel is under the control of multiple devices. For more information about using control surfaces, 
please see Using Control Surfaces with ACID on page 267. 

In the Mixing Console, the

horizontal bars at the top of

channels 1-4 indicate which

channels are under external


control 

Tips: 

•	 If you want to change the order in which channels are displayed, you can click the channel label and drag a channel strip to a new 
location. 

•	 Hover over a fader and roll your mouse wheel to change its setting. 
•	 To edit a fader value quickly, you can double-click the displayed value to type a new value. 
•	 Hold Ctrl while dragging a fader to move it in fine increments. 
154 | CHAPTER 10 



Insert FX 
Control Region 

Sends Control 
Region 

I/O Control 
Region 

Peak Meters 
Control Region 

Faders Control 
Region 

Channel Label 

Item 
Insert FX Control 
Region 

Sends Control 
Region 

I/O Control Region 

Peak Meters Control 
Region 

Faders Control 
Region 

Channel Label 

Description 
The Insert FX control region displays the insert effects chain for a track or 
bus. 

Note: MIDI tracks do not have this region on the channel strip. 

The Sends control region displays controls for routing tracks to busses or 
assignable effects chains. For assignable effects chains, the Send Region 
also displays an input fader and meter. 

Note: MIDI tracks do not have this region on the channel strip. 

The I/O control region allows you to choose the recording input for a 
track or route a channel to a bus or hardware output. 
The Peak Meters control region displays peak meters you can use to 
monitor instantaneous levels during playback and determine the loudest 
level in your audio signal. 

Note: To change the range of all meters in the Mixing console, drag 

the Meter Range slider in the View pane (or right-click a meter and 
choose a range from the shortcut menu). 

The Faders control region allows you to control a channel's gain. 

•	 Audio track channels display controls for the track automation mode, 
arm for record, input monitor mode, mute, solo, pan, track gain, and 
phase. 

•	 MIDI track channels display controls for the track automation mode, 
arm for record, MIDI input, solo, mute, pan, and track gain. 

•	 Bus channels display controls for the bus automation mode, mute, 
solo, pan, bus gain, and pre/post fader effects processing. 

•	 Assignable effects channels display controls for the bus automation 
mode, mute, solo, pan, and bus gain. 

If the Meter Region is not visible, the Fader Region also displays a peak 
meter. 
The Channel Label displays the name of the track or bus. Double-click to 
edit the name. 

Adding track, assignable FX, bus, and soft synth channels 

In its default configuration, the Mixing Console displays a channel for each track, bus, soft synth, and assignable effects chain in your 
project. 

You can use the buttons on the Mixing Console toolbar to add tracks, assignable effects chains, or busses to your project. For more 

information, see The Mixing Console toolbar on page 151. 

Using audio and MIDI track channel strips 

A separate channel strip is displayed for each audio and MIDI track in your project. Each channel strip mirrors controls that are displayed 

in the track header.


To show or hide audio track channel strips, click the Tracks button in the View pane. 


To show or hide MIDI track channel strips, click the MIDI Tracks button in the View pane.
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Changing a track’s name 

To rename an audio or MIDI track, double-click the track label at the bottom of the channel strip and type a new name in the box (or 
press F2 to rename the selected track). The channel strip in the Mixing Console and the track header are updated when you press Enter. 

Adding or editing track (insert) effects 

Note: MIDI tracks do not have an Insert FX control region. 

When the Insert FX control region is visible, each track displays its effects chain at the top of the channel strip. 

To show or hide the Insert FX control region, click the Insert FX button in the View pane. 

Each effect is displayed as a button. You can hover over the button to see a ToolTip that displays the full plug-in and preset name. 

Tip: When the Insert FX control region isn't visible, you can click the Track FX button in the Faders control region to display the Audio 
Plug-In window for the track’s effects chain. 

Adding a plug-in 

Click the button and then choose a new plug-in from the menu to add a new plug-in to the effects chain. 

Editing effects settings 

Click an effect’s button to display the Audio Plug-In window, where you can adjust the plug-in’s settings. 

When you right-click an effect’s button, a shortcut a menu is displayed: 

•  Choose  Show <Plug-In Name> to open the Audio Plug-In window, where you can adjust the plug-in’s controls. 

•  Choose  Bypass <Plug-In Name> to temporarily bypass a plug-in. 
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When an effect is bypassed, its button is displayed in red text. 

•	 Choose Remove <Plug-In Name> to remove a plug-in from the track effects chain. 

•	 Choose Presets, and then choose a setting from the submenu to load a new preset. 

•	 To replace the current plug-in, right-click the effect’s button, and then choose a new plug-in from the menu. Plug-ins are organized 
in submenus by type (EQ, Dynamics, Reverbs, etc.). 

Adjusting bus or assignable effects send levels 

Note: MIDI tracks do not have a Sends control region. 

When the Sends control region is visible, each track displays controls you can use to route the track to busses and assignable effects 
chains. 

To show or hide the Sends control region, click the Sends button in the View pane. 

When the Automation Settings button in the Faders control region is not selected, click the Channel Send button and choose a bus 
or assignable effects chain from the menu, and then drag the fader to adjust the send level. 

When the Automation Settings button  in the Faders control region is selected, the fader handle is displayed as a , and you can use 
it to edit send volume automation on the track. 

Notes: 

•	 The trim level is added to the automation settings so your envelope is preserved, but with a boost or cut applied. For example, setting the 
trim control to -3 dB has the same effect as decreasing every envelope point by 3 dB. 

•	 To adjust the size of the Sends control region, you can drag the bottom divider to make more or fewer sends visible. 

Bus sends are pre-volume (and pre-mute) by default. To change to post-volume (and post-mute), click the Pre/Post button to switch to 
Post Volume Send mode. 
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Change a track’s input or output device 

When the I/O control region is visible, each track (audio and MIDI) displays controls you can use to set the track's input device (for 
recording) and output device. 

To show or hide the I/O control region, click the I/O button in the View pane. 

To choose the recording input for the track, click the Input Source button and choose a port from the menu.


To route an audio track to a bus, click the Output button and choose a bus from the menu. 


To route a MIDI track to a soft synth device, click the Output button and choose a soft synth from the menu.


Monitoring track levels 

When the Meters control region is visible, each audio and MIDI track displays meters you can use to monitor track levels. 

To show or hide the Meters control region, click the Meters button in the View pane. 

Note: If the Meters control region is not visible, peak meters are displayed in the Faders control region. 

Right-click the meter and choose a setting from the shortcut menu to change the resolution and display options. 

Changing a track’s automation mode 

When the Faders control region is visible, each track displays controls you can use to adjust 
track panning, volume and muting. The controls can adjust static (trim) or automation levels. 
Use the Automation Settings button  at the top of the Faders control region to choose the 
automation mode and turn automation on or off. 

To show or hide the Faders control region, click the Faders button in the View pane. To 
change a track’s automation recording mode, click the down arrow  next to the 
Automation Settings button and choose a setting from the menu. 

Click the button (so the Automation Settings button is not selected) if you want the Fader 
control region controls to function as trim controls. Adjusting a trim control affects the entire 
track. When the Automation Settings button is selected, you can use the buttons to edit pan, 
volume, and mute automation for the track. 

Audio track MIDI track 
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Muting or soloing a track 

When the Faders control region is visible, each track displays Mute and Solo buttons. 

To show or hide the Faders control region, click the Faders button in the View pane. 

Muting a track 

When the Automation Settings button  is not selected, you can click the Mute button  to prevent a track from 
being played in the mix. Click the Mute button on additional tracks to add them to the mute group. To unmute a 
track, click the Mute button again. 

When the Automation Settings button  is selected, the Mute button is displayed as , and you can use the 
button to edit mute automation. 

Soloing a track 

Click the Solo button  to mute all unselected tracks. Click the Solo button on additional tracks to add them to the 
solo group. To remove a track from the solo group, click its Solo button again. 

Inverting a track’s phase 

Note: MIDI tracks do not have a phase button. 

When the Faders control region is visible, each track displays an Invert Track Phase button . 

To show or hide the Faders control region, click the Faders button in the View pane. 

Click the Invert Track Phase button  to reverse the phase of all events on an audio track. 

Although inverting data does not make an audible difference in a single file, it can prevent phase cancellation when 
mixing or crossfading audio signals. 

Select multiple tracks to invert several tracks simultaneously. 

Note: If the Invert event switch is selected, inverting the phase of the track will return the event to its original phase. 

Arming a track for recording or toggling input monitoring 

When the Faders control region is visible, each track displays an Arm for Record button and an Input Monitor 

Mode button you can use to turn record input monitoring on or off. 

Note: MIDI tracks do not have an Input Monitor Mode button. 
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To show or hide the Faders control region, click the Faders button in the View pane. 

Arming tracks for recording 

Select the Arm for Record buttons  on the tracks where you want to record. Arming a track enables it for recording. 

When a track is armed, the track meter displays the track’s level. If input monitoring is not on, the meter displays the level of your input 
source. If input monitoring is turned on, the meter shows the level of the input source plus the track effects chain. 

Toggling record input monitoring 

Click the Input Monitor Mode button  and choose a command from the menu. 

Note: This button is available only when you’re using a low-latency audio device that supports input monitoring. 

To turn on input monitoring, click the Input Monitor Mode button and choose and then choose Input Monitor Mode: On or 
Input Monitor Mode: Auto  from the menu. During recording, your signal will be played back with the current track effects chain, but 
a dry (unprocessed) signal is recorded. 

When Input Monitor Mode: On  is selected, the behavior is similar to Input Monitor Mode: Auto mode, but you will always hear the 
input monitor during recording—monitoring is not toggled on and off when recording in to a selected event. 

When Input Monitor Mode: Auto is selected, you will hear the input monitor signal when playback is stopped and during recording. 
If you’re recording into selected events, you’ll hear the input monitor signal only when the cursor passes over the selected events. 

Important: Your ability to monitor effects in real time is dependent on your computer’s performance. Effect automation envelopes are 
bypassed during record monitoring. 

Adjusting track panning or volume


When the Faders control region is visible, each track displays a Pan slider and a Volume fader.
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To show or hide the Faders control region, click the Faders button in the View pane. 

Adjusting panning 

When the Automation Settings button  is not selected, you can drag the Pan slider to control the position of the track in the stereo 
field: dragging to the left will place the track in the left speaker more than the right, and dragging to the right will place the track in the 
right speaker. 

You can hold Ctrl while dragging the slider to adjust the setting in finer increments, or double-click the slider to return it to 0. 

When the Automation Settings button  is selected, the Pan slider handle is displayed as a , and you can use it to edit pan 
automation. 

Note: The trim level is added to the pan automation settings so your panning envelope is preserved, but with an offset applied. For 

example, setting the trim control to 9% left has the same effect as moving every envelope point 9% to the left.


Adjusting volume 

When the Automation Settings button  is not selected, you can drag the Volume fader to control the overall (trim) volume of the 
track. 

You can hold Ctrl while dragging the slider to adjust the setting in finer increments, or double-click the slider to return it to 0. 

When the Automation Settings button  is selected, the Volume fader handle is displayed as a , and you can use it to edit volume 
automation. 

Note: The trim level is added to the volume automation settings so your envelope is preserved, but with a boost or cut applied. For 

example, setting the trim control to -3 dB has the same effect as decreasing every envelope point by 3 dB.
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Using output busses 

You can use busses to group and mix tracks. The most common uses of busses are for routing tracks and effects outputs to specific 
hardware outputs or simply to use a bus as a master control for a set of tracks. 

For example, if you wanted to control the master level of all your drum tracks to a relative level, you could create a bus and assign all 
drum tracks to that bus. After your drums are mixed, you can adjust the overall volume of the drum tracks by adjusting the bus volume. 

Adding or deleting output busses 

From the Insert menu, choose Bus (or click the Insert Bus button ( ) in the Mixing Console window) to add a bus to your project. 

The number of busses in your project will be determined by several factors, such as the number of outputs that your hardware contains 
or how you will be using and applying effects throughout your project. 

Note: You can add up to 26 busses, and you can change the number of busses at any time. 

By default, all busses are assigned to the Master bus. In this configuration, you can use them for creating subgroups of tracks—for 
example, you could route all your drum tracks to a bus so you can adjust their levels together without changing their relative levels. 
However, you can also route busses to hardware outputs so you can use busses for sending tracks to external effects processors or for 
mixing on an external mixer. For more information, see Routing a bus to a hardware output on page 163. 

Adding a bus 

From the Insert menu, choose Bus to add a bus to your project. 

Tip: If the Mixing Console Window is visible, click the Insert Bus button ( ). 

Renaming a bus 

To rename a bus, double-click the label at the bottom of the channel strip and type a new name in the box (or press F2 to rename the 
selected bus). The channel strip in the Mixing Console is updated when you press Enter: 

Delete all characters in a custom bus name to reset a custom bus name to its default. 

Deleting a bus 

Right-click a bus channel strip and choose Delete from the shortcut menu, or select a bus channel strip in the Mixing Console window 
and press the Delete key. 

Note: When you remove a bus from a project, any tracks assigned to that bus will be reassigned to the Master bus. 
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Routing busses 

You can create up to 26 (plus the Master) virtual busses that you can route to hardware attached to your computer or to other busses. 

By default, all busses are assigned to the Master bus. In this configuration, you can use them for creating subgroups of tracks—for 
example, you could route all your drum tracks to a bus so you can adjust their levels together without changing their relative levels. 
When you assign busses to hardware outputs, you can use busses for sending tracks to external effects processors or for mixing on an 
external mixer. 

Important: When you route busses to hardware outputs, those busses will not be included in the mix when you render your project. 

Routing a bus to another bus 

Using bus track headers 

1. Add busses to your project. For more information, see Adding a bus on page 162. 

2. If bus tracks aren’t already visible, choose Show Bus Tracks from the View menu. 

3. Click the Playback Device Selector button on the audio bus track and choose a bus from the menu: 

• The button is displayed as a  when a bus is routed to the master bus. 

• The bus letter is displayed ( , , and so on) when a bus is routed to another bus. 

• The button is displayed as a  when a bus is routed to a hardware output (not available for soft synth bus controls). 

Note: To prevent feedback, you cannot perform circular routing. For example, if your project has two busses and bus A is routed to B, bus 
B can only be routed to the Master bus. 

Using the Mixing Console window 

1. Add busses to your project. For more information, see Adding a bus on page 162. 

2. If the window isn’t already visible, choose Mixing Console from the View menu. 

3. If the I/O control region isn’t already visible, click the I/O button in the View pane. 

4. To choose an output device, click the Output button and choose a bus from the menu. 

Routing a bus to a hardware output 

Before you get started, verify that you are using Windows classic wave drivers or an ASIO driver: 

1. From the Options menu, choose Preferences and click the Audio Device tab. 

2. From the Audio device type drop-down list, choose Windows Classic Wave Driver or an ASIO driver. 

3. Click OK to close the Preferences dialog. 

Note: If you have selected Microsoft Sound Mapper in the Audio device type drop-down list on the Audio Device tab in the Preferences 
dialog, you will not be able to assign the bus to a different device. 
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Using bus track headers 

1. Add busses to your project. For more information, see Adding a bus on page 162. 

2. If bus tracks aren’t already visible, choose Show Bus Tracks from the View menu. 

3. Click the Playback Device Selector button on the audio bus track and choose an ouput device from the menu: 

• The button is displayed as a  when a bus is routed to the master bus. 

• The bus letter is displayed ( , , and so on) when a bus is routed to another bus. 

• The button is displayed as a  when a bus is routed to a hardware output (not available for soft synth bus controls). 

Using the Mixing Console window 

1. Add busses to your project. For more information, see Adding a bus on page 162. 

2. If the window isn’t already visible, choose Mixing Console from the View menu. 

3. If the I/O control region isn't already visible, click the I/O button in the View pane. 

4. To choose an output device, click the Output button and choose an ouput device from the menu. 

Assigning tracks to output busses 

Assigning tracks to busses allows you to apply settings to a series of tracks or route tracks to a hardware output. For more information, 
see Assigning tracks to busses on page 111. 

Adding or editing output bus effects 

You can add effects to a bus using the bus tracks header in the track list or the bus channel strips in the Mixing Console. For more 
information, see Adding effects to a bus track on page 106 or Adding or editing track (insert) effects on page 156. 

Automating effect parameters for output busses 

If a plug-in supports automation, you can add envelopes to a bus track to automatically adjust effect parameters over time. For more 
information, see Adding or removing track effect automation on page 140. 

Using audio bus channel strips 

A separate channel strip is displayed for each bus in your project.


To show or hide channel strips for busses, click the Busses button in the View pane.
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Changing a bus’s name 

To rename a bus, double-click the label at the bottom of the channel strip and type a new name in the box (or press F2 to rename the 
selected bus). The channel strip in the Mixing Console is updated when you press Enter. 

Adding or editing bus (insert) effects 

When the Insert FX control region is visible, each bus displays its effects chain at the top of the channel strip. 

To show or hide the Insert FX control region, click the Insert FX button in the View pane. 

Each effect is displayed as a button. You can hover over the button to see a ToolTip that displays the full plug-in and preset name. 

Tip: When the Insert FX control region isn't visible, you can click the Bus FX button in the Faders control region to display the Audio 
Plug-In window for the bus effects chain. 
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Adding a plug-in 

Click the  button and then choose a new plug-in from the menu to add a new plug-in to the effects chain. 

Editing effects settings 

Click an effect’s button to display the Audio Plug-In window, where you can adjust the plug-in’s settings. 

When you right-click an effect’s button, a shortcut a menu is displayed: 

• 	Choose  Show <Plug-In Name> to open the Audio Plug-In window, where you can adjust the plug-in's controls. 

• 	Choose  Bypass <Plug-In Name> to temporarily bypass a plug-in. 

When an effect is bypassed, its button is displayed in red text. 

• 	Choose  Remove <Plug-In Name> to remove a plug-in from the effects chain. 

• 	Choose  Presets, and then choose a setting from the submenu to load a new preset. 

•	 To replace the current plug-in, right-click the effect’s button, and then choose a new plug-in from the menu. Plug-ins are organized 
in submenus by type (EQ, Dynamics, Reverbs, etc.). 

Adjusting bus send levels 

When the Sends control region is visible, each bus displays controls you can use to route the bus to assignable effects chains or to 
busses that are routed to hardware outputs. 

To show or hide the Sends control region, click the Sends button in the View pane. 

When the Automation Settings button  in the Faders control region is not selected, click the Channel Send button and choose a bus 
or assignable effects chain from the menu, and then drag the fader to adjust the send level. 

When the Automation Settings button  in the Faders control region is selected, the fader handle is displayed as a , and you can use 
it to edit send volume automation on the bus track. 

Notes: 

•	 The trim level is added to the automation settings so your envelope is preserved, but with a boost or cut applied. For example, setting the 
trim control to -3 dB has the same effect as decreasing every envelope point by 3 dB. 

•	 To adjust the size of the Sends control region, you can drag the bottom divider to make more or fewer sends visible. 

Bus sends are post-volume (and post-mute) by default. To change to pre-volume (and pre-mute), click the Pre/Post button to switch to 
Pre-Volume Send mode. 

Changing a bus’s output device 

When the I/O control region is visible, each bus displays controls you can use to set the bus's output device.


To show or hide the I/O control region, click the I/O button in the View pane.


To choose an output device, click the Output button and choose a bus or hardware output from the menu.


Important: When you route busses to hardware outputs, the outputs from those busses will not be included in the mix when you 
render your project. 

Monitoring bus levels 

When the Meters control region is visible, each bus displays meters you can use to monitor output levels.


To show or hide the Meters control region, click the Meters button in the View pane.


If the Meters control region is not visible, peak meters are displayed in the Faders control region. 


Right-click the meter and choose a setting from the shortcut menu to change the resolution and display options.
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Muting or soloing a bus 

When the Faders control region is visible, each bus displays Mute and Solo buttons. 

To show or hide the Faders control region, click the Faders button in the View pane. 

Muting a bus 

When the Automation Settings button  is not selected, you can click the Mute button  to prevent a bus from being played in the 
mix. Click the Mute button on additional busses to add them to the mute group. To unmute a bus, click the Mute button again. 

When the Automation Settings button  is selected, the Mute button is displayed as , and you can use the button to edit mute 
automation on the bus track. 

Soloing a bus 

Click the Solo button to mute all unselected busses. Click the Solo button on additional busses to add them to the solo group. To 
remove a bus from the solo group, click its Solo button again. 

Adjusting bus panning or volume 

When the Faders control region is visible, each bus displays a Pan slider and a Volume fader. 

To show or hide the Faders control region, click the Faders button in the View pane. 

Adjusting panning 

When the Automation Settings button  is not selected, you can drag the Pan slider to control the position of the bus in the stereo 
field: dragging to the left will place the bus in the left speaker more than the right, and dragging to the right will place the bus in the 
right speaker. 

You can hold Ctrl while dragging the slider to adjust the setting in finer increments, or double-click the slider to return it to 0. 

When the Automation Settings button  is selected, the Pan slider handle is displayed as a , and you can use it to edit pan 
automation on the bus track. 

The trim level is added to the pan automation settings so your panning envelope is preserved, but with an offset applied. For example, 
setting the trim control to 9% left has the same effect as moving every envelope point 9% to the left. 

Adjusting volume 

When the Automation Settings button  is not selected, you can drag the Volume fader to control the overall (trim) volume of the bus. 

You can hold Ctrl while dragging the slider to adjust the setting in finer increments, or double-click the slider to return it to 0. 

When the Automation Settings button  is selected, the Volume fader handle is displayed as a , and you can use it to edit volume 
automation on the bus track. 

Note: The trim level is added to the volume automation settings so your envelope is preserved, but with a boost or cut applied. For 

example, setting the trim control to -3 dB has the same effect as decreasing every envelope point by 3 dB.
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Changing pre/post routing 

The Pre/Post-Fader Send button in the Sends control region and the Pre/Post Fader Insert FX button  in the Faders control region 
work together to determine the signal flow for your busses. 

The Pre/Post Fader Insert FX button allows you to indicate whether the insert FX chain is affected by the channel's gain fader. When set 
to Post Fader Insert FX , the FX chain is affected by the channel’s gain. When set to Pre Fader Insert FX , the FX chain is not affected 
by the channel’s gain fader, which is essential on the master bus when using plug-ins that dither the audio for final rendering. 

The Pre/Post Fader Send button allows you to create cue mixes that are not affected by the gain (or mute/pan) stages of the bus or 
track. 

• When Pre Fader Insert FX and Pre Fader Send are selected, your audio signal flows as follows: bus effects — bus send — bus 
pan — bus volume. 

• When Pre Fader Insert FX and Post Fader Send are selected, your audio signal flows as follows: bus effects — bus pan — bus 
volume — bus send. 

• When Post Fader Insert FX and Pre Fader Send are selected, your audio signal flows as follows: bus send — bus pan — bus 
volume — bus effects. 

• When Post Fader Insert FX and Post Fader Send are selected, your audio signal flows as follows: bus pan — bus volume — bus 
effects — bus send. 

Using Input Busses 

You can use input busses to input, process, record, and mix external audio sources with your ACID project. Following are some 
examples of how you can use input busses in your projects: 

• Use an input bus as a recording input, allowing you to apply effects and record a wet signal. 

• Use an input bus as a mixer input for an external device, such as a synthesizer. 

• Use an input bus as a return for hardware-based effects. 

• Use an input bus to monitor a source such as a talkback microphone. 

Adding or deleting input busses 

From the Insert menu, choose Input Bus (or click the Insert Input Bus button  in the Mixing Console window) to add an input bus to 
your project.


You can add up to 26 input busses, and you can change the number of busses at any time.


Adding a bus


From the Insert menu, choose Input Bus to add an input bus to your project.


Tip: If the Mixing Console Window is visible, click the Insert Input Bus button . 

Renaming a bus 

To rename a bus, double-click the label at the bottom of the channel strip and type a new name in the box (or press F2 to rename the 
selected bus). The channel strip in the Mixing Console is updated when you press Enter: 

Delete all characters in a custom bus name to reset a custom bus name to its default. 
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Deleting a bus 

Right-click an input bus channel strip and choose Delete from the shortcut menu, or select an input bus channel strip in the Mixing 
Console window and press the Delete key. 

Using input bus channel strips 

A separate channel strip is displayed for each input bus in your project. For more information, see Using Input Busses on page 168. 

To show or hide channel strips for busses, click the Busses button in the View pane. 

Note: Input bus channel strips are available only when using the Mixing Console in ACID Pro 7. 

Changing a bus’s name 

To rename an input bus, double-click the label at the bottom of the channel strip and type a new name in the box (or press F2 to rename 
the selected bus). The channel strip in the Mixing Console is updated when you press Enter. 

Adding or editing input bus (insert) effects 

When the Insert FX control region is visible, each input bus displays its effects chain at the top of the channel strip.


To show or hide the Insert FX control region, click the Insert FX button in the View pane.


Each effect is displayed as a button. You can hover over the button to see a ToolTip that displays the full plug-in and 

preset name.


Tips: 

• When the Insert FX control region isn't visible, you can click the Input Bus FX button  in the Faders control region to display the Audio 
Plug-In window for the bus effects chain. 

• Input bus insert effects are always applied pre-fader. 

Adding a plug-in 

Click the button and then choose a new plug-in from the menu to add a new plug-in to the effects chain. 
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Editing effects settings 

Click an effect's button to display the Audio Plug-In window, where you can adjust the plug-in's settings. 

When you right-click an effect's button, a shortcut a menu is displayed: 

• 	Choose  Show <Plug-In Name> to open the Audio Plug-In window, where you can adjust the plug-in's controls. 

• 	Choose  Bypass <Plug-In Name> to temporarily bypass a plug-in. 

When an effect is bypassed, its button is displayed in red text. 

• 	Choose  Remove <Plug-In Name> to remove a plug-in from the effects chain. 

• 	Choose  Presets, and then choose a setting from the submenu to load a new preset. The current preset is indicated by a check mark. 

•	 To replace the current plug-in, right-click the effect's button, and then choose a new plug-in from the menu. Plug-ins are organized 
in submenus by type (EQ, Dynamics, Reverbs, etc.). 

Adjusting input bus send levels 

When the Sends control region is visible, each bus displays controls you can use to route the input bus to assignable effects chains or to 

busses that are routed to hardware outputs. A bus cannot send to a bus that is directly or indirectly routed to the Master bus.


To show or hide the Sends control region, click the Sends button in the View pane.


When the Automation Settings button 
  in the Faders control region is not selected, click the Channel Send button and choose a bus 
or assignable effects chain from the menu, and then drag the fader to adjust the send level. 

When the Automation Settings button  in the Faders control region is selected, the fader handle is displayed as a , and you can use 
it to edit send volume automation on the bus track. 

Notes: 

•	 The trim level is added to the automation settings so your envelope is preserved, but with a boost or cut applied. For example, setting the 
trim control to -3 dB has the same effect as decreasing every envelope point by 3 dB. 

•	 To adjust the size of the Sends control region, you can drag the bottom divider to make more or fewer sends visible. 

Bus sends are post-volume (and post-mute) by default. To change to pre-volume (and pre-mute), click the Pre/Post button to switch to 
Pre-Volume Send mode. 

Changing an input bus’s input or output port 

When the I/O control region is visible, each bus displays controls you can use to set the bus's input and output device. 

To show or hide the I/O control region, click the I/O button in the View pane. 

Choosing an input device 

To choose an output device, click the Input button and choose a port from the menu. 

Choosing an output device 

To choose an output device, click the Output button and choose a bus or hardware output from the menu, or choose Output Off. 

Setting the output to Output Off is useful when you're using an input bus as a recording input and want to monitor the bus through the 
track or when using an input bus as a talkback mic. 

When you route busses to hardware outputs, the outputs from those busses will not be included in the mix when you render your 
project. 

If you want to use an input bus as a track input, click the Record Input button on the track header, choose Input Busses from the menu, 
and choose an input bus from the submenu. 

Monitoring bus levels 

When the Meters control region is visible, each bus displays meters you can use to monitor output levels. 
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To show or hide the Meters control region, click the Meters button in the View pane. 

Note: If the Meters control region is not visible, peak meters are displayed in the Faders control region. 

Right-click the meter and choose a setting from the shortcut menu to change the resolution and display options. 

Muting or soloing an input bus 

When the Faders control region is visible, each bus displays Mute and Solo buttons. 

To show or hide the Faders control region, click the Faders button in the View pane. 

Muting a bus 

When the Automation Settings button  is not selected, you can click the Mute button  to prevent a bus from being played in the 

mix. Click the Mute button  on additional busses to add them to the mute group. To unmute a bus, click the Mute button  again. 

When the Automation Settings button  is selected, the Mute button is displayed as , and you can use the button to edit mute 
automation on the bus track. 

Soloing a bus 

Click the Solo button to mute all unselected busses. Click the Solo button  on additional busses to add them to the solo group. To 

remove a bus from the solo group, click its Solo button again.

 Adjusting input bus volume or panning 

When the Faders control region is visible, each input bus displays a Pan slider and a Volume fader. 

Tip: The Pan slider is displayed only when an input bus is routed to the master bus or an auxiliary bus. It is not available when the input 
bus is routed directly to a hardware output. 

To show or hide the Faders control region, click the Faders button in the View pane. 
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Adjusting panning 

When the Automation Settings button  is not selected, you can drag the Pan slider to control the position of the bus in the stereo 
field: dragging to the left will place the bus in the left speaker more than the right, and dragging to the right will place the bus in the 
right speaker. 

You can hold Ctrl while dragging the slider to adjust the setting in finer increments, or double-click the slider to return it to 0. 

When the Automation Settings button  is selected, the Pan slider handle is displayed as a , and you can use it to edit pan 
automation on the bus track. 

Note: The trim level is added to the pan automation settings so your panning envelope is preserved, but with an offset applied. For 

example, setting the trim control to 9% left has the same effect as moving every envelope point 9% to the left.


Adjusting volume 

When the Automation Settings button  is not selected, you can drag the Volume fader to control the overall (trim) volume of the bus. 

You can hold Ctrl while dragging the slider to adjust the setting in finer increments, or double-click the slider to return it to 0. 

When the Automation Settings button  is selected, the Volume fader handle is displayed as a , and you can use it to edit volume 
automation on the bus track. 

Note: The trim level is added to the volume automation settings so your envelope is preserved, but with a boost or cut applied. For 

example, setting the trim control to -3 dB has the same effect as decreasing every envelope point by 3 dB.


Changing input bus pre/post routing 

Insert effects on input busses are always pre fader: the FX chain is not affected by the channel's gain fader. 

The Pre/Post Fader Send button allows you to create cue mixes that are not affected by the gain (or mute/pan) stages of the bus or 
track. 

• When Pre Fader Send is selected, your audio signal flows as follows: bus effects — bus send — bus pan — bus volume. 

• When Post Fader Send is selected, your audio signal flows as follows: bus effects — bus pan — bus volume — bus send. 

Using input busses with hardware-based effects 

Plug-ins are great, but there are times when you may want the sound of a specific piece of hardware for your tracks. This topic will show 
you how to use auxiliary busses and input busses to send a track to an external processor. 

1. Connect your effects processor to your audio interface: 

a. Connect the input of your effects processor to an output from your sound card (for this example, we'll use LineOut 1). 

b. Connect the output of your effects processor to an input on your sound card (for this example, we'll use Inst 1). 

2. Add an audio bus to your project. This bus will be used as a destination to send a track to your effects processor. 

3. Configure your bus to send its output to your effects processor: 

In the I/O control region of the bus's channel strip, click the Output button and choose the output that is connected to your effects 
processor's input (LineOut 1/LineOut 2 for this example). 

This auxiliary bus provides 
a signal path to your 
effects processor's input. 
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4.	 Add an input bus to your project. This input bus will receive the signal from your effects processor. For more information, see Adding 
a bus on page 168. 

5.	 Configure your input bus to take its input from the effects processor and send its output to your main mix: 

a.	 In the I/O control region of the input bus's channel strip, click the Input Source button and choose the sound card input that is 
connected to your effects processor's output (Inst 1 for this example). 

b.	 Click the Output button and choose the output where you want to send your processed signal. We’ll send this signal to the 
master bus so it is included with your main mix and will be included when performing a real-time render. For more information, 
see Rendering in real time on page 50. 

This input bus provides a signal path from your 

effects processor's output to your project.


6.	 Send your track to the effects processor: 

Click the bus button on the track header and choose the bus you created in step 2. 

The bus button on the track header 
lets you send the track's audio to 
your effects processor. 

.7.	 Click Play 

When you play your project, the track is sent to your auxiliary bus, into the effects processor, out of the effects processor into the 
input bus, and out to the master bus. 

8.	 When you're ready to render your project, you can use real-time rendering to include the output from your effects processor with 
your project. For more information, see Rendering in real time on page 50. 
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Using input busses with hardware-based synthesizers 

If you'd like to use your vintage synth with your ACID project, this topic will show you how to use input busses to send a MIDI track to a 
hardware synthesizer. 

1.	 Connect the MIDI Out port on your MIDI interface to the MIDI In port on your synthesizer. 

2.	 Connect the audio output of your synthesizer to an input on your sound card (for this example, we'll use Inst 1). 

3.	 Add an input bus to your project. This input bus will receive the audio signal from your synthesizer. For more information, see 
Adding or deleting input busses on page 168. 

4.	 Configure your input bus to take its input from the synthesizer and send its output to your main mix: 

a.	 In the I/O control region of the input bus's channel strip, click the Input Source button, and choose the sound card input that 
is connected to your synthesizer's output (Inst 1 for this example). 

b.	 Click the Output button and choose the output where you want to send your synthesizer's signal. We’ll send this signal to the 
master bus so it is included with your main mix and will be included when performing a real-time render. 

This input bus provides a signal path from your 

synthesizer's audio output to your project.


5. Send a MIDI track to the synthesizer:


Click the MIDI Output button on the track header and choose the MIDI port where you connected your synthesizer in step 1.


The MIDI Output on the track header lets you 
send the track's MIDI to your synthesizer. 

.6.	 Click Play 

When you play your project, the track is sent to your synthesizer, out of the synthesizer into the input bus, and out to the master 
bus. 

7.	 When you're ready to render your project, you can use real-time rendering to include the output from your synthesizer with your 
project. For more information, see Rendering in real time on page 50. 
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Monitoring an external source without mixing it with your project 

You may not want every signal that goes through the Mixing Console to be mixed with your project. For example, you could set up a 
cue (talkback) microphone to communicate between the control room and recording booth. 

This topic will show you how to use an input bus to set up a cue microphone. 

1.	 Add an input bus to your project. For more information, see Adding or deleting input busses on page 168. 

2.	 Connect a microphone to an input on your sound card (for this example, we'll use Mic/Inst 1). 

3.	 In the recording booth, connect a pair of powered speakers or a headphone amplifier to an output on your sound card (for this 
example, we'll use LineOut 3L/LineOut 4R). 

4.	 Set up your input bus: 

a.	 In the I/O control region of the input bus channel strip, click the Input Source button and choose the sound card input where 
your cue microphone is connected: 

b. Click the Output button and choose the sound card output where your speaker or headphone amplifier is connected: 

When you speak into the cue microphone, its output is sent to the recording booth without being mixed into your project output. 

Using FX send (assignable effects) channel strips 

A separate channel strip is displayed for each FX send (assignable effects chain) in your project. For information on adding assignable 
effects chains, see The Mixing Console toolbar on page 151. 

To show or hide channel strips for assignable effects, click the FX Sends button in the View pane. 
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Changing an assignable effect chain’s name 

To rename an assignable effects chain, double-click the label at the bottom of the channel strip and type a new name in the box (or 
press F2 to rename the selected assignable effects chain). The channel strip in the Mixing Console is updated when you press Enter. 

Adding or editing effects 

When the Insert FX control region is visible, each assignable effects chain displays its effects at the top of the channel strip.


To show or hide the Insert FX control region, click the Insert FX button in the View pane.


Each effect is displayed as a button. You can hover over the button to see a ToolTip that displays the full plug-in and preset name.


Adding a plug-in 

Click the  button and then choose a new plug-in from the menu to add a new plug-in to the effects chain. 

Editing effects settings 

Click an effect’s button to display the Audio Plug-In window, where you can adjust the plug-in’s settings. 

When you right-click an effect’s button, a shortcut a menu is displayed: 

• 	Choose  Show <Plug-In Name> to open the Audio Plug-In window, where you can adjust the plug-in's controls. 

• 	Choose  Bypass <Plug-In Name> to temporarily bypass a plug-in. 

When an effect is bypassed, its button is displayed in red text. 

• 	Choose  Remove <Plug-In Name> to remove a plug-in from the effects chain. 

• 	Choose  Presets, and then choose a setting from the submenu to load a new preset. 

•	 To replace the current plug-in, right-click the effect’s button, and then choose a new plug-in from the menu. Plug-ins are organized 
in submenus by type (EQ, Dynamics, Reverbs, etc.) 
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Adjusting assignable effects input levels 

When the Sends control region is visible, each assignable effects chain displays controls you can use to adjust and monitor the input 
volume of the effects chain. 

To show or hide the Sends control region, click the Sends button in the View pane. 

Changing an effects chain’s output device 

When the I/O control region is visible, each assignable effects chain displays controls you can use to set the chain’s output device.


To show or hide the I/O control region, click the I/O button in the View pane.


To choose an output device, click the Output button and choose a bus from the menu.


Monitoring output levels 

When the Meters control region is visible, each assignable effects chain displays meters you can use to monitor output levels.


To show or hide the Meters control region, click the Meters button in the View pane.


If the Meters control region is not visible, peak meters are displayed in the Faders control region. 


Right-click the meter and choose a setting from the shortcut menu to change the resolution and display options.


Muting or soloing an assignable effects chain 

When the Faders control region is visible, each assignable effects chain displays Mute and Solo buttons. 

To show or hide the Faders control region, click the Faders button in the View pane. 

Muting an assignable effects chain 

When the Automation Settings button  is not selected, you can click the Mute button  to prevent an assignable effects chain bus 
from being played in the mix. Click the Mute button on additional chains to add them to the mute group. To unmute a chain, click the 
Mute button again. 

When the Automation Settings button  is selected, the Mute button is displayed as , and you can use the button to edit mute 
automation on the bus track. 

Soloing an assignable effects chain 

Click the Solo button  to mute all unselected assignable effects chains and busses. Click the Solo button on additional assignable 
effects chains or busses to add them to the solo group. To remove a chain from the solo group, click its Solo button again. 

Adjusting assignable effects panning or volume


When the Faders control region is visible, each bus displays a Pan slider and a Volume fader.


To show or hide the Faders control region, click the Faders button in the View pane. 
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Adjusting panning 

When the Automation Settings button  is not selected, you can drag the Pan slider to control the position of the bus in the stereo 
field: dragging to the left will place the bus in the left speaker more than the right, and dragging to the right will place the bus in the 
right speaker. 

You can hold Ctrl while dragging the slider to adjust the setting in finer increments, or double-click the slider to return it to 0. 

When the Automation Settings button  is selected, the Pan slider handle is displayed as a , and you can use it to edit pan 
automation on the bus track. 

Note: The trim level is added to the pan automation settings so your panning envelope is preserved, but with an offset applied. For 

example, setting the trim control to 9% left has the same effect as moving every envelope point 9% to the left.


Adjusting volume 

When the Automation Settings button  is not selected, you can drag the Volume fader to control the overall (trim) volume of the bus. 

You can hold Ctrl while dragging the slider to adjust the setting in finer increments, or double-click the slider to return it to 0. 

When the Automation Settings button  is selected, the Volume fader handle is displayed as a , and you can use it to edit volume 
automation on the bus track. 

Note: The trim level is added to the volume automation settings so your envelope is preserved, but with a boost or cut applied. For 

example, setting the trim control to -3 dB has the same effect as decreasing every envelope point by 3 dB.
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Chapter 11 
Recording Audio 

ACID® software can record audio into multiple mono or stereo audio tracks while simultaneously playing back existing 
audio and video tracks. You are limited only by the performance of your computer system and audio hardware. Audio is 
recorded to a media file on your computer and into an event on the timeline. You may record into an empty track, a time 
selection, an event, or a combination of time and event selection. Audio output from your computer during recording is 
not necessarily recorded with the new audio. 

Recording does not alter any of the source media files in your project. Even when recording into an existing event, you 
are not overwriting the data in that event. Instead, the data is recorded into a new take for that event and saved to a 
media file on your hard drive. 

For information about real-time MIDI recording, MIDI merge recording, and MIDI step recording, see Recording MIDI on 
page 189. 

Setting up your equipment 

There are numerous ways to connect your equipment to your system. Refer to your equipment’s documentation for 
specific setup instructions. The following are some possible general configurations. 

Basic setup 

This setup includes a simple microphone and speaker that are connected to the computer’s sound card. With a more 
sophisticated microphone, you would typically want to use a preamplifier for input to the sound card. 

Sound card out 

Sound card in 

Setup with mixer 

This setup includes a mixer where the speaker and microphone connect. The mixer is then connected to the computer’s 
sound card. Mixers usually have preamps built into them. This diagram does not show you an instrument or a physical 
preamplifier, such as a rack-mounted component. The reason for this omission is because these types of setups vary 
widely based on your mixer, instrument, and pre-amp type. Refer to your components’ documentation for specific setup 
configurations. 

Sound card out 

Sound card in 

Mixer out 

Mixer in 

Mixer 
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Setup with digital multitrack 

This setup includes a digital multitrack recorder with an optional MIDI synchronization component. Usually you would have a mixer, a 
microphone, etc. connected to these components. Your particular setup will vary depending on your equipment. Refer to your 
components’ documentation for specific setup configurations. 

Digital card 

MIDI card 

Digital out 

Digital in 

Sync. out 

Sync. in 
Digital 
multitrack 

MTC converter 

The dashed line indicated an 
option if you are synching ACID 
software to tape via a MIDI 
timecode. 

Preparing to record 

Before you record, you must arm the tracks into which you will record the new audio. You must also select the recording settings for the 
tracks. You have the additional options of using a metronome or turning off playback during recording. 

You may record into an empty track, a time selection, an event, or a combination of time and event selection. You can also record 
multiple takes for an event so you can maintain multiple versions of an event that you may play back and edit. 

Arming the track for recording 

Whether recording into an existing track, an empty track, a selected event, or a time selection, you must prepare a track for recording. 
You can arm multiple tracks prior to recording. 

Click the Arm for Record button ( ) in the track list. 


Once a track is armed, a record meter appears in the track list. Depending on your hardware, a record gain fader may also appear.


Using the metronome 

A built-in metronome marks time to help with the timing and tempo when recording a performance. The metronome’s sound is not 
mixed in the final rendering of the project. 

Turning the metronome on or off 

From the Options menu, choose Metronome (or click the Metronome button on the transport bar) to turn the metronome on or 
off. 

When you start recording or playing your project, the metronome will start playing the project tempo and will follow any tempo or time 
signature changes. For example, if you start recording at measure 20 and your project tempo changes at that measure is 160 BPM, the 
metronome will play at 160 BPM. 
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The metronome sounds are created by the general MIDI sound set, and the volume of the metronome is determined using the Preview 
fader in the Mixing Console. 

Notes: 

•	 The metronome’s sound is not mixed in the final rendering of the project. 
•	 Before rendering from a ReWire mixer application, turn off the ACID metronome, or the metronome will be included in the rendered


output.

•	 The metronome will not follow grooves that you’ve applied to your project. If you want to hear a grooved metronome, use a simple click 

loop and apply the desired groove to the track. 

Using the metronome to count off for playback or recording 

Metronome countoff allows you to use the metronome to count off a set number of bars before beginning recording or playback in the 
same way a drummer counts off with her sticks before the band starts playing. 

From the Options menu, choose Enable Metronome Countoff (or click the Metronome Countoff  button on the Transport bar) 
to turn metronome countoff on or off. 

You can click the down arrow next to the button to set countoff options: 

Item 

Enable Metronome Countoff 

Description 

Turns countoff on or off. 

Countoff Always On Metronome counts off during playback and recording. 

Countoff Only During Playback Metronome counts off during playback only. 

When countoff is turned on for playback only the button will display a play icon: 

Countoff Only During Recording Metronome counts off during recording only.


When countoff is turned on for recording only, the button will display a record icon:


One-Bar Countoff Sets the number of measures before the cursor position the metronome will count off. 

Two-Bar Countoff 
Note: Countoff always uses the tempo at the cursor position. Countoff always uses the tempo at the cursor 

Four-Bar Countoff position. In the following example, if you positioned the cursor at measure three and choose Two-Bar Countoff, 
the metronome would count off for two measures at 120 BPM before reaching the cursor position: 

Configure Metronome Displays the Audio tab in the Preferences dialog, where you can choose a metronome sound. For more 
information, see Using the Audio tab on page 255. 

Adjusting the metronome’s volume 

If you need to adjust the volume of the metronome, drag the Preview fader in the Mixing Console. 

If the Preview fader isn’t visible, click the Preview Bus button in the Mixing Console View pane. 

For more information on the Mixing Console, see Using the Mixing Console on page 151. 
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Recording 

You may record into an empty track, a time selection, an event, or a combination of time and event selection. The recording is added to 
the timeline as new clip and is saved to a media file on your hard drive. 

By default, the Microsoft Sound Mapper is used to record audio. However, you can use the Audio Device tab in the Preferences dialog to 
specify a different recording device. For more information, see Using the Audio Device tab on page 257. 

Notes: 

•	 Recorded files are in the folder specified on the Folders tab of the Preference dialog by default. If you want to choose a project-specific 
folder, you can use the Recorded files folder box on the Audio tab of the Project Properties dialog. For more information, see Using the 
Audio tab on page 255. 

•	 You can use the ACID type for recorded audio drop-down list on the Audio tab of the Preferences dialog to indicate whether you want 
to create Beatmapped clips of one-shots when recording audio. 

•	 Use the Record action when nothing is armed drop-down list on the Audio tab of the Preferences dialog to indicate whether you want 
to create an audio track, a MIDI track, or do nothing if you click the Record button  when no tracks are armed. 

Recording into an empty track 

1.	 Select a track. Alternately, to record to a new track, choose Audio Track from the Insert menu. 

2.	 Place the cursor on the timeline where you want to begin recording. 

3.	 Arm the track by clicking the Arm for Record button ( ) on the track. 

4.	 Start recording by clicking the Record button ( ) on the transport bar.


Depending on the recording selection, a waveform is created along the timeline as you record into the armed track(s).


Recorded waveform 
Start/stop 
recording 

Stop recording 

5.	 Stop recording by clicking the Record button ( ) again or the Stop button ( ) on the transport bar. 

6.	 A small dialog opens displaying the name and location of the file or files that were just created. Click Done to return to the main 
workspace. 

When a check mark appears in this box, 
ACID software displays this dialog after 
each recording session. 

Delete—removes selected file 

Rename—changes the name of a selected file 

Delete All—removes all files in dialog 

Done—returns to track view 
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Recording into a time selection 

By making a time selection, you specify where along the timeline to 
record. The time selection also determines how long the software 
records. Any selected events that occur within the time selection are 
split and the recorded data is placed into the time selection. 

The event’s waveform is displayed as it is recorded and automatically 
stops recording when the cursor reaches the end of the time selection. Recorded waveform 

Recording into an event 

By recording into an event, you automatically create a new clip containing the recorded material that is the same duration as the 
selected event. The edges of the selected event serve as the punch-in and -out points that are used for recording. Recording into an 
event allows you to establish a pre-roll before recording, which gives you time to prepare before recording starts. 

Because the entire recording is saved to the media file (not just the material between the edges of the take), you are not limited to the 
recorded material contained in the length of the new clip. You can adjust the edges of the event or slip the contents of the event if 
necessary. For more information, see Shifting the contents of (slipping) events on page 64. 

The existing event that you record into is not affected or deleted. Instead, the event now contains two media files, each listed as a 
separate clip in the track’s Clip Pool. For more information, see Using the Clip Pool to manage clips on page 104. 

1.	 Place the cursor before the event to allow for pre-roll. 

2.	 Press Ctrl and click the event to select it. 

Tip: You can record into multiple events by pressing Ctrl and making selections. 

3.	 Click the Arm for Record button ( ) on the event’s track. When recording into multiple selected events, arm their respective 
tracks at this time. 

4.	 Click the Record button ( ) on the transport bar to begin recording. 

5.	 Click the Record button ( ) again or the Stop button ( ) on the transport bar to stop recording. 

Recording into an event with a time selection 

Recording into a time selection allows for a pre- and post- roll during recording. The time selection is adjustable to increase or decrease 
the pre- and post-roll duration. During recording, the selected event’s edges serve as the punch-in and -out points. You can create 
multiple punch-in and -out points by selecting more events within the time selection. 

You may need to split an existing event into three pieces so that you can select a smaller portion of the event to record into. For more 
information, see Splitting events on page 58. 

1.	 Click the Arm for Record button ( ) on the desired track(s). 

2.	 Select the event to record into. 

Tip: You may record into multiple events by pressing Ctrl and making your selections. 

3.	 On the marker bar, drag a time selection. You may adjust the time selection by dragging the selection bar’s starting and ending 
points. Make the time selection start before the event for a pre-roll. 

4.	 Click the Record button ( ) on the transport bar to begin recording. 

If input monitoring is turned on, the track’s original audio is played until the cursor reaches the selected event. When the cursor 
plays through the selected event, you’ll hear your recording input, and the track’s original audio is played again when the cursor 
moves past the selected event. 
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Using pre-roll 

The previous technique allows you to define the playback region with a time selection and sets the punch-in and punch-out points in 
the recording to the event boundaries. When you click the Record button, playback begins at the beginning of the time selection. The 
event is then filled with the newly recorded material. The audio file that is recorded to your hard disk is the full duration of the time 
selection. The event only contains a portion of the full recorded performance and can therefore be trimmed (both shorter and longer) 
and repositioned within the event. 

Time selection bar ­
defines the recorded 
audio file’s duration. 

Post-roll Pre-roll 

Punch-out Punch-in 

Recording using an input bus 

When you use an input bus to record audio, you can include input bus effects with the recorded signal. 


For example, imagine that you need to record an electric guitar with an amplifier-modeling plug-in. 


Scenario 1: Plug your guitar into your sound card's instrument input and choose that input as your recording input: 


In this scenario, you could then add your amplifier-modeling plug-in as a track effect and record with input monitoring on. Your guitar 

would be recorded directly (without the plug-in), and the plug-in would be processed each time you play or render your project. This 

method allows you to adjust the plug-in settings as you work on your project.


Scenario 2: Set up an input bus that uses your amplifier-modeling plug-in as an insert effect, and choose that input bus as your 

recording input:


In this scenario, your amplifier-modeling plug-in is cooked into the recorded signal. This method allows you to record your processed

signal but doesn't allow you to change your amplifier settings without rerecording the guitar part. 


1.	 Add an input bus to your project. For more information, see Adding or deleting input busses on page 168. 

2.	 Set up your input bus: 

a.	 Click the Add New Insert FX button  in the Insert FX control region of the input bus channel strip to add plug-ins to 
your input bus. For more information about input bus channel strips, see Using input bus channel strips on page 169. 

b.	 In the I/O control region of the input bus channel strip, click the Input Source button and choose the sound card input you 
want to record. 

c.	 Click the Output button in the I/O control region of the input bus channel strip and choose Off. The bus output is left off so we 
can monitor the input through the track. 

3.	 Set your track to record from your input bus: 

a.	 Click the Record Input button on the track header, choose Input Busses from the menu, and choose your input bus. 

b.	 Click the Record Input button and choose Input Monitor Mode: On or Input Monitor Mode: Auto so you can hear your input 
signal during recording. 

•When Auto  is selected, you will hear the input monitor signal when playback is stopped and during recording. If you're 
recording into selected events, you'll hear the input monitor signal only when the cursor passes over the selected events. 

•When On  is selected, the behavior is similar to Auto mode, but you will always hear the input monitor during recording 
— monitoring is not toggled on and off when recording into a selected event. 

Important: Your ability to monitor effects in real time is dependent on your computer's performance. Effect automation envelopes are 
bypassed during record monitoring. 

4.	 Position the cursor where you want to start recording. 
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5.	 Select the Arm for Record buttons ( ) on the track where you want to record. Arming a track enables it for recording. 

When a track is armed, the track meter displays the track's level. If input monitoring is not on, the meter displays the level of your 
input source. If input monitoring is turned on, the meter shows the level of the input source plus the track effects chain. 

6.	 Click the Record button ( ) on the Transport bar to start recording. 

7.	 To stop recording, click the Record button again or click the Stop button ( ) on the Transport bar. The Recorded Files dialog is 
displayed. 

8.	 Use the Recorded Files dialog to confirm the file name and location of your recorded audio. Click Delete or Delete All if you do not 
want to save the recorded files, or click Rename to change the file's name. 

9.	 Click Done to close the Recorded Files dialog. Your recorded file is displayed as a new event in the timeline. 

Working with multiple recorded clips 

Clicking the Loop Playback button ( ) on the transport bar enables you to continually create clips during recording. The last clip 
recorded is set as the track’s active clip. You can use clips as different versions of a recorded event that you can quickly switch between 
to choose the best one. 

During recording with loop playback enabled, the time selection continually repeats and starts recording a new clip until you stop 
recording. You can preview, select, rename, and delete clips in the Clip Pool pane of the Track Properties window to manage the clips. 
For more information, see Using the Clip Pool to manage clips on page 104. 

The Clip Properties window will display region markers to represent the selected event’s clip in the waveform. For more information, see 
Configuring clip properties on page 115. 

Specifying where recordings are stored 

Recorded files are saved in the folder specified on the Folders tab of the Preferences dialog is used by default. 

If you want to choose a project-specific recorded files folder, you can use the Recorded files folder box on the Audio tab of the Project 
Properties dialog. 

Changing where recorded files are stored for new projects 

1.	 From the Options menu, choose Preferences. 

2.	 Click the Folders tab. 

3.	 Choose a setting from the Record drop-down list or click the Browse button to choose a folder. 

4.	 Click OK. 

Changing where recorded files are stored for individual projects 

1.	 From the File menu, choose Properties. The Project Properties dialog appears. 

2.	 Click the Audio tab to display the project’s audio properties. 

3.	 Click the Browse button next to the Recorded files folder box. 

4.	 Browse for the location where you want to save recorded files. 

5.	 Click OK. 
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Monitoring audio levels 

While you’re recording, a responsive meter is provided in the track header to monitor the 
incoming signal level of the selected recording device. It is important that you record 
with the highest signal possible without clipping. 

A reading of 0 dB is the maximum for a digital signal. Clipping occurs when the incoming 
signal is too high to be represented as a digital value. The result is distortion in the recording. A clipped signal will be indicated by a red 
indicator warning at the end of the meters. 

Right-click the meters and choose a command from the shortcut menu to adjust the display of the meters. 

Using record input monitoring 

If you’re using a low-latency audio device and you want to hear your recording signal with real-time track effects, you can turn on input 
monitoring. 

To turn on input monitoring, click the Record Device Selector button ( ) and choose Input Monitor Mode: Auto or Input Monitor 
Mode: On from the menu. During recording, your signal will be played back with the current track effects chain, but a dry (unprocessed) 
signal is recorded. 

When Input Monitor Mode: Auto  is selected, you will hear the input monitor signal when playback is stopped and during 
recording. If you’re recording into selected events, you'll hear the input monitor signal only when the cursor passes over the selected 
events. 

When Input Monitor Mode: On  is selected, the behavior is similar to Input Monitor Mode: Auto, but you will always hear the input 
monitor during recording—monitoring is not toggled on and off when recording in to a selected event. 

Note: Your ability to monitor effects in real time is dependent on your computer's performance. Effect automation envelopes are 

bypassed during record monitoring.
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Chapter 12 
Working with MIDI 

ACID® software allows you to record MIDI tracks and edit MIDI in your projects. The software provides two plug-ins: the 
piano roll editor and the list editor. You can also render projects with MIDI tracks, play MIDI from an external device, and 
synchronize to MIDI timecode (MTC). 

Adding MIDI tracks and files 

You can add MIDI files to your project or create new MIDI files from scratch. You can use MIDI tracks to record and play 
back data from synthesizers and other MIDI-compliant equipment. MIDI tracks can use .mid, .smf, .wav, and .rmi files. 

Adding MIDI tracks 

To add a new, blank MIDI track to your project do one of the following: 

• 	From the  Insert menu, choose MIDI Track . 

• Right-click in the timeline and choose Insert MIDI Track. 

Tip: You can also add a MIDI track by pressing Ctrl+Alt+Q. 

Adding MIDI files to a project 

You can add MIDI files to your project just as you would add audio files. You can double-click a MIDI file to create new 
tracks and events, or you can drag a MIDI file from the Explorer or Media Manager window to an existing track to add a 
new clip. 

Note: When you select a MIDI file in the Explorer window, its length, tempo, type, and number of tracks are displayed 
at the bottom of the window: 

When you right-click a MIDI file in the Explorer window, you can choose how you want to add it to your project: 

1.	 Add to Project — Adds the file to the current ACID project and adds tracks to the track list. No events are created. 

•	 For Type 0 MIDI files, a separate track is created for each channel in the MIDI file, and all tracks are organized 
within a folder track. 

•	 For Type 1 MIDI files, a separate track is created for each track in the MIDI file, and all tracks are organized within 
a folder track. 
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2.	 Add to Project with Events — Adds the file to the current ACID project at the cursor position, adds tracks to the track list, and 
creates events for the MIDI note data on each track. Envelopes are added to the tracks to represent MIDI controller data. 

•	 For Type 0 MIDI files, a separate track is created for each channel in the MIDI file, and all tracks are organized within a folder 
track. 

•	 For Type 1 MIDI files, a separate track is created for each track in the MIDI file, and all tracks are organized within a folder track. 

3.	 Add to Project with Events Rippled — Adds the file to the current ACID project at the cursor position, adds tracks to the track list, 
and creates events. Existing events are shifted downstream to make room for your MIDI file. Envelopes are added to the tracks to 
represent MIDI controller data. 

•	 For Type 0 MIDI files, a separate track is created for each channel in the MIDI file, and all tracks are organized within a folder 
track. 

•	 For Type 1 MIDI files, a separate track is created for each track in the MIDI file, and all tracks are organized within a folder track. 

4.	 Open as New Project — Starts a new project, adds tracks to the track list, and creates events for the MIDI note data on each track. 

•	 For Type 0 MIDI files, a separate track is created for each channel in the MIDI file. 

•	 For Type 1 MIDI files, a separate track is created for each track in the MIDI file. 

Freezing MIDI tracks 

Projects that use soft synths can tax your computer's processing and disk resources. Freezing MIDI tracks allows you to convert each 
MIDI track to a .wav file, effectively taking your soft synths offline. 

Freeze your tracks when you're finished editing them. After freezing, you can adjust track volume and panning only. 

Notes: 

•	 Only tracks that are routed to soft synths can be frozen. Track freeze is unavailable for tracks that are routed to MIDI devices or ReWire 
devices, muted, or armed for recording. 

•	 Any VSTi parameter envelopes you have applied to a soft synth bus track are also saved into the frozen .wav file. 
•	 The soft synth bus in the Mixing Console window is not frozen. You can continue to work with effects, volume, and panning on the soft 

synth bus. 
•	 If you freeze your MIDI tracks and save your project as an ACID project with embedded media (.acd-zip), the frozen .wav files will be 

saved with your project. You can use this method to archive a MIDI project or share your project with a collaborator who doesn't have 
all your soft synths. 

Freezing selected tracks 

1.	 Select the tracks you want to freeze. 

2.	 Click the Freeze Track button  on a selected track (or right-click a selected track and choose Freeze Track from the shortcut 
menu). 

The tracks are rendered to .wav format. Please note that render speed is dependent on the soft synth plug-in. 

If you freeze a track that is routed to a multiport VST instrument, you'll be prompted to choose which port you want to freeze. VSTi 
technology does not allow you to freeze multiple ports. 

MIDI track before freezing 

MIDI track after freezing—all controls 
other than Mute, Solo, Volume, Pan, and 
Automation Settings are unavailable. 
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Editing frozen tracks 

After you freeze a MIDI track, you can adjust track volume and panning only. Trim and automation controls are available in the track 

header and Mixing Console.


These controls behave as they do on an audio track. For more information, see Adjusting the mix on page 41.


A frozen MIDI track does not allow you to edit the following:


•	 Moving, splitting, deleting, and drawing events are not available. 

•	 MIDI data — such as inline MIDI editing, continuous controller messages, SYSEX data, volume and pan messages, and voice 
changes — is frozen. 

•	 MIDI filtering is not available. 

•	 MIDI track properties cannot be edited. 

•	 The Chopper window is not available. 

Unfreezing tracks 

1.	 Select the tracks you want to unfreeze. 

2.	 Click the Freeze Track button  on a selected track (or right-click a selected track and choose Freeze Track from the shortcut 
menu to clear the check box). 

Recording MIDI 

You can use an external MIDI controller (or the keyboard/drum list between the track header and timeline) to record MIDI into your 

ACID project.


You can record in real time during project playback by using step recording or MIDI merge recording to build MIDI tracks.


Track-level MIDI input filters—available on the Input Filters tab in the Track Properties window—allow you to control exactly which 


MIDI messages you want to record (or exclude) or even split a MIDI keyboard into zones to record into two different tracks at once.


Tip: If you use the keyboard/drum list between the track header and timeline to input MIDI notes, note that the buttons are velocity 
sensitive: clicking toward the right side of a button plays the note with a higher velocity setting than clicking toward the left side. The 
keyboard/drum list is visible in inline MIDI editing mode. 

Important: Attempting to record MIDI controller data over an existing event will overwrite existing note data. If you want to record 
controllers over an existing event, use MIDI merge recording. For more information, see Using MIDI merge recording on page 192. 
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Setting up a MIDI controller for recording into a track 

1.	 Select the MIDI track you want to record into, or press Ctrl+Alt+Q to add a new, blank MIDI track to your project. 

2. Choose a MIDI input port by clicking the MIDI Input button on the track header. Choose a command from the menu: 

•	 Auto Input  — Uses automatic input routing. The focus track will accept input from any MIDI device. 

•	 Input Off  — Turns off MIDI input to the track. 

•	 Hardware Input Port List  — Displays the devices that are selected in the Make these devices available for MIDI input list 
on the MIDI tab of the Preferences dialog. Choose the specific device you want to use to send MIDI to the track. 

Note: You must choose a specific input port to use MIDI input filters. For more information, see Configuring MIDI input filters on page 
205. 

•	 Soft Synth Input Port List  — Displays the available soft synths in your project. Choose the soft synth you want to use to 
send MIDI to the track. 

Choose Soft Synth  from the Insert menu and select a soft synth for your project from the Soft Synth Chooser dialog. You 
can also select Insert Soft Synth from the Mixing Console window. 

3.	 Choose a MIDI input channel: 

• 	Click the  MIDI Input button on the track header. 

• 	Choose  MIDI Channel from the menu, and choose the MIDI channel you want to send data to the track, or choose All if you 
want the track to listen to all channels. 

Tip: If you want to select multiple input channels, hold Ctrl and select additional channels from the MIDI Channel submenu. 

4.	 Click the MIDI Input button on the track header and choose Send MIDI Input Thru to MIDI Output from the menu if you want to 
echo notes from the MIDI controller to the track's MIDI device or soft synth for monitoring. 

5.	 Click the MIDI Input button on the track header and choose MIDI Input Filters from the menu to open the Track Properties 
window. Use the Input Filters tab to specify which MIDI messages you want to record (or exclude). For more information, see 
Configuring MIDI input filters on page 205. 

Recording MIDI in real time 

With real-time recording, you can record MIDI in real time while your project plays back. 

1.	 Connect a MIDI controller to your computer. If you don't have a MIDI controller, you can use the keyboard in the track view (when 
in MIDI timeline editing mode) or the keyboard in the Soft Synth Properties window. For more information, see Soft Synth Properties 
on page 23. 

Note: Not all VSTi plug-ins can record using the keyboard in the Soft Synth Properties window. 

2.	 Select the Arm for Record buttons  on the tracks where you want to record. Arming a track enables it for recording. 

3.	 Choose a MIDI input device and channel for each armed track. For more information, see Setting up a MIDI controller for recording into 
a track on page 190. 

If you’re recording using the keyboard in the track view or the Soft Synth Properties window, choose Auto Input. 

Click the MIDI Input button on the track header and choose Send MIDI Input Thru to MIDI Output from the menu if you want to 
echo notes from the MIDI controller to the track’s MIDI device or soft synth for monitoring. 

4.	 Set up any desired MIDI message, velocity, or quantize filters for your armed tracks. For more information, see Configuring MIDI input 
filters on page 205. 

5.	 Position the cursor where you want to start recording. 
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6.	 Click the Record button on the transport bar to start recording. MIDI messages from your controller are recorded as you play 
them. 

•	 Notes are added to an event in the timeline. 

•	 MIDI controller adjustments (such as pitch wheel and modulation wheel movements) are recorded as track envelopes. For 
more information, see MIDI controller automation on page 141. 

MIDI controllers are recorded in latch mode: envelope points are created when you change a control setting, and recording 
continues until you stop playback. When you stop adjusting the control, the control's current setting overwrites the existing 
envelope points. 

Note: Envelope points are not thinned when recording MIDI controllers from a hardware device. 

7.	 To stop recording, click the Record  button again or click the Stop button on the transport bar.

A new clip is created for the recorded MIDI data on each armed track. You can use the Clip Pool tab in the Track Properties window

to manage clips.


Note: You can also record into time selections, punch into MIDI events, or record multiple clips (when recording into a selection with 

Loop Playback  selected) in the same way you record audio. 

Using MIDI step recording 

Click the MIDI Step Record  button to open the MIDI Step Record dialog, where you can record by specifying the interval between 
MIDI messages. Step recording allows you to record notes with very precise timing. 

1.	 Connect a MIDI controller to your computer. If you don't have a MIDI controller, you can use the keyboard in the track view (when 
in MIDI timeline editing mode) or the keyboard in the Soft Synth Properties window. 

Note: Not all VSTi plug-ins can record using the keyboard in the Soft Synth Properties window. 

2.	 Select the Arm for Record buttons on the tracks where you want to record. Arming a track enables it for recording. If you don't 
arm a track for recording, a new MIDI track will be created when you click the MIDI Step Record button. 

3.	 Choose a MIDI input device and channel for each armed track. For more information, see Setting up a MIDI controller for recording into 
a track on page 190. If you're recording using the keyboard in the track view or the Soft Synth Properties window, choose Auto 
Input. Click the MIDI Input button on the track header and choose Send MIDI Input Thru to MIDI Output from the menu if you 
want to echo notes from the MIDI controller to the track's MIDI device or soft synth for monitoring. 

4.	 Set up any desired MIDI message, velocity, or quantize filters for your armed tracks. For more information, see Configuring MIDI input 
filters on page 205. 

5.	 Position the cursor where you want to start recording. 

6.	 Click the MIDI Step Record button. 
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7.	 Use the MIDI Step Record dialog to set options for recorded MIDI notes. 

a.	 Click the Step size button and choose interval between the beginnings of notes. 
Select the Tuplet check box to set irregular intervals. For example, to set a triplet interval in 4/4 time, select the Tuplet check 
box and choose 3 in time of 4. 

b.	 Click the Duration button and choose length of the note's sustain. When you choose a duration longer than the step size, 
notes will overlap. 

c.	 To set the note-on velocity for recorded notes, type a value in the Velocity box. If you want to record note-on velocity from 
your controller, select the As Played check box. 

8.	 MIDI messages from your controller are recorded as you play them, and notes are added to an event in the timeline. 

Notes: 

•	 MIDI controller adjustments (such as pitch wheel and modulation wheel movements) are not recorded in step record mode. 
•	 If you press a key before releasing the current key, both notes will be recorded at the same timeline position. Release both keys to advance 

to the next step. 

9.	 To stop recording, close the MIDI Step Record dialog or click the Stop button on the transport bar. 

Using MIDI merge recording 

Click the MIDI Merge Record  button to build a MIDI part by recording repeatedly into a loop region. MIDI merge data is recorded in 
real time, and you can add more notes each time recording passes through the loop region. 

1.	 Connect a MIDI controller to your computer. If you don't have a MIDI controller, you can use the keyboard in the track view (when 
in MIDI timeline editing mode) or the keyboard in the Soft Synth Properties window. 

Note: Not all VSTi plug-ins can record using the keyboard in the Soft Synth Properties window. 

2.	 Select the Arm for Record  buttons on the tracks where you want to record. Arming a track enables it for recording. If you don't 
arm a track for recording, a new MIDI track will be created when you click the MIDI Step Record button. 

3.	 Choose a MIDI input device and channel for each armed track. For more information, see Setting up a MIDI controller for recording into 
a track on page 190. 

4.	 Set up any desired MIDI message, velocity, or quantize filters for your armed tracks. For more information, see Processing and filtering 
MIDI events on page 198. 

5.	 Click and drag in the marker bar or a blank area of the timeline to create a loop region. 

6.	 Select the Loop Playback button. 

7.	 Select the MIDI Merge Record button. 

8.	 Position the cursor at the start of the loop region. If you want to record with pre-roll, you can position the cursor before the loop 
region. 
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9. Click the Record button on the transport bar to start recording.


MIDI messages from your controller are recorded as you play them. 


• Notes are added to an event in the timeline. 

•	 MIDI controller adjustments (such as pitch wheel and modulation wheel movements) are recorded as track envelopes. For 
more information, see MIDI controller automation on page 141. MIDI controllers are recorded in touch timeout mode: envelope 
points are created or edited when you change a control setting. When you stop adjusting the control, existing envelope points 
on the timeline are preserved. 

MIDI controllers that are switches (such as a damper pedal) are always recorded in latched mode: envelope points are created 
when you change a control setting, and recording continues until you stop playback. When you stop adjusting the control, 
the control's current setting overwrites the existing envelope points. 

When recording returns to the beginning of the loop region, existing MIDI controller envelopes are unaffected. For example, 
you could record note data the first time recording passes through the loop region, record pitch-bend controllers the second 

time, and modulation the third time. 

Note: Envelope points are not thinned when recording MIDI controllers from a hardware device. 

10. To stop recording, click the Record  button again or click the Stop  button on the transport bar. 

Editing MIDI on the timeline 

Click the Enable Inline MIDI Editing button to edit MIDI events directly on the timeline. In this mode, you can draw and erase notes 
in a piano roll or drum grid view. 

A piano roll allows you to edit MIDI notes for 
most patches. 

A drum grid allows you to edit MIDI notes for soft 
synths that have drum maps defined. 
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When you edit a MIDI event, all events that use the same clip will be updated. For more information, see Using clips with tracks on page 
101. 

Tips: 

• Hold Ctrl+Shift while double-clicking a MIDI event to enter inline editing mode. 
• While in inline editing mode, drag over a blank area of the timeline with the Draw tool to create a new clip and draw an empty event. 
• While in inline MIDI editing mode, you can hover over a note or velocity stem to view its value in the bottom-right corner of the timeline: 

• If you want to move a MIDI event while in timeline MIDI editing mode, drag the top of the event with the Draw  or Selection  tool: 

If you want to edit a single event, right-click the event and choose Copy to New Clip from the shortcut menu. 

Choosing a drum map or kit for a track 

MIDI tracks can display a piano roll or a drum grid. For more information, see Creating or editing drum maps on page 225. 

Tracks that are routed to the DLS soft synth will display a drum grid only if a drum map exists for the current patch. You cannot edit 
drum maps for GM2 drum kits. 

Choosing a drum map or kit 

1.	 Click the Program button on the track header. 

2.	 Perform one of the following actions: 

•	 If your track is routed to the DLS soft synth, choose Drum Kits from the menu. A submenu displays the available drum kits. 

•	 If your track is routed to a MIDI device or a VSTi soft synth, choose Drum Maps from the menu, and then choose Select Drum 
Map from the submenu. The Output Settings page of the Track Properties dialog is displayed. 

3.	 Choose the drum map or kit you want to use. 

Displaying the piano roll 

If your track is routed to a MIDI device or VSTi soft synth, you can switch from a drum grid view to a piano roll view. Click the Program 

button , choose Drum Maps, and then choose None. 

Navigating the piano roll or drum grid 

In inline MIDI editing mode, adjusting the height of the track will allow you to see more or less of the piano roll or drum grid. After you 
set the height of the track, you can use the following methods to navigate. 
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Scroll vertically 

Perform any of the following actions to scroll vertically within a track: 

• Use the scroll buttons at the left edge of the track to scroll up or down: 

Piano roll Drum grid 

•  With the Draw  or Selection tool, hover over the timeline and hold Ctrl while rolling the mouse wheel forward or back. 

• Hold Ctrl while dragging the keyboard/drum list up or down. 

• Hover over the keyboard/drum list and roll the mouse wheel forward or back. 

Zoom note height 

Perform either of the following actions to zoom note height: 

•  With the Draw  or Selection tool, hover over the timeline and hold Ctrl+Alt while rolling the mouse wheel forward or back. 

• Hover over the keyboard and hold Shift while rolling the mouse wheel forward or back. 

Zoom note width 

Note width is based on the horizontal zoom level of the timeline. Use the zoom controls in the lower-right corner of the timeline (or 
hover over the timeline and roll the mouse wheel forward or back) to zoom in or out. 

Auditioning notes with the keyboard/drum grid 

You can use the keyboard/drum grid between the track header and timeline to audition the track's MIDI output or record MIDI. When 
you click the keys, the note is played using the appropriate patch at the cursor position. 

These buttons are velocity sensitive: clicking toward the right side of a button plays the note with a higher velocity setting than clicking 
toward the left side. 

Clicking toward the right side of the keyboard (or Clicking toward the left side of the keyboard (or 

drum list) plays the note with a higher velocity. drum list) plays the note with a lower velocity.


Audio driver latency can limit your ability to preview DLS voices in real time. Using low-latency drivers will produce the best results. 

Selecting notes 

You can select individual and groups of notes with the Draw and Selection tools. 

Selecting individual notes 

Click individual notes with the Draw or Selection tool to select them. Hold Ctrl while clicking to add or remove notes from the 

selection. 
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Selecting groups of notes 

Drag with the Selection tool to draw selection boxes around the notes you want to include. The Selection tool can 

draw three types of selection boxes: 

Free selection	 The default behavior of the tool. Click to select individual notes (hold Shift or Ctrl 

to select multiple notes). Drag to draw a rectangular region that begins where 

you start drawing and ends where you release the mouse button. All notes 

inside the region will be selected. This method is good for selecting a group of 

notes that are close together.


Vertical	 Can be used to easily select all notes that occur within a time range. The vertical 
selection box automatically selects all of the notes between your first mouse 
click and where you draw the selection box; even notes that are not visible at the 
current magnification are selected. 

Horizontal	 Can be used to easily select all notes on a single or multiple adjacent rows. The 

horizontal selection box automatically selects all notes on a row that is touched 

by the selection box; even notes that are not visible at the current magnification

are selected.


To change the type of selection box you are using, right-click the mouse while holding down the left mouse button. 
Clicking the right mouse button will toggle through the three types of selection boxes. 

Adding or deleting notes 

1. Click the Enable Inline MIDI Editing button 

2. Use the scroll buttons at the left edge of the track to navigate the piano roll/drum grid: 

. 

Tip: Drag the bottom border of the track header to increase the height of the track. 

3. Select an editing tool. 

Tool Icon Description 
Draw Allows you to insert, edit, select, and move notes.


In drum-grid mode, the Draw and Paint tools both draw fixed-length note events.

Paint Allows you to insert notes of a specific length. 

The Paint tool is different from the Draw tool in that it can cross note row boundaries. Use the Paint tool to add
random element to your ACID projects.


Note: In drum-grid mode, the Draw and Paint tools both draw fixed-length note events.


Using the Paint tool:


•	 Click the down arrow next to the Paint tool button and choose a note length from the menu. 

•	 Click the Paint tool button to select the tool. The Paint tool is selected, and notes will be painted using the 
selected note length. 

Note: Right-click with the Paint tool to erase notes. 
Erase Allows you to remove existing notes. 



4. Inside an event, drag in the row for the pitch you want to create to create a new note, or click an existing note with the Erase tool
 to remove it. If you draw or paint notes beyond the event edge, the event is automatically extended. Hold Shift while dragging 

to override horizontal snapping (press Shift after you click). 

Tip: In inline MIDI editing mode, drag in the top portion of the track to create a new event using the active clip. 

Editing note positions 

1. Click the Enable Inline MIDI Editing button 

2. Use the scroll buttons at the left edge of the track to navigate the piano roll/drum grid: 

. 

3. Select the notes you want to edit by doing either of the following: 

• Click a note with the Draw tool to select it. You can hold Ctrl while clicking to select multiple notes. 

• Use the Selection tool  to select multiple events by clicking and dragging to create a selection box around the notes you 
want to edit. 

4. Drag notes left or right to change their position on the timeline, or drag up or down to assign a note to a different pitch. 

Tips: 

• Hold Shift while dragging to override horizontal snapping (press Shift after you click). 
• Hold Alt while dragging to constrain to horizontal or vertical movement. 

• With the Draw and Selection  tools you can cut, copy, and paste MIDI notes. 

Editing note duration 

1. Click the Enable Inline MIDI Editing button . 

2. Select the Draw tool . 

3. Use the scroll buttons at the left edge of the track to navigate the piano roll/drum grid: 

4. Drag either edge of a note. The edge of the note moves, changing its duration: 

Hold Shift while dragging to override horizontal snapping (press Shift after you click). 
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Editing note velocity 

Note velocity is represented in the timeline by velocity stems. To show or hide velocity stems in inline MIDI editing mode, choose Show 
Inline MIDI Editing from the View menu, and then choose Show Note-On Velocities or Show Note-Off Velocities from the submenu. 

1.	 Click the Enable Inline MIDI Editing button 

2.	 Select the Draw tool 

3.	 If velocity stems aren't already displayed, choose Show Inline MIDI Editing from the View menu, and then choose Show Note-On 
Velocities or Show Note-Off Velocities from the submenu. 

. 

. 

Tips: Press F while inline MIDI editing mode to toggle the display of velocity stems. 

4.	 Drag the top of the stem (for note-on velocity or for note-off velocity ) up to increase the note's velocity, or drag down to 
decrease velocity. If multiple notes are selected, the velocities of all selected notes are adjusted at the same time. 

Tips: 

•	 Double-click the top of a velocity stem to set the note's velocity to the default value (64). 
•	 Right-click a note and choose Velocity from the shortcut menu. You can then choose a command from the submenu to 

set the note-on velocity. 
•	 If multiple notes are selected, you can edit the velocities of all selected notes simultaneously. 

Processing and filtering MIDI events 

From the Edit menu, choose MIDI Processes and Filters to apply destructive editing to MIDI events on the timeline. You can quantize 
data in events, edit velocity values, change the duration of an event, or transpose MIDI data. 
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Quantizing MIDI events 

1.	 From the Edit menu, choose MIDI Processes and Filters. The MIDI Processes and Filters dialog is displayed. 

2.	 Select the Quantize tab. 

3. Select your quantization options: 

Item Description 

Quantize start Select this check box to force the beginning (note-on messages) of MIDI events to a specified resolution 
on the grid. 

Quantize release Select this check box to force the end (note-off messages) of MIDI events to a specified resolution on the 
grid. 

Preserve duration If you select Quantize start or Quantize release, you can select this check box to maintain the lengths of 
notes. 

Quantize grid Click an icon to select the resolution of the quantize grid. 

Tuplet Select this check box to set irregular beat boundaries for the quantize grid. For example, to quantize to 
triplet beat boundaries in 4/4 time, select the Tuplet check box and choose 3 in time of 4. 

Offset by Select the check box and type a value in the box to offset the quantize grid by the specified number of 
ticks. You can type negative values to shift the grid backward. 

Swing	 Drag the slider to add a swing to the quantize grid. When you set this slider to 0, notes are quantized 
directly to the grid. Increasing the setting shifts every other grid boundary forward: set to 300% to shift 
every other grid boundary to the next grid division. 

Strength	 Drag the slider to adjust how strictly you want to quantize. For example, to quantize directly to the grid, 
set the slider to 100%. If you set the slider to 50%, a note that would be shifted 4 ticks is moved only 20 
ticks. 

4.	 Select the tracks or events you want to quantize: 

•	 Select a track to quantize all events on the track. Hold Ctrl or Shift while clicking a track header to select multiple tracks. 

•	 If you want to quantize multiple events on multiple tracks, hold Ctrl or Shift while clicking the events to select them, and then 
select the tracks. 

•	 If a selected event has note events selected, only the selected notes will be quantized. 

Note: Muted tracks will not be quantized. 

5. Click the Apply button. 
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Editing velocity 

1. From the Edit menu, choose MIDI Processes and Filters. The MIDI Processes and Filters dialog is displayed. 

2. Select the Velocity tab. 

3. Select a check box to indicate whether you want to edit note-on or note-off velocities: 

Item	 Description 

Change Start Velocity Select this check box to edit note-on velocities. 

Change Release Velocity Select this check box to edit note-off velocities. 

4. Select a radio button to indicate how you want to change velocity: 

Item Description 

Invert	 Select this radio button to invert selected note velocities. When you invert a velocity, it is subtracted from 
127 (negative values are forced to positive) so a note with a velocity of 127 will be 0 after inversion, a 
velocity of 10 will be 117, and so on. 

Set to Select this radio button and drag the slider to change note velocities to a specific value. 

Add Select this radio button and drag the slider to add (or subtract) a constant offset to selected note 
velocities. 

Scale by Select this radio button and drag the slider to multiply selected note velocities by a percentage. For 
example, setting this slider to 50% would reduce all note-on or note-off velocities by half. 

Limit	 Select this radio button and type values in the Min and Max boxes to restrict selected note velocities to 
the specified range. For example, if you type 40 in the Min box and 90 in the Max box, velocities below 40 
will be set to 40, velocities greater than 90 will be set to 90, and velocities between 40 and 90 will be 
unaffected 

Change over time	 Select this radio button and type values in the From and To boxes to change velocity values gradually 
over time. The velocity for the first note in the selection is set to the From value, and the velocity for the 
last note in the selection is set to the To value. Select the By percentage check box to change velocity 
over time based on the current values. For example, to fade a selection in, select the By percentage check 
box and type 1 in the From box and 100 in the To box. To fade a selection out, type 100 in the From box 
and 1 in the To box. Drag the Curve slider to choose the fade curve that will be used to generate velocity 
for notes between the first and last note. 

Note: Note-on velocities are bound between 1 and 127 while note-off velocities are bound between 0 and 127. 
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5.	 Select the tracks or events you want to edit: 

•	 Select a track to edit all events on the track. Hold Ctrl or Shift while clicking a track header to select multiple tracks. 

•	 If you want to edit multiple events on multiple tracks, hold Ctrl or Shift while clicking the events to select them, and then 
select the tracks. 

•	 If a selected event has note events selected, only the selected notes will be edited. 

Note: Muted tracks will not be edited. 

6.	 Click the Apply button. 

Editing duration 

1.	 From the Edit menu, choose MIDI Processes and Filters. The MIDI Processes and Filters dialog is displayed. 

2.	 Select the Duration tab. 

3.	 Select a radio button to indicate how you want to change a note duration: 

Item Description 

Change by Select this radio button, and then choose a setting from the drop-down list: 

•	 Setting duration to — Allows you to set notes to a specific duration. 

Click the down arrow next to the selected note size and choose the desired note duration from the 
menu. Choose User size to type a duration in beats.ticks in the edit box: for example, type 2.000 for 
two beats, or type 0.200 for 200 ticks. 

•	 Adding to duration — Allows you to add a constant value to existing note durations. 

Click the down arrow next to the selected note size and choose the amount you want to add to notes. 

•	 Subtracting from duration — Allows you to subtract a constant value from existing note durations. 

Click the down arrow next to the selected note size and choose the amount you want to subtract from 
notes. 

Scale by Select this radio button and drag the slider to multiply selected note durations by a percentage. For 
example, setting this slider to 200% would double note durations. 

Select the Change start times check box if you want to change the start times of notes while changing 
duration. 

Limit 

For example, if you set the Scale by slider to 50% and select the Change start times check box, you can 
compress notes so they play in double time. If you set the Scale by slider to 50% and clear the Change 
start times check box, note durations will be shorter, but their positions on the timeline will not change. 

Select this radio button and choose Min and Max values to restrict note durations to the specified range. 

For example, if you choose an eighth note as the Min setting and a half note as the Max setting, sixteenth 
notes will be changed to eighth notes, and whole notes will be changed to half notes. Notes between the 
Min and Max settings are unaffected. 

4.	 Select the tracks or events you want to edit: 

•	 Select a track to edit all events on the track. Hold Ctrl or Shift while clicking a track header to select multiple tracks. 

•	 If you want to edit multiple events on multiple tracks, hold Ctrl or Shift while clicking the events to select them, and then 
select the tracks. 

•	 If a selected event has note events selected, only the selected notes will be edited. 

Note: Muted tracks will not be edited. 

5. Click the Apply button. 
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Editing MIDI track properties 

From the View menu, choose Track Properties to display the Track Properties window. The contents of the Track Properties window 
reflect the currently selected track. 

For MIDI tracks, you can use the Output Settings tab to adjust MIDI controllers, voices, and drum maps. You can use the Input Filters tab 
set up MIDI message, velocity, or quantize filters. You can use the Clip Pool tab to organize each track's media and enable looped or one-
shot drawing for MIDI events. For more information, see Audio track properties on page 115. 

Configuring MIDI track output settings 

You can use the Output Settings tab on the configure which controllers can be automated; add, remove, or hide envelopes; set default 
values, and set each envelope's default fade curve. 

Controller automation 

1. From the View menu, choose Track Properties. The Track Properties dialog is displayed. 

2. Select the check box for each controller you want to automate with an envelope. If the controller you want to automate isn't 
displayed, select the Show all controllers check box at the bottom of the dialog. 

3. Click the down arrow in the Envelope box and choose a command from the menu: 

Command Description 

Insert Envelope If the controller does not have an automation envelope, No is displayed. Click the down arrow 
and choose Insert Envelope to add an automation envelope to the timeline. 

Show/Hide Envelope If the controller has an automation envelope, Visible or Hidden is displayed. Click the down 
arrow  and choose Hide Envelope or Show Envelope to toggle its display. 

Click the Hide all Envelopes button at the bottom of the dialog to hide all controller envelopes 
on the track. 

Reset all envelope points  If the controller has an automation envelope, you can click the down arrow and choose 
Reset all envelope points to restore all points to the default value 

Click the Reset all envelope points button at the bottom of the dialog to set all points on all 
controller envelopes on the track to the default value. 

Delete Envelope If the controller has an automation envelope, you can click the down arrow and choose 
Delete Envelope to remove the envelope all envelope points from the timeline.


Click the Remove all Envelopes button at the bottom of the dialog to delete all controller 

envelopes on the track.
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4.	 Double-click the Def box and type a new value to change the default setting for a controller. This value is used when you reset 
envelope points. 

5.	 Click the down arrow in the Curve Type box to set the default fade curve for each controller's automation envelope. The new 
curve type will be applied to all segments on the envelope. You can right-click a segment and choose a new fade curve to override 
the default curve type. 

6.	 Click the Save button if you want to save the current settings as a mapping file, or click Load to browse to a mapping file that will 
replace the current settings. 

Note: You can also select controllers by doing either of the following: 

•	 Double-click the MIDI track icon to open Track Properties dialog. On the Output Setting tab, choose Controllers from the drop-down 
menu. 

•	 Click the Program button , choose Select Program Change. 

Tip: You can MIDI merge recording to record MIDI controller values from a MIDI device. For more information, see Using MIDI merge

recording on page 192.


Setting the track voice 

You can set the voice used to play the entire track, or you can add keyframes to add program changes. 

1.	 Right-click the track header, choose Insert/Remove Envelopes, and then choose Configure Controllers from the menu. The Track 
Properties dialog is displayed. 

2.	 On the Output Settings tab, choose Voices from the drop down menu. 

3.	 Choose the voice you want to use. 

Note: You can also set the track voice by doing the following: 

•	 Double-click the MIDI track icon to open Track Properties dialog. On the Output Setting tab, choose Voices from the drop-down menu. 
•	 Click the Program button , choose Select Program Change, and then choose Voices from the drop-down menu. 

Changing the track voice 

1.	 Click the Program button 

2.	 Choose a program from the menu, or choose Select Program Change to display the Output Settings tab in the Track Properties 
window, where you can select a patch. 

. 
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If the track does not contain program change keyframes, the selected patch is used to play the entire track. If the track contains 
keyframes, the selected patch is assigned to the keyframe that occurs before the current cursor position. 

Note: You can also select drum maps by doing either of the following: 

• Double-click the MIDI track icon to open Track Properties dialog. On the Output Setting tab, choose Drum Map from the drop-down 
menu. 

• Click the Program button , choose Drum Maps and then Select Drum Map. 

Changing the patch for a hardware synth 

If your track is routed to a hardware synth, there are several ways to change patches: 

• 	Click the  Program button  and choose Synth Control of Patch if you want to change patches using the synth's controls. 

• 	Click the  Program button  and choose Use Program Change and Bank if you want to change patches by specifying the 
program, MSB, and LSB values. Double-click the values in the track header to edit them: 

•	 If you've created a patch map for your device, click the Program button and choose Use Device Patch Map to return to the 
device's patch map. You can then choose a patch by clicking the Program button and choosing a patch from the menu. (For 
more information about creating patch maps and assigning them to hardware devices, click here.) 

Selecting a drum map for a track 

1.	 Right-click the track header, choose Insert/Remove Envelopes, and then choose Configure Controllers from the menu. The Track 
Properties dialog is displayed. 

2.	 Under the Output Settings tab, select Drum Map from the drop down menu. 

3.	 Choose the drum map you want to use. 

Note: You can also select drum maps by doing any of the following: 

• Double-click the MIDI track icon to open Track Properties dialog. On the Output Setting tab, choose Drum Map from the drop-down 
menu. 

• Click the Program button , choose Drum Maps, and then choose Select Drum Map. 
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Configuring MIDI input filters 

You can use the Input Filters tab set up MIDI message, velocity, or quantize filters. 

Setting up MIDI message input filters 

Use the Input Filters tab to choose which notes or other MIDI messages you want to record or exclude from MIDI recordings. 

1.	 Select the track where you want to apply the filter. 

2.	 From the View menu, choose Track Properties. 

3.	 In the Track Properties dialog, click the Input Filters tab. 

4.	 Choose Message Filter from the drop-down list at the top of the page. 

5.	 Select the Enable check box. 

6.	 Select your recording options. 

Item Description 

Record all Select this radio button if you want to record all MIDI messages from the input port. 

Record selected items Select this radio button if you want to choose which MIDI messages you want to record. 

Record unselected items Select this radio button if you want to choose which MIDI messages you want to ignore when 
recording. 

7.	 Choose a setting from the MIDI Message Type drop-down list. The box at the bottom of the page displays the available MIDI 
messages. 

8.	 Select the check box for each MIDI message that you want to filter. When editing note messages, you can double-click the Min and 
Max boxes to type the notes you want to filter. 

Tips: 

•	 If you're recording into two tracks, you can use note message filters to split your keyboard and create two separate parts. For example, set 
track 1 to record only notes A1 to B4, and set track 2 to record only notes C5 to C9. If you assign track 1 to a plucked string bass soft synth 
and track 2 to a grand piano synth, the low notes you play on your keyboard will be recorded only on track 1 and will be voiced by the 
bass. The high notes you play will be recorded only on track 2 and will be voiced by the piano. 

•	 Filtering continuous controller messages allows you to control exactly which continuous controllers are recorded. For example, if you 
wanted to make sure you didn't accidentally record modulation automation by bumping your keyboard's modulation wheel, you could 
select the Record unselected items radio button, choose Continuous Controllers from the MIDI Message Type drop-down list, and 
then select the Modulation check box. 

•	 Excluding system exclusive messages during recording can improve performance during real-time recording and when using MIDI thru. 
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Setting up MIDI velocity input filters 

Use the Input Filters tab to modify or limit note-on and note-off velocity from a track's MIDI input device during recording. 

1. Select the track where you want to apply the filter. 

2. In the Track Properties dialog, click the Input Filters tab. 

3. Choose Velocity from the drop-down list at the top of the page. 

4. Select the Enable check box. 

5. Select a check box to indicate whether you want to edit note-on or note-off velocities: 

Item Description 

Change Start Velocity Select this check box to edit note-on velocities. 

Change Release Velocity Select this check box to edit note-off velocities. 

6. Select a radio button to indicate how you want to change velocity:. 

Item Description 

Invert	 Select this radio button to invert note velocities. When you invert a velocity, it is subtracted from 127 (negative 
values are forced to positive), so a note with a velocity of 127 will be 0 after inversion, a velocity of 10 will be 
117, and so on). 

Set to Select this radio button and drag the slider to change note velocities to a specific value. 

Add Select this radio button and drag the slider to add (or subtract) a constant offset to note velocities. 

Scale by Select this radio button and drag the slider to multiply note velocities by a percentage. For example, setting 
this slider to 50% would reduce all note-on or note-off velocities by half. 

Limit	 Select this radio button and type values in the Min and Max boxes to restrict note velocities to the specified 
range. For example, if you type 40 in the Min box and 90 in the Max box, velocities below 40 will be set to 40, 
velocities greater than 90 will be set to 90, and velocities between 40 and 90 will be unaffected. 

Note: Note-on velocities are bound between 1 and 127, and note-off velocities are bound between 0 and 127. 
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Setting up MIDI quantize input filters 

Use the Input Filters tab to force notes from a track's input port to align with musical beats during recording. 

1. Select the track where you want to apply the filter. 

2. In the Track Properties dialog, click the Input Filters tab. 

3. Choose Quantize from the drop-down list at the top of the page. 

4. Select the Enable check box. 

5. Select your quantization options: 

Item Description 

Quantize start Select this check box to force the beginning (note-on messages) of MIDI events to a specified resolution 
on the grid. 

Quantize release Select this check box to force the end (note-off messages) of MIDI events to a specified resolution on the 
grid. 

Preserve duration If you select Quantize start or Quantize release, you can select this check box to maintain the lengths of 
notes. 

Quantize grid Click an icon to select the resolution of the quantize grid. 

Tuplet Select this check box to set irregular beat boundaries for the quantize grid. For example, to quantize to 
triplet beat boundaries in 4/4 time, select the Tuplet check box and choose 3 in time of 4. 

Offset by Select the check box and type a value in the box to offset the quantize grid by the specified number of 
ticks. You can type negative values to shift the grid backward. 

Swing	 Drag the slider to add a swing to the quantize grid. When you set this slider to 0, notes are quantized 
directly to the grid. Increasing the setting shifts every other grid boundary forward: set to 300% to shift 
every other grid boundary to the next grid division. 

Strength	 Drag the slider to adjust how strictly you want to quantize. For example, to quantize directly to the grid, 
set the slider to 100%. If you set the slider to 50%, a note that would be shifted 4 ticks is moved only 20 
ticks. 
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Using the clip pool 

You can use the Clip Pool to organize each track’s media and enable looped or one-shot drawing for MID events. 

1. Select a track. 

2. From the View menu, choose Track Properties. The Track Properties dialog is displayed. 

3.	 Select the Clip Pool tab. 

Tips: You can also access the clip pool by doing the following: 

•	 Double-click the MIDI track icon to open Track Properties dialog. Click the Clip Pool tab from the drop-down menu. 
• Click the Paint Clip Selector button and then choose Clip Pool. 

For more information, see Using the Clip Pool to manage clips on page 104. 

Toggling looped or one-shot painting for a MIDI clip 

Select the Loop button  on the Clip Pool if you want a MIDI clip to repeat when painted on the timeline. Loop clips are displayed with 

a  icon in the track list. 

Deselect the Loop button  if you want a MIDI clip to be treated as a one-shot. One-shot clips are displayed with a icon. 

Editing a MIDI clip’s time signature


To change a MIDI clip's time signature, right-click a clip on the Clip Pool tab, choose Time Signature from the shortcut menu, and then 

choose a time signature from the submenu. 


The time signature you choose will be used to display the grid on the piano roll editor and to display M.B.T (measure.beat.tick) values on 

the list editor. 


For more information, see Using the piano roll editor on page 213. 


For more information, see Using the list editor on page 216.


MIDI Track Envelopes and Keyframes 

With MIDI track envelopes, you can adjust volume, panning, controller parameters, program changes, or Sysex commands dynamically 
over the duration of a track. 

You can automate VSTi parameters using envelopes on the soft synth bus track. 

To record track automation using the controls in the track header, select the Automation Settings button . When the button is not 

selected, the controls adjust static (trim) levels. 

Tips: You can use the Display tab in the Preferences dialog to change the colors used to draw track envelopes. Using custom envelope 
colors can help you avoid getting lost in a maze of envelopes when you're using track envelopes to control MIDI controllers. For more 
information, see Using the Display tab on page 263. 
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Adding a mute envelope 

1.	 Select a MIDI track. 

2.	 From the Insert menu, choose Envelopes, or right-click in the track list and choose Insert/Remove Envelope from the shortcut 
menu. 

3.	 From the submenu, choose Mute. A check mark is displayed next to the command, and an envelope is added to the timeline. 

Mute automation is either on or off with no fade between the on and off states. If you want to use fades, apply volume automation. 

4.	 If you want to change the track's mute state throughout the track, edit the envelope in the timeline. For more information, see 
Adjusting envelopes on page 142. 

5. If you want to change the track's mute state by recording automation settings, select the Automation Settings button in the 
track header. 

6.	 Click the Mute button in the track header to change the track's mute automation state at the cursor position. 

The button behaves differently depending on the track automation recording mode: 

•	 When the track automation mode is set to Off, the button mutes the entire track. 

•	 When the track has a mute envelope and the track automation mode is set to Read, the button changes state to reflect the 
envelope setting during playback but cannot be adjusted. 

•	 When the track has a mute envelope and the track automation mode is set to Touch or Latch, the button edits the envelope 
setting at the cursor position. 

Notes: When you apply mute automation to a track, it's possible to have a track that is muted and soloed simultaneously if you use the 

Mute and Solo buttons in the track header. The mute state overrides the solo state: 

•	 If a track's Solo button is selected, the track is included in the solo group, but it will be muted whenever the mute automation is set to mute 
the track. 

•	 If the track's Mute button is selected, the track is muted regardless of the mute automation settings. 

For more information, see Track automation on page 137. 

Adding a MIDI controller envelope 

1.	 Select the track where you want to add or remove the envelope. 

2.	 Perform one of the following actions: 

• 	Click the Insert/Hide Envelope button  next to the controller's slider in the track header. 

•	 From the Insert menu, choose Envelopes, and then choose a controller type. 

•	 Right-click the track header, choose Insert/Remove Envelope from the shortcut menu, and then choose a controller type. 

If the controller you want to adjust is not displayed in the menu, choose Configure Controllers from the menu. You can use 
the Output Settings tab of the Track Properties window to configure which controllers are available on the track. 

3.	 If you want to change the controller setting throughout the track, edit the envelope in the timeline. For more information, see 
Adjusting envelopes on page 142. 

4.	 If you want to change controller settings by recording automation, click the Automation Settings button  in the track header. 
The slider handles are displayed as in automation mode. 

Tip: If you want to record MIDI controller envelopes into a track using a hardware controller, you can use MIDI merge recording to record 
the envelopes. For more information, see Using MIDI merge recording on page 192. 
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5.	 Drag a slider to edit automation settings at the cursor position. 

The track header controls behave differently depending on the track's automation recording mode: 

•	 When the track automation mode is set to Off, the controls adjust the level of the entire track. In this mode, the automation 
envelope is bypassed, and the control does nothing. 

•	 When the track has a controller envelope and the track automation mode is set to Read, the control will follow the envelope 
during playback but cannot be adjusted. 

•	 When the track automation mode is set to Touch or Latch, the control edits the envelope setting at the cursor position. If the 
track does not have an envelope, an envelope will be added when you adjust the control. 

If multiple tracks are selected, all selected tracks are adjusted. 

For more information, see Recording automation settings on page 147. 

Configuring MIDI track controller automation 

You can use the Output Settings tab in the MIDI Track Properties dialog to configure which controllers can be automated; add, remove, 
or hide envelopes; set default values; and set each envelope's default fade curve. For more information, see Configuring MIDI track output 
settings on page 202. 

Resetting a MIDI controller envelope’s points 

Perform either of the following actions to reset an envelope's points to their default values: 

•	 Click the down arrow next to the Insert/Hide Envelope button  next to the controller's slider in the track header and 
choose Reset All Envelope Points. 

•	 Right-click the envelope and choose Reset All from the shortcut menu. 

You can set the default value for each continuous controller on the Output Settings tab in the Track Properties dialog. For more 
information, see Editing MIDI track properties on page 202. 

Deleting a MIDI controller envelope 

Click the down arrow  next to the Insert/Hide Envelope button  next to the controller's slider in the track header and choose 
Delete Envelope. 

Adding a program change keyframe 

If you want to show or hide an envelope without deleting its settings, click the Insert/Hide Envelope button 

To add a program change keyframe: 

1.	 Click the Program button and choose Insert Program Change Keyframe. The program change keyframe row is displayed at the 
bottom of the track. 

2.	 Using the Draw or Envelope  tool, double-click in the track's keyframe row to add a keyframe. 

. 

3. To edit a keyframe, double-click it to display the Output Settings tab in the Track Properties window, and then select the patch you 
want to assign to the keyframe. 
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Add a Sysex keyframe 

1.	 Right-click the track header, choose Insert/Remove Envelope, and then choose Insert Sysex from the submenu. 

2.	 Using the Draw or Envelope  tool, double-click in the track's keyframe row to add a keyframe. 

3.	 To edit a keyframe, double-click it to display the System Exclusive Editor dialog. 

Tip: To hide the Sysex keyframe row without removing keyframes, right-click the track header, choose Insert/Remove Envelope, and 
then choose Hide Sysex from the submenu. You can view the keyframe row again by right-clicking the track header, choosing Insert/ 
Remove Envelope, and then choosing Show Sysex. 

Automating VSTi parameters 

You can use the soft synth bus track to control parameter automation for VST instruments. 

Adding parameter automation envelopes 

1.	 Select the bus track header for a VSTi soft synth. 

2.	 From the Insert menu, choose Envelopes, and then choose Soft Synth Automation from the submenu. The Soft Synth Parameter 
Automation dialog is displayed. 

3.	 Select the check box for each parameter you want to automate with an envelope. 

4.	 Click the down arrow in the Envelope box and choose a command from the menu: 

Item Description 

Insert Envelope	 If the parameter does not have an automation envelope, No is displayed. 

Click the down arrow and choose Insert Envelope to add an automation envelope to the timeline. 

Show/Hide If the parameter has an automation envelope, Visible or Hidden is displayed. 
Envelope 

and choose Hide Envelope or Show Envelope to toggle its display.


Click the Hide all Envelopes button at the bottom of the window to hide all envelopes on the bus track.


Click the down arrow 

and choose Reset All 
Envelope Points	 Envelope Points to restore all points to the default value. 

Click the Reset all Envelopes button at the bottom of the window to set all points on all envelopes on the 
bus track to the default value. 

Reset All 	 If the parameter has an automation envelope, you can click the down arrow 

Delete Envelope	 If the parameter has an automation envelope, you can click the down arrow and choose Delete 
Envelope to remove the envelope and all envelope points from the timeline.


Click the Remove all Envelopes button at the bottom of the window to delete all parameter envelopes 

on the bus track.


5.	 Click the down arrow in the Curve Type box to set the default fade curve for each parameter's automation envelope. The new 
curve type will be applied to all envelope segments. You can right-click a segment and choose a new fade curve to override the 
default curve type. 
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Editing parameter automation envelopes 

You can edit mute automation settings by adding an envelope to the bus track or by using the controls in the Soft Synth Properties 
window. For more information, see Soft Synth Properties on page 23. 

1.	 Select the Automation Settings button 

2.	 Click to position the cursor in the timeline where you want to edit a parameter. 

3.	 You can adjust automated parameters by editing the envelopes in the timeline or by recording automation with the controls in the 
Soft Synth Properties window. For more information, see Adjusting envelopes on page 142. 

The controls in the Soft Synth Properties window behave differently if the track has automation envelopes and when you change 
the track automation recording mode: 

•	 When the track automation mode is set to Off, the controls in the Soft Synth Properties window affect the entire bus track (and 
all tracks routed to the soft synth). 

•	 When the track has automation envelopes and the track automation mode is set to Read, the Soft Synth Properties controls 
change state to reflect the envelope setting during playback but cannot be adjusted. 

•	 When the track has automation envelopes and the track automation mode is set to Touch or Latch, the Soft Synth Properties 
controls edit the envelope setting at the cursor position. 

For more information, see Track automation on page 137. 

Editing MIDI clip properties 

From the View menu, choose Clip Properties (or Ctrl+Alt+3) to display the Clip Properties window. You can also get to the Clip 

Properties window by double-clicking the track icon  and selecting the Clip Pool tab in the Track Properties window. Double-click 
one of the clips to open the Clip Properties dialog. 

The contents of the Clip Properties window will change to display properties for the currently selected clip in the timeline. You can use 

the Clip Properties window to edit MIDI data using the list editor or piano roll. 

Tip: When the Clip Properties window is undocked, you can double-click its title bar to toggle its size — especially handy when 

you’re using the piano roll.


For more information, see Using clips with tracks on page 101. 

Editing a MIDI clip with the Piano Roll 

The piano roll editor is a OPT plug-in that you can use to create and edit note events within the ACID Clip Properties window for a MIDI 
track. For more information, see Using the piano roll editor on page 213. 

Editing a MIDI clip with the List Editor 

The List Editor tab is an OPT plug-in that you can use to perform detailed filtering and editing within the Clip Properties window for a 
MIDI track. For more information, see Using the list editor on page 216. 

Merging controller data from a MIDI clip 

If you use MIDI clips that contain MIDI controller data, the controller data will not be displayed in the timeline by default. 

Right-click the event on the timeline and choose Merge Envelope Data from the shortcut menu to represent MIDI controllers as 

envelopes on the timeline. 

Note: The Merge Envelope Data command is not available in inline MIDI editing mode. For more information, see Editing MIDI on the 
timeline on page 193. 

Tip: When Lock Envelopes to Events is selected from the Options menu, envelope points will move with an event as you move it along 
the timeline. When Lock Envelopes to Events is not selected, you can move events and envelopes independently. 
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Using the piano roll editor 

The piano roll editor is an OPT plug-in that you can use to create and edit note events within the Clip Properties window for a MIDI clip. 

The top pane of the piano roll editor displays note information like a sequencer or a roll from a player piano. Each note is represented by 
a rectangular note event of a certain length and pitch. The piano keys along the left side of the window indicate the pitch of a note 
event. The beat ruler across the top of the window shows the length and location of a note event. 

The lower pane of the piano roll editor displays velocity information for each note event. A transport bar for previewing MIDI appears at 
the bottom of the window. 

Viewing the piano roll editor 

1. Double-click the MIDI icon ( ) on the track header to open the Track Properties window. 

2. Select the Clip Pool tab in the Track Properties dialog. 

3. Double-click one of the listed clips to open the Clip Properties dialog. 

4. Click the Piano Roll Editor tab. The piano roll editor appears. 

Middle C Transport bar 

Velocity 

Pitch and length 

Previewing MIDI 

You can preview the entire MIDI file, a loop selection, or single notes using the piano roll editor. 

Tip: To control volume during playback in the piano roll editor, drag the Preview fader in the Mixing Console window. 

Previewing the MIDI file 

Use the transport bar buttons at the bottom of the piano roll editor to play your MIDI. 

Tip: You can use the Solo button ( ) to solo a particular MIDI track during preview playback. 

Previewing a selection in looped playback 

You can preview a selection in looped playback just as you would in the main ACID window. 

1. Drag the handles of the loop bar in the piano roll editor to create the desired loop region. 

2. Click the Loop Playback button ( ) to turn on looped playback. 

3. Click the transport bar’s Play button ( ) or press Space. The piano roll editor loops the playback of the selected area. To stop 
playback, click the transport bar’s Stop button ( ) or press Space. 
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Adding note events 

You can add note events using the Draw tool ( ) or the Paint tool ( ) in the same way you do in the main ACID window. 

Tip: As you drag to create new events, the event edge snaps to the divisions on the beat ruler. To snap to smaller divisions, click the 
Zoom In Time button ( ) at the bottom of the window to zoom in more tightly. Or, to turn off snapping altogether, click the Enable 


Snapping button (
 ) to toggle it off. 

Drawing note events 

The Draw tool limits you to drawing one pitch at a time. In other words, you cannot drag up and down with the Draw tool to draw note 
events across several pitches at once. 

1. Click the Draw Tool button ( ). The Draw tool is selected. 

2. Drag in the row for the pitch you wish to create. A new note event appears as you drag. 

Painting note events 

Unlike the Draw tool, the Paint tool allows you to create note events across multiple pitches with a single drag of the mouse. The Paint 
tool also allows you to select the note length you want to paint. 

1. Click the arrow adjacent to the Paint Tool button ( ) and choose a note length to paint from the menu. 

2. Click the Paint Tool button ( ). The Paint tool is selected. 

3. Drag to create new note events. The new events appear as you drag. 

Editing note events 

You can change the length or pitch of a note event using the Draw tool. You can also cut, copy, and paste events in the same way you 
do in the main ACID window. 

Changing pitch 

With the Draw tool ( ) selected, drag a note event to a new row. 

Changing length 

With the Draw tool ( ) selected, drag the edge of a note event to a new location. 

Tip: As you drag the edge of a note event, the event edge snaps to the divisions on the beat ruler. To snap to smaller divisions, click the 
Zoom In Time button ( ) at the bottom of the window to zoom in more tightly. Or, to turn off snapping altogether, click the Enable 


Snapping button (
 ) to toggle it off. 

Specifying a velocity value for notes 

To enter a specific velocity value, right-click a note event in the piano roll, choose Velocity from the shortcut menu, and choose the 
appropriate command from the submenu. 

Command Description


Set to Maximum Sets the velocity to 127.


Set to Default Sets the velocity to 64.


Set to Minimum Sets the velocity to 0.


Set to... Allows you to enter a custom velocity

value. 
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Changing velocity data 

1.	 In the lower-left corner of the Piano Roll Editor tab, click the drop-down arrow and choose Velocity from the menu. 

2.	 In the area at the bottom of the Piano Roll Editor tab, drag the top of a velocity bar up or down to change the velocity value. You 
can also drag across multiple bars to change their values at the same time. 

Setting pitch bend 

1.	 In the lower-left corner of the Piano Roll Editor tab, click the drop-down arrow and choose Pitch Bend from the menu. 

2.	 In the area at the bottom of the Piano Roll Editor tab, drag to draw your pitch bend curve. To erase a curve, right-click and drag. 

Changing continuous controller information 

1.	 In the lower-left corner of the Piano Roll Editor tab, click the drop-down arrow, choose All Continuous Controllers from the menu, 
and choose a controller from the submenu. 

2.	 In the area at the bottom of the Piano Roll Editor tab, drag to draw your controller information. 

Selecting note events 

With the Draw tool selected, you can select individual note events by clicking them. You can also use one of several methods to select 
multiple events: 

•	 With the Draw tool selected, press Ctrl or Shift while clicking note events. Pressing Shift allows you to select the first and last note 
events of a range in order to select all notes in between, while pressing Ctrl allows you to select non-contiguous note events. 

• 	Click the  Selection Tool button ( ) and drag across note events you wish to select. 

•	 Press Ctrl+A to select all note events on a track. 

Moving note events 

After you select note events, you can drag them to new positions. 

Tip: Press Alt while dragging note events to restrict your movement to vertical (change pitch) or horizontal (change location in 

time).

WORKING WITH MIDI | 215 



Using cut, copy, and paste 

After you select note events, you can click the Cut (  ) or  Copy ( ) buttons to cut or copy the events. You can then position the 

cursor in a new location and click the Paste button ( ) to paste the events. Note events are always pasted at the same pitch as the 
original note event. 

Toggling note snapping 

Click the Enable Snapping Notes to Specified Scale button ( ) to toggle snapping. 

If the button is selected, you can only draw or drag notes within the selected scale. Hold Alt while drawing or dragging notes to override 
snapping. 

Click the down arrow  next to the button to choose a root note and scale. 

Quantizing note events 

You can use the MIDI Quantize dialog to force notes to align with musical beats based on the parameters you specify. 

1. Select the notes you want to quantize. For more information, see Selecting note events on page 215. 

2. Click the Quantize button ( ). The MIDI Quantize dialog appears. 

3. From the Quantize resolution drop-down list, choose the beat to which you want the selected notes to be quantized. 

4. Select the Start times check box to snap start times to the beat selected in the Quantize resolution drop-down list. 

5. Select the Note durations check box to snap note durations to the beat selected in the Quantize resolution drop-down list. 

6. Click Apply. 

Deleting note events 

Use the Erase tool ( ) to erase events in the piano roll. Alternately, you can select events and press Delete. For more information, see 
Selecting note events on page 215. 

Undoing and redoing 

You can easily undo and redo actions in the piano roll editor by using keyboard shortcuts. Press Ctrl+Z to undo an action, and press 
Ctrl+Shift+Z to redo an action. 

Using the list editor 

The List Editor tab is an OPT plug-in that you can use to perform detailed filtering and editing within the Clip Properties window for a 
MIDI clip. 

Events within the MIDI file are displayed in a table. Each event occupies one row, and the rows are sorted in chronological order. The 
columns in the List Editor tab display the contents of the events. 

Viewing the list editor 

1. Double-click the MIDI icon ( ) on the track header to open the Track Properties window. 

2. Select the Clip Pool tab in the Track Properties dialog. 

3. Double-click one of the listed clips to open the Clip Properties dialog. 

4. Click the List Editor tab. The list editor appears. 
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Toolbar 

Events 

Transport bar Loop boxes 

Previewing MIDI 

You can preview individual events or the MIDI file as a whole within the list editor. 

Tip: To control volume during playback in the list editor, drag the Preview fader in the Mixing Console window. 

Previewing single events 

When monitoring is enabled, the list editor will play events when you select them. 

1. In the list editor, click the Monitor button ( ) to turn on the event monitor. 

2. Click anywhere in an event row to play the event. 

Playing MIDI files 

In list editor, you may play your MIDI file by using the buttons on the transport bar: 

Item Icon Description 

Loop Playback Click to toggle looped playback mode. When the button is selected, only the events between 
the mark in and mark out points will be played. 

Play from Start Plays the entire MIDI file from the beginning, regardless of cursor position. 

Play Plays from the current cursor position. 

Pause Halts playback. The next time you click Play, playback will begin with the last event played. 

Stop Halts playback. The next time you click Play, playback will begin with the first event in the list. 

Go to Start Moves the cursor to the beginning of the list. 

Go to End Moves the cursor to the end of the list. 
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Setting a loop region 

When the Loop Playback button  is selected, you can set a portion of the edit list to play repeatedly. The beginning, end, and length 
of the loop region are displayed in the Loop boxes in the lower-right corner of the List Editor tab. 

1.	 Select the Loop Playback button 

2.	 Select the first event you want to play. 

3.	 Click the Mark Loop Start button 

4.	 Select the last event you want to play. 

5.	 Click the Mark Loop End button 

6.	 Click the Play button to start playback. Select the event where you want to begin playback and click the transport bar’s Play button 
( ) or press Space. The piano roll editor begins playback and loops the marked selection. 

7.	 To stop playback, click the transport bar’s Stop button ( ) or press Space. 

Filtering the list 

A MIDI file can contain a dizzying number of individual events. You can speed the task of locating events in the list editor by applying a 
filter. You can filter what the list editor displays either by track or by event type. 

Filtering the list by event type 

1.	 Click the Event Filter button ( ). The MIDI Event Filter dialog appears. 

. 

. 

2.	 Select the check box for an event type to hide that type, or clear the check box to display that event type. 

3.	 Click OK. The list is filtered according to the criteria you selected. 

Editing events 

Once you have located a particular event, you can edit the parameters of the event as needed. 

1.	 Click in the event row you want to edit. 

2.	 Click the Edit Event button ( ). The Edit MIDI Event dialog appears. 

Tip: You can also double-click an event’s Message parameter to open the Edit Event dialog. 

3.	 Edit the values in the dialog. For more information, see Event parameters on page 219. 

4.	 Click OK. The event updates to the new values. 

Tip: You can edit individual parameters in columns other than Message by double-clicking the parameter and entering a new 
value. 
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Event parameters 

The table below describes the editable event parameters for different event types. 

Event type Editable parameter Description 

After Touch Start Time Time (in measures.beats.ticks) where you want the event to begin. 

Channel MIDI channel (1-16) where you want to send the event. 

Pressure Amount of vibrato (0-127) you want to apply to each voice on the channel. 

Control Start Time Time (in measures.beats.ticks) where you want the event to begin. 
Change Channel MIDI channel (1-16) where you want to send the event. 

Controller Change Displays the number of the current controller change type. Choose a 
Number controller change type from the drop-down list to the right of the Event 

type drop-down. 

Controller Change Value Controller value. 

Note Start Time Time (in measures.beats.ticks) where you want the event to begin. 

Channel MIDI channel (1-16) where you want to send the event. 

Note Numeric value of the note you want to play. For more information, see 
MIDI notes and frequencies on page 220. 

On Velocity Speed of the note’s attack (0-127). Low values produce a soft attack; high 
values produce a strong attack. 

Off Velocity Speed of the note's release (0-127). Low values produce a soft release; high 
values produce a staccato release. 

Duration Length of the note’s sustain in measures.beats.ticks. 

Packed NRPN* Start Time Time (in measures.beats.ticks) where you want the event to begin. 

Channel MIDI channel (1-16) where you want to send the event. 

NRP MSB Parameter’s most significant byte. 

NRP LSB Parameter’s least significant byte. 

Data MSB Value for the most significant byte. 

Data LSB Value for the least significant byte. 

Packed RPN** Start Time Time (in measures.beats.ticks) where you want the event to begin. 

Channel MIDI channel (1-16) where you want to send the event. 

NRP MSB Parameter’s most significant byte. 

NRP LSB Parameter’s least significant byte. 

Data MSB Value for the most significant byte. 

Data LSB Value for the least significant byte. 

Patch Start Time Time (in measures.beats.ticks) where you want the event to begin. 

Channel MIDI channel (1-16) where you want to send the event. 

Bank LSB Least significant byte value for the bank. 

Bank MSB Most significant byte value for the bank. 

Patch Number of the patch you want to play. 

Pitch Bend Start Time Time (in measures.beats.ticks) where you want the event to begin. 

Pitch +/­ Number of cents by which you want to bend the pitch. 

Poly Pressure Start Time Time (in measures.beats.ticks) where you want the event to begin. 

Channel MIDI channel (1-16) where you want to send the event. 

Note Note to which you want to apply pressure. 

Pressure Pressure (0-127) you want to apply to the note. Most devices will apply 
more vibrato to a note as the pressure increases. 

Program Start Time Time (in measures.beats.ticks) where you want the event to begin. 
Change Channel MIDI channel (1-16) where you want to send the event. 

Patch Number of the new patch you want to play. 

*Packed nonregistered parameter numbers (NRPN) are used to adjust settings such as vibrato and filtering, but are not 
part of the General MIDI specification. Refer to your MIDI device’s documentation for more information about the 
required parameters. 

**Packed registered parameter numbers (RPN) are used to adjust common settings such as pitch wheel range. 
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MIDI notes and frequencies 

The following table shows the musical pitch and frequency associated with each MIDI note. 

A5 is 440 Hz, and middle C is C5 at 261.63 Hz. These values can differ, often by one octave, from values used by other manufacturers. The 
following frequencies are based on equal temperament tuning. 

Pitch MIDI Key Frequency Pitch MIDI Key Frequency Pitch MIDI Key Frequency


C0 0 8.176 G3 43 97.998 D7 86 1174.7


C#-0 1 8.662 G#3 44 103.82 D#7 87 1244.5


D0 2 9.177 A3 45 110.00 E7 88 1318.5


D#0 3 9.723 A#3 46 116.54 F7 89 1396.9


E0 4 10.301 B3 47 123.47 F#7 90 1480.0


F0 5 10.913 C4 48 130.81 G7 91 1568.0


F#0 6 11.562 C#4 49 138.59 G#7 92 1661.2


G0 7 12.250 D4 50 146.83 A7 93 1760.0


G#0 8 12.978 D#4 51 155.56 A#7 94 1864.7


A0 9 13.750 E4 52 164.81 B7 95 1975.5


A#0 10 14.568 F4 53 174.61 C8 96 2093.0


B0 11 15.434 F#4 54 184.99 C#8 97 2217.5


C1 12 16.352 G4 55 195.99 D8 98 2349.3


C#1 13 17.324 G#4 56 207.65 D#8 99 2489.0


D1 14 18.354 A4 57 220.00 E8 100 2637.0


D#1 15 19.445 A#4 58 233.08 F8 101 2793.8


E1 16 20.601 B4 59 246.94 F#8 102 2960.0


F1 17 21.826 C5 60 261.63 G8 103 3136.0


F#1 18 23.124 C#5 61 277.18 G#8 104 3322.4


G1 19 24.499 D5 62 293.66 A8 105 3520.0


G#1 20 25.956 D#5 63 311.13 A#8 106 3729.3


A1 21 27.500 E5 64 329.63 B8 107 3951.1


A#1 22 29.135 F5 65 349.23 C9 108 4186.0


B1 23 30.867 F#5 66 369.99 C#9 109 4434.9


C2 24 32.703 G5 67 391.99 D9 110 4698.6


C#2 25 34.648 G#5 68 415.31 D#9 111 4978.0


D2 26 36.708 A5 69 440.00 E9 112 5274.0


D#2 27 38.890 A#5 70 466.16 F9 113 5587.7


E2 28 41.203 B5 71 439.88 F#9 114 5919.9


F2 29 43.653 C6 72 523.25 G9 115 6271.9


F#2 30 46.249 C#6 73 554.37 G#9 116 6644.9


G2 31 48.999 D6 74 587.33 A9 117 7040.0


G#2 32 51.913 D#6 75 622.25 A#9 118 7458.6


A2 33 55.000 E6 76 659.26 B9 119 7902.1


A#2 34 58.270 F6 77 698.46 C10 120 8372.0


B2 35 61.735 F#6 78 739.99 C#10 121 8869.8


C3 36 65.406 G6 79 783.99 D10 122 9397.3


C#3 37 69.295 G#6 80 830.61 D#10 123 9956.1


D3 38 73.416 A6 81 880.00 E10 124 10548.1


D#3 39 77.781 A#6 82 932.32 F10 125 11175.3


E3 40 82.406 B6 83 987.77 F#10 126 11839.8


F3 41 87.307 C7 84 1046.5 G10 127 12543.9


F#3 42 92.499 C#7 85 1108.7
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Creating events 

In addition to editing existing events, you can also create new events. 

1.	 Click the Insert Event button ( ). The Insert MIDI Event dialog appears. 

2.	 Choose an event type from the Event type drop-down list. 

3.	 Enter a start time in the Start time box. 

4.	 Enter values for the remaining event parameters. 

5.	 Click Insert. The new event is inserted at the designated start time. 

Quantizing events 

You can use the MIDI Quantize dialog to force events to align with musical beats based on the parameters you specify. 

1.	 To quantize only specific events, select the events you want to quantize in the list editor. 

Tip: Hold Shift or Ctrl while clicking event rows to select multiple events. 

2.	 Click the Quantize button ( ). The MIDI Quantize dialog appears. 

3.	 From the Quantize resolution drop-down list, choose the beat to which you want the selected events to be quantized. 

4.	 Choose the appropriate options for quantizing: 

•	 Select the Start times check box to snap event start times to the beat selected in the Quantize resolution drop-down list. 

•	 Select the Note durations check box to snap note durations to the beat selected in the Quantize resolution drop-down list. 

•	 Select the Notes only check box to quantize note events alone. When you select this check box, the list editor does not 
quantize after touch, control change, meta, NRPN, RPN, pitch bend, poly pressure, and program change events. 

•	 Select the Apply to current selection only check box to quantize only the selected events. Clear the check box to quantize all 
events within the list. 

5.	 Click Apply. 

Deleting events 

Click an event row and click the Delete button ( 

Undoing and redoing 

You can easily undo and redo actions in the list editor by using keyboard shortcuts. Press Ctrl+Z to undo an action, and press Ctrl+ 
Shift+Z to redo an action. 

). 
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Routing tracks to MIDI devices or soft synths 

Each MIDI track can be played through any external MIDI port or any DLS, VSTi, or ReWire 2.0 soft synth bus control in the Mixing 
Console window. For more information, see Adding track, assignable FX, bus, and soft synth channels on page 155. 

1.	 Click the MIDI Output button. A list of all the available MIDI devices and software synthesizers is displayed. 

•	 If the soft synth you want to use does not appear in the menu, choose Insert Soft Synth to add a soft synth bus control to the 
project and route the track to the new synth. Click one of the following links for more information about DLS sets, VST 
instruments, or ReWire device applications. 

•	 If a MIDI device does not appear in the menu, choose External MIDI Device Preferences to open the MIDI tab of the 
Preferences dialog and verify that the check box for the device is selected. If a device is selected for generating MIDI timecode 
on the Sync Preferences tab, it will be unavailable as a playback device. 

2. Choose a device from the list to send the current track to that device. To route to a specific port in a ReWire 2.0 device, choose your 
ReWire device application from the list, and then choose a port from the submenu. 

Note: In order to render projects that contain MIDI tracks, MIDI tracks must be routed to DLS, VSTi, or ReWire 2.0 soft synths. Tracks that 
are routed to external MIDI devices will not be included in the rendered file. For more information, see Using the Sync tab on page 262. 

3. To choose which MIDI channel will be used to send MIDI data, choose MIDI Channel, and then choose a channel from the 
submenu. 

Tip: If you want to select multiple input channels, hold Ctrl and select additional channels from the MIDI Channel submenu. 

Resetting MIDI ports 

When a MIDI port is stuck playing a sustaining sound, a quick method to turn off MIDI ports is provided (much like the panic button on 
MIDI hardware devices). From the Tools menu, choose Reset All MIDI Ports to send a global Note Off command to all MIDI ports. 

Tip: Press Ctrl+Alt+F7 to reset all MIDI ports. 

Rendering projects with MIDI tracks 

To render projects that contain MIDI tracks, route the MIDI tracks to soft synths (DLS sets) rather than to external MIDI devices; MIDI 
tracks that are routed to external MIDI devices are not included in the rendered file. For more information, see Rendering projects on page 
47. 

Playing MIDI from external devices 

You can receive MIDI input from an external device such as a MIDI keyboard. You can then use a soft synth control (with its DLS set or 
VST instrument) or external MIDI device to output the sound from the external device. 

Adding external devices as MIDI inputs 

1.	 Verify that the Enable Real-Time MIDI command is selected in the Options menu. 

2.	 From the Options menu, choose Preferences. The Preferences dialog appears. 
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3.	 Click the MIDI tab. 

4.	 Select a device in the Make these devices available for MIDI input pane. 

5.	 To enable MIDI thru for the selected input, right-click the entry in the MIDI Thru column and choose a MIDI thru device from the 
shortcut menu. 

Note: The MIDI thru device must be selected in the Make these devices available for MIDI track playback pane in order to 
appear in the menu. You can choose more than one MIDI device for MIDI thru output, if desired. 

6. Click OK.


Assigning MIDI inputs to soft synth controls


You can route MIDI input from an external device to any soft synth control in your project. 

Note: You can assign both individual tracks and external MIDI devices to a single soft synth. 

1.	 In the Mixing Console window, double-click the soft synth icon on a control ( ). The Soft Synth Properties window appears. 

2.	 Click the External MIDI Input Port button ( ) and select the MIDI input device from the menu. 

Soloing MIDI device inputs 

External MIDI devices can be routed to multiple soft synths or MIDI thru devices. Soloing a MIDI device input prevents your device from 
playing through other soft synths and MIDI thru devices, soloing the input through the selected soft synth control. You can solo MIDI 
input on more than one soft synth control, if desired. 

1.	 Double-click the soft synth icon on a control ( ). The Soft Synth Properties window appears. 

2.	 Click the Solo Listen to MIDI Input button ( 

Creating or editing program maps 

From the Tools menu, choose Program Map Editor to display the Program Map Editor dialog. 

You can use the Program Map Editor dialog to create or edit program maps for external MIDI devices. A program map allows you to 
view program names in the track header and on the Output Settings tab of the Track Properties window when a MIDI track is routed to 
a hardware synth. 

). 
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Creating program maps 

1.	 From the Tools menu, choose Program Map Editor to display the Program Map Editor dialog. 

2. Click the New button  to create a new program map. You'll be prompted to choose a file name and location where you want to 
save the new map. 

Tip: If you want to create a program map based on an existing map, load a program map and then click the Save As button  to save 
a copy of the program map with a new name. 

3.	 Click the Add New Program or Add New Drum Program button to add a program to the table in the first available slot. 

Note: If a group is selected from the Voice Group drop-down list, the table lists only programs that belong to the selected group. Any 
programs you add will automatically be associated with the selected group. 

4.	 Type a description of the program in the Program box. You can double-click an existing name to edit it. 

5.	 If you want to assign the program to a group, right-click the Group box and choose a group from the shortcut menu. If you want to 
create a new group, choose Add New Group and type a name in the box. 

6.	 Double-click the Prog, MSB, and LSB values to edit them and type the values that correspond to the appropriate program. Please 
refer to your device or its documentation to determine the correct values for each program. 

Notes: 

• Within ACID, MIDI values range from 0-127. If your device uses 1-128, subtract 1 when editing the program. 
• Devices that use Sysex messages to change programs are limited to 128 programs. 

7.	 Click OK to close the dialog and save your changes. 

Editing program maps 

1.	 From the Tools menu, choose Program Map Editor to display the Program Map Editor dialog. 

2.	 Load the program map you want to edit: 

•	 Choose a setting from the MIDI Device drop-down list. 

• 	Click the  Load button and browse to the map you want to edit. 

Tip: If you want to create a program map based on an existing map, load a program map and then click the Save As button to save 
a copy of the program map with a new name. 

3.	 To add programs to the map, click the Add New Program or Add New Drum Program  button to add a program to the 
table in the first available slot. 

Note: If a group is selected from the Voice Group drop-down list, the table lists only programs that belong to the selected group. Any 
programs you add will automatically be associated with the selected group. 

4.	 To remove a program from the map, select a program and click the Delete button 

5.	 To edit a program name, double-click the name and type a new value in the box. 

6.	 To change a program to a drum program , right-click the program name and choose Drum Kit from the shortcut menu. To 
change a drum program to a program, right-click the program name and choose Drum Kit from the shortcut menu to clear the 
check mark. 

7.	 If you want to assign the program to a group, right-click the Group box and choose a group from the shortcut menu. If you want to 
create a new group, choose Add New Group and type a name in the box. 

. 
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8. Double-click the Prog, MSB, and LSB values to edit them and type the values that correspond to the appropriate program. Please 
refer to your device or its documentation to determine the correct values for each program. 

Notes: 

• Within ACID, MIDI values range from 0-127. If your device uses 1-128, subtract 1 when editing the program. 
• Devices that use Sysex messages to change programs are limited to 128 programs. 

9.	 Click OK to close the dialog and save your changes. 

Assigning a patch map to a MIDI device 

1.	 From the Options menu, choose Preferences. 

2.	 Click the MIDI tab. 

3.	 In the Make these devices available for MIDI track playback section of the dialog, verify the check box is selected for your MIDI 
device. 

4.	 Right-click the Device value for your MIDI device and choose Load Device Template from the shortcut menu. 

5.	 Browse to the patch map you want to use and click Open. The selected patch map will be used for any track that is routed to the 
MIDI device. 

Creating or editing drum maps


From the Tools menu, choose Drum Map Editor to display the Drum Map Editor dialog. 


You can use the Drum Map Editor dialog to create or edit drum maps. When a drum map is defined for a soft synth, you can use the 

drum grid in the timeline to edit MIDI data. 


A piano roll allows you to edit MIDI 
notes for most patches. 

A drum grid allows you to edit MIDI 
notes for soft synths that have drum 
maps defined. 

For more information, see Editing MIDI on the timeline on page 193. 

Editing a drum map 

1.	 From the Tools menu, choose Drum Map Editor to display the Drum Map Editor dialog. 

2.	 Choose the drum map you want to edit. 

•	 Select a drum map in the MIDI Drum Map Template list.

—or—


• 	Click the  Open button to browse to an XML drum mapping file. 

Tip: Drum maps that belong to the GM2 kits are displayed with a  and cannot be edited. 

3. If you want to edit the name of the drum map, double-click the name in the MIDI Drum Map Template column and type a new 
name in the box. 
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4.	 If you want to associate the drum map with a MIDI device, double-click the Device box and type the name of a MIDI device. 

When you associate a drum map with a MIDI device, the drum maps will be displayed automatically on the Output Settings tab of 
the Track Properties window when you choose Drum Map from the drop-down list at the top of the page. For more information, see 
Editing duration on page 201. 

Note: Be sure to type the device name identically in the Drum Map Editor and the Patch Map Editor. For more information, see Creating 
or editing program maps on page 223. 

5.	 If you want to change the description of the map, edit the text in the Drum Map Description box. 

6.	 Add keys as needed: 

a.	 Click the Insert Key button  to add a key to the drum map. 

If a key is selected, the next available key will be inserted. For example, if you select C5 and click Insert Key, C#5 will be added 
if it does not exist in the current drum map. If C#5, D5, and D#5 already exist, E5 will be added. 

b. Double-click the name in the Instrument column and type the name of the instrument associated with the selected key. 

7. Select a key in the table on the right side of the dialog and click the Delete Key button to remove it from the drum map. 

8.	 If you want to copy key assignments from other drum maps, perform the following steps: 

a.	 In the MIDI Drum Map Template list, select the drum map that contains the keys you want to copy. 

b.	 Select the keys you want to copy. Hold Ctrl or Shift to select multiple keys. 

c.	 Click the Copy Selected Keys button 

d.	 In the MIDI Drum Map Template list, select the drum map that you want to edit. 

. 

e. Click the Paste Copied Keys into Map button .Select the keys you want to copy. Hold Ctrl or Shift to select multiple keys. 

f. 

If a key is selected, the next available key will be inserted. For example, if you select C5 and click Insert Key, C#5 will be added 
if it does not exist in the current drum map. If C#5, D5, and D#5 already exist, E5 will be added. 

Double-click the name in the Instrument column and type the name of the instrument associated with the selected key. 

9.	 Click OK to close the dialog and save your changes. 

Choosing a drum map for a track 

Tracks that are routed to a VSTi soft synth or a MIDI device can display a piano roll or a drum grid. 

Tracks that are routed to the DLS soft synth will display a drum grid only if a drum map exists for the current patch. You cannot edit 
drum maps for GM2 drum kits. 

Synchronizing using MIDI timecode 

ACID can generate MIDI timecode (MTC) and MIDI clock as well as trigger from MIDI timecode. These features allow ACID to be 
synchronized with other audio applications and external audio hardware. 

Note: The software cannot chase MTC or MIDI clock. 

Generating MIDI timecode 

MIDI timecode is a standard timecode that most applications and some hardware devices use to synchronize themselves. Stable MTC is 
generated at all available frame rates for other applications to chase. 

1.	 Specify a MIDI output device to which you will send timecode and a frame rate for the timecode. These options can be found on 
the Sync tab of the Preferences dialog. For more information, see Using the Sync tab on page 262. 

2.	 From the Options menu, choose Timecode, and choose Generate MIDI Timecode from the submenu. 

MTC begins generating wherever you click the Play button ( ). 
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Generating MTC with an offset 

In some cases, you may want to start sending timecode with an offset (e.g., 01:00:00:00) to allow time for multiple devices to 
synchronize. You can create an offset on the ACID time ruler to accomplish this. For more information, see Using the ruler offset on page 
249. 

Viewing outgoing timecode 

You can view outgoing timecode in the time display located directly above the track list. Right-click the time display and choose MIDI 
Timecode Out from the shortcut menu to display outgoing MTC time. 

Triggering from MIDI timecode 

You can trigger ACID playback using MTC. This means that the software initiates playback by receiving timecode from another device. 

1. Connect a word clock signal between your computer and triggering device to lock synchronization. 

Note: If the MIDI trigger device can output MIDI timecode, a timecode converter is not necessary; you can connect the trigger device 
directly to your computer. 

2. Configure your triggering device to send MTC to your computer. 

3. From the Options menu, choose Preferences and select the Sync tab to configure the application to receive MTC. 

•  From the  Input device drop-down list, choose the port through which you receive MTC. 

•  From the  Frame rate drop-down list, choose the frame rate that your trigger device uses to send MTC to ACID. 

4. From the Options menu, choose Timecode, and choose Trigger from MIDI Timecode from the submenu. 

When an incoming MTC signal is received, playback begins from the position indicated by the timecode. If MTC is not being 
received, you can play and edit normally. 

Viewing incoming timecode 

You can view the incoming timecode in the time display located directly above the track list. Right-click the time display and choose 
MIDI Timecode In from the shortcut menu to show the incoming MTC time. 

This display also shows status and error information. If Trigger from MIDI Timecode is enabled but no MTC is detected, the display 
reads Waiting...; If the wrong frame rate of MTC is being detected, the display reads Wrong format. 
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Generating MIDI clock 

MIDI clock differs from MTC in that it contains tempo as well as positional information. MIDI clock is essentially measured in ticks from 
the beginning of the project. MIDI clock sends 24 ticks per quarter note. 

The advantage of using MIDI clock is that tempo changes are sent to the chasing application and they will be preserved. 

1.	 Specify a MIDI output device to which you will send the clock. This option can be found on the Sync tab of the Preferences dialog. 
For more information, see Using the Sync tab on page 262. 

2.	 From the Options menu, choose Timecode, and choose Generate MIDI Clock from the submenu. 

MIDI clock is generated when you click the Play button ( ). 

Viewing outgoing MIDI clock 

You can view the outgoing clock in the time display located directly above the track list. Right-click the time display and choose MIDI 
Clock Out from the shortcut menu to display the outgoing MIDI clock time. 

Exporting MIDI files 

By using the Clip Pool tab, you can save the selected clip to a new folder or with a new file name. When you export a MIDI file, the MIDI 
tracks in your project are saved to a standard MIDI file. Track names, track device names, and track voices are saved in the exported file 

Saving MIDI clips for export 

You may now export multiple MIDI tracks and individual clips to standard MIDI files. To export files: 

1.	 Select Paint Clip Selector from the track header. 

2.	 Choose Clip Pool to open the Track Properties dialog box. 

3.	 Right-click on the clip you want to save and select Save As. 

4.	 Name the file and choose Save. 

Notes: 

•	 Files are saved in the MIDI Export folder but they can be saved to any location. 
•	 Files are saved as standard MIDI files (.mid). 
•	 All MIDI clips are exported as MIDI file type 0. The MIDI File Type box is greyed out. 
•	 File resolution is set at 960 pulses per quarter note. Resolution can be set between 24 and 960 pulses per quarter note. All sequencers/ 

players can read in any arbitrary resolution. 

Exporting the project to a standard MIDI file 

1.	 From the File menu choose Export MIDI. 

2.	 From the Export Project as Standard MIDI File screen, choose a drive and folder from the Save in drop down list, or use the browse 
window to locate the folder where you want to save your file. 

3.	 Type a name in the File name box, or select a file in the browse window to replace an existing file. 

4.	 Choose a setting from the MIDI file type drop-down list to indicate the type of file you want to save: 

• 	Choose  Standard MIDI File Type 1 to preserve tracks when exporting. This mode preserves the MIDI data in your ACID project. 

• 	Choose  Standard MIDI File Type 0 to save your project as a single-track, multichannel MIDI file. For more information, see 
Adding MIDI files to a project on page 187. 

Note: When you add a Type 0 MIDI file to your project, a separate track will be created for each channel in the file. If you have tracks 

routed to separate soft synths or MIDI devices, they will be preserved as separate tracks only if their MIDI outputs use different 

channels. For more information, see Routing tracks to MIDI devices or soft synths on page 222.
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5. Type a value in the Resolution box to set the resolution of file. The default is 960, but you can specify any value between 24 and 
960. 

Important: Not all MIDI devices can read arbitrary resolutions. 

6. Click the Save button. 

Configuring a Mackie Control Universal 

The Mackie Control Universal is fully supported by ACID. An overlay is available from Mackie that you can use to label the buttons and 
controls with their mapped functions in ACID. 

For more information, see Using the Mackie Control Universal on page 273. 

Configuring a Frontier TranzPort 

Using a Frontier TranzPort, you can control ACID wirelessly.


For more information, see Using a Frontier TranzPort on page 283.


Configuring a generic MIDI controller 

You can configure up to five generic MIDI control surfaces to work with the ACID interface. 

For information about your specific device, please refer to the manufacturer's documentation. 

For more information, see Configuring a generic MIDI controller on page 285. 

Configuring a Behringer BCF2000 controller 

The Behringer BCF2000 is fully supported by ACID and lends a tactile element to your editing sessions. 

For more information, see Configuring ACID to use the Behringer BCF2000 on page 289. 
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Chapter 13 
Working with Video 

By adding a video track to your ACID® project, you can use the software as a scoring tool. 

Video is always added to the top track in the track list. Depending on your horizontal zoom level, each frame displayed in 
the video track may represent multiple frames from the source video. As you zoom in, marks display to represent each 
frame, and you can zoom further to view individual frames. 

Managing video 

ACID makes it easy to add video to a project and work with the video track. 

Adding or replacing video files 

Use the Explorer window to find the file you want to use, and then add it to the project by double-clicking it or dragging 
it into the track view. The video file is placed in the top track, and if the file has an audio stream, it is placed as a separate, 
one-shot track in the track view. 

If your project already contains a video track, you are prompted to replace the existing video if you open another video 
file. 

Tip: You can also add a still image (such as a BMP, JPEG, PSD, GIF, PNG, or TGA file) to the video track. 

Removing the video track 

Right-click anywhere in the video track and choose Remove Video from the shortcut menu. 

Hiding and showing the video track 

By default, video displays in the track view when you add it to a project. You can hide or show the video track at any time 
by choosing Show Video Track from the View menu. A check mark next to the command indicates that the video track 
displays. 

Synchronizing audio and video 

Editing the audio associated with a video file can cause it to become out of sync with the video. To resynchronize the 
audio and video, right-click the audio file and choose Synchronize with Video from the shortcut menu. 

Note: This does not work if you have changed the audio track to a loop. 

Removing the video’s audio 

Right-click the audio track in the track list and choose Delete Track from the shortcut menu. The audio track is removed, 
but the video remains. 

Changing frame numbering 

Each frame is numbered in the video track. You can change the numbering format or turn off frame numbering 
altogether. 

1. From the Options menu, choose Preferences. The Preferences dialog appears. 

2. Click the Video tab. 

3. Choose a setting from the Show source frame numbers on video thumbnails as drop-down list. 
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Editing video events 

You have several video editing options to help you score your video. 

Moving video events 

Drag the event to a new location along the video track. 

Trimming video events 

Drag either end of the video event. The video event stays in place, but the beginning or end of the video moves. 

You cannot trim the beginning or end of the event past the event’s original end. You cannot trim an event earlier than its starting point 
unless the event has been trimmed previously. 

Slipping and sliding video events 

To help you picture what happens when you slip and slide events, think of an event as a window to a media file. The window can display 
the entire media file or a small section. When the window displays only a portion of the media file, you can move either the window or 
the underlying media to adjust the media played by an event: 

• When you slip an event, your event maintains its place on the timeline, but the media file moves in the direction you drag. 

• When you slide an event, the media file maintains its place on the timeline, but the event moves in the direction you drag. 

Shifting the contents of video events (slipping) 

Hold Alt while dragging the video event to move the position of the video within the event. The event itself does not move. 

Slip-trimming video events 

Hold Alt while dragging the beginning or end of a video event. The video moves with the event edge, and the opposite edge of the 
event remains fixed. 

Sliding video events 

Hold Ctrl+Alt while dragging the video event to move the event while leaving the video in place. The relative position of the video 
changes as when you slip an event. 

Using the Video Preview window 

The Video Preview window is used to view the video as it plays or to view the frame at the cursor position. To display the Video Preview 
window, choose Video Preview from the View menu, or press Alt+4. 
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Shortcut menu 

Toolbar buttons 

Background 

Status bar 

Copying a frame to the clipboard


The Copy Frame toolbar button in the Video Preview window allows you to copy the current frame to the Windows® clipboard.


Using toolbar buttons 

The toolbar allows you to access two commonly used functions of the Video Preview window. 

Button Description 

Copies the current frame to the 
Windows clipboard. 

Sends the preview to an external 
monitor. 

Using the shortcut menu 

Right-click anywhere in the Video Preview window to display a shortcut menu with Video Preview window options. 

Item Description 

Copy Frame Copies the current frame to the Windows clipboard. 

Default Background Sets the background color of the Video Preview window to the default 
color. 

Black Background Sets the background color of the Video Preview window to black. 

White Background Sets the background color of the Video Preview window to white. 

External Monitor Sends the preview to an external monitor. 

Display Square Pixels Compensates for any spatial distortions due to non-square pixel aspect 
ratios. 

Display at Media Size Displays video at the native resolution, clipping if necessary. 

Show Toolbar Toggles the display of the Video Preview window toolbar. 

Show Status Bar Toggles the display of the Video Preview window status bar. 

Viewing the status bar 

Right-click the Video Preview window and choose Show Status Bar from the shortcut menu to view the status bar. The status bar shows 
the video’s frame size, frame rate, and display size. 
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Previewing on external monitors 

You can use your system’s external monitor for previewing video playback. You must have an OHCI IEEE-1394 adapter and a device to 
convert the DV signal to video, such as a DV camcorder, deck, or media converter. 

To specify an external monitor, click the External Monitor button ( ) on the Video Preview window, or choose Preferences 
from the Options menu and click the Video tab. 

Other settings for the external monitor can also be found on the Video tab. For more information, see Using the Video tab on page 261. 

Scoring video 

ACID has tools that allow you to adjust the tempo of a project to easily synchronize audio with specific video frames. 

1.	 Add your audio track(s) and video to your project. 

2.	 If the Video Preview window is not displayed, choose Video from the View menu. 

3.	 Click the Play button ( ) to begin playback. 

4.	 Press H each time you want to place a time marker at a frame you want to emphasize (where an explosion is heard, for example). 

5.	 Click the Stop button ( ) to stop playback. 

6.	 Return to the leftmost time marker and fine tune its placement so it coincides exactly with the desired video frame. 

Tip: Holding Alt while pressing the right or left arrow keys allows you to step the cursor through your video by individual frames. You

may need to drag your time marker to the cursor to get it on the desired frame.


7.	 Place the cursor at the point to which you want to synchronize your time marker. For example, you might want the frame that you 
marked in step six to coincide with a downbeat. 

8.	 Right-click the time marker and select Adjust Tempo to Match Marker to Cursor from the shortcut menu. The new tempo appears 
in the track list. 

9.	 Press T to insert a tempo change marker. The adjusted tempo is detected and inserted into the tempo marker’s box. The tempo 
change marker preserves synchronization between the time marker and location on the beat ruler as you perform editing further 
down the timeline. For more information, see Adding tempo/key/time signature change markers on page 91. 

10. Repeat steps six through nine to synchronize the rest of your video. 
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Chapter 14 
Working with 5.1 Surround 

You can create 5.1-channel mixes to wrap a listener in your remixes or prepare audio for cinema, DVD-Video, DVD-Audio, 
or DTS 5.1 Music projects. 

Note: ACID plays, mixes, and renders uncompressed 5.1-channel audio. Authoring software such as Sony DVD 

Architect software is required to burn the audio to DVD.


What is 5.1 surround? 

5.1 surround is a standard format consisting of three speakers across the front and two speakers in the rear. The “.1” is a 
sixth channel called low-frequency effects (LFE) that enhances the bass levels in the mix. 

5.1 surround includes five main channels... ...and a sixth channel for low frequency effects. 

Left Center Right 

Right 
Surround 

Left 
Surround 

LFE 

The LFE channel is commonly used in motion pictures to enhance low audio frequencies for effects such as explosions or 
crashes. Audio in this channel is commonly limited to a range from about 25 Hz to 120 Hz. Unlike the five primary 
channels, the LFE channel adds no directional information. Depending on the speaker setup and audio levels, the sound 
assigned to the LFE channel may be routed among the five main speakers or to an additional subwoofer. 
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Setting up surround hardware 

Before you create surround projects, you should set up your system to provide 5.1 surround playback. To play a 5.1 surround project, 
you must have an appropriate speaker setup such as: 

•	 Six powered speakers 

•	 Six passive speakers with a six-channel amplifier 

Your system must also have an appropriate sound card setup such as: 

•	 5.1-compatible sound card 

•	 Sound card with three stereo outputs 

•	 Three stereo sound cards 

There are several ways to set up your system, depending on the sound card and speaker setup you are using. 

Six powered speakers	 Six passive speakers with a six-channel amplifier 
5.1- Connect powered speakers to your sound card’s Connect your sound card’s front, rear, and center/ 
compatible outputs as indicated by your sound card’s subwoofer outputs to the appropriate inputs on a 

sound card documentation. six-channel amplifier/home theater receiver. Connect front, 
rear, center, and LFE speakers to the amplifier. 

Sound card Connect powered speakers to your sound card’s Connect your sound card’s outputs to the appropriate 
with three outputs where you have routed each of the pairs of inputs on a six-channel amplifier/home theater receiver. 

stereo channels. The left channel of the Center/LFE pair is Connect front, rear, center, and LFE speakers to the 

outputs the center channel; the right channel is the LFE amplifier. 
channel. 

Three stereo 	 Connect powered speakers to your sound cards’ Connect your sound card’s outputs to the appropriate 
sound cards	 outputs where you have routed each of the pairs of inputs on a six-channel amplifier/home theater receiver. 

channels. The left channel of the Center/LFE pair is Connect front, rear, center, and LFE speakers to the 
the center channel; the right channel is the LFE amplifier. 
channel. 

Setting up surround projects 

You can configure an ACID project to use 5.1 surround in the Project Properties dialog. You can also choose to apply a low-pass filter for 
the LFE channel. Applying a low-pass filter approximates the bass-management system in a 5.1 decoder and ensures that you’re 
sending only low-frequency audio to the LFE channel. 

1.	 From the File menu, choose Properties. 

2.	 Click the Audio tab. 

3.	 From the Master bus mode drop-down list, choose 5.1 surround. 

4.	 To limit the audio sent to the LFE channel, do the following: 

•	 Select the Enable low-pass filter on LFE check box and enter a value in the Cutoff frequency for low-pass filter box. The low-
pass filter isolates the audio sent to the LFE channel by limiting it to frequencies lower than the value entered in the Cutoff 
frequency for low-pass filter box. 

•	 Choose a setting from the Low-pass filter quality drop-down list to determine the sharpness of the filter’s rolloff curve. Best 
produces the sharpest curve. 

Note: Before rendering your surround project, check your surround authoring application’s documentation to determine its required 
audio format. Some encoders require a specific cutoff frequency and rolloff, while other encoders require that no filter be applied before 
encoding. 

5.	 Click OK. 

The track list and Mixing Console window switch to 5.1 surround mode. The Master bus becomes the Surround Master bus, which 
contains faders for each of the six surround channels. Surround panners appear on tracks and Mixing Console controls. Tracks routed to 
Mixing Console controls (busses, assignable effects, or soft synths) do not have surround panners; panning for these tracks takes place 
on the Mixing Console control. 
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Track list in 5.1 surround mode	 Mixing Console in 5.1 surround mode 

Surround 

panner 

Surround 

panners 

Track routed 
to LFE 

Track routed 
to Bus 

MIDI track 

routed to 

soft synth


Front L/R Rear L/R Center LFE 

Routing to hardware in the Mixing Console 

You must route the surround audio to the correct output in the Mixing Console. 

1.	 From the Options menu, choose Preferences. 

2.	 Click the Audio Device tab. 

3.	 From the Audio device type drop-down list, choose an audio device type other than Microsoft Sound Mapper (such as Windows 
Classic Wave Driver). 

4.	 Choose the playback devices for the six surround channels: 

• 	From the  Default Stereo and Front playback device drop-down list, choose the appropriate device for the front left and right 
surround channels. 

• 	From the  Default Rear playback device drop-down list, choose the appropriate device for the rear left and right surround 
channels. 

• 	From the  Default Center and LFE playback device drop-down list, choose the appropriate device for the center and LFE 
surround channels. 

5.	 Click OK. 

Overriding the default device routing 

By setting up the device routing in the Audio Device tab of the Preferences dialog, you have set the defaults for surround routing. 
However, you can override the default device routing at any time. 

1.	 From the View menu, choose Mixing Console to open the Mixing Console window. 

2.	 In the I/O control region, click the Output button and choose an output device for the Front channels. 

3.	 Repeat step two for the Rear and Center/LFE channel pairs. 

Assigning audio to the LFE channel 

Once the project is in 5.1 surround mode, you must decide whether a track will provide the “5” (surround panning) or the “1” (LFE 
channel) in 5.1 surround. Initially, all tracks in a surround project are set to provide surround panning, but you can assign a track to the 
LFE channel instead. 

You can assign an individual track to the LFE channel or you can route the track to a Mixing Console control (bus, soft synth, or 
assignable effect chain) and assign the control to the LFE channel. 

To assign audio to the LFE channel, right-click the surround panner on the track header or Mixing Console control and choose LFE Only 
from the shortcut menu. The track or Mixing Console control is assigned to the LFE channel. 
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To change a track or Mixing Console control back to surround panning, right-click the LFE indicator and choose Surround Pan from the 
shortcut menu. 

Note: Before rendering your surround project, check your surround authoring application’s documentation to determine its 
required audio format with respect to the LFE channel. For more information, see Setting up surround projects on page 236. 

Adjusting volume 

Adjusting track volume for 5.1 surround projects behaves almost identically to stereo projects. The fader controls in the track headers 
can function as trim controls that adjust the overall volume of the track, bus, or assignable effects chain, or they can adjust volume 
automation settings. For more information, see Track automation on page 137. 

Adjusting track volume 

You can adjust track volume using the Vol fader in the track header the same way you do in stereo projects. 

Deselect the Automation Settings button ( ) in the track header if you want to adjust trim levels. 

Track header in trim mode 

Select the Automation Settings button if you want to adjust volume automation. The fader handle is displayed as a  in automation 
mode. 

Track header in automation mode 

Adjusting assignable effects send or bus send levels 

You can adjust send levels for busses or assignable effects chains using the multipurpose fader in the track header. Click the fader label 
and choose an assignable effects chain or bus from the menu. The fader in the track header can function as a trim control that adjusts 
the overall send level of the track, or it can adjust send level automation settings. 

Deselect the Automation Settings button ( ) if you want to adjust trim levels.


Select the Automation Settings button if you want to adjust volume automation. The fader handle is displayed as a
  in automation 
mode. 

Adjusting channel levels 

Use the Master bus control in the Mixing Console window to adjust the individual levels of the 5.1 channels. The faders in the track bus 
control can function as trim controls that adjust the overall level of each channel, or you can automate the master volume of the Master 
bus (individual channel levels cannot be automated). 

Click the Automation Settings button ( ) in the bus control or bus track and verify Show Automation Controls is not selected if you 
want to adjust trim levels, or select Show Automation Controls if you want to adjust volume automation. 
238 | CHAPTER 14 



Panning audio 

You can pan audio in a 5.1 surround project in two ways: 

•	 Pan tracks individually using the Surround Panner window. 

•	 Route tracks to mixer controls (busses, assignable effect chains, or soft synths) and pan the mixer controls using the Surround 
Panner window. 

Note: You cannot pan audio on tracks or busses that are routed to hardware outputs in a 5.1 surround project. 

Panning tracks 

1.	 Deselect the Automation Settings button ( ) on the track you want to pan. 

2. Double-click the surround panner on the track you wish to pan. The Surround Panner window appears. 

Double-click to display 
the Surround Panner 
window 

3.	 Adjust the panning settings. For more information, see Using the Surround Panner window on page 240. 

4.	 Close the Surround Panner window. 

Tip: You can also use the surround panner in the track header to pan your track. 

Panning mixer controls 

You may choose to route tracks to busses or other mixer controls (such as soft synths or assignable effect chains) and pan them as a 
group rather than panning each track individually. 

Note: When you route a track to a bus or soft synth control, stereo (two-channel) output is sent to the mixer control and the mixer 
control sends 5.1 (six-channel) output to the Master bus. 

1. Add a mixer control to the project. For more information, see Using the Mixing Console on page 151. 

2. Route tracks to the mixer control. For more information, see Assigning tracks to busses on page 111. 

3. Double-click the surround panner on the mixer control to display the Surround Panner window. 
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Double-click to display 
the Surround Panner 
window 

4. Adjust the panning settings. For more information, see Using the Surround Panner window on page 240. 

5. Close the Surround Panner window. 

Tip: You can also use the surround panner on the mixer control to pan your track. 

Using the Surround Panner window 

Whether you’re adjusting track panning or mixer control panning, you use the same controls in the Surround Panner window. 

View the Surround Panner window by double-clicking a surround panner on a track header or mixer control. Once the Surround Panner 
window is open, you can dock it in the ACID workspace. For more information, see Docking and floating ACID windows on page 247. 

Tip: You can also choose Surround Panner from the View menu to display the Surround Panner window. Once the Surround 
Panner window is displayed, double-click the surround panner for a track or mixer control to view its pan settings. 

Pan point 

Toggle options for constraining pan 
point movement 

Assign track/bus to LFE channel 

= Muted channel 

= Active (included) channel 

Pan type indicator 

1. Click the speaker icons to mute or include channels. 

Muting a channel ensures that no audio bleeds through a channel. For example, you might want to mute all but the center channel 
when you’re panning dialogue to the center channel. 

Tip: Ctrl + click a speaker icon to solo the channel. 

2. Drag the pan point to position the sound within the sound field. For more information, see Moving the pan point on page 241. 
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3.	 Click the center speaker icon to include the center channel and drag the Center fader to apply a gain to the center channel. 

Applying a gain to the center channel may make dialogue more present in the mix. 

Note: When automating panning using keyframes, you cannot automate the gain applied using the Center fader. For more 

information, see Automating panning on page 242.


4.	 Drag the Smoothness slider to adjust the smoothness of the interpolation path between panning keyframes. The smoothness 
setting appears only when you are automating panning using keyframes. For more information, see Adjusting the Smoothness slider 
on page 244. 

Moving the pan point 

You have a variety of methods to help you position the pan point in the Surround Panner window. 

Method 

Double-click 

Ctrl+drag Makes fine adjustments. 
Shift+drag Constrains motion to vertical, horizontal, or diagonal motion at 45 

degree increments. 
Alt+drag 

Shift+Alt+drag 

Arrow keys 
Ctrl+Arrow keys 
Page Up/Page Down 
Shift+Page Up/Page Down 
Numeric keypad 1-9 
Ctrl+Numeric keypad 1,3,7, 9 

Mouse wheel 
Shift+mouse wheel 
Ctrl+mouse wheel 
Ctrl+Shift+mouse wheel 

Description 
Click to toggle through three options for constraining pan point motion 
as you drag: Move Freely ( ), Move Left/Right Only ( ), and Move 

Front/Back Only ( ). 

Double-clicking the pan point resets it to the center front of the 

surround panner.


Double-clicking in the Surround Panner window moves the pan point 

to the double-click location.


Constrains motion to a constant radius from the center of the surround 
panner. 
Constrains motion to the maximally inscribed circle (a constant radius 
at the greatest possible distance from the center of the surround 
panner). 
Moves front/back/left/right. 
Makes fine adjustments. 
Moves front/back. 
Moves left/right. 
Jumps to a corner, edge, or center of the surround panner. 
Jumps to a location on the maximally inscribed circle (a constant radius 
at the greatest possible distance from the center of the surround 
panner). 
Moves front/back. 
Moves left/right. 
Makes fine front/back adjustments. 
Makes fine left/right adjustments. 

Choosing pan types 

When you pan a track or mixer control, you can choose among several pan types to determine how the audio is panned. The current 
pan type appears at the bottom of the Surround Panner window. 

Right-click the Surround Panner window and choose a pan type from the shortcut menu. 

• 	The Add Channels pan type makes the audio appear to move as a unit among the surround channels. As you move the pan point 
toward a channel (speaker icon), more and more of the signal from the other channels are folded into the channel you are panning 
towards, until at the extreme, all channels are fed at full intensity into a single channel. This pan type uses a linear panning curve. 

• 	The  Balance pan type is most useful for adjusting the relative signal levels of the channels. In this pan type, as you move the pan 
point from the center to a channel, the signal in the channel you are panning towards starts at the base dB level (either 0 dB, -3 dB, 
or -6 dB) and increases to 0 dB. The signal in the channel you are panning away from starts at a base dB level (either 0 dB, -3 dB, or ­
6 dB) and decays to no signal level. For example, when you pan fully to the right, only the right channel is audible. This pan type 
uses a linear panning curve. 

• 	The  Constant Power pan type maintains a constant volume as you move the pan point from channel to channel. This pan type, 
which uses the constant-power panning curve, is most useful for panning monaural source media. 
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•  The  Film mode allows you to pan between pairs of adjacent speakers in 5.1 surround projects using a constant power model. This 
mode is optimized for theater-style speaker placement. In stereo projects, Film mode functions identically to Constant Power. 

As you drag the pan point to the center speaker, the sound becomes diffused through the front and rear speakers. When the track 
is panned fully to the center speaker, there is no output from the front and rear speakers. 

Dragging the pan point to the center of the surround panner sends the signal to all speakers. 

Note: If you're panning fully to a single speaker in Film mode, you may notice that some signal is mixed to the opposite speaker. This 
is because the ideal placement for surround speakers does not match the representation in the surround panner. For example, 
panning to the front-left speaker produces a low-level signal in the rear-left speaker. 

This is because your front-left speaker should be positioned 30° left of center and the speaker in the surround panner is located 45° 
left of center. To produce a true 45° left-of-center pan, the signal is panned between the front- and rear-left speaker. 

Using the grid to monitor panning 

The grid in the Surround Panner window helps you to visualize how your panning will sound. The grid's spacing changes to match the 
current pan type. 

The vertical lines represent the points where the left-to-right signal ratio is 6 dB, 0 dB, and -6 dB respectively: at the far-left line, the left 
channel is 6.0 dB louder than the right channel. 

The horizontal lines represent the points where the front-to-rear signal ratio is 6 dB, 0 dB, and -6 dB respectively. As you adjust the 
Center fader, the lines move forward or backward to compensate for the center-channel gain. 

Note: The grid assumes that you're using a correctly set-up surround system (matched speakers and ideal positioning). Variations in 
your monitoring system will cause inconsistencies between the graph and perceived output. 

Automating panning 

You can automate panning on a track or mixer control by adding keyframes. Keyframes are similar to envelope points in that they mark 
specific locations in the track where settings change. However, unlike envelope points, keyframes appears just below the track to which 
they apply. 

To add panning keyframes to a mixer control, you must first view the mixer control in track view. From the View menu, choose Show 
Bus Tracks to view the bus track at the bottom of the track view. 

Turning on panning keyframes 

Before adding individual keyframes, you must first turn on the panning keyframes for the track or bus track. 

1. Select the track or bus track for which you want to automate panning. 

2. From the Insert menu, choose Envelopes, and choose Surround Pan Keyframes from the submenu. 

An additional row appears below the track with a single keyframe positioned at the beginning of the project. This single keyframe 
represents the current panning settings for the track. 

Keyframe 

Adding panning keyframes 

With panning keyframes turned on, you can add keyframes at any location along the track or bus track. 

1. Position the cursor where you want to begin panning the track. 

2. Select the Automation Settings button ( ) on the track you want to pan. 
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3. Double-click the surround panner to display the Surround Panner window. 

4. Adjust the panning settings. For more information, see Using the Surround Panner window on page 240. 

Note: You cannot automate muting/including channels. 

5. Close the Surround Panner window.


A keyframe with the pan settings you created appears below the track at the cursor position.


Tip: You can also add keyframes by double-clicking the keyframe row or by right-clicking the row and choosing Add Keyframe 
from the shortcut menu. Once you’ve added the keyframe, double-click it to adjust panning settings in the Surround Panner window. 

As you add keyframes to a track or bus track, the Surround Panner window shows the path of the panning keyframes. The 
Smoothness slider controls the smoothness of the interpolation path between the keyframes. For more information, see Adjusting 
the Smoothness slider on page 244. 

Working with keyframes 

After you add keyframes, you can work with them in much the same way as envelope points. For more information, see Using track 
automation envelopes on page 112. 

Moving keyframes 

Drag a keyframe to a new position below its track. 

Duplicating keyframes 

Hold Ctrl and drag a keyframe to a new position below its track. 

Editing keyframes 

1. Double-click a keyframe to open the Surround Panner window. 

2. Adjust the panning settings as desired and close the window. 
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Changing keyframe interpolation curves 

To control how the pan is interpolated between keyframes, right-click a keyframe and choose an interpolation curve type from the 
shortcut menu. Keyframe interpolation curves control how the pan occurs over time. 

Keyframe Interpolation curve 
Hold 

Description 
No interpolation takes place. The keyframe's settings are maintained until the next 
keyframe. 

Linear Panning is interpolated in a linear path. 

Fast Panning is interpolated in a fast logarithmic path. 

Slow Panning is interpolated in a slow logarithmic path. 

Smooth Panning is interpolated along a smooth, natural curve. 

Adjusting the Smoothness slider 

The Smoothness slider controls the perceived motion of sound within the sound field among three or more keyframes. When you drag 
the Smoothness slider to 0, the changes are interpolated between keyframes along a linear path. As you increase the smoothness value, 
the path between keyframes grows more curved and smooth. 

1. Double-click a keyframe. The Surround Panner window appears. 

Smoothness slider 

2. Drag the Smoothness slider to adjust the smoothness of the spatial interpolation path leading up to this keyframe. 
Three keyframes with 	 ...and the same three keyframes 


with smoothness=0.
smoothness=100... 

Locking keyframes to events 

If you want keyframes to move with an event when it is moved along the timeline, choose Lock Envelopes to Events from the Options 
menu. 
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Hiding keyframes 

1.	 Select the track for which you want to hide keyframes. 

2.	 From the View menu, choose Show Envelopes, and choose Surround Pan Keyframes from the submenu. 

Deleting keyframes 

Right-click a keyframe and choose Delete from the shortcut menu. 

Rendering surround projects 

Rendering a surround project creates six mono files (AIFF, WAV, W64, or PCA) or a single 5.1-channel file (AC-3, WMA, and WMV) that 
your authoring application can use to create DVD-Video or 5.1-channel music projects. 

With the addition of the Sony 5.1 Surround Plug-In Pack, you can render AC-3 files using ACID software and burn the resulting files to 
DVD. 

Note: Before rendering your surround project, check your surround authoring application’s documentation to determine its required 
audio format. Some encoders require a specific low-pass filter cutoff frequency and rolloff, and your encoder may require that no filter be 
applied before encoding. Use the Audio tab of the Project Properties dialog to configure a low-pass filter. For more information, see 
Setting up surround projects on page 236. 

1.	 From the File menu, choose Render As. The Render As dialog appears. 

2.	 From the Save in drop-down list, choose the drive and folder where the file will be saved. 

3.	 Enter a new name for the project in the File name box. A separate file will be created for each channel using this name as a base. 

For example, if you type My Project in the File name box and render your project using wave files, the following files would be 
created: My Project Left.wav, My Project Right.wav, My Project Center.wav, My Project LFE.wav, My Project Left 
Surround.wav, and My Project Right Surround.wav. 

4.	 From the Save as type drop-down list, choose the desired file format. If you have the Sony AC-3 Encoder, you can choose AC-3 
from the list. 

5.	 Choose 44,100 Hz, 16 Bit, Mono, PCM from the Template drop-down list if you want to render six mono files, or choose an 
appropriate 5.1-channel template if the selected file type supports it. 

6.	 Select the Render loop region only check box if you want to save only the portion of the project that is contained within the Loop 
Region. Loop Playback does not need to be selected for this option to work. 
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7.	 If the selected file type supports it, you can select the Save project markers with media file check box to include markers, regions, 
and time markers in the rendered media file. If the information cannot be saved to your media file, an .sfl file will be created (using 
the same base name as your media file). 

8.	 Click Save. 

Burning AC-3 files to DVD 

With the addition of the AC-3 DVD Burner included in the Sony 5.1 Surround Plug-In Pack, you can burn AC-3 files to a DVD. 

1.	 From the Tools menu, choose Start AC-3 DVD Burner. The AC-3 DVD Burner application starts. 

2.	 Follow the instructions for burning a DVD in the AC-3 DVD Burner online help. To access online help, click Help in the AC-3 DVD 
Burner screen. 
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Appendix A

 Customizing ACID Software


You can customize the software to suit your project needs and working preferences. You may change these settings at 
any time. If you use the same settings for all of your projects, you may set the ACID® application to use your settings as 
defaults. 

In this chapter, you will find information about functions that allow you to customize and set the application’s 
preferences. 

Working with ACID windows 

The software has various windows that allow you to perform specific tasks related to your project or manage your media. 
These windows can float on the workspace or be docked in the window docking area. All these windows may be viewed 
or hidden via the View menu or their respective shortcut keys. 

Window Shortcut keys	 Description 
Explorer Alt+1	 Allows you to view and access your media files without leaving the work 

area. You may also preview media files and place them in your project 
from this window. 

Chopper™ Alt+2 Allows you to select portions of a media file that can be placed into tracks 
as events. 

Mixing Console Alt+3 Allows you to work with busses, assignable effect chains, and soft synth 
controls. 

Video Preview Alt+4 Displays a project’s video output at the current cursor position in the 
timeline. 

Media Manager Alt+5 Displays the Media Manager™, which you can use to search for, manage, 
and tag your media files. 

Track Properties Alt+6 Allows you to view and edit track attributes. For MIDI tracks, allows you to 
edit MIDI using the piano roll editor, list editor or other OPT plug-ins. 

Surround Alt+7 Allows you to control panning in a 5.1 surround project. 
Panner 
Soft Synth Alt+8 Allows you to change the attributes of soft synth controls in the Mixing 
Properties Console window. 
Audio Plug-In Alt+9 Allows you to view and edit settings for assignable, bus, soft synth, and 

track effect chains. 
Plug-In Ctrl+Alt+1 Allows you to view and choose effects plug-ins to be added to a track, 
Manager bus, or assignable effects chain. 
Groove Pool Ctrl+Alt+2 Allows you to view and edit grooves in your project. 
Clip Properties Ctrl+Alt+3	 For audio (non-MIDI) clips: allows you to change clip types (loop, one-

shot, and Beatmapped), and adjust time stretching, pitch, root notes, 
tempo, and downbeat. 

For MIDI clips: allows you to edit data using the list editor or piano roll. 

Docking and floating ACID windows 

The window docking area allows you to keep frequently used windows available but out of the way while you are 
working with a project. You can dock windows either in a single stack spanning the width of the screen or divide the 
window docking area into sections (e.g., right, middle, and left) and create several stacks. You can also create floating 
docks by dragging several windows to the same area on your screen. 

Windows that are not currently visible in a stack display a tab that you can click to display it. You can also expand, restore, 
or close a window using the buttons in the window’s upper-left corner. Windows are displayed in fixed positions in the 
lower portion of the window. 
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Close window 

Expand/restore window 

Drag handle 

Tabs 

Note: When the last window in the docking area is closed or removed, the docking area minimizes automatically. When the docking 
area is minimized, dragging a dockable window over the bottom of the ACID window causes the docking area to open again. 

Docking windows 

1.	 If the window is floating on the workspace, grab the window by its title bar and drag it to the window docking area anywhere 
below the track list or track view. As you drag the window, the window’s outline appears. 

2.	 Position the window’s outline in the docking area where you want it and release the mouse. 

Floating windows 

You may float a window so that it does not appear in the docking area. 

1.	 Grab the window by its handle (the border along the left side) and drag the window to the workspace. As you drag the window, the 
window’s outline appears. 

2.	 Position the window anywhere in the workspace and release the mouse. You can move the floating window by dragging it to a 
new position or docking it again. 

If desired, you can create a floating dock with multiple windows by repeating steps 1 and 2. 

Preventing windows from docking 

Press Ctrl while dragging a window to prevent it from docking in the workspace. 

Resizing the window docking area 

You can resize the track list, track view and docking area sections of the ACID workspace by dragging the dividers between them. 

Tip: You can quickly hide or show the window docking area by pressing F11. 
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Changing the time ruler format 

You may specify a time format for the ACID time ruler to display. The ruler, located below the track view, displays real time in several 
formats. You may change the ruler format in one of the following ways: 

• 	From the  View menu, choose Time Ruler, and choose the desired format from the submenu. 

•	 Right-click the time ruler and choose the desired format from the shortcut menu. In addition to right-clicking the time ruler in the 
track view, you can use this technique on the time rulers in the Chopper and Track Properties windows. 

The following table describes the available time formats. 

Time format Description 
Samples Displays the time ruler in samples. 
Time Displays the time ruler in hours:minutes:seconds.milliseconds. 
Seconds Displays the time ruler in seconds. 
Time & Frames Displays the time ruler in hours:minutes:seconds.frames with a frame rate equal to that of your 

video. 
Absolute Frames Displays the time ruler in total frames from the beginning of the project. 
Feet & Frames 16 mm Displays the time ruler in feet+frames at a rate of 40 frames per foot. 
Feet & Frames 35 mm Displays the time ruler in feet+frames at a rate of 16 frames per foot. 
SMPTE Film Sync Displays the time ruler in hours:minutes:seconds:frames with a frame rate of 24 frames per 
(24 fps) second for synchronizing with film. 
SMPTE EBU (25 fps) Displays the time ruler in hours:minutes:seconds:frames with a frame rate of 25 frames per 

second for European Broadcasting Union. 
SMPTE Non-Drop Displays the time ruler in hours:minutes:seconds:frames with a frame rate of 29.97 frames per 
(29.97 fps) second. 
SMPTE Drop Displays the time ruler in hours:minutes:seconds;frames with a frame rate of 29.97 frames per 
(29.97 fps) second using dropped frame numbers. 
SMPTE 30 (30 fps) Displays the time ruler in hours:minutes:seconds:frames with a frame rate of 30 frames per 

second. 
Audio CD Time Displays the time ruler in tt+mm:ss:ff (track number +/- minutes:seconds:frames) with a frame 

rate of 75 fps. 

Using the ruler offset 

The ruler offset allows you to change the project ruler to start at a specific time. Typically, this feature is used in conjunction with SMPTE 
and MIDI projects when their timelines are the main reference. Basically, the ruler offset allows you to set the ACID time ruler based on 
another project’s timeline for reference purposes, i.e., the SMPTE or MIDI timelines. 

When you enter a new value along the timeline, the ruler’s time units are adjusted at the cursor position and at the start of the timeline. 
For example, if the cursor is positioned at the 2:00 minute mark and you enter 15:00 minutes, the start of the project will begin at 13:00 
minutes. The ruler offset feature works the same for all time formats. 

1.	 Position the cursor anywhere along the timeline. 

2.	 Right-click the time ruler to display a shortcut menu. 

3.	 From the shortcut menu, choose Set Time at Cursor. A box opens at the cursor position. 

4.	 Enter a time value. 

5.	 Press Enter to set the cursor position’s time value. The value that you enter at the cursor position affects all time values that 
precede and follow it. 

Using the project grid 

The project grid appears on the track view and is mainly used to align the events in your project. The grid divides your project into equal 
units based on the setting that you choose. The grid setting can be based on the project type or how you prefer to work. 

It is important to remember that in some cases the grid lines and the ruler divisions do not match. This is because they are two 
independent functions. However, you may set the grid to align to the ruler, which is the default setting. 
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The grid can use the following formats: 

Ruler Marks 16th Notes

Measures 16th Note Triplets

Half Notes 32 Notes

Quarter Notes 32nd Note Triplets

Quarter Note Triplets 64th Notes

8th Notes 64th Note Triplets

8th Note Triplets


Setting the grid type 

You may change the grid type at any time and apply it to your project. There are two ways to set the grid type for your project. 

• 	From the  Options menu, choose Grid Spacing, and choose the type of grid you want from the submenu. 

•	 Right-click the marker bar, choose Grid Spacing from the shortcut menu, and choose the type of grid that you want from the 
submenu. 

Using the toolbar 

The toolbar is set to display below the menu bar. However, you may hide and customize the toolbar to suit your preferences. The 
settings that you apply to the toolbar remain set until you change them again. 

Hiding and displaying the toolbar 

If you prefer to use shortcut keys when working with your project, you may hide the toolbar to create more workspace. Choose Toolbar 
from the View menu to hide it. The check mark next to the command is removed and the toolbar disappears. The toolbar remains 
hidden until you choose Toolbar from the View menu to display it again. 

Reordering toolbar buttons 

You can change the toolbar’s button order to suit your preferences. You may either reorder the buttons directly on the workspace or via 
the Customize Toolbar dialog. 

Reordering buttons on the ACID workspace 

1.	 Hold Shift and drag the button that you want to move to the new location on the toolbar. A hand icon ( ) within an outline of the 
button indicates that you are moving the button. 

2.	 Release the mouse to drop the button in its new location. 

Reordering buttons in the Customize Toolbar dialog 

The Customize Toolbar dialog allows you to control the order and functionality available on the Toolbar. You may return the toolbar to 
its default settings by clicking the Reset button. 

1.	 From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog appears. 
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2. On the Current toolbar buttons pane, select the button that you want to move and click Move Up or Move Down. 

3. Click Close to save the toolbar changes and close the dialog. 

Adding buttons to the toolbar 

A series of buttons are included that you may add to the toolbar. These buttons are listed in the Customize Toolbar dialog. You may also 
add separators on the toolbar to organize the buttons to suit your preferences. 

You may return the toolbar to its default settings by clicking the Reset button on the dialog. 

1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog appears. 

2. On the Available toolbar buttons pane, use the scroll bars to locate the button that you want to add and select it. 

3. On the Current toolbar buttons pane, select the button that you want the newly added button to proceed in order. 

For example, if you want to add the Save As button and want it to precede the Publish button, select the Publish button in the 
Current toolbar buttons pane. 

4. Click Add. The new button is added above the selected button on the Current toolbar buttons pane. 

Tip: You may also double-click a button in the Available toolbar buttons pane to add it to the toolbar. 

5. Click Close to save the toolbar settings and close the dialog. 

Removing buttons from the toolbar 

You may remove buttons and separators from the toolbar. If you have added buttons to the toolbar, removing unused or unwanted 
buttons allows you to maximize the toolbar’s space. You may remove toolbar buttons either directly on the workspace or via the 
Customize Toolbar dialog. 

Removing buttons on the ACID workspace 

1. Hold Shift and drag the button that you want to remove off the toolbar. A hand icon ( ) within an outline of the button indicates 
that you are removing the button. 

2. Release the mouse to remove the button. 

Removing buttons in the Customize Toolbar dialog 

You may return the toolbar to its default settings by clicking the Reset button on this dialog. 

1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog appears. 

2. On the Current toolbar buttons pane, select the button that you want to remove. 

3. Click Remove. The button is removed from the Current toolbar buttons pane and will not appear on the toolbar. 

Tip: You may also double-click a button to remove it. 

4. Click Close to save the toolbar settings and exit the dialog. 
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Using the time display 

The time display above the track list reflects the cursor’s position on the timeline. 

Changing cursor position 

You can edit the cursor position using time as it is displayed on either the beat ruler or time ruler: 

•	 To set the cursor’s position based on the beat ruler, right-click the time display and choose Edit Cursor Position - Beats from the 
shortcut menu. 

•	 To set the cursor’s position based on the time ruler, right-click the time display and choose Edit Cursor Position - Time from the 
shortcut menu. 

Once you make your selection from the shortcut menu, a box appears for the appropriate time display. Enter the cursor’s new position 
and press Enter. 

Tip: You can also edit the cursor position directly by double-clicking the desired time display value and entering the new cursor position. 

Changing the time display 

The time display window always reflects the format of the time ruler. You may change the ruler settings for the time ruler via the time 
display window. 

1.	 Right-click the time display window to display a shortcut menu. 

2.	 Choose Time at Cursor Format to display a submenu. 

3.	 Choose the desired time format. 

Both the time window and time ruler display the chosen time format. 

Monitoring MIDI timecode 

You can use the time display to monitor incoming or outgoing MIDI timecode. MIDI can be monitored in the following ways: 

•	 Display MIDI timecode generated from external sources. 

•	 Display MIDI timecode and MIDI clock information that is generated. 

The time display settings work in conjunction with your project’s properties and MIDI setup options. 

1.	 Right-click the time display window to display a shortcut menu. 

2.	 From the shortcut menu, choose the type of MIDI monitoring to be displayed. Once you have made your selection, the time display 
window displays both the MIDI code being input or output and a status message. 

Setting default track properties 

Each new track has certain default properties, including height, volume, pan type, and track effects. You can modify these track 
properties and then use the modified track as a standard for all new tracks you create. 

1.	 Modify a track’s volume (pg. 41), pan type (pg. 113), height (pg. 40), and track effects (pg. 101). 

2.	 Right-click the track header and choose Set Default Track Properties from the shortcut menu. 
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3. Select the check boxes for properties you wish to set. Clear the check boxes for the properties you wish to leave as 
they are. 

Tip: Select the Restore original defaults check box to return to the original track properties. 

4. Click OK. 

Setting ACID preferences 

From the Options menu, choose Preferences to display the Preferences dialog. 
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Using the General tab 

Item Description 

Automatically open last project on Select this check box if you want to reopen the project that was open the last time the 
startup software was closed. When you clear this check box, the software starts with a blank 

project. 

Show logo splash screen on Select this box if you want the ACID logo splash screen to display upon startup. 
startup 

Use Net Notify to stay informed When you select this check box, information is periodically displayed from Sony at 
about Sony products startup. Clear the check box to bypass the Net Notify dialog. 

Create undos for FX parameter Select this check box if you want Undos to be created when you change a plug-in 
changes parameter. 

Confirm media file deletion when When you select this check box, a message box appears asking if you want to delete a 
still in use media file that is currently in use by the project. 

Close media files when ACID is not 
the active application 

When you select this check box, you can edit files in external editors while the files are 
contained in events in ACID. 

Close audio and MIDI ports when 
ACID is not the active application 

Select this check box if you want to close ACID audio and MIDI ports when you switch to 
another application. 

Clear the check box if you want to leave ports open. For example, if you have a MIDI 
keyboard routed to an ACID soft synth, clearing the check box allows you to continue to 
hear the soft synth while you work with a sequencer. 

Note: When you edit a clip in an external editor, audio, MIDI, and external control 

hardware is released regardless of the Close audio and MIDI ports when ACID is not 
the active application check box setting. The ports are re-enabled when focus is 
restored to ACID. 

Enable multimedia keyboard 
support 

When you select this check box, you can use a multimedia keyboard to control playback 
of a project. 

Automatically render large Wave 
files as Wave64 

The WAV format is limited by a maximum file size of ~2GB. When you select this check 
box, you can render larger files as Sony Wave64 files. 

Prompt for region and marker 
names if not playing 

When you select this check box, a box appears so you can name markers and regions as 
you place them. 

Create project file backups on 
save (.acd-bak) 

When you select this check box, a backup of project files is made when you open them. 
Backup files are stored in the same folder as your project and use the same file name 
with the extension .acd.bak. You can use backup project files to revert to a project’s 
previous state. 

Preserve pitch for new 
Beatmapped tracks when tempo 
changes 

Select the check box if you want to maintain the pitch of Beatmapped tracks when the 
project tempo changes. 

Automatically start the 
Beatmapper Wizard for long files 

Select the check box if you want to start the Beatmapper Wizard when you add a file 
that is longer than 30 seconds to your project. 

Use slower updates to prevent 
playback clicks during editing 

Select this check box if you want to update the ACID audio engine more slowly. 
Selecting this option can prevent unwanted artifacts during timeline editing. 

Enable autosave Select this check box to create a temporary project file that can aid in crash recovery. 
Your project information is autosaved every five minutes without overwriting your 
project file. 

Use SPTI for CD burning Select this check box if you want to use SPTI (SCSI Pass-Through Interface) to 
communicate with your CD burning drive. 

Autoname extracted CD tracks Select this check box if you want file names to be automatically assigned to tracks that 
you extract from CDs. 

File names include the CD's ID number and track number. 

Keep bypassed FX running (to 
avoid pause on bypass/enable) 

Select this check box if you want effects to remain open so you can bypass/enable 
effects with no pause for A/B testing. When the check box is cleared, effects are fully 
bypassed, conserving processing power. 

Confirm groove deletion when still 
in use 

When this check box is selected, a message box will appear asking if you want to delete 
a groove that is currently in use by the project. 

Enable Windows XP Theme 
support 

When this check box is selected, the ACID window will inherit the appearance of the 
current theme when using Windows® XP. When the check box is cleared, user interface 
elements will maintain the classic Windows operating system appearance. 
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Item	 Description 

Save media-usage relationships in 	 When this check box is selected, the Media Manager™ will save information about 
active media library	 media usage so you can perform searches for media relationships. 

You can search for projects that use a media file, projects where a media file was 
previewed, media that was rendered with a media file, and so on. 

Enable Media Manager (requires When this check box is selected, the Media Manager will start when you start ACID. 
ACID restart) Clear the check box to turn off the Media Manager and prevent it from starting with the 

application. If you're not using the Media Manager, you may want to turn it off to 
conserve processing power or memory. 

Allow snapping for post-groove 
When this check box is selected, groove markers  in the Groove Editor will snap to the markers 
current grid spacing if snapping is enabled. Hold Shift while dragging to bypass

snapping (press Shift after you click).


Clear the check box if you do not want groove markers to snap to the grid.


Check .acd file type association at When this check box is selected, ACID automatically checks whether .acd, acd-bak, and 
startup .acd-zip are associated with ACID and prompts you to restore the file association if 

necessary. 

Do not query Gracenote for CD When this check box is selected, ACID will not attempt to obtain disc information from 
information Gracenote MusicID when you insert an audio CD. 

Recently used project list Select the check box and enter a number in the box if you want to list your most 
recently used projects at the bottom of the File menu. 

Default All	 Restores all general preferences to the default settings. 

Using the Audio tab 

Item Description 

Open files as loops between 
(seconds) 

Enter a lower and upper limit to specify which files will be opened as loops if 
stretching properties are not saved in the file. 

Files that are shorter than the lower limit will be opened as one-shot tracks; files 
longer than the upper limit will the Beatmapper Wizard. (pg. 113) 

Quick fade edit edges of audio 
events 

When the check box is selected, ACID software will place a rapid fade on the edges 
of audio events (10 ms by default) to soften potentially harsh transitions. When 
the command is not selected, edges of new events are not faded (fades that were 
applied before the check box is cleared are not removed). 

Right-click an event and select or clear the Quick Fade Edges command to 
override the default event fade behavior for individual events. 

Note: Selecting or clearing the check box will not affect existing quick fades in 
your project. To remove all quick fades from a project, enter 0 in the Quick fade 
time box. 

Quick fade time (ms) Enter a time (in milliseconds) to specify the duration of fades applied to the edges 
of events. 

Important: Changing this setting will affect all existing quick fades in your 

project. 

Waveform display while recording 

ACID type for recorded audio 

Record action when nothing is 
armed 

Choose a setting from the drop-down list to specify whether you want to display 
waveforms in the timeline while recording audio. (pg. 182) Turning off waveform 
displays can improve performance. 

Choose a setting from the drop-down list to specify the type of clip that will be 
created when you record audio (pg. 34). 

Choose a setting from the drop-down list to specify what happens if you click the 
Record button when no track is armed: 

New Audio Track: Creates a new audio track where you can record. 

New MIDI Track: Creates a new MIDI track where you can record. 

Do Nothing: The Record button is unavailable unless an audio or MIDI track is 
armed for recording. 
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Item Description 

Include project name when Select this check box if you want to use the project name to identify recorded 
naming recorded media clips. 

For example, if this check box is selected and you’re working with My Remix.acd, 
recorded files will be named My Remix Track X Recording X.wav. 

If this check box is not selected, recorded files will be named Track X Recording 
X.wav. 

Track prefader sends listen to mute Select this check box if you want pre-volume sends from tracks to busses and 
assignable effects to respond to the track mute state.


When the check box is cleared, the pre-volume sends are not affected by the mute

state (in order to facilitate cue mixes). 


Use legacy track send gain Select this check box if you want to configure audio track sends to behave as they 
did in ACID 6.0 and earlier. When the check box is selected, you can open projects 
created with earlier versions of ACID and be assured they will sound the same as 
they did in earlier versions of ACID. 

Metronome sound Choose a setting from the drop-down list to choose the sound that will be used to 
play the metronome. For more information, see Using the metronome on page 
180. 

Normalize peak level (dB) Type a value or use the spinner to change the value that will be used when 
normalizing clips. 

Default All Click to restore the Audio tab to the default settings. 
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Using the Audio Device tab 

Item	 Description 

Audio device type	 Choose a driver type from the drop-down list: 

•	 Microsoft Sound Mapper: The default setting. Allows the Sound Mapper to 
choose an appropriate playback device. 

•	 Direct Sound Surround Mapper: Allows the Surround Mapper to choose 
appropriate playback devices for the front, rear, and center/LFE channels in a 
5.1 surround project (pg. 236). 

•	 Windows Classic Wave Driver: Allows you to choose a specific audio device 
using a classic wave driver. For stereo projects, choose a device from the 
Default Stereo and Front playback device drop-down list. For 5.1-surround 
projects, choose devices from the Default Stereo and Front playback device, 
Default Rear playback device, and Default Center and LFE playback device 
drop-down lists. 

•	 ASIO: Allows you to choose a specific audio device using a low-latency ASIO 
driver. For stereo projects, choose a device from the Default Stereo and Front 
playback device from the drop-down list. For 5.1-surround projects, choose 
devices from the Default Stereo and Front playback device, Default Rear 
playback device, and Default Center and LFE playback device drop-down lists. 

•	 ReWire Device Driver: Allows you to use ACID software as ReWire device in a 
ReWire mixer application. If a ReWire mixer application starts ACID software, 
that ACID window will start in ReWire mode and cannot be switched from 
ReWire mode. If a ReWire mixer connects to an existing ACID window, that 
window will run in ReWire mode, and you can switch out of ReWire mode if 
necessary. If you exit that instance of the software and start ACID software 
again, the new instance will start ReWire mode, and you can switch out of 
ReWire mode if necessary by choosing a different audio device type. 

Default Stereo and Front playback	 Choose the device that you want to use for playing stereo sound data. In a 5.1 
device	 surround project, this device plays the right and left channels. 

Selecting a device such as the Microsoft Sound Mapper allows Windows to select 
an appropriate device to use for the current sound data. 

Note: If you have selected Microsoft Sound Mapper, you cannot assign busses 

to different devices. 

Default Rear playback device Choose the device that you want to use for playing the rear channels (right 
surround and left surround) in a 5.1 surround project. 

Default Center and LFE playback Choose the device that you want to use for playing the center and LFE channels in 
device a 5.1 surround project. 

Playback buffering (seconds) The Playback buffering (seconds) slider specifies the total amount of buffering 
that is used during playback. The larger the number, the more buffering that 
occurs during playback. This value should be as low as possible without gapping. 
To set it, start at 25 and play a typical song. Move some of the track faders. If the 
playback gaps at all, try increasing this slider in small increments until the gapping 
stops. As you increase this slider, the RAM meter at the bottom of the ACID 
window will indicate more RAM usage. 

If you simply cannot get playback to be free of gapping, you need to either 
decrease the number of tracks you are trying to play simultaneously, install more 
RAM in your computer so you can increase buffering, buy a faster access hard 
drive, or minimize the number of audio plug-ins you are trying to use 
simultaneously. 

Enable track buffering Select this check box and drag the Track buffering slider if you want to adjust the 
amount of audio that is prerendered ahead of the cursor position. 

When the check box is selected, a separate processing thread is used to render 
audio from tracks. On multiprocessor or multicore computers, a thread will be 
created for each logical processor. 

When the check box is cleared, a single processing thread is used to render audio 
from tracks and busses. 

Default audio recording device Choose the device that you want to use for recording sound data. 

Selecting the Microsoft Sound Mapper allows the operating system to select an 
appropriate device to use for the current sound data. 
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Automatically detect and offset for Select the check box to automatically compensate for offset between the time you 
hardware recording latency initiate recording and when your sound card starts recording. 

Advanced Click this button to open the Advanced Audio Configuration dialog. 

Default All Click to restore the Audio tab to the default settings. 

Setting Advanced audio preferences from the Audio Device tab 

Item Description 

Audio devices This list displays all of the audio devices that are installed in your computer. 
Selecting a device allows you to set the options for that device. 

Interpolate position When you select this check box, the software attempts to compensate for 
inaccurate devices by interpolating the playback or recording position. If you 
notice that your playback cursor is offset from what you are hearing, select this 
option for the playback device. 

Position bias If the position of playback or record does not match what you hear after you 
enable Interpolate position, you can attempt to compensate using the Position 
bias slider. Moving this slider offsets the position forward or backward to 
compensate for the inaccuracies of the device. 

Do not pre-roll buffers before When you select this check box, buffers are not created prior to starting playback. 
starting playback Some devices do not behave properly if you clear this check box. If your audio 

stutters when you start playback, try selecting this option. 

Audio buffers Drag the slider to set the number of audio buffers that will be used. Adjusting this 
setting can decrease gapping or help you synchronize the input and output for 
record input monitoring. 

Buffer size (samples) Choose a setting from the drop-down list to indicate the buffer size you want to 
use. 

Priority Choose a setting from the drop-down list to set the priority that is assigned to your 
audio buffers. Increasing the buffers’ priority can help you attain smoother 
playback, but it can also adversely affect other processes. 
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Customizing ASIO Port Naming 

When you use an ASIO sound card, default names are displayed in ACID for each of the device’s ports. If you have a simple setup, the 
default names probably work well enough for you. However, if you have a complex setup, customizing the port names can help you 
keep track of your routing with meaningful labels. 

For example, if you have your control room monitors connected to outputs 1 and 2 on your sound card, you could replace the default 
MainOut 1L and MainOut 1R port names with CtrlRm Left and CtrlRm Right. If your lead vocal microphone is connected to Mic/Inst 1, 
you could name the port LeadVocal, and a harmony microphone connected to Mic/Inst 1 could be labeled Harmony. 

1.	 From the Options menu, choose Preferences, and then click the Audio Device tab. 

2.	 Choose your ASIO audio interface from the Audio device type drop-down list, and then click Apply. 

3.	 Click the Advanced button to display the Advanced Audio Configuration dialog. 

4.	 If you want to edit the name of an input or output port, click the label in the Name column, and then press F2. You can then type a 
new name in the edit box. 

Item Description 

Name The name of the port as it will be displayed in ACID. 

Default naming. 

Input pairs and outputs can be mono, or multiple mono, or 
stereo. 

•	 Mono: A single-channel input or output. 

•	 Stereo: A pair of two mono inputs or outputs. For example, 
you might connect the right and left outputs of a stereo 
device to a stereo input. 

•	 Multi mono: A grouping of two monaural channels as a 
multichannel port. The content in the channels is from 
distinct monaural sources and not intended to be mixed 
as a stereo signal. For example, you might connect two 
microphones to separate inputs to record harmony vocals. 

After renaming the multiple mono port Mic/InstIn 1/Mic 
InstIn 2 to Guitar, the port is switched to stereo, and the left 
and right channels are renamed Guitar Left and Guitar Right. 

If you rename either of a stereo port’s channels, the port is 
switched to a multiple mono channel, and labels are updated 
accordingly. 

If you want to switch back to a stereo channel, you can 
rename the Multi Mono channel. 

Notes: 

•	 ASIO port names are not saved per project. 

•	 In stereo pairs, odd-numbered ports represent the left channel; even-numbered ports represent the right channel. 

•	 Stereo pairs must consist of sequential channels. You cannot make stereo pairs from arbitrary channels. 

•	 If you want to restore a port’s default name, delete the label in the Name column, and the Internal Name is restored. 

•	 If you want to restore all port names, click the Reset Names button (or press Alt+N). 

I/O Indicates whether the port is an input or output port. 

Internal Name The default name of the port. 

Channel Indicates whether a port is a stereo, mono, or multiple mono. 
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Using the MIDI tab 

Note: If you have a MIDI controller that includes buttons and knobs that you map to external control functions, you can use the device 
as an external control device and as a MIDI input device for recording MIDI — for example, you can use the buttons, knobs, and sliders on 
the device for external control, and still use the keyboard, pitch wheel, and modulation wheel for recording MIDI. 

MIDI messages that are mapped to external control functions are filtered when you record MIDI. If a note message is assigned to a control 
surface function, both the note-on and note-off messages will be filtered. 

Item Description 

Make these devices available for 
MIDI track playback 

Select the check box for each MIDI device that you want to use as a MIDI output 

for MIDI tracks and generating MIDI clock.


To load a program map for a hardware synth, right-click the Device box for your

MIDI device and choose Load Device Template from the shortcut menu. 


The selected program map will be used for any track that is routed to the MIDI 

device. The device name will be displayed on the MIDI Output button on the track 

header, and the programs from the device map will be available when you click


the Program button 
 in the track header. 

To assign an input device to a MIDI output port, right-click the Device box, choose 
Input from the shortcut menu, and then choose an input device from the 
submenu. For example, by assigning an input device, you can choose which 
controller you want to use to play a MIDI device. 

When you assign an input device to a MIDI output port, the device name is 
displayed in the Device column in the appropriate row in the Make these devices 
available for MIDI input list. 

If you want an output device to receive MIDI thru data from an input device, right-
click the MIDI Thru From column and choose a device from the shortcut menu. 

When you choose a MIDI Thru From device, the device name is displayed in the 
Device column in the MIDI Thru To column in the Make these devices available 
for MIDI input list. 

Make these devices available for 
MIDI input 

Select the check box for each MIDI device that you want to be available for 
recording MIDI (pg. 189) and controlling soft synths (pg. 222). 

To assign an output port to an input device, right-click the Device box, choose 
Output from the shortcut menu, and then choose an output device from the 
submenu. 

Auto MIDI input routing 

If you want a MIDI input device to echo its MIDI data to an output device, right-
click the MIDI Thru To column and choose a device from the shortcut menu. You 
can select multiple devices to send MIDI thru data. 

When this check box is selected, the focus track will accept input from any MIDI 
input device. 

When multiple tracks are selected, the focus track displays a blinking indicator in 
its track number. 

The Solo Listen to MIDI Input button in the Soft Synth Properties window is 

unavailable when this check box is selected. 

Default All Restores all MIDI preferences to the default settings. 
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Using the Video tab 

Item Description 

Device Choose a DV output device from the drop-down list. This is the interface to which 
your video device is connected. 

Details Displays information about the device selected in the External monitor device 
drop-down list. 

If project format is invalid for DV If your source media does not conform to DV standards, choose a setting from the 
output, conform to the following drop-down list.The video is adjusted to display properly on your external monitor. 

Sync offset (frames) If your audio is not synchronized with your external monitor, you can configure an 
offset for your hardware. Drag the slider to synchronize audio and video. 

This setting affects synchronization for previewing on an external monitor. Audio 
and video synchronization in your ACID project is unaffected. 

Record engage delay (frames) Drag the slider to specify the number of frames it takes your camcorder or deck to 
switch from Record Pause to Record mode. If you're missing frames from the 
beginning of your file after printing to tape, increase the setting. If you see 
duplicated frames at the beginning of your video, decrease the setting. 

Default All Restores all video preferences to the default settings. 

Using the Editing tab 

Item Description 

Project tempo range Use the up and down arrows or enter a value in the boxes to specify the minimum 
and maximum tempo available in the ACID project. Changing this option affects 
the resolution of the Project Tempo slider. 

Tempo curve segmentation Choose a setting from the drop-down list to change the timing resolution ACID 
uses to interpolate tempo curves. For more information, see Using a tempo curve 
to change tempo between markers on page 92. 

Editing Application X Enter the name of each editor you want to display in the track list shortcut menu. 

Right-click a track in the track list and choose Edit in [editor name] to edit the 
media file associated with a track. 

You can specify any editing tool you want to use; however, this feature was 
designed for use with destructive audio/MIDI editors. 

Browse Click Browse and select the .exe file for each editor you want to have available in 
the track list shortcut menu. 

Name Enter the name that you want to use to identify each editor. The name is displayed 
in the track list shortcut menu and the Tools menu. 

Clear Removes the specified editor from the Editing tab. 

Check for latest versions of Sony 
editors 

When you select this check box, the software automatically searches for the latest 
available Sony editors on your computer. If one is located, it appears as an 
available editor in the Editing Application X box. 

Default All Restores all editing preferences to the default settings. 
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Using the Sync tab 

Setting sync preferences 

Generate MIDI Timecode settings 

Output device Choose a MIDI device from the drop-down list. MIDI timecode is sent to this 
device. The MTC slave should also be set to this device. This device will not be 
available for MIDI playback. 

Frame rate Choose a frame rate from the drop-down list. This frame rate is used to generate 
the MIDI timecode. The MTC slave must be set to the same frame rate. 

Generate MIDI Clock settings 

Output device Choose a MIDI device from the drop-down list. MIDI clock is sent to this device. 
The MIDI clock slave should also be set to this device. 

Trigger from MIDI Timecode settings 

Input device Choose a MIDI device from the drop-down list. MIDI timecode is received from this 
device. The MTC master should also be set to this device. 

Frame rate Choose a frame rate from the drop-down list. This value specifies the frame rate at 
which the MTC master sends timecode to ACID. 

Advanced Click to open the Advanced Sync Preferences dialog. 

Default All Restores all sync preferences to the default settings. 

Setting advanced sync preferences 

MTC Input 

Free-wheel for timecode loss Select this check box if you want to continue to play if timecode is lost. 

Enabling this option can compensate for infrequent losses in timecode. If you 
frequently lose timecode, you should perform troubleshooting to determine the 
cause of the problem. 

Free-wheel slack time Use the up and down arrows or enter a value in the box to specify the amount of 
time that timecode can be lost before the free-wheel playback time starts. A 
longer time is more tolerant of breaks in the incoming timecode. 

Free-wheel playback time Use the up and down arrows or enter a value in the box to specify the amount of 
time that playback continues after the free-wheel slack time has been exceeded. 

Synchronization delay time Use the up and down arrows or enter a value in the box to specify the amount of 
time it takes for the software to synchronize itself to incoming timecode. 

On slower computers, this time should be set to approximately two seconds. On 
faster computers, it may be set lower. 

Setting this value too low can sometimes result in audible pitch shifting at the 
start of playback. 

Offset adjust If ACID is consistently behind or ahead of your MTC generator, enter a value in the 
box to adjust a synchronization offset with quarter-frame accuracy. 

If the software is behind, set this value to a negative number. A setting of - 4 is a 
common offset. 

If the software is ahead, set this value to a positive number. A setting of +4 is a 
common offset, although it is rare that the application will sync ahead. 

MTC Output 

Full-frame message generation	 Select a radio button to determine when full-frame timecode messages are sent 
while Generate MIDI Timecode is active. Full-frame messages are used by some 
external synchronizable audio devices to seek to a proper location prior to actually 
starting synchronization. Tape-based recorders especially benefit from seeking to 
full-frame messages because of the time it takes to move the transport to the 
proper location. However, full-frame messages are ignored by some devices, and 
may actually cause unexpected behavior in other devices. 

Refer to your hardware documentation to find out if your hardware supports full-
frame messages. 

MIDI Clock Output 
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MTC Input 

Send Start instead of Continue 
when beginning playback 

Select this check box if you want a Start command rather than a Continue 
command to be sent when Generate MIDI Clock is activated. 

When the check box is cleared, a Continue command is sent, as this type of 
command allows the chasing device to start from a specific time. However, some 
older sequencers that support MIDI Clock chase do not support the Continue 
command and must start playback from the beginning every time. 

Song Position Pointer generation	 Select a radio button to determine when Song Position Pointer messages are sent 
while Generate MIDI Clock is active.


Song Position Pointer messages are used by MIDI applications and devices to

seek to a proper location prior to starting synchronization.


Using the Display tab 

Item 

Track colors 

Envelope colors 

Section colors 

Description 

Use these controls to change the default colors used to display tracks in your 
project. 

Select a track from the Track drop-down list, and then click the color swatch to 
display a color picker. 

You can choose any color using the RGBA or HSLA controls, or click the 
eyedropper to sample a color from your screen. 

When you click OK or Apply, all tracks that used the selected color are updated. 

To customize an envelope’s color, select an envelope from the Envelope type 
drop-down list. Click the color button to the right to display the Envelope Color 
dialog and choose a custom color. 

Use these controls to change the default colors used to display sections in your 
project. 

Choose a section letter from the Section drop-down list and click the color button 
to the right to display a color picker, where you can choose any color using the 

RGBA or HSLA controls. Click the  button to switch between RGB and HSL 

color modes, or click the eyedropper  to sample a color from your screen. 

Icon color saturation 

Icon color tint 

Default All 

For more information, see Using sections on page 66. 

Drag the slider to adjust the color intensity of icons in the ACID window. Drag to 
the left to decrease the color saturation, or drag to the right to increase it. 

Drag the slider to adjust the amount of tinting that is applied to the icons in the 
ACID window. Drag the slider to the right to add an average of the title bar colors 
to the icons. Drag to the left to decrease the amount of tinting applied. 

Restores all display preferences to the default settings. 

Using the Other tab 

Item	 Description 

Enable multiple-selection preview 	 Select this check box if you want to preview multiple selected files in the Explorer. 
in Explorer window	 Enter values in the Number of times to repeat each Loop, Seconds of each One-

Shot to play, and Number of Beatmapped measures to play boxes to specify 
how different file types are previewed. 
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Using the Folders tab 

Item Description 

Default project folder This box displays the path to the folder that will be used for creating new projects. 
Click the Browse button to choose a different folder. 

Use a single default folder for Select this radio button if you want to save all project media in a single folder. 
project media saves 

Use separate defaults for each type	 Select this radio button if you want to choose where to save each type of project 
of project media save	 media. 

The following boxes display the location where each type of media file will be 
saved. 

Record	 This box displays the path to the folder that will be used when 
you record new audio or MIDI tracks. Click the Browse button to 
choose a different folder. 

The folder you specify here is used by default for new projects, 
but if you want to choose a project-specific recorded files folder, 
you can use the Recorded files folder box on the Audio tab of 
the Project Properties dialog. 

Extract from CD This box displays the path to the folder that will be used for 
tracks that you extract from audio CDs. Click the Browse button 
to choose a different folder. 

Render project This box displays the path to the folder that will be used when 
you render your project. Click the Browse button to choose a 
different folder. 

Render to new This box displays the path to the folder that will be used when 
you render to a new track. Click the Browse button to choose a 
different folder. 

Chop to new This box displays the path to the folder that will be used when 
you create new tracks with the Chopper window. Click the 
Browse button to choose a different folder. 

New MIDI This box displays the path to the folder that will be used when 
you export MIDI. Click the Browse button to choose a different 
folder. 

MIDI files are not created when you record MIDI or create new 
MIDI clips. MIDI data for clips is stored within the ACID project. 

Default groove folder This box displays the path to the folder where default grooves for new ACID 
projects are saved. Click the Browse button to choose a different folder. 

This folder is also used as the default location for saving exported grooves from 
the Groove Pool window. 

Temporary files folder Displays the folder where temporary files are stored. Click Browse to specify a new 
folder. 

When you add a media file to a project from a removable device, a copy of the 
media file is stored in a temporary files folder. This keeps the media file available 
for use even if the source of the media is no longer accessible. 

Be aware that this folder is cleared when you close the software. However, the 
temporary files are not cleared if the software closes inappropriately. 

Free storage space in selected 
folder 

This value displays the amount of space available in the folder specified in the 
Temporary files folder box. 
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Using the External Control & Automation tab 

Use the External Control & Automation tab to set up and customize control surfaces. From the Options menu, choose Preferences to 

display the Preferences dialog. Click the External Control & Automation tab. For more information, see Configuring a Mackie Control 

Universal on page 229. 

Note: From the Options menu, choose External Control to enable your selected control surfaces. 

Preference Description 
Smooth and thin automation 
data after recording or drawing 

When recording automation or drawing envelope curves, ACID software creates as 
many envelope points or keyframes as possible to represent your control 
movements. 

Select this check box if you want to reduce the number of envelope points/ 
keyframes after recording or drawing is finished. 

For more information, see Recording automation settings on page 147. 

For more information, see Adding effect automation envelopes on page 140. 
Set controls to default values 	 Select this check box if you want controls to return to their default values when set 
when automation is turned off	 the track's automation recording mode to Automation Off. Automated effect 

parameters do not have default settings and will retain their last-set values when 
you turn automation off. 

When the check box is cleared, controls will retain their last-set values when you 
turn automation off. 

Available devices	 Choose a device from the drop-down list and click Add to choose the control 
surfaces that will be available to ACID software. Adding a device loads its default 
profile. 

For information about configuring specific MIDI controllers, see Setting up a 
Mackie Control Universal on page 269, Using a Frontier TranzPort on page 
283, or Configuring a generic MIDI controller on page 285. 

Active control devices Lists the control devices that you’ve added. Double-click a device name to 
customize its behavior. 

Default all	 Restores all control surface preferences to the default settings. 

Note: You can connect one Mackie Control Universal (with up to four Mackie Control Universal Extenders), one Frontier TranzPort, and 
up to five generic MIDI controllers. 

Customizing keyboard shortcuts


From the Options menu, choose Customize Keyboard to customize the keyboard shortcuts available in the ACID interface.


The Keyboard mapping box displays the currently assigned shortcut keys. Click a tab in the middle of the dialog to choose which

shortcuts you want to see.


Editing or creating new shortcuts 

1. Click a tab in the middle of the dialog to indicate the type of command you want to assign to a keyboard shortcut. 

2. Select a command in the list. 

Tip: You can type a word in the Show commands containing box to filter the list of commands to display only commands that contain 
the word you typed. 

3. Click the Shortcut keys box and press the key combination you want to assign to the selected command. 

4. Click the Add button to assign the key combination in the Shortcut keys box to the selected command. 
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Saving a keyboard mapping 

Click the Save as button and type a name to save your current keyboard shortcuts to an .ini file in the C:\Documents and 
Settings\[user name]\Local Settings\Application Data\Sony\ACID Pro\7.0 folder 

(C:\Users\[user name]\AppData\Local\Sony\ACID Pro\7.0 on Windows Vista). 

Tip: The Application Data folder is not visible unless the Show hidden files and folders radio button is selected on the View tab of the 
Windows Folder Options control panel. 

You can use this file as a backup or to share your keyboard shortcuts with other ACID users.


Deleting a keyboard mapping 


Choose a mapping from the Keyboard mapping drop-down list and click the Delete button to remove the selected keyboard mapping.


Tip: You cannot delete the default ACID keyboard mapping. 

Importing a keyboard mapping 

Copy an ACID keyboard mapping .ini file to the C:\Documents and Settings\[user name]\Local Settings\Application 

Data\Sony\ACID Pro\7.0 folder (C:\Users\[user name]\AppData\Local\Sony\ACID Pro\7.0 on Windows Vista). 

Tip: The Application Data folder is not visible unless the Show hidden files and folders radio button is selected on the View tab of the 
Windows Folder Options control panel. 

The next time you start ACID, the new keyboard mapping will be available from the Keyboard mapping drop-down list in the 
Customize Keyboard dialog. 

Resetting the default keyboard mapping


Choose [Default] from the Keyboard mapping drop-down list and click OK to restore the default configuration. 
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Appendix B 
Using Control Surfaces with ACID 

A control surface is a hardware device that uses knobs, faders, and buttons to control user interface elements that are 
normally controlled with a mouse. Using a control surface lends a tactile feel to your editing sessions. 

Unlike keyboard shortcuts—which determine the shortcut's behavior based on the portion of the ACID window that has 
focus—a control surface's mapped functions work no matter what part of the application has focus. 

When your control surface is enabled, an indicator is displayed in the track list and the Mixing Console to indicate which 
channels are under external control. Multiple bars are displayed if a channel is under the control of multiple devices. 

In the track list, vertical 
bars in tracks 1-4 indicate 

that those tracks are 
under external control. 

In the Mixing Console, 
horizontal bars at the top 

of channels 1-4 indicate 
which channels are under 

external control 

Connecting a control surface 

You can use one Mackie® Control Universal with up to four Mackie Control Universal Extenders, one Frontier TranzPort, or 
up to five generic control surfaces with ACID software. Perform the following steps for each device. 

1.	 Connect the MIDI Out port on your MIDI interface to the MIDI In port on your control surface. 

2.	 Connect the MIDI In port on your MIDI interface to the MIDI Out port on your control surface. For more information, 
see Configuring ACID to use your control surface on page 268. 

3.	 Configure ACID software to use your control surface. 

Note: If you’re using a USB interface such as Frontier TranzPort, just plug in the USB cable. For information about your 

specific device, please refer to the manufacturer's documentation.
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Configuring ACID to use your control surface 

Use the MIDI tab in the Preferences dialog to select the device to which your control surface is connected. For more information, see 
Using the MIDI tab on page 260. 

1.	 From the Options menu, choose Preferences to display the Preferences dialog. 

2.	 Enable your MIDI input and output ports: 

a. Select the MIDI tab in the Preferences dialog. 

b.	 In the Make these devices available for MIDI track playback box, select the check box for the MIDI port that is connected to 
your control surface's In port. 

c.	 In the Make these devices available for MIDI input box, select the check box for the MIDI port that is connected to your control 
surface's Out port. 

Note: MIDI ports that are in use by a Mackie Control Universal or Mackie Control Universal Extender display a  icon to 

indicate that they are not available for MIDI track input or playback.


3.	 Choose your control surface: 

a.	 Select the External Control & Automation tab in the Preferences dialog. For more information, see Using the External Control & 
Automation tab on page 265. 

b.	 Choose a device from the Available devices drop-down list and click the Add button. Adding a device loads its default profile. 
If you want to customize the behavior of the control surface, double-click its entry in the Active control devices list. 

4.	 Click OK to apply your changes and close the Preferences dialog. 

5.	 From the Options menu, choose External Control to enable your selected control surfaces. 

Configuring or customizing your control surface 

Use the External Control & Automation tab in the Preferences dialog to select the control surfaces you want to use and adjust their 
configuration. For more information, see Using the External Control & Automation tab on page 265. 

1.	 From the Options menu, choose Preferences to display the Preferences dialog. 

2.	 Select the External Control & Automation tab. 

3.	 Choose a device from the Available devices drop-down list and click the Add button. The device is added to the Active control 
devices list. 

4.	 Double-click the entry in the Active control devices list to display the configuration dialog. 

For information about configuring specific MIDI controllers, see Setting up a Mackie Control Universal on page 269, Using a Frontier 
TranzPort on page 283, Configuring a generic MIDI controller on page 285, or The Behringer BCF2000 control surface on page 288. 

Using your control surface 

This section describes how to use your control surface in general terms.


For information about your specific device, please refer to the manufacturer's documentation.


1.	 From the Options menu, choose External Control to enable your selected control surfaces. 

2.	 If necessary, press the Automation button on your control surface. 

3.	 Click the Automation Settings button  for each track you want to edit with the control surface and choose Automation Write 
(Touch) or Automation Write (Latch) to enable automation recording. For more information, see Automation recording modes on 
page 147. 

To enable automation recording for audio busses and soft synths, use audio bus tracks. 

Use the functions on your control surface to edit your project. 
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Setting up a Mackie Control Universal


The Mackie Control is fully supported by ACID® software and lends a tactile element to your editing sessions. There are many overlays 
available that you can use to label the Mackie Control buttons and controls with their mapped functions in ACID. For more information 
about Mackie Control overlays, please check the Mackie Web site: 
http://www.mackie.com/products/mcu/index.html 

The overlay identifies the default control mapping. You can also customize the buttons and controls on the Mackie control. For more 
information, see Configuring or customizing control mappings on page 271. When you use the default mapping, the Mackie Control is 
divided into several functional areas. All functionality described in this document refers to the default control mapping. 

Connecting the Mackie Control Universal 

You can use one Mackie Control Universal (with up to four Mackie Control Extenders) with ACID. Perform the following steps for each 
device. 

If you’re using Mackie Control Extenders, you’ll need a multiport MIDI interface with MIDI In/Out ports for each device. 

1. Connect the MIDI Out port on your MIDI interface to the MIDI In port on your Mackie Control Universal. 

2. Connect the MIDI In port on your MIDI interface to the MIDI Out port on your Mackie Control Universal. 

3. Repeat Steps 1 and 2 for each Mackie Control Extender. 
APPENDIX B | 269 

http://www.mackie.com/products/mcu/index.html


Configuring the software to use the Mackie Control Universal 

1.	 From the Options menu, choose Preferences to display the Preferences dialog. 

2.	 Enable your MIDI input and output ports: 

a.	 Select the MIDI tab in the Preferences dialog. 

b.	 In the Make these devices available for MIDI track playback box, select the check box for the MIDI port that is connected to 
the Mackie Control Universal’s In port. 

c.	 In the Make these devices available for MIDI input box, select the check box for the MIDI port that is connected to your 
Mackie Control Universal’s Out port. 

d.	 Repeat Steps 2b and 2c for each Mackie Control Extender. 

e.	 Click Apply. 

Note: MIDI ports that are in use by a Mackie Control or Extender display a  icon to indicate that they are not available for MIDI 
track input or playback. 

3.	 Choose your control surface: 

a.	 Select the External Control and Automation tab in the Preferences dialog. 

b.	 From the Available devices drop-down list, choose Mackie Control and click the Add button to load the default profile. 

4.	 Click OK to apply your changes and close the Preferences dialog. 

5.	 From the Options menu, choose External Control to enable the Mackie Control Universal. 

Configuring channel mappings for Mackie Control Extenders 

If you’re using Mackie Control Extenders, you’ll need to set up your channel mapping. Channel mapping tells the software how the 
devices are arranged on your desktop. 

For example, if your Mackie Control Universal is on the left of your Mackie Control Extender, you could configure the Mackie Control to 
adjust channels 1 through 8 and use the Mackie Control Extender to adjust channels 9 through 16. If you have a Mackie Control 
Universal positioned between two Mackie Control Extenders, you could adjust channels 1 through 8 on the left Extender, adjust 
channels 9 through 16 on the Mackie Control Universal, and adjust channels 17 through 24 on the right Extender. 

1.	 From the Options menu, choose Preferences to display the Preferences dialog. 

2.	 Select the External Control & Automation tab. 

3.	 Double-click your Mackie Control in the Active control devices list to display the Configure Mackie Control dialog. 
The current channel mapping is displayed on each device's LCD. 
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4. Choose the channels you want to control with the Mackie Control Universal: 

a. From the Device Type drop-down list, choose Mackie Control. 

b. From the Channel Mapping drop-down list, choose the channels you want to adjust with the Mackie Control Universal. 

5. Choose the channels you want to control with the Mackie Control Extender: 

a. From the Device Type drop-down list, choose Mackie Control Extender. 

b. From the Channel Mapping drop-down list, choose the channels you want to adjust with the Mackie Control Extender. 

6. Repeat Step 5 for each Mackie Control Extender. 

7. Click OK to apply your changes and close the Configure Mackie Control dialog. 

8. Click OK to apply your changes and close the Preferences dialog. 

Configuring or customizing control mappings 

Use the External Control & Automation tab in the Preferences dialog to select the control surfaces you want to use and adjust their 
configuration. 

Reminder: When you customize your control mappings, button functions may not match the labels on the overlay. You can click the 
Default All button in the Configure Mackie Control dialog to restore the default settings. 

1. From the Options menu, choose Preferences to display the Preferences dialog. 

2. Select the External Control & Automation tab. 
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3. Double-click your Mackie Control in the Active control devices list to display the Configure Mackie Control dialog. 

4. To add or change a function do the following: 

a. Select an item in the User defined surface control mappings list. 

b. Select an item in the Available host functions list. 

c. Click the Assign button. 

5. To remove a function, select an item in the User defined surface control mappings list and click the Clear button. 

6. To remove all functions, click the Clear All button. 

7. To replace all custom functions with the default settings, click the Default All button. 

Important: The Mackie Control Universal can control either trim or automation settings. In order to control automation settings, the 

Automation button in the Audio/Video section must be selected, and the track or bus you want to edit must be set to Automation Write 


(Touch) or Automation Write (Latch). Hold the F1 button while turning the V-Pot (or use the Automation Settings button ) to 
change the automation recording mode for each track and bus track. 
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Using the Mackie Control Universal 

The following sections describe the default control mapping for the Mackie Control Universal when used with ACID. 

The Mackie Control Universal can control either trim or automation settings. In order to control automation settings, the Automation 
button in the Audio/Video section must be selected, and the track or bus you want to edit must be set to Automation Write (Touch) or 
Automation Write (Latch). Hold the F1 button while turning the V-Pot (or use the Automation Settings button) to change the 
automation recording mode for each track and bus track. 

Channel section 

The channel section includes V-Pots (knobs), buttons, and faders that you can use to edit your tracks and busses. 

If you’re using Mackie Control Extender units, you can control eight additional channels with each Extender. For more information, see 
Configuring channel mappings for Mackie Control Extenders on page 270. 

1 
2 
3 
4 
5 
6 

7 

Item Description


1 V-Pot Adjusts values for panning, volume (when Flip button is selected), and effect parameter values.


•	 Audio track volume: Adjusts track volume when the Pan or Sends button is selected and the Flip button is 
selected. 

•	 Audio track panning: Adjusts audio track panning when the Pan button is selected. 

•	 Bus send levels: Adjusts bus send levels when the Sends button is selected. 

•	 Effect parameters: Adjusts effect parameters when the Inserts button is selected. 

The V-Pot is velocity sensitive, so rotating quickly changes values quickly, and you can press the button to 

choose a selection.


When the Pan or Sends button is selected, press the V-Pot to edit the track or bus effects chain.


2	 Rec/Ready Arms audio tracks for recording. 
Button 

3 Signal LED Indicates whether an audio track or bus is outputting a signal. 

4 Solo Button Press to solo a track or remove it from the solo group. 

5 Mute Button Press to mute or unmute a track. 

6 Select  Press to select a track. 
Button 
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Item Description 

7 Fader Adjusts the track or bus level (unless the Flip button is selected). 

When the Automation button is selected, the fader adjusts the automation envelope if the track is in 
Automation Write (Touch) or Automation Write (Latch) mode. 

The fader can also adjust settings for the following items when you select other buttons in the Channel section. 

• Audio track panning: Adjusts audio track panning when the Pan and Flip buttons are selected. 

• Bus send levels: Adjusts bus send levels when the Sends and Flip buttons are selected. 

The fader is touch sensitive, so if you're recording automation parameters, recording will begin when you touch 
the fader and stop when you release it. The current setting is displayed in the Mackie Control display. 

Footswitches (not shown) 

The Mackie Control has two switched inputs (labeled User Switch A and User Switch B) that you can use to connect footswitches. 

By default, footswitch A toggles playback, and footswitch B starts and stops recording. 

You can customize the footswitches in the Configure Mackie Control dialog. Double-click Mackie Control in the Active control devices 
list on the External Control & Automation tab of the Preferences dialog to display the Configure Mackie Control dialog. For more 
information, see Configuring or customizing control mappings on page 271. 

Control buttons 

The buttons in the Control section determine the operation of the V-Pots and faders in the channel section of your Mackie Control. In 
every mode, the fader adjusts track volume, and the V-Pot adjusts the selected control mode. You can press the Flip button to reverse 

the V-Pot and fader function. 

1 
2 
3 
4 
5 
6 

Item 

1 Output  

Description 

Press the  Output button to set the output device for each track or bus. Turn the V-Pot in the channel section to 
choose an output device and press the V-Pot to select it. 

2 Input Press to set the recording input device for each track. Turn the V-Pot in the channel section to choose an input 
device and press the V-Pot to select it. 

3 Pan 

4 Sends 

Press to adjust track panning using the V-Pot in the channel section. 

In 5.1 surround projects, pressing the Pan button toggles left-to-right panning, front-to-rear panning, and 
center-channel level adjustment using the V-Pot. 

Press to adjust bus and assignable effects send levels. Press the Sends button to scroll through the available 
busses and assignable effects chains, and then turn the V-Pot to adjust the send level. 
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Item Description 

5 Inserts Press to adjust effects settings. 

Press the button once to display PL in the Mackie Control Assignment display. The Mackie Control LCD displays 
the effects that are assigned to each track or bus. The following example shows a three-track project: 

Turn the V-Pot to scroll through the effects, and press the V-Pot to edit the current effect. In editing mode, PE is 
displayed in the Assignment display. The following example shows the settings for the Noise Gate plug-in on 
track one: 

PE mode uses the following controls: 

•	 V-Pots 1-4: Turn to edit the effect's parameters. For “switch” parameters such as Bypass, press the V-Pot to 
change the setting. 

•	 V-Pot 5: Turn to scroll through an effect's property pages. 

•	 V-Pot 6: Turn to choose from a plug-in's available presets. Press the V-Pot to choose a preset. 

•	 V-Pot 7: Turn to edit the current effect for a different channel. 

•	 V-Pot 8: Turn to choose other effects for the current channel. 

Press the Inserts button again to view effects chains. PS is displayed in the Assignment display. The following 
example shows the effects chain on track one: 

PS mode uses the following controls: 

•	 V-Pots 1, 3, and 5: Turn to choose other effects for the current channel. Press to edit the selected effect and 
enter PE mode. 

•	 V-Pots 2, 4, and 6: After choosing an effect with V-Pot 1, 3, or 5, press V-Pot 2, 4, or 6 to add it to the channel. 

•	 V-Pot 7: If a channel has multiple pages of effects in the chain, turn to display additional effects. In the 
previous example, Aud 1 1/2 means that track one has two pages of effects. 

•	 V-Pot 8: Turn to choose effects chains for other channels. 

When <No Insert> is displayed above a V-Pot, you can turn the V-Pot to view effects that you can add to the 
chain. New effects are displayed with a *. Press the next V-Pot (to the right) to add the effect. 

6	 Settings Press to adjust track or bus settings using the F1 through F6 buttons. 

•	 F1: Hold the button and turn the V-Pot to change the automation recording mode for each track and bus 
track. 

•	 F2: Hold the button and turn the V-Pot to change the current panning mode. 

•	 F3: Hold the button and press the V-Pot to change the track phase. 

•	 F4: Hold the button and turn the V-Pot to change record input monitoring settings when you're using an 
ASIO audio device. 

•	 F5: When the Pan button is selected, press the Settings button and then hold F5 while pressing the V-Pot to 
change the bus or assignable effects output fader to Pre FX or Post FX. 

When the Sends button is selected, press the Settings button and hold F5 while pressing the V-Pot to change 
a track's bus or assignable effects send level to Pre Volume or Post Volume. Press the Sends button to scroll 
through the available bus and effects sends. 

•	 F6: Press the Settings button and hold F6 while pressing the V-Pot on a channel to return the channel's 
settings to the track defaults. 
APPENDIX B | 275 



Fader Banks buttons 

The Fader Banks buttons control the behavior of the channel section controls. 

1 
2 

3 

Item Description 

1 Bank Press the left or right arrow button to scroll the channels 8 units at a time. 

For example, if tracks 1-8 are currently displayed, pressing the right arrow will change to tracks 9-16. 

2 Channel	 Press the left or right arrow button to scroll the channels 1 unit at a time. 

For example, if tracks 1-8 are currently displayed, pressing the right arrow will change to tracks 2-9. 

Hold the Option button while pressing either Channel button to change track order. For example, if track two is 
selected and you press Option+ < Channel, track two becomes track one. Conversely, if track one is selected and 
you press Option + Channel >, track one becomes track two. 

3 Flip Press to exchange the behavior of the fader and V-Pot when allowed. 

Display buttons 

The Display buttons control the behavior of the channel section controls. 

1 
2 

Item Description 

1 Meters/ When you're working with audio tracks or busses, press to display meters or numeric values. Even in Meters 
Values mode, numeric values are displayed when you edit a value. 

Hold the Shift button in the Modifiers section while pressing the Meters/Values button to toggle control of 
tracks, busses, or tracks and busses. 

•	 Press once to show audio and MIDI tracks. 

•	 Press again to show audio tracks. 

•	 Press again to show MIDI tracks. 

•	 Press again to show busses. 

•	 Press again to show all tracks and busses. 

2 Time Fmt 	 Press and hold to display the current time format. Turn V-Pot 8 while holding the button to change the format. 
Zero 
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Markers buttons 

The Markers buttons control additional track and channel settings. 

Item Description 

1 
2 
3 
4 
5 
6 
7 
8 

1 Marker 1/9  Press to place the cursor at marker 1, or hold Shift and press to place the cursor at marker 9. 
Automation 
Mode 

When the Settings button is selected, hold the button and turn the V-Pot to change the automation recording 
mode for each track and bus track. 

2 Marker 2/10 Press to place the cursor at marker 2, or hold Shift and press to place the cursor at marker 10. 
Pan Mode When the Settings button is selected, hold the button and turn the V-Pot to change the current panning mode. 

3 Marker 3 Press to place the cursor at marker 3. 

4 Marker 4  Press to place the cursor at marker 4. 
Input 
Monitor 

When the Settings button is selected, hold the button and turn the V-Pot to change record input monitoring 
settings when you're using an ASIO audio device. 

5 Marker 5  Press to place the cursor at marker 5. 
Pre/Post When the Pan button is selected, press the Settings button and then hold F5 while pressing the V-Pot to change 

the bus or assignable effects output fader to Pre FX or Post FX. 

When the Sends button is selected, press the Settings button and hold F5 while pressing the V-Pot to change a 
track's bus or assignable effects send level to Pre Volume or Post Volume. Press the Sends button to scroll 
through the available bus and effects sends. 

6 Marker 6  Press to place the cursor at marker 6. 
Default Press the Settings button and hold F6 while pressing the V-Pot on a channel to return the channel's settings to 

the track defaults. 

7 Marker 7 Press to place the cursor at marker 7. 

8 Marker 8 Press to place the cursor at marker 8. 

Add New buttons 

The Add New buttons add busses or tracks to your project. 

1 
2 

Item Description 

1 Track Press to add a new audio track. 

2 Bus Press to add an audio bus to your project. 
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Windows buttons 

The Windows buttons control the display of various ACID windows. 

1 
2 
3 

Item Description 

1 Mixer Press to show the Mixing Console window. If the window is not docked, pressing the button shows/hides the 
window. 

2 Video  Press to show the Video Preview window. If the window is not docked, pressing the button shows/hides the 
Preview window. 

3 Plug-Ins Press to show the Plug-In Manager window. If the window is not docked, pressing the button shows/hides the 
window. 

View buttons 

The View buttons control the display of various sections of the ACID window. 

1 
2 
3 

Item Description 

1 Bus Tracks Press to show or hide audio bus tracks in the ACID timeline. 

When the Video button is selected, press to show or hide the video bus track. 

2 Dock Area Press to show or hide the Window Docking Area at the bottom of the ACID window. 

3 Track List Press to show or hide the track list in the timeline. 
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Modifiers buttons 

The Modifiers buttons extend the functionality of other buttons on the Mackie Control. 

1 
2 

3 

4 

Item Description 

1 Shift  Hold the  Shift button while pressing a button labeled with inverse text to perform the shift function. 

For example, hold Shift while pressing the Undo/Redo button to reverse an undo action. 

2 Option/Track  Hold the Option/Track Order button while pressing a button in the Settings, Add New, or Windows group for 
Order	 alternative functions. 

Hold the Option/Track Order button while pressing a the Channel < or Channel > button to change track order. 

Hold the Option/Track Order button while pressing F1 to F16 to perform custom functions you can define. 

For more information, see Configuring or customizing control mappings on page 271. 

3 Ctrl Hold the Ctrl button while using a control for alternative functions.


4 Alt Hold the Alt button while using a control for alternative functions.


Audio/Video buttons 

The Audio/Video buttons control various audio and video settings for your project. 

1 
2 
3 

4 
5 
6 

Item Description 

1 Automation Press to place the controls on the Mackie Control in automation mode. The controls in the channel section of the 
Mackie Control will affect the automation parameters on the track or bus if Automation Write (Touch) or 

Automation Write (Latch) mode is selected.


When the button is not selected, the buttons control trim (static) values.


2 Bypass FX Press to bypass/enable all audio effects. 

3 Metronome Press to turn the metronome on or off. 

Hold Shift and press to toggle metronome countoff. 

4 Surround Press to toggle the project properties between stereo and 5.1 surround mode. 

5 Downmix Press to toggle the state of the Downmix Output button in the Mixing Console window. 

6 Dim Press to toggle the state of the Dim Output button in the Mixing Console window. 
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Project buttons 

The Project buttons perform various project-level commands. 

1 
2 

3 
4 

Item Description 

1 Save Press to save your project. 

2 Undo/Redo Press to reverse edit operations. 

Hold Shift while pressing the button to reverse an undo operation. 

3 OK  Not used.  

4 Cancel  Not used.  

Timeline buttons 

The Timeline buttons perform various commands for the project timeline. 

1 
2 
3 
4 
5 
6 
7 

Item Description 

1 Marker Press to place a marker at the cursor position. 

Hold the Ctrl button while pressing the button to remove a marker. 

2 Region Press to convert the current selection to a region. 

Hold the Ctrl button while pressing the button to remove a region. 

3 Loop/ Press to toggle looped playback mode. 
Select Hold the Shift button while pressing the Loop/Select button to create a time selection from the loop region. 

4 Mark In/  Press to set the beginning of the loop region at the cursor position. 
Go to In Hold the Shift button while pressing the Mark In/Go to In button to move the cursor to the beginning of the 

loop region. 

5 Mark Out/  Press to set the end of the loop region at the cursor position. 
Go to Out Hold the Shift button while pressing the Mark Out/Go to Out button to move the cursor to the end of the loop 

region. 

6 Event Trim/  Hold the Shift button while pressing the Event Trim/Center Cursor button to center the cursor in the timeline 
Center view. 
Cursor 
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Item	 Description 

7 RTZ/  Press to move the cursor to the beginning of the project. 
End Hold the Shift button while pressing the RTZ/End button to move the cursor to the end of the project. 

Transport buttons 

The Transport buttons allow you to navigate the timeline and preview your project. 

1 
2 
3 
4 
5 

Item	 Description 

1 Rewind	 Press and hold to move backward through the timeline at 20x speed. 

2 Fast Forward	 Press and hold to move forward through the timeline at 20x speed. 

3 Stop	 Press to stop playback and return the cursor to its position before playback started. 

4 Play	 Press to start playback. Press again to stop playback and leave the cursor at its current position. 

5 Record	 Press to start recording. Press again to stop recording and leave the cursor at its current position. 

Hold the Shift button while pressing the Record button to render the current selection to a new track. 
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Arrow buttons 

The arrow buttons allow you to navigate the timeline and preview your project. 

1 

2 

Item Description


1 Left/Right  • Press the left or right arrow button to move left or right 1/32 note. 


• Hold Ctrl while pressing the left or right arrow button to go to the beginning or end of the project. 

• Hold Alt while pressing the left or right arrow button to go to the beginning of the next or previous measure. 

2 Up/Down  • Press to zoom in or out. 
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Jog dial 

The jog dial allows you to navigate the timeline and trim events. 

Navigating the timeline


When playback is paused and the Scrub button is not selected, the jog dial performs the following functions:


• Turn the dial clockwise or counterclockwise to navigate the timeline by 1/32 note. 

•  Hold  Alt and turn the dial to go to the beginning of the next or previous measure. 

Scrubbing the timeline 

During playback, turning the jog dial increases or decreases the playback rate.


When playback is paused and the Scrub button is selected, turning the jog dial scrubs the timeline.


Using a Frontier TranzPort 

Using a Frontier TranzPort, you can control ACID wirelessly.


For more information, see Connecting a control surface on page 267.


Viewing the control mappings 

The map for the TranzPort assigns the controls as follows. 

Control Function Shift Function 

Track Focus to previous track or Insert audio track. 
mixer control. 

Track 

Rec 

Mute 

Solo 

Focus to next track or mixer 
control. 

Arm track for record. 

Mute track 

Solo track. 

Insert MIDI track. 

Undo Undo. Redo. 

In Set loop start. 
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Control Function Shift Function 

Out Set loop end. 

Punch Toggle metronome.	 Toggle MIDI merge recording when displaying volume or panning for a MIDI 
track. 

•	 Press Track  or Track to select a MIDI track. 

•	 Press Shift + Loop until volume or panning information is displayed on the 
TranzPort. 

•	 Hold Shift and press Punch. 

For more information, see Using MIDI merge recording on page 192. 

Loop Toggle looped playback. Toggle jog wheel control of volume, panning, input, or output device for tracks 
or mixer controls. 

• Press Track  or Track to select the track you want to adjust. 

• Press Shift + Loop until the item you want to edit is displayed on the 
TranzPort. 

• Hold Shift while rotating the jog wheel to adjust the selected control. 

Shift Toggle alternate functions. 

Markers Move to previous marker. 
Prev 

Markers Insert marker at cursor. 
Add 

Markers Move to next cursor. 
Next 

Jog Wheel Scroll cursor. Adjust volume or pan for current track. 

Rewind. Go to start. 

Fast forward. Go to end. 

Stop playback or recording. 

Play/pause. 

Punch in or start recording. 

Adjusting track or bus volume 

1. Press Track  or Track to select the track or mixer control you want to adjust. 

2. Press Shift+Loop until the TranzPort displays volume. 

3. Hold Shift while rotating the jog wheel to adjust the volume of the selected track or mixer control. 

Adjusting track or bus panning 

1. Press Track or Track to select the track or mixer control you want to adjust. 

2. Press Shift+Loop until the TranzPort displays panning. 

Note: Not all mixer controls allow panning adjustment. 

3. Hold Shift while rotating the jog wheel to adjust panning for the selected track or mixer control. 
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Editing a track's input device 

1.	 Press Track or Track to select the track you want to adjust. 

2.	 Press Shift+Loop until the TranzPort displays the track's input device. 

3.	 Hold Shift while rotating the jog wheel to scroll through the available inputs. When you change the input device, an asterisk is 
displayed before the device name on the TranzPort. 

4.	 Press Shift+Punch to set the input device. 

Editing a track or mixer control’s output device 

1.	 Press Track or Track to select the track or mixer control you want to adjust. 

2.	 Press Shift+Loop until the TranzPort displays the track’s output device. 

3.	 Hold Shift while rotating the jog wheel to scroll through the available output devices. When you change the output device, an 
asterisk is displayed before the device name on the TranzPort. 

4.	 Press Shift+Punch to set the output device. 

Configuring a generic MIDI controller 

You can configure up to five generic MIDI control surfaces to work with the ACID interface. 

For information about your specific device, please refer to the manufacturer's documentation. 

Notes: 

•	 If you have a MIDI controller that includes buttons and knobs or faders, you can use the device as an external control device and as a MIDI 
input device for recording MIDI — for example, you can use the buttons, knobs, and sliders on the device for external control, and still use 
the keyboard, pitch wheel, and modulation wheel for recording MIDI. For more information, see Recording MIDI on page 189. 

MIDI messages that are mapped to external control functions are filtered when you record MIDI. If a note message is assigned to a control 
surface function, both the note-on and note-off messages will be filtered. 

•	 Effects parameters cannot be adjusted with a generic controller. 

Important: A generic control surface can control either trim or automation settings. In order to control automation settings, you 

must assign a button to place the control surface in automation mode, and the Automation Settings button on the track or bus 

you want to edit must be set to Automation Write (Touch) or Automation Write (Latch). 


Customizing your control mappings 

1.	 From the Options menu, choose Preferences to display the Preferences dialog. 

2.	 Select the External Control & Automation tab. 

3.	 Double-click the Generic Control entry in the Active control devices list to display the Configure Generic Control dialog. 

4.	 To add or change a function do the following: 

a. Choose a setting from the View function group drop-down list. 

b. Select the Learn check box. 

c. Select an command in the Host Command list and activate the control on your control surface. 

d. You can click the Edit button to fine-tune the MIDI message settings. 

5.	 Repeat step 4 for each command you want to make available on your control surface. 

6.	 To remove a function, select an item in the Host Command list and click the Reset button. 

7.	 To remove all functions, click the Reset All button. 

8.	 Click the Save As button to save your updated configuration file. 
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Loading a control mapping file 

1.	 From the Options menu, choose Preferences to display the Preferences dialog. 

2.	 Select the External Control & Automation tab in the Preferences dialog. 

3.	 Double-click the Generic Control entry in the Active control devices list to display the Configure Generic Control dialog. 

4.	 Click the Open button and browse to the mapping file you want to use. 

5.	 Click OK to apply your changes and return to the Preferences dialog. 

6.	 Click OK to close the Preferences dialog. 

Example of how you can set up MIDI keyboard as a generic control surface 

If you have a MIDI device that has knobs, faders, and buttons, you can use assign those controls to adjust the tracks in your project. 

For this example, let's set up a MIDI keyboard with 8 knobs to adjust track volume. 

Notes: 

•	 You can use this same process to assign a controller to any configurable parameter. To adjust track volume, we're selecting Channel x 
Fader in the Host Command list in step 10 below. However, if you wanted to adjust panning, you could choose Channel x Pan, or if you 
wanted to adjust the bus send level, you could choose Channel x Send. 

•	 Effect parameters cannot be controlled with a generic controller. 

1.	 From the Options menu, choose Preferences to display the Preferences dialog. 

2.	 Select the MIDI tab, and verify that the port where your controller is connected is selected in the Make these devices available for 
MIDI input list. 

3.	 Select the External Control & Automation tab. 

4.	 From the Available devices drop-down list, choose Generic Control, and then click the Add button. The Generic Control is added 
to the Active control devices list. 

5.	 Double-click the Generic Control entry in the Active control devices list to display the Configure Generic Control dialog. 

6.	 Verify that the port where your controller is connected is selected from the MIDI input drop-down list at the bottom of the dialog. 

7.	 Because the MIDI keyboard in our example has 8 knobs, type 8 in the Number of channels box. 

8.	 Now, let's assign buttons to shift the channel banks up and down so you can control all the tracks in your project. 

For example, when you start using the controller, the knobs will adjust tracks 1-8. When you shift the banks down, you can control 
tracks 9-16, and so on. 

a. From the View function group drop-down list, choose Channels. 

b. Select the Learn check box. 

c. Select Channel Bank Down from the Host Command list. 

d. Press the button or key you want to use to switch to the next group of 8 tracks. 

e. Select Channel Bank Up from the Host Command list. 

f. Press the button or key you want to use to switch to the previous group of 8 tracks. 

9.	 Choose Audio Channels from the View function group drop-down list. 

10. Program each knob: 

a. Verify that the Learn check box is still selected. 

b. Select Channel 1 Fader from the Host Command list. 

c. Turn knob 1 on your MIDI keyboard. You'll notice that the Channel, MIDI Message, and MIDI Data columns are updated. 

d. Repeat steps 10a and 10b to program knobs 2 through 8 on your keyboard. 

11. Now, let's assign a button to toggle the controller in and out of automation mode so we can use the knobs to adjust the track's 
volume (trim) or record volume automation: 

a. From the View function group drop-down list, choose Assign. 
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b. Select Toggle Automation Mode from the Host Command list. 

c.	 Verify that the Learn check box is still selected, and then press the button or key you want to use to switch your control surface 
in and out of automation mode. 

You'll notice that the Channel, MIDI Message, and MIDI Data columns are updated. 

12. Click OK to close the Configure Generic Control dialog, and then click OK to close the Preferences dialog. 

13. From the Options menu, choose External Control to enable your controller. 

You're ready to start using your controller. 

•	 Turn each knob on your controller and notice that turning knob 1 adjusts the volume (trim) of track 1, turning knob 2 adjusts 
the volume of track 2, and so on. 

•	 Press the button that you assigned to scroll the channel bank down in step 8. 

Turn each knob on your controller and notice that turning knob 1 now adjusts the volume (trim) of track 9, turning knob 2 
adjusts the volume of track 10, and so on. 

•	 Press the button that you assigned to scroll the channel bank up in step 8 so you can control tracks 1-8 again. 

•	 Press the button that you assigned to toggle automation mode in step 11. 

Select the Automation Settings button  on each track to enable automation recording. 

Start playback, and turn each knob on your controller, and notice that turning knob 1 records volume automation on track 1, 
turning knob 2 records automation on track 2, and so on. For more information, see Automation recording modes on page 147. 

•	 Press the automation mode toggle button once more, and you can use the knobs to adjust track trim levels again. 
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The Behringer BCF2000 control surface


Knobs 

Push buttons 

Faders 

LCD 
display 

Encoder 
groups 
buttons 

Editing 
buttons 

Preset 
buttons 

Assignable 
buttons 

Note: The following instructions describe using the Behringer BCF2000 only as an emulated Mackie Control 
Universal device. However, it can also be used as a generic controller. To set up the BCF2000 as a generic controller, 
see Configuring a generic MIDI controller on page 285 or the manufacturer’s instructions. 

Overview 

The buttons and knobs on the Behringer BCF2000 perform the following functions: 

•	 Encoder Groups buttons with Editing buttons. These buttons control the save function, metronome, track effects display, sound 
device display, automation mode, downmix output, and bus display. For more information, see Push buttons on page 293. 

•	 Encoder Groups buttons with Push buttons. These buttons control track functions including mute, solo, track selection, 
recording, and adding a track to a project. For more information, see Push buttons on page 293. 

•	 Encoder Groups buttons with Assignable buttons. These buttons control play, pause, rewind, fast forward, record, and home 
functions. You can also add markers and regions to your project. For more information, see Knobs on page 293. 

•	 Encoder Groups buttons with knobs. These control panning, busses, sound devices and track effects. For more information, see 
Knobs on page 293. 

•	 Faders. These control the track volume level and automation envelopes. For more information, see Faders on page 294. 

•	 Preset buttons. These controls allow you to move left or right through the BCFview virtual display. For more information, see 
Preset buttons on page 294. 

Hardware setup 

You can use the Behringer BCF2000 with ACID after you have installed the appropriate USB driver, firmware, firmware update utility, and 
BCFview virtual display from the Behringer Web site at http://www.behringer.com/. 

1.	 First open and run the USB MIDI driver .zip file (v1.1.1.1) for BCF2000. 

Note: After installing the MIDI driver, the B-Control Rotary/Fader 2000 (12/23/2004,1.1.1.1) will be visible under Sound, video and 
game controllers in your system’s Device Manager. 
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2.	 Open and run the BCF2000 Version 1.10 firmware .zip file. 

3.	 Open and run the firmware update utility .zip file. 

4.	 Turn off the Behringer BCF2000 and turn it back on after a few seconds. The LCD display should quickly flash 1.10 to indicate that 
the firmware has successfully installed. Then the LCD display should read P-1. 

If P-1 is not displayed, turn off the Behringer BCF2000. Press and hold the first push button in the top row of buttons (under the first 
knob) and turn the unit back on. The LCD display should now read P-1. 

5.	 Plug the USB cable into the back of the Behringer BCF2000 and into your computer’s USB port. 

Note: In addition to USB mode, you can also use the Behringer BCF2000 in MIDI mode. For more information about MIDI 

connections, refer to the documentation on the Behringer Web site at http://www.behringer.com/.


6.	 Press and hold the Edit button and press the Store button at the same time. The LCD display should read EG (edit global mode). 

7.	 Turn the first rotary encoder (labeled Type on the Behringer unit) clockwise slightly until the LCD displays U-1. U-1 indicates USB 
mode. In the LCD display, U-1 will flash for just a moment and then read EG again. 

8.	 Press the Exit button to exit the edit global (EG) mode. The LCD display should read P-1. 

9.	 Turn off the Behringer BCF2000. 

10. Press and hold the second push button in the top row of buttons (under the channel knobs) and turn the unit back on. The LCD 
should now display NC C (Mackie® Control for Cubase). 

11. Open and run the BCFview virtual display for BCF2000. 

12. Right-click the virtual display and choose BCF2000. 

Configuring ACID to use the Behringer BCF2000 

1.	 Open your ACID project. 

2.	 From the Options menu, choose Preferences to display the Preferences dialog. 

3.	 Enable your MIDI input and output ports: 
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a. Select the MIDI tab in the Preferences dialog. 

b. In the Make these devices available for MIDI track playback box, select the BCF2000 check box. 

c. In the Make these devices available for MIDI input box, select the BCF2000 check box. 

d. Click Apply. 

Note: MIDI ports that are in use by the Behringer BCF2000 display a  icon to indicate that they are not available for MIDI track 
playback or input. 

4. Choose your control surface: 

a. Select the External Control & Automation tab in the Preferences dialog. 

b. From the Available devices drop-down list, choose Mackie Control and click the Add button to load the default profile. 

c. Under Active control devices, double-click Mackie Control to open the Configure Mackie Control dialog. 

Double-click Mackie Control to open 
the Configure Mackie Control dialog. 

d. From the Device type drop-down list, choose Emulated Mackie Control Device. 
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e. From the MIDI input and MIDI output drop-down lists, choose BCF2000. 

BCF2000 should be selected under 
MIDI input and MIDI output. 

5. Click OK in the Configure Mackie Control dialog to close it. 

6. Click OK in the Preferences dialog to apply your changes and close the dialog. 

7. From the Options menu, choose External Control to enable the Behringer BCF2000. 

Note: The faders should automatically move into positions that correspond with your ACID settings. 
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Using the Behringer BCF2000 with ACID 

The following sections describe the default control mapping for the Behringer BCF2000 when used with ACID. 

Encoder Groups buttons 

The Encoder Groups buttons − when used alone or with Editing buttons, Push buttons, Assignable buttons − or knobs, allow you to 
change a variety of settings in your project. 

Encoder Groups buttons 

Upshift 

Input 

Output 

Downshift 

Store 

Learn 

Exit 

Edit 

Editing buttons 

Items Description 

Upshift+Learn Saves your project 

Upshift+Exit Turns the metronome on or off. 

Input Displays the sound device in the BCFview virtual display for each track. In this example, Microsoft Sound 
Mapper (McSnMp) is shown. 

Editing buttons 

Knobs 

Note: Turning the knobs displays other available sound devices for each track. For more information, see 
Knobs on page 293. 

Input+Store Displays the effects for each track. 

Note: Turning the knobs displays what effects are used on each track. For more information, see Knobs on 
page 293. 

Input+Edit Removes the sound device or track information from the virtual track viewer. 

Downshift+Store Bypasses Track FX. 

Track FX off 

Downshift+Edit Turns automation mode on or off.


Downshift+Exit Turns the Downmix Output on or off in the Mixing Console window.


Output Displays the tracks with their associated busses in the BCFview virtual display. In the example below, the 

Master bus is shown. 

Note: Turning the knobs displays all busses in your project. For more information, see Knobs on page 293. 

Output+Store Displays the effects for each track. 

Output+Edit Removes the bus or FX information from the BCFview virtual display. 
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Push buttons 

Items Description 

Push buttons (top row) Turns mute on or off for each track. 

Upshift+push button (top row) Turns the solo on or off for each track. 

Push button (bottom row) Selects the track. 

Upshift+push button (bottom row) Arms the track for recording. 

Downshift+push button (bottom row) Adds an audio track to your project. 

Top row of 
push buttons 

Bottom row of 
push buttons 

Knobs 

Encoder 
Groups 
buttons 

Assignable buttons 

Assignable button 1 

Assignable button 2 

Assignable button 3 

Assignable button 4 

Items Description 

Assignable button 1 Rewind. Press and hold to move backward through the timeline. 

Assignable button 2 Fast forward. Press and hold to move forward through the timeline. 

Assignable button 3 Stop. Press to stop playback and return the cursor to its position before playback 
started. 

Assignable button 4 Play/Pause. Press to start playback. Press again to stop playback and leave the cursor 
at its current position. 

Upshift+assignable button 1 Inserts loop region to the cursor position. 

Upshift+assignable button 2 Home. Moves the cursor to the beginning of your project. 

Upshift+assignable button 4 Record. Adds a track to your project and arms it for recording. 

Downshift+assignable button 1 Inserts a marker to your project. 

Downshift+assignable button 2 Inserts a region marker into your project. 

Downshift+assignable button 3 Turns selected loop region on or off. 

Downshift+assignable button 4 Creates a loop region from the cursor position. 

Knobs 

Items Description 

Rotating knobs Controls panning, busses, sound devices, and track effects for each track. The knobs 
are velocity sensitive, so rotating quickly changes values. 

Pressing knobs Chooses a selection. 
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Faders 

The faders control the following in your project: 

• The track volume level. 

• The automation envelope on the track (when in automation mode). 

Preset buttons 

The Preset buttons allow you to move left or right through the BCFview virtual display to expose all the tracks in your project. The virtual 
channel view will display 8 tracks at one time. 

Left Right 

Tracks 1-8 of your ACID project in the virtual view. 

If you press the right preset button, the next set of tracks in your project 
Preset buttons will be exposed. 

Pressing the left preset will take you back to tracks 1-8. 

In the real world... 

Adding envelopes and automating them 

A couple of common questions when using the Behringer BCF2000 is “How do I add envelopes to an ACID track?” and “How do I set up 
the Behringer to record the envelope’s moves?” The following instructions should guide you through that process. 

1.	 Open an ACID project. 

2.	 On the Behringer unit, turn on the automation mode by pressing Downshift+Edit. 
For more information, see Encoder Groups buttons on page 292. 

Note: You can select multiple tracks at one time by pressing the bottom row of buttons for each track. 

3. In the track header, choose Automation Write (Touch) or Automation Write (Latch) to determine how the automation will be 
written. 

Automation Settings button in the track header 
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4. To add a volume, pan, or mute envelope, do the following: 

a. To add a volume envelope (purple), move the track fader. 

b. To add a pan envelope (red), twist the track knob. 

c. To add a mute envelope (green), press the top row button of the track.. 

Twist the track knob

to add a pan envelope


Mute

Press the top row envelope 
track button to add 

a mute envelope


Pan 
envelope 

Volume 
envelope 

Cursor 
Move the track fader to 
add a volume envelope 

Note: To add envelope points, place your cursor where you want to add the point by twisting the track knob (pan), 
pressing the top row track button (mute), or moving the track fader (volume). 

Volume 
envelope 

Pan 
envelope 

Mute 
envelope 

Envelope points in the timeline 

5. After an envelope is added to a track, you can set-up the Behringer BCF2000 to record the volume, pan, and mute envelope’s 
moves in your ACID project. 

a. On the Behringer unit, turn on the automation mode by selecting Downshift+Edit. 

b. Place the cursor at the beginning of your ACID project. 

c. Use assignable button 4 to play your project. For more information, see Assignable buttons on page 293. 
As the cursor moves past the envelope points, the faders will move automatically (volume), the top row button will light red 
(mute), and the red lights around the track knob will light up (pan). 

Tip: You can add points to the envelope as the project is playing back. For example, by moving a fader, you can add 
points to a volume envelope. 

Note: For more information about envelopes, see the full ACID User Manual (available on the application disc or the 
Sony Creative Software Inc. Web site) or check the online help (from the ACID Help menu, choose Contents and 
Index). 
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Fader automation 

Another question that comes up often is, “Why aren’t the faders following the envelopes?” There are two quick answers to this question. 

1.	 The Behringer BCF2000 is not in automation mode. To enable automation press Downshift+Edit. 
For more information, see Encoder Groups buttons on page 292. 

2.	 On the track header, Automation Off has been selected. To enable automation, choose Automation Read, Automation Write 
(Touch), or Automation Write (Latch). 

Automation disabled on the track header Automation enabled on the track header 
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Appendix C 
ACID Tips and Tricks 

The following sections contain some time-saving tips and creative suggestions for building ACID® projects. 

Adding long media files quickly 

You can paint an entire CD track or MIDI file on an ACID track with a single click. 

1.	 Add a long file such as a CD track or MIDI file to your ACID project. For more information, see Adding media to the 
project on page 31. 

2.	 Click the Paint Tool button ( ). The Paint tool is selected. 

3.	 Press Ctrl and click in the track. The entire file is painted onto the track at the position you clicked. 

Note: In a Beatmapped track, the file is painted starting from the location you identified as the downbeat. If the file

contains pick-up notes, drag the left edge of the event to reveal audio before the downbeat.


Playing with duplicate tracks 

You can duplicate a track in your ACID project and then use the new track to create some interesting effects. 

Detuning paired tracks 

Detuning a paired track is a quick and easy way to thicken an audio track without adding the additional processing of 
effects. This trick works extremely well with synths, pads, strings and ambient sounds, but you can also experiment with it 
to add body to drums, basses, and horns. 

1.	 Right-click a track and choose Duplicate Track from the shortcut menu. A copy of the track is added to the track list. 
The new track is the currently selected track. 

2.	 Use the + (plus) and - (minus) keys on your numeric keypad to change the pitch of the duplicated track. 

Octave intervals (e.g., +12, -12, -24) typically sound best when working with pitched audio; however, experimenting 
with other, less ordinary intervals may produce surprising results. When working with non-pitched audio, intervals 
do not matter, thereby allowing you to freely experiment with radical pitch shifting. 

This technique typically works best when tuning the duplicate track to a lower octave than the original track, but 
you can also experiment with raising the pitch of the duplicate track. 

Panning in conjunction with detuning 

Few things are as uninteresting as a series of tracks panned down the middle of a stereo image. Particularly after 
detuning a paired track, you should experiment with spatially positioning the tracks using the panning control (on the 
multipurpose slider) or a pan envelope. Panning each track to a specific channel produces a nice, wide aural effect. If you 
are looking for something a little more dynamic, position the original track anywhere in the stereo image and use a pan 
envelope to sweep the duplicate track from the left channel to the right channel of the mix. For more information, see 
Using track automation envelopes on page 112. 
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Duplicating with offset 

Another way to add interesting dynamics to a project is to duplicate tracks and add an offset to one of the pair. This trick works well with 
most instrument loops and allows you to create different levels of effect. For example: 

•	 Configuring a slight offset between duplicate tracks creates a natural chorus effect. 

•	 Configuring small offsets creates various reverb effects. 

•	 Configuring larger offsets creates interesting echoes. 

1.	 Right-click a track and choose Duplicate Track from the shortcut menu. A copy of the track is added to the track list. 

2.	 Hold Alt while dragging the waveform of the duplicate track. Notice that the waveform moves within the event, which retains its 
size and position on the timeline. 

3.	 Experiment with different offsets between the duplicate tracks. 

Tip: As with most tricks, this method can be combined with pan and volume envelopes to produce an unlimited range of effects. 

Creating ping-pong pan effects 

You can use a pair of tracks to ping-pong audio from one speaker to another. 

1.	 Right-click a track and choose Duplicate Track from the shortcut menu. A copy of the track is added to the track list. 

2.	 Use the multipurpose slider to pan the original track 100% right and the duplicate track 100% left. 

3.	 Use the Erase tool ( ) to erase every other beat, alternating between the original and duplicate track. 

Tip: You can also use a pan envelope on a single track to create the same effect. For more information, see Volume or pan automation on 
page 138. 

Adding depth with assignable effects 

You can add depth to your mix by panning a dry signal (no effects) to one side and a wet signal (with effects such as chorus or reverb) to 
the other. You can pan the dry and wet signals by adding an assignable effects chain to your project. 

1.	 Add an assignable effects chain containing an effect such as chorus or reverb to your project. For more information, see The Mixing 
Console toolbar on page 151. 

2.	 Press B to view bus tracks. 

3.	 Right-click the bus track for the assignable effect control, choose Insert/Remove Envelope from the shortcut menu, and choose 
Pan from the submenu. A pan envelope appears on the bus track. 

4.	 Drag the envelope down to 100% right. 

5.	 Use the multipurpose slider (on the track to which you want to apply the effect) to make three changes: 

•	 Pan the track 100% left. 

•	 Set the assignable effect send to approximately the same volume as the track. 

• Set the assignable effect send to Pre Volume.


Preview the effect. The dry signal is panned to the left, and the wet signal (with the chorus or reverb effect) is panned to the right.


Pan the track hard left...	 ...match the assignable effect ...and set the assignable effect send to 


send level to the track volume... Pre Volume
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Playing double time/half time 

You can also produce interesting effects by misinforming ACID regarding the number of beats in a file. Configuring a file with half its 
actual number of beats results in double-time playback. This is an easy way to add speed metal drum tracks to your project. This 
technique is also useful for adding a kick drum on every beat to producing a heavy dance foundation. Conversely, configuring a file with 
twice its actual number of beats results in half-time playback. 

1.	 Right-click the desired track in the track list and choose Clip Properties from the shortcut menu. The Clip Properties window 
appears. 

2.	 Click the Stretch tab. 

3.	 Change the value in the Number of beats box. 

Constructing the wall of sound 

As mentioned previously, it is sometimes preferable to color and thicken mixes without resorting to effects and other digital processing. 
Working without the benefit of multitrack recording, music producer Phil Spector colored his songs by having several instruments play 
slightly different parts. For example, he might have an acoustic bass, an electric bass, and a piano play slight variations on the same 
basic riffs. These variations, along with the different timbre of the actual instruments, produced a dense sonic mass that became known 
as The Wall of Sound. 

•	 To add this aural density to your projects, experiment with using two, three, or even four tracks of similar instrumentation. 

•	 Alter the pitch of specific tracks to help them cut through the mix. For more information, see Changing a clip’s key on page 93. 

•	 Further differentiate specific tracks using pan and volume envelopes to color the project and simulate live performance. For 
more information, see Using track automation envelopes on page 112. 

•	 Make the effects even more pronounced by setting a start offset within specific individual events. For more information, see 
Changing event properties on page 64. 

Adding through subtraction 

You can create dynamics by removing sections of events. You can erase sections of events from a project by using the Erase (  ) tool.

To demonstrate using subtractive arranging, add three or four similar drum loops to a project. Use the Erase tool to delete specific 
sections of each event. For example, erase all snares from one track, all basses from another, high hats from the third, and so on. This 
results in a tighter, more realistic drum sound for your project. 

Experiment with taking this technique a step further and randomly remove sections from each track. When doing this, remember to 
keep at least one of the drum tracks playing at all times, unless you want the drums to completely drop out of the mix. Randomly 
removing sections of events adds realism to your projects by approximating how a drummer plays with slight variations throughout a 
song. 

Tweaking dynamics 

You can use several techniques to adjust the dynamics of your mix. 

Fading in and out of mixes 

With bus tracks, you can use a volume envelope to fade in and out of the entire project. 

1.	 Press B to view bus tracks. 

2.	 Select the Master bus track and press Shift+V to add a volume envelope. 

3.	 Add and adjust envelope points to fade into and out of the project. For more information, see Choosing stereo pan types on page 113. 

Adding build ups 

If you are attempting to build projects that escape the perceived limitations of computer-generated loop-based music, you should 
concentrate on reproducing the subtle (and not so subtle) dynamics associated with live instrumentation. 
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One of the simplest, but most effective examples of this is the build up. When musicians play live, there is a tendency to increase 
dynamics as a song enters a chorus or refrain. Think of how a drummer uses accents, drum rolls, and fills that steadily increase in volume 
to enter a song or indicate an approaching change from verse to chorus or chorus to bridge. 

This effect is easily reproduced by adding a volume envelope to the track. Add points at the various drum beats and adjust them so that 
the volume steadily increases. For more information, see Adding volume or pan envelopes on page 138. 

Creating wah-wah effects with automated Track EQ 

You can use the automatable Track EQ effect to create a custom wah-wah effect on a track. The example below provides sample values 
to use in the Track EQ plug-in, but you can adjust the settings to suit your taste. 

1.	 Click the Track FX button ( ) on the track to which you want to add the effect. The Audio Plug-In window appears. 

2.	 Adjust the settings for band 1 as follows: 

•	 Frequency: 20,000 

•	 Gain: -14.9 

• 	Rolloff: 24  

3.	 Adjust the settings for band two as follows: 

• 	Gain: 15  

•	 Bandwidth: 0.9 

4.	 Click the FX Automation button ( ). The FX Automation Chooser dialog appears. 

5.	 Select the Band2 Frequency check box and click OK. An effect automation envelope appears on the track. 

6.	 Add points to the envelope so that the Band2 Frequency parameter oscillates between about 100 Hz and 3000 Hz. For more 
information, see Choosing stereo pan types on page 113. 

Making automated changes more stark 

ACID envelopes allow you to change settings for a variety of features over time. While you may often use envelopes to transition 
smoothly from one setting to another, you can also create interesting effects by making stark changes between settings. 

Abruptly changing volume or pan 

By holding its setting until the next envelope point, the hold fade curve allows you to use volume and pan envelopes to make abrupt 
changes. For more information, see Changing envelope fade curves on page 144. 

1.	 Select a track and press Shift+V (volume) or Shift+P (pan) to add an envelope. 

Tip: You can also use this technique on a bus track. 

2.	 Click the Envelope Tool button ( ) to select the envelope tool. 

3.	 Right-click the first point on the envelope and choose Hold from the shortcut menu. 

4.	 Add several more points by double-clicking the envelope. Note that each new point also has the hold fade curve. 

5.	 Set each point to a different level. For more information, see Adjusting individual envelope points on page 143. 

You can repeat the pattern by copying and pasting the envelope points repeatedly. For more information, see Cutting, copying, and 
pasting envelope points on page 144. 

Turning automated effects on and off 

You can use effect automation envelopes to change effect settings over time, but you can create a simple, dramatic effect by simply 
automating whether the effect is processed (on) or bypassed (off ). 

1.	 Add an automatable effect to a track and adjust the effect’s parameters to your liking. For more information, see Using track effects on 
page 108. 

2.	 In the Audio Plug-In window, click the FX Automation button ( ) to display the FX Automation Chooser. 

3. Click the automatable plug-in at the top of the FX Automation Chooser. A list of the effect's automatable parameters appears. 
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4.	 Select the Bypass check box and click OK. An envelope for the Bypass parameter of the effect appears on the track. 

5.	 Add multiple points to the envelope. For more information, see Adding envelope points on page 142. 

6.	 Adjust the envelope points to alternate between bypassing the effect (Bypass=True) and processing the effect (Bypass=False). For 
more information, see Adjusting individual envelope points on page 143. 

Preview the effect. The track alternates cleanly between processing the effect and bypassing the effect. You can repeat the pattern 
by copying and pasting the envelope points repeatedly. For more information, see Cutting, copying, and pasting envelope points on 
page 144. 

Making automated frequency changes more natural 

When you automate an effect’s frequency parameters, such as the frequency parameters in the track EQ effect, you may notice that the 
frequency changes are more apparent moving through the lower frequencies than the higher frequencies. Without getting too 
technical, frequency scales in track EQ and other plug-ins use a logarithmic scale instead of a linear scale. Since effect automation uses 
linear interpolation, an effect’s automated frequency parameter will sound as if it sweeps through the lower frequencies faster than the 
high frequencies. You can visualize this if you watch the plug-in settings in the Audio Plug-In window during automated effect 
playback. 

To make automated frequency changes sound more natural, use envelope fade curves to change the rate at which interpolation 
happens between two envelope points. For a high-to-low frequency sweep, use a fast fade curve between points, and for a low-to-high 
frequency sweep, use a slow curve. Although the fast and slow curves are not logarithmic curves, they are similar enough to make the 
frequency transitions sound more even. For more information, see Changing envelope fade curves on page 144. 

Overriding compress/expand 

One of the most powerful features of the software is its ability to compress or expand a loop while maintaining the loop’s original pitch. 
However, you can override this feature in order to produce specific effects in your projects. 

1.	 Right-click an event and choose Clip Properties from the shortcut menu. 

2.	 Click the Stretch tab. 

3.	 From the Stretching method drop-down list, choose Pitch shift segments. The clip’s pitch will change in relation to the tempo of 
the project. 

While this may seem like just a way of producing old-school effects, it actually has practical applications as well. For example, specifying 
Pitch shift segments can actually improve the fidelity of drum loops recorded at a tempo near the project tempo. In addition, 
overriding the compress/expand feature allows you to create great bass grooves by slowing drum loops. 
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Slicing and dicing in the Chopper 

You can use the Chopper™ to add creative slice-and-dice effects to your ACID project. 

Chopping new loops for alternate time signatures 

The Chopper makes it easy to clone a new loop from a song or sample. This feature can be particularly handy when you want to create a 
loop for a different time signature. In this example, you’ll create a 3/4 pattern from a 4/4 loop. 

1.	 Set the project time signature to 3/4. For more information, see Changing project time signature on page 91. 

2.	 Place a 4/4 loop file in the Chopper. For more information, see Placing files in the Chopper on page 97. 

3.	 Select a three-beat section of audio to be used for the new loop. Use the Chopper’s transport bar to preview the new loop. 

4.	 Right-click the selection and choose Chop to New Track from the shortcut menu. Alternately, press Ctrl+M. The Chop to New Track 
dialog appears. 

Tip: You can also drag a selection from the Chopper to the track list. 

5.	 Complete the information in the Chop to New Track dialog and click Save. 

The selection is saved and the file is added as a 3/4 loop to a new track in the project. For more information, see Saving Chopper 
selections as new files on page 100. 

Chopping multiple files into a new loop 

Want to combine short segments of several loops into a new loop? You can use the Chopper to chop segments from several files into 
new loops and then combine the new loops into a single loop. 

1.	 Place a file in the Chopper. For more information, see Placing files in the Chopper on page 97. 

2.	 Select audio in the Chopper and press Ctrl+M to chop the audio to a new loop. 

3.	 Repeat steps one and two for as many loop segments as you want. 

4.	 Draw events on the new tracks to create a new melodic or rhythmic pattern. 

5.	 Select the new tracks and from the Tools menu, choose Render to New Track to render the tracks to a single track. The Render to 
New Track dialog appears. 

6.	 Complete the information in the Render to New Track dialog and click Save. For more information, see Mixing multiple tracks to a 
single track on page 129. 

The new composite loop is saved and adds it to your project as a new track. 

Creating drum-roll build ups 

1.	 Place a file in the Chopper. For more information, see Placing files in the Chopper on page 97. 

2.	 Create a one-measure selection. For more information, see Creating selections of a specific musical length on page 97. 

3.	 Click the Insert Selection button ( ) once. The selection is pasted to the track view. 

4.	 Click the Halve Selection button ( ). This decreases the selected portion of the waveform by half. 

5.	 Click Insert Selection button ( 

6.	 Click the Halve Selection button ( 

7.	 Continue to double the number of inserts after each halving of the selection until you achieve the desired drum roll effect. 

) twice. 

). 
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Creating drum fills 

1.	 Place a file in the Chopper. 

2.	 Create an eighth-note (or other length) selection of a drum track in the Chopper. 

3.	 Click the Insert Selection button ( ). 

4.	 Use the Shift Selection Left (  )  and  Shift Selection Right ( ) buttons to move the selection randomly through the drum track, 
clicking the Insert Selection button ( ) to insert drum hits. 

Creating one-track remixes 

1.	 Place a Beatmapped track in the Chopper. For more information, see Using the Beatmapper on page 113. 

2.	 Create a selection in the Chopper. 

3.	 Click the Insert Selection button ( ) twice. 

4.	 Use the Shift Selection Right button ( ) to move through the track, clicking the Insert Selection button ( ) as desired to 
insert events. 

Creating pseudo-granular synthesis 

1.	 Create a sixty-fourth note (or shorter) selection in the Chopper. 

2.	 Click the Insert Selection button ( ). 

3.	 Use the Shift Selection Left (  )  and  Shift Selection Right ( ) buttons to move the selection randomly through the track, 
clicking the Insert Selection button ( ) to insert events. 

Building instrument solos 

The previous section described an extended technique to create challenging rhythmic variations in your projects. You can use a slightly 
different version of the slice-and-dice technique to build instrument solos for your projects. To demonstrate this, let’s start with an 
event containing a simple bass riff. 

1.	 Slice and dice the file in the Chopper to create new riffs and add them to the project. For more information, see Using the Chopper on 
page 95. 

2.	 Use the pitch shifting to transpose some of the new events. For more information, see Changing an event’s key on page 93. 

3.	 Apply volume envelopes to simulate the varying attacks associated with live soloing. For more information, see Adding volume or 
pan envelopes on page 138. 

4.	 Use tempo/key/time signature change markers to create passages with tempos that deviate from the project tempo. For more 
information, see Working with tempo/key/time signature change markers on page 91. 

Building scales 

Though it is well outside the intended scope of the application, you can build unique scales from audio loops. To do this, you must first 
isolate a note and determine what pitch it is. You can easily do this using the Spectrum Analysis tool in Sound Forge®. Once you isolate 
and identify the note, choose Save As from the File menu in Sound Forge to save the note as a new WAV file with a unique name. 
Finally, add the file to the ACID project and use pitch shifting to create all remaining notes in the scale. 
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Appendix D

 Shortcut commands


Keyboard command reference 

The ACID keyboard commands are shortcuts that you can use while working on your project. 

Important: Some keyboard commands listed below are associated with features that are not available in all versions of 
ACID. For information on a specific feature and its availability, please refer to the description of the feature in this manual. 

General commands 

Description Keys 
Display online help F1 
Display context-sensitive help Shift+F1 and click an item 
Refresh screen F5 
Shortcut menu Shift+F10 
Temporarily suspend snapping Shift+drag 

Project file commands 

Description Keys 
Create new project Ctrl+N 
Create new project and bypass the 
Project Properties dialog 

Ctrl+Shift+N 

Open existing project or media file Ctrl+O 

Description 
Save project 
Open project properties 

Close the current project 

Keys 
Ctrl+S 
Alt+Enter 

Ctrl+F4 
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Magnification and view commands 

Description 
Show Explorer window 

Show Chopper window 

Show Mixing Console window 

Show Video/Video Preview Alt+4 
window 
Show Media Manager window Alt+5 

Show Track Properties window 

Show Surround Panner window 

Show Soft Synth Properties 
window 
Show Audio Plug-In window 

Show Plug-In Manager window 

Show Groove Pool window 

Show Clip Properties window 
Shift focus forward through open 
ACID windows 

Shift focus backward through open 
ACID windows 
Shift focus forward (clockwise) 
through track list, timeline, bus 
track timeline, and bus track list 
(when track view or timeline has 
focus) 
Shift focus backward 
(counterclockwise) through track 
list, bus track list, bus track 
timeline, and timeline (when track 
view or timeline has focus) 

Explorer window commands 

Description 
Add all selected files to the track 
list 

Keys 
Alt+1 

Alt+2 

Alt+3 

Alt+6 

Alt+7 

Alt+8 

Alt+9 

Ctrl+Alt+1 

Ctrl+Alt+2 

Ctrl+Alt+3 
F6 

Shift+F6 

Tab 

Shift+Tab 

Keys 
Enter 

Description 
Restore project magnification to 
the default settings 
Restore track height to a level 
where all track list controls are 
displayed 
Reduce timeline magnification so 
the entire length of the project and 
as many tracks as possible are 
displayed 
Zoom time in/out small increments 
(when timeline has focus) 
Zoom time in/out large increments 
(when timeline has focus) 
Zoom in time until each video 
thumbnail represents one frame 
Zoom track height in/out (when 
timeline has focus) 
Change track height for all tracks 

Minimize/restore track height for 
all tracks 
Return all tracks to the default 
height 
Minimize/restore the window 
docking area 
Show/hide Event Information 
Minimize/restore timeline 
vertically and horizontally (window 
docking area and track list will be 
hidden 
Minimize/restore the track list 

Show/Hide bus tracks 

Description 
Add selected file or currently 
playing file to the track list 

Keys 
F9 

Shift+F9 

Ctrl+F9 

Up or Down Arrow 

Ctrl+Up or Down Arrow 

Alt+Up Arrow 

Shift+Up or Down Arrow 

Ctrl+Shift+Up or Down 
Arrow 
‘ 

Ctrl+’ 

F11 or Alt+’ 

Ctrl+Shift+I 
Ctrl+F11 or Ctrl+Alt+’ 

Shift+F11 or Shift+Alt+’ 

B 

Keys 
Ctrl+Enter 
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Cursor placement, loop region and time selection commands 

Description Keys	 Description Keys 
Go to beginning of active loop Home Center in view \

region or viewable area (if no

selection)

Go to end of active loop region or End Move cursor to corresponding Number keys (not 
viewable area (if no selection) marker or select corresponding Keypad) 

region 
Toggle cursor between beginning Numeric keypad 5 Move left/right one pixel Left/Right Arrow 
and end of loop region 
Time select loop region (when Shift+Q Move to marker(s) Ctrl+Left/Right Arrow 
Time Selection tool is selected) 
Toggle previous selection Backspace Move left/right to event edit points Ctrl+Alt+Left/Right Arrow 

including fade edges 
Go to beginning of project W or Ctrl+Home	 Move through a video event one Alt+Left or Right Arrow 

frame at a time 
Go to end of project Ctrl+End	 Create or extend loop region/time Shift+Left or Right Arrow 

selection 
Move left by grid marks Page Up Double loop region/selection ‘ (apostrophe) 

length 
Move right by grid marks Page Down Halve loop region/selection length ; (semicolon) 
Go to 
(using measures, beats, and ticks) 

Ctrl+G Shift loop region/selection left , (comma) 

Go to Shift+G Shift loop region/selection right . (period) 
(using absolute time) 
Set end of time selection Ctrl+Shift+G 
(using measures, beats, and ticks 
when Time Selection tool is 
selected) 
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Event editing commands 

Description Keys	 Description Keys 
Paint the entire media length for all Ctrl+click in timeline	 Join selected events J 
media except video (only when 
Paint tool is selected) 
Cycle event clip forward for all C  Create fades  F  
selected clips 
Cycle event clip backward for all Shift+C Reverse event U 
selected clips 
Select Draw tool Ctrl+D Trim events to selection length. Ctrl+T 

This command has no effect if 
there is no selected data. Trimming 
does not copy data onto the 
clipboard. Available only when the 
Time Selection tool is active 

Select next edit tool in list D	 Slip Trim: moves the media with Alt+drag edge of event 
the edge as it is trimmed 

Select previous edit tool in list Shift+D	 Slip: move media within event Alt+drag inside the event 
without moving the event 

Undo Ctrl+Z	 Slide: move event while leaving the Ctrl+Alt+drag event 
underlying media in place 

Redo Ctrl+Shift+Z Create fades F 
Cut selection Ctrl+X Copy selection Ctrl+C 
Copy event Ctrl+drag Pitch up one semitone	 Numeric keypad +


=

Paste from clipboard Ctrl+V Pitch down 4 semitones	 Shift+Numeric keypad ­


Shift+­

Paste repeat from clipboard Ctrl+B Pitch up 4 semitones	 Shift+Numeric keypad + 

Shift+= 
Paste insert Ctrl+Shift+V	 Pitch down one octave Ctrl+Numeric keypad ­
Insert event at cursor Y	 Pitch up one octave Ctrl+Numeric keypad + 
Paste event at cursor Shift+Y Reset pitch	 Ctrl+Shift+Numeric 

keypad - or + 
Ctrl+Shift+-/= 

Delete selection Delete Change an event’s gain setting Keypad / or *

Move selected event(s) right one Numeric keypad 6 Change an event’s gain setting by Shift+Keypad / or *

pixel 10%

Move selected event(s) left one Numeric keypad 4 Change an event’s gain setting by Ctrl+Keypad / or *

pixel 25%

Temporarily suspend Snap To Shift while dragging an Set an event’s gain to 0.0 dB Shift+Ctrl+Keypad *


event (press Shift after 
you click) 

Erase entire event Ctrl+click event with Set an event’s gain to silence Shift+Ctrl+Keypad / 
Erase tool 

Split event(s) S	 Render to new track Ctrl+M 
Chop to new clip if the Chopper 
window has focus 

Pitch down one semitone	 Numeric keypad ­
-
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Playback commands 

Description 
Start/stop playback 
Stop playback 
Toggle looped playback 
Play from start 

Keys 
Spacebar 
Esc 
Q 
Shift+Spacebar or 
Ctrl+Shift+Spacebar 
when the timeline or track 
view has focus 

Description 
Record 
Go to start of project 
Go to end of project 
Skip backward 

Keys 
Ctrl+R 
Ctrl+Home or W 
Ctrl+End 
Page Up 

Shift+F12 from any 
window 

Play from cursor Ctrl+Spacebar when the 
timeline or track view has 

Skip forward Page Down 

focus 

F12 (from any window) 
Pause/resume playback Enter when the timeline 

or track view has focus 

Ctrl+F12 from any 
window 

Timeline commands 

Description Keys Description Keys 
Record Ctrl+R Insert/remove track volume Shift+V 

envelope 
Go to (using measures.beats.ticks) Ctrl+G Adjust envelope point value in fine Ctrl+drag envelope point 

increments without changing the or segment 
point’s timeline position 

Go to (using current time ruler Shift+G Adjust envelope point value in Ctrl+Alt+drag envelope 
format) normal increments without point or segment 

changing the point’s timeline 
position 

Set end of time selection (using Ctrl+Shift+G Adjust envelope point’s timeline Alt+drag 
measures, beats, and ticks when position without changing its value 
Time Selection tool is selected) 
Toggle snapping F8 Insert region R 
Temporarily suspend snapping Shift+drag Insert marker (standard) M 
Toggle snap to grid Ctrl+F8 Insert time marker H 
Ripple edit mode Ctrl+L Insert disc-at-once CD track marker N 
Draw tool Ctrl+D Change tempo Alt+drag time marker 
Select next edit tool in list D Insert command marker C 
Select previous edit tool in list Shift+D Insert tempo change T 
Mark in point I or [ Insert key change K 
Mark out point for selection O or ] Insert time signature change Shift+K 
Render to new track Ctrl+M Insert tempo and key change Shift+T 
Insert/show/hide track pan P Maximize timeline vertically F11 
envelope (window docking area will be 

hidden) 
Insert/remove track pan envelope Shift+P Maximize timeline vertically and Ctrl+F11 

horizontally (window docking area 
and track list will be hidden) 

Insert/show/hide track volume V Maximize timeline horizontally Shift+F11 
envelope (track list will be hidden) 
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Track list commands 

Description Keys	 Description Keys 
Mute selected tracks Z	 Render to new track Ctrl+M 
Solo selected tracks X	 Show/hide bus tracks B 
Record Ctrl+R	 Insert folder track Ctrl+Alt+F 
Cycle through effect automation E or Shift+E	 Insert audio track Ctrl+Q 
envelopes 
Insert new MIDI track Ctrl+Alt+Q 

Mixing Console commands 

Description Keys	 Description Keys 
Change selection of a mixer control Left/Right Arrow	 Select multiple nonadjacent mixer Ctrl+Left/Right Arrow 

controls 
Move the right channel of the fader Ctrl+Up/Down Arrow	 Delete the selected bus or Delete 
for the selected mixer control	 assignable FX control 
Move the left channel of the fader Shift+Up/Down Arrow Move the fader of the selected Up/Down Arrow 
for the selected mixer control mixer control (for assignable effect 

controls, moves the Out fader) 
Select multiple, adjacent mixer Shift+Left/Right Arrow 
controls 

MIDI commands 

Description Keys Description Keys 
Insert new MIDI track Ctrl+Alt+Q Trigger from MIDI Timecode Ctrl+F7 
Generate MIDI Timecode F7 Reset all MIDI ports Ctrl+Alt+F7 
Generate MIDI Clock Shift+F7 Show velocity information in MIDI F 

events 
Copy to new MIDI clip Ctrl+Shift+C Toggle inline MIDI editing mode G 

Chopper commands 

For more information, see Using Chopper toolbar and keyboard commands on page 96. 

Surround Panner commands 

For more information, see Moving the pan point on page 241. 

Mouse scroll-wheel shortcuts 

Description	 Keys 
Zoom in on timeline Rotate mouse wheel forward or 

back 
Vertical scroll	 Ctrl+wheel 
Horizontal scroll Shift+wheel 
Auto-scrolling	 Press mouse wheel and move 

the mouse in the desired 
direction 

Move the cursor in grid increments Ctrl+Shift+wheel 
Move the cursor in video frames Ctrl+Alt+Shift+wheel 
Adjust slider/fader	 Wheel up or down while 

hovering over slider/fader 
handle 

Adjust slider/fader in fine Ctrl+wheel up or down while 
increments hovering over slider/fader 

handle 
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Appendix E 
Glossary 

The glossary contains terms and their definitions that you may come across in the manual. This glossary not only includes 
terms associated with ACID® software, but also includes relevant industry terms. 

.acd-zip An ACID project file that contains all information regarding the project including track 
layout, envelope settings, and effects parameters. In addition, all audio files used in the 
project are embedded into the project file. 

Activation Code This number is based on the Computer ID number of the computer on which the software 
is installed. Each computer has a unique number, similar to a license plate. When you 
register your copy of the software, Sony generates an activation code for you based on 
the Computer ID number. Once you enter the activation code, the ACID application will 
not time out. Since the activation number is based on the Computer ID, it is important 
that you have the software installed on the computer where you will be using it. 

Adaptive Delta Pulse 
Code Modulation 
(ADPCM) 

A method of compressing audio data. Although the theory for compression using ADPCM 
is standard, there are many different algorithms employed. For example, Microsoft's 
ADPCM algorithm is not compatible with the International Multimedia Association’s (IMA) 
approved ADPCM. 

Advanced Streaming 
Format (ASF) 

See Windows Media® Format. 

Aliasing A type of distortion that occurs when digitally recording high frequencies with a low 
sample rate. For example, in a motion picture, when a car's wheels appear to slowly spin 
backward while the car is quickly moving forward, you are seeing the effects of aliasing. 
Similarly, when you try to record a frequency greater than one half of the sampling rate 
(the Nyquist Frequency), instead of hearing a high pitch, you may hear a low-frequency 
rumble. 

To prevent aliasing, an anti-aliasing filter is used to remove high-frequencies before 
recording. Once the sound has been recorded, aliasing distortion is impossible to remove 
without also removing other frequencies from the sound. This same anti-aliasing filter 
must be applied when resampling to a lower sample rate. 

ASIO ASIO™ (Audio Stream In/Out) is a low-latency driver model developed by Steinberg Media 
Technologies AG. 

ASX File ASF Stream Redirector file. See Redirector File. 

Attack The attack of a sound is the initial portion of the sound. Percussive sounds (drums, piano, 
guitar plucks) are said to have a fast attack. This means that the sound reaches its 
maximum amplitude in a very short time. Sounds that slowly swell up in volume (soft 
strings and wind sounds) are said to have a slow attack. 

Attenuation A decrease in the level of a signal. 

Audio Compression 
Manager (ACM) 

The Audio Compression Manager from Microsoft® is a standard interface for audio 
compression and signal processing for Microsoft Windows. The ACM can be used by 
Windows programs to compress and decompress WAV files. 

Audio Interchange File 
Format (AIFF) 

An audio file format developed by Apple®. 

Audio Proxy File (.sfap0) See Proxy File. 

Bandwidth When discussing audio equalization, each frequency band has a width associated with it 
that determines the range of frequencies that are affected by the EQ. An EQ band with a 
wide bandwidth affects a wider range of frequencies than one with a narrow bandwidth. 

When discussing network connections, refers to the rate of signals transmitted; the 
amount of data that can be transmitted in a fixed amount of time (stated in bits/second): 
a 56 Kbps network connection is capable of receiving 56,000 bits of data per second. 

Beatmapped track A file that has tempo information added to it as a result of going through the 
Beatmapper® Wizard. 
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Beats Per Minute (BPM) 

Bit 

Bit Depth 

Buffer 

Bus 

Byte 

Clipboard 

Clipping 

Codec 

Compression Ratio 
(audio) 

Compression Ratio 
(file size) 

Computer ID 

Crossfade 

DC Offset 

The tempo of a piece of music can be written as a number of beats in one minute. If the 
tempo is 60 BPM, a single beat occurs once every second. 

The most elementary unit in digital systems. Its value can only be 1 or 0, corresponding to 
a voltage in an electronic circuit. Bits are used to represent values in the binary 
numbering system. As an example, the 8-bit binary number 10011010 represents the 
unsigned value of 154 in the decimal system. In digital sampling, a binary number is used 
to store individual sound levels, called samples. 

The number of bits used to represent a single sample. For example, 8- or 16-bit are 
common sample sizes. While 8-bit samples take up less memory (and hard disk space), 
they are inherently noisier than 16-bit samples. 

Memory used as an intermediate repository in which data is temporarily held while 
waiting to be transferred between two locations. A buffer ensures an uninterrupted flow 
of data between computers. Media players may need to rebuffer when there is network 
congestion. 

A virtual pathway where signals from tracks and effects are mixed. A bus's output can be a 
physical audio device in the computer from which the signal is heard. 

Refers to a set of 8 bits. An 8-bit sample requires one byte of memory to store, while a 16­
bit sample takes two bytes of memory to store. 

The clipboard is the location where data cut or copied from ACID is stored. You can then 
paste the data back into the software at a different location. 

Occurs when the amplitude of a sound is above the maximum allowed recording level. In 
digital systems, clipping is seen as a clamping of the data to a maximum value, such as 
32,767 in 16-bit data. Clipping causes sound to distort. 

Coder/decoder: refers to any technology for compressing and decompressing data. The 
term codec can refer to software, hardware, or a combination of both technologies. 

A compression ratio controls the ratio of input to output levels above a specific threshold. 
This ratio determines how much a signal has to rise above the threshold for every 1 dB of 
increase in the output. For example, with a ratio of 3:1, the input level must increase by 
three decibels to produce a one-decibel output-level increase: 

Threshold = -10 dB 

Compression Ratio = 3:1 

Input = -7 dB 

Output = -9 dB 

Because the input is 3 dB louder than the threshold and the compression ratio is 3:1, the 
resulting signal is 1 dB louder than the threshold. 

The ratio of the size of the original noncompressed file to the compressed contents. For 
example, a 3:1 compression ratio means that the compressed file is one-third the size of 
the original. 

Each computer has a unique number, similar to a license plate. Sony creates an activation 
number based on that number. Since the activation number is based on the Computer ID, 
it is important that you have the ACID application installed on the computer where you 
will be using it. The Computer ID is automatically detected and provided to you when you 
complete the installation process. 

The Computer ID is used for registration purposes only. It doesn't give Sony access to any 
personal information and can't be used for any purpose other than for generating a 
unique activation number for you to use the software. 

Mixing two pieces of audio by fading one out as the other fades in. 

DC offset occurs when hardware, such as a sound card, adds DC current to a recorded 
audio signal. This current results in a recorded wave that is not centered around the zero 
baseline. Glitches and other unexpected results can occur when sound effects are applied 
to files that contain DC offsets. 
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Decibel (dB) A unit used to represent a ratio between two numbers using a logarithmic scale. For 
example, when comparing the numbers 14 and 7, you could say 14 is two times greater 
than the number 7; or you could say 14 is 6 dB greater than the number 7. Where did we 
pull that 6 dB from? Engineers use the equation dB = 20 x log (V1/V2) when comparing 
two instantaneous values. Decibels are commonly used when dealing with sound 
because the ear perceives loudness in a logarithmic scale. 

In ACID, most measurements are given in decibels. For example, if you want to double the 
amplitude of a sound, you apply a 6 dB gain. A sample value of 32,767 (maximum positive 
sample value for 16-bit sound) can be referred to as having a value of 0 dB. Likewise, a 
sample value of 16,384 can be referred to having a value of -6 dB. 

Device Driver A program that enables Windows to connect different hardware and software. For 
example, a sound card device driver is used by Windows software to control sound card 
recording and playback. 

Digital Rights 
Management (DRM) 

A system for delivering songs, videos, and other media over the Internet in a file format 
that protects copyrighted material. Current proposals include some form of certificates 
that validate copyright ownership and restrict unauthorized redistribution. 

Digital Signal Processing 
(DSP) 

A general term describing anything that alters digital data. Signal processors have existed 
for a very long time (tone controls, distortion boxes, wah-wah pedals) in the analog 
(electrical) domain. Digital Signal Processors alter the data after it has been digitized by 
using a combination of programming and mathematical techniques. DSP techniques are 
used to perform many effects such as equalization and reverb simulation. 

Since most DSP is performed with simple arithmetic operations (additions and 
multiplications), both your computer's processor and specialized DSP chips can be used 
to perform any DSP operation. The difference is that DSP chips are optimized specifically 
for mathematical functions while your computer's microprocessor is not. This results in a 
difference in processing speed. 

DirectX A set of Application Program Interfaces designed by Microsoft for multimedia 
development. A DirectX® plug-in, such as the Sony Noise Reduction™ DirectX Plug-In, 
uses the DirectX Media Streaming Services (DMSS) API. Because DMSS is a standard API, a 
DirectX plug-in can be used in any application that supports DMSS. 

Downbeat This term is used in the Beatmapper to refer to the first beat of the first measure. 

Downloadable Sound 
(DLS) 

A DLS file stores a custom sound set that you can load into your soft synth, giving you 
another set of voices for MIDI playback. 

Drag and Drop A quick way to perform certain operations using the mouse. To drag and drop, you click 
and hold an item, drag it (hold the left mouse button down and move the mouse) and 
drop it (let go of the mouse button) at another position on the screen. 

Dynamic Range The difference between the maximum and minimum signal levels. It can refer to a musical 
performance (high-volume vs. low-volume signals) or to electrical equipment (peak level 
before distortion vs. noise floor). For example, orchestral music has a wide dynamic range, 
while thrash metal has a very small (always loud) range. 

Envelopes Envelopes allow you to automate the change of a certain parameter over time. In the case 
of volume, you can create a fade out (which requires a change over time) by adding an 
envelope and creating a point in the line to indicate where the fade starts. Then you pull 
the end point of the envelope down to -inf. 

Equalization (EQ) Equalizing a sound file is a process by which certain frequency bands are raised or 
lowered in level. EQ has various uses. The most common use for ACID users is to simply 
adjust the subjective timbral qualities of a sound. 

Event An instance of a media file on a track. An event may play an entire media file or a portion 
of the file. 

File Format A file format specifies the way in which data is stored. In Windows, the most common 
audio file format is the Microsoft WAV format. 

Frame Rate Audio uses frame rates only for the purposes of synching to video or other audio. To 
synchronize with audio, a rate of 30 fps (frames per second) is typically used. To 
synchronize with video, 29.97 fps drop is usually used. 
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Frequency Spectrum 

Groove 

Hertz (Hz) 

In-place plug-in 

Insert Increment 

Insertion Point 

Loop 

Marker 

MIDI Channel 

Media Control Interface 
(MCI) 

Media File 

MIDI Clock 

MIDI Port 

MIDI Timecode (MTC) 

Multiple-Bit-Rate 
Encoding 

The frequency spectrum of a signal refers to its range of frequencies. In audio, the 
frequency range is basically 20 Hz to 20,000 Hz. The frequency spectrum sometimes refers 
to the distribution of these frequencies. For example, bass-heavy sounds have a large 
frequency content in the low end (20 Hz-200 Hz) of the spectrum. 

A groove refers to the rhythmic pattern of a piece of music. By deviating from a machine-
quantized beat, individual beats may be played early or late to change the feel of the 
music. Applying a groove can simulate the timing patterns of human musicians, lending a 
human feel to MIDI-generated music or quantizing several distinct pieces of music to a 
common timing. 

The unit of measurement for frequency or cycles per second (CPS). 

An in-place plug-in processes audio data so that the output length always matches the 
input length. A non-in-place plug-in's output length need not match a given input length 
at any time: for example, Time Stretch, Gapper/Snipper, Pitch-Shift (without preserving 
duration), and some Vibrato settings can create an output that is longer or shorter than 
the input. 

Plug-ins that generate tails when there is no more input but otherwise operate in-place 
(such as reverb and delay) are considered in-place plug-ins. 

Sections of silence between selections that you can create using the Chopper and insert 
into the track view. 

The insertion point (also referred to as the cursor position) is analogous to the cursor in a 
word processor. It is where markers or commands may be inserted depending on the 
operation. The insertion point appears as a vertical flashing black line and can be moved 
by clicking the left mouse button anywhere in the track view. 

Loops are small audio clips that are designed to create a repeating beat or pattern. Loops 
are usually one to four measures long and are stored completely in RAM for playback. 

A marker is an anchored, accessible reference point in a file. 

An informational pathway over which MIDI data can travel. 

A standard way for Windows programs to communicate with multimedia devices such as 
sound cards and CD players. If a device has an MCI device driver, it can easily be 
controlled by most multimedia Windows software. 

Files that may be placed within the ACID project. After a media file is placed into the 
project, it is referred to as an event. 

A MIDI device-specific timing reference. MIDI Clock is not absolute time like MIDI 
timecode (MTC); instead it is a tempo-dependent number of ticks per quarter note. MIDI 
clock is convenient for synchronizing devices that need to perform tempo changes mid-
song. MIDI clock out is supported, but MIDI clock in is not. 

A MIDI port is the physical MIDI connection on a piece of MIDI hardware. This port can be 
a MIDI in, out or through. Your computer must have a MIDI-capable card to output MIDI 
timecode to an external device or to receive MIDI timecode from an external device. 

MTC is an addendum to the MIDI 1.0 specification and provides a way to specify absolute 
time for synchronizing MIDI-capable applications. MTC is essentially a MIDI 
representation of SMPTE timecode. 

Multiple-bit-rate encoding (also known as Intelligent Streaming for the Windows Media 
platform and SureStream™ for the RealMedia™ G2 platform) allows you to create a single 
file that contains streams for several bit rates. A multiple-bit-rate file can accommodate 
users with different Internet connection speeds, or these files can automatically change 
to a different bit rate to compensate for network congestion without interrupting 
playback. 

To take advantage of multiple-bit-rate encoding, you must publish your media files to a 
Windows Media server or a RealServerG2. 
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Musical Instrument 
Device Interface (MIDI) 

A standard language of control messages that provides for communication between any 
MIDI-compliant devices. Anything from synthesizers to lights to factory equipment can 
be controlled via MIDI. 

Normalize Refers to raising the volume so that the highest level sample in the file reaches a user 
defined level. Use normalization to make sure you are using all of the dynamic range 
available to you. 

Nyquist Frequency The Nyquist Frequency (or Nyquist Rate) is one half of the sample rate and represents the 
highest frequency that can be recorded using the sample rate without aliasing. For 
example, the Nyquist Frequency of 44,100 Hz is 22,050 Hz. Any frequencies higher than 
22,050 Hz produce aliasing distortion in the sample if no anti-aliasing filter is used while 
recording. 

Offline Media A media file that cannot be located on the computer. If you choose to leave the media 
offline, you can continue to edit events on the track; the events point to the original 
location of the source media file. 

One-Shot One-shots are chunks of audio that are not designed to loop, and they are streamed from 
the hard disk rather than stored in RAM if they are longer than three seconds. Things such 
as cymbal crashes and sound bites could be considered one-shots. 

Unlike loops, one-shots do not change pitch or tempo with the rest of a project. 

OPT Plug-In A plug-in that uses the Open Plug-in Technology (OPT) standard from Yamaha. OPT plug-
ins provide tools for working with MIDI such as edit views, effect processors and filters, 
arpeggiators, and real-time panel automation. 

Pan To place a mono or stereo sound source perceptually between two or more speakers. 

Peak Data File The file created when a media file is opened for the first time. This file stores the 
information regarding the graphic display of the waveform so that opening a file is almost 
instantaneous. This file is stored in the directory where the audio file resides and has a .sfk 
extension. If this file is not in the same directory as the audio file or is deleted, it is 
recalculated the next time you open the file. 

Proxy File Working with certain types of media files with particular audio compression schemes can 
be inefficient and slow. To compensate for this, audio proxy files are created for these 
formats to dramatically increase speed and performance. 

The file is saved as a proprietary .sfap0 file, with the same name as the original media file 
and the same characteristics as the original audio stream. The conversion happens 
automatically and does not result in a loss of quality or synchronization. You can safely 
delete audio proxy files at any time since these files are recreated as needed. 

Pulse Code Modulation 
(PCM) 

PCM is the most common representation of uncompressed audio signals. This method of 
coding yields the highest fidelity possible when using digital storage. PCM is the standard 
format for WAV and AIFF files. 

Quantization The correction of rhythms to align with selected note lengths or beats in a MIDI sequence. 

Real-Time Streaming 
Protocol (RTSP) 

A proposed standard for controlling broadcast of streaming media. RTSP was submitted 
by a body of companies including RealNetworks and Netscape®. 

Redirector File A metafile that provides information to a media player about streaming media files. To 
start a streaming media presentation, a Web page includes a link to a redirector file. 
Linking to a redirector file allows a file to stream; if you link to the media file, it downloads 
before playback. 

Windows Media redirector files use the .asx or .wax extension; RealMedia redirector files 
use the .ram, .rpm, or .smi extension. 

Region A region is a section of time used to subdivide your project into segments. 

Rendering The process in which the project is saved to a specific file format like WMA or MP3. 
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Resample 

Sample 

Sample Rate 

Sample Size 

Sample Value 

Secure Digital Music 
Initiative (SDMI) 

Shortcut Menu 

Signal-to-Noise Ratio 

Society of Motion 
Picture and Television 
Engineers (SMPTE) 

Soft Synth 

Streaming 

The act of recalculating samples in a sound file at a different rate than the file was 

originally recorded. If a sample is resampled at a lower rate, sample points are removed

from the sound file, decreasing its size, but also decreasing its available frequency range.

Resampling to a higher sample rate, extra sample points are interpolated in the sound file. 

This increases the size of the sound file, but does not increase the quality. When down-

sampling, one must be aware of aliasing.


The word sample is used in many different (and often confusing) ways when talking 

about digital sound. Here are some of the different meanings:


A discrete point in time which a sound signal is divided into when digitizing. For example,

an audio CD-ROM contains 44,100 samples per second. Each sample is really only a 

number that contains the amplitude value of a waveform measured over time.


A sound that has been recorded in a digital format; used by musicians who make short 

recordings of musical instruments to be used for composition and performance of music 

or sound effects. These recordings are called samples. In this manual, we try to use sound 

file instead of sample whenever referring to a digital recording.


The act of recording sound digitally, i.e., to sample an instrument means to digitize and 

store it. 


The sample rate (also referred to as the sampling rate or sampling frequency) is the 

number of samples per second used to store a sound. High sample rates, such as

44,100 Hz provide higher fidelity than lower sample rates, such as 11,025 Hz. However,

more storage space is required when using higher sample rates.


See Bit Depth. 

The sample value (also referred to as sample amplitude) is the number stored by a single

sample. In 16-bit audio, these values range from -32768 to 32767. In 8-bit audio, they 

range from -128 to 127. The maximum allowed sample value is often referred to as 100%

or 0 dB.


The Secure Digital Music Initiative (SDMI) is a consortium of recording industry and

technology companies organized to develop standards for the secure distribution of

digital music. The SDMI specification was created to answer consumer demand for 

convenient accessibility to quality digital music, enable copyright protection for artists'

work, and enable technology and music companies to build successful businesses.


A context-sensitive menu that appears when you right-click certain areas of the screen.

The functions available in the shortcut menu depend on the object being right-clicked as

well as the state of the program. As with any menu, you can choose an item from the 

shortcut menu to perform an operation. Shortcut menus are used frequently for quick 

access to many commands.


The signal-to-noise ratio (SNR) is a measurement of the difference between a recorded 

signal and noise levels. A high SNR is always the goal.


The maximum signal-to-noise ratio of digital audio is determined by the number of bits 

per sample. In 16-bit audio, the signal to noise ratio is 96 dB, while in 8-bit audio the ratio 

is 48 dB. However, in practice this SNR is never achieved, especially when using low-end 

electronics.


SMPTE timecode is used to synchronize time between devices. The timecode is formatted 

as hours:minutes:second:frames, where frames are fractions of a second based on the 

frame rate. Frame rates for SMPTE timecode are 24, 25, 29.97 and 30 frames per second.


A soft synth is a software-based synthesizer. Downloadable Sounds (DLS) and Virtual 

Studio Technology Instruments (VSTi) are two types of soft synths.


You add a soft synth control in the Mixing Console window for each software synthesizer 

you want to use in a project.


A method of data transfer in which a file is played while it is downloading. Streaming 

technologies allow Internet users to receive data as a steady, continuous stream after a 

brief buffering period. Without streaming, users must download files completely before

playback.
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Tempo Tempo is the rhythmic rate of a musical composition, usually specified in beats per 
minute (BPM). 

Threshold A threshold determines the level at which the signal processor begins acting on the 
signal. During normalization, levels above this threshold are attenuated (cut). 

Time Format The format by which the time ruler and selection times are displayed. These can include: 
time, seconds, frames, and all standard SMPTE frame rates. 

Track A discrete timeline for audio data. Audio events sit on tracks and determine when a sound 
starts and stops. Multiple audio tracks are played together to give you a composite sound 
that you hear through your speakers. 

Track List The track list contains the master controls for each track. From here you can adjust the 
mix, select playback devices, and reorder tracks. 

Track View The majority of the track view is made up of the space where you draw events on each 
track. 

μ-Law μ-Law (mu-Law) is a companded compression algorithm for voice signals defined by the 
Geneva Recommendations (G.711). The G.711 recommendation defines μ-Law as a 
method of encoding 16-bit PCM signals into a non-linear 8-bit format. The algorithm is 
commonly used in European and Asian telecommunications. μ-Law is very similar to A-
Law, however, each uses a slightly different coder and decoder. 

Undo/Redo These commands allow you to change a project back to a previous state or reapply 
changes after you have undone them. 

Virtual MIDI Router 
(VMR) 

A software-only router for MIDI data between programs. The VMR is used to receive MIDI 
timecode and send MIDI clock. No MIDI hardware or cables are required for a VMR, so 
routing can only be performed between programs running on the same PC. 

VST Instrument (VSTi) A Virtual Studio Technology instrument (VSTi®) is software synthesizer plug-in technology 
for outputting MIDI developed by Steinberg Media Technologies AG. 

WAV A digital audio file format developed by Microsoft and IBM®. One minute of 
uncompressed audio requires 10 MB of storage. 

Waveform A waveform is the visual representation of wave-like phenomena, such as sound or light. 
For example, when the amplitude of sound pressure is graphed over time, pressure 
variations usually form a smooth waveform. 

Waveform Display Each event shows a graph of the sound data waveform. The vertical axis corresponds to 
the amplitude of the wave. For 16-bit sounds, the amplitude range is -32,768 to +32,767. 
For 8-bit sounds, the range is -128 to +127. The horizontal axis corresponds to time, with 
the leftmost point being the start of the waveform. In memory, the horizontal axis 
corresponds to the number of samples from the start of the sound file. 

Windows Media® Format A Microsoft® file format that can handle audio and video presentations and other data 
such as scripts, URL flips, images and HTML tags. Advanced Streaming Format files can be 
saved with .asf, .wma, or .wmv extensions. 
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Index 
Numerics 

5.1 Surround Plug-In Pack, 235, 245, 246

5.1 Surround, See Surround 

A 

AC-3 Encoder, 235, 245, 246

Add channels panning model, 113, 241

Adding


Events, 35

Media to projects, 31

MIDI tracks, 187

Video, 231


Adding notes, 196

Adjusting bus send level, 112

Adjusting section length, 67

Adjusting the mix, 41

Anchors


Adding, 121

Deleting, 121

Moving, 121

Reset beat anchors, 121


Arming tracks to record, 180

ASIO port naming, 259

Assignable effects


Adjusting levels sent from tracks, 112–146

Automation, 139

Volume envelope, 142


Assigning patchmaps, 225

Assigning tracks to busses, 111

Audio Clip Properties window, 115

Audio device preferences tab, 257

Audio effects


Automation, 140

Audio Plug-In window, 23, 108–110

Audio preferences tab, 255

Audio properties tab, 29

Audio signal flow, 25–26

Automatic crossfades, 60


Changing fade types, 61

Creating, 60


Automating

Effects, 112–146

Surround panning, 242–245


Automating VSTi parameters, 107, 211

Automation


Adding envelope points, 142

Adding volume or pan envelopes, 138

Adjusting volume or pan settings, 138

Assignable effects automation, 139

Bus automation, 139

Drawing envelope points, 143

Editing envelopes, 142

Generic control surfaces, 286


Latch mode, 147

MIDI controller, 141

MIDI program change, 142

Modes, 147

Mute automation, 137

Recording, 147

Showing or hiding controls, 137

Thinning envelope points, 143

Touch mode, 147

Track automation, 137

Track effect automation, 140

Volume or pan, 138


B 

Balance panning model, 113, 241

Beat ruler, 21

Beatmapped clips


Stretching properties, 121

Beatmapped tracks, 34


Stretching properties, 117

Beatmapper wizard, 113

Behringer BCF2000 control surface, 288


Configuring ACID, 289

Overview, 288

Setting up hardware, 288


Bit depth, 29

Burning CDs, 51

Bus


Assigning to a track, 111

Bus automation, 139


Adding bus envelopes, 139

Adjusting bus automation levels, 139


Bus tracks, 106

Adding effects, 106

Adding envelopes, 106

Automating VSTi parameters, 107

Monitoring output levels, 107

Muting, 106

Soloing, 106


Busses

Adding or deleting, 162

Adjusting levels sent from tracks, 112–146

Assigning tracks to, 19, 111

Automating parameters, 139

Automation, 139

Bus send volume envelopes, 142

Input, 168

Output, 162

Panning, 239


C 

CD

Extracting media, 32
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Writing media, 51

Changing, 158

Changing a section’s color, 67

Changing an event’s clip, 103

Changing the track color, 40

Channel strip


adding/editing track effects, 156

adjusting bus/assignable effects send levels, 157


Channel strips

changing a track’s name, 156

FX Send (Assignable Effects), 175


Choosing a drum map for a track, 226

Chopper, 23, 95–100


Grid, 95

Inserting increments, 98

Inserting selections from, 99

Keyboard shortcuts, 96

Markers and regions, 96

Saving selections as new files, 100

Selecting audio, 96

Snapping options, 95

Tips and tricks, 302

Using with one-shots, 100

Window, 95


Clearing all events from a section, 68

Clip properties


Adjusting for MIDI tracks, 123

Changing clip types, 117


Clip Properties window, 115, 212

Clips


Adding to tracks, 101

Changing pitch, 93

changing settings, 104

Clip Pool, 104

Copying across tracks, 102

Copying across tracks without copying events, 103

Loops, 34

One-shots, 34

Previewing, 103

Setting the active clip and creating events, 102

Stretching properties, 121

Types, 34


Cloning loops, 100, 302

Command markers, 85

Configuring input filters, 205

Connecting a control surface, 267

Connecting a Mackie Control Universal, 269

Constant power panning model, 113, 241

Context-sensitive help, 16

Control surface knobs, 293

Control surface setup, 265

Control surfaces, 267


Behringer BCF2000, 288, 292

Frontier TranzPort, 283

Generic MIDI controller, 285


Mackie Control Universal, 269

Controller envelopes, 208

Copying


Events, 55

Tracks, 41


Copying rendering templates, 49

Copying sections, 68

Creating drum maps, 225

Creating patch maps, 224

Cursor, 37–40, 252

Customizing names for ASIO ports, 259

Cutting


Events, 57

In ripple mode, 61

Tracks, 41


D 

Deleting

Audio from a video, 231

Envelope points, 143

Events, 37, 57

In ripple mode, 62

Tracks, 41

Video, 231


Deleting notes, 196

Deleting sections, 68

Detuning tracks, 297

Digital multitrack setup, 180

Display preferences, 263

DLS sets


Routing tracks to, 222

Docking windows, 248

Drawing events, 35

Drum grid, 194

Drum map, 194

Drum maps, 225

Duplicating tracks, 41

DVD burning, 246


E 

Editing clip properties, 115

Editing drum maps, 225

Editing frozen MIDI tracks, 189

Editing MIDI, 193

Editing MIDI events, 37

Editing patch maps, 224

Editing preferences tab, 261

Effects


Automating, 112–146

Saving presets, 109

Track, 108–110


Envelopes, 142–145

Adding points, 142

Adjusting, 142

Changing fade curves, 144

Color preferences, 263
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Deleting points, 143

Drawing points, 143

Envelope tool, 144

Event, 65

Flipping, 144

Thinning points, 143

Track, 112–146

Track envelopes, 142–145

Volume (track), 142


Equipment setup for recording, 179–180

Basic, 179

Mixer, 179

With digital multitrack, 180

With MIDI option, 180


Erasing events, 37, 299

Event takes


Recording audio as new, 182

Events


Automatic crossfades, 60

Changing a clip, 103

Changing length, 36

Changing pitch, 93

Copying, 55

Copying across tracks, 102

Cutting, 57, 61

Deleting, 57, 62

Editing in ripple mode, 61

Envelopes, 65

Erasing, 37

Fading edges for offsets, 65

Fading in and out, 66

Inserting at the play cursor, 36

Joining, 60

Locking, 65

MIDI editing, 37

Moving, 37

Muting, 65

Painting, 35

Pasting, 55, 63

Pitch shifting, 64

Properties, 64

Recording into, 183

Reversing, 57

Sections, 66

Selecting, 38–40

Shifting the contents of, 64

Sliding, 64

Slipping, 64

Slip-trimming, 64

Snapping, 89

Splitting, 58

Start offset, 64

Trimming, 57

Volume, 66


Explorer window, 30–32 

Exporting loops, 130

Exporting MIDI, 228

External Control & Automation Preferences, 265

External devices


Playing MIDI from, 222

Routing MIDI tracks to, 222

Routing video to, 234


External monitor, 234

Extracting media from CD, 32


F 

Fading edges of events, 65

Fading in/out


Events, 66

Tracks, 112–146


Film panning model, 242

Filtering MIDI, 198

Filtering MIDI events


In the list editor, 218

Fitting to time, 94

Flipping envelopes, 144

Floating windows, 248

Folder tracks, 35, 128


Adding tracks, 128

Creating, 128

Editing events, 129

Muting, 129

Removing tracks, 129

Soloing, 129


Frame numbering, 231

Freeze Track, 19

Freezing MIDI tracks, 188

Frontier TranzPort, 267


Adjusting panning, 284

Adjusting volume, 284

Editing input device, 285

Editing output device, 285

Viewing control maps, 283


G 

General preferences tab, 254

Generic control surface setup, 229, 283, 285

Generic controller, 267

Generic MIDI controller


Custom control maps, 285

Loading control maps, 286

Setting up a generic control surface, 286


Glossary, 311

Go to, 38

Gracenote


Obtaining or editing CD information, 33

Grid, 249

Groove Pool window, 24


H 

Hardware 
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Playing MIDI from, 222

Routing MIDI tracks to, 222

Routing surround to, 237

Routing video to, 234

Setting up for surround, 236


Help, 15, 16

Hiding/showing


Toolbar, 250

Track envelopes, 145

Video tracks, 231

Windows, 247


I


Icons

Color intensity preferences, 263

Tinting preferences, 263


Increments

Creating, 98

Creating a custom musical length, 99

Creating a specific musical length, 99


Inline MIDI editing, 193

Input bus


Adjusting volume or panning, 171

Muting or soloing, 171

Recording with, 184


Input busses, 168

Adding, 168

Channel strips in Mixing Console, 169

Deleting, 169

Monitoring external sources, 175

Renaming, 168

Using with hardware-based effects, 172

Using with hardware-based synthesizers, 174


Input filters, 205

Inserting sections, 67

Inserting time, 93

Installation, 15


J 

Joining events, 60


K 

Key changes

Clips, 93

Event, 64, 93

Marker, 91

Project, 91


Keyboard shortcuts

Chopper window, 96

General, 305


Keyframes, 242–245

Knobs


Control surface, 293


L 

LFE channel, 235, 237

List editor, 216


Creating MIDI events, 221

Deleting MIDI events, 221

Editing MIDI events, 218

Filtering MIDI events, 218

MIDI event parameters, 219

MIDI notes and frequencies, 220

Previewing MIDI events, 217

Quantizing note events, 221

Undoing and redoing, 221


Locking events 
To track envelopes, 145


Looped playback, 45

Loops


Clips, 34

Creating in the Chopper, 100

Exporting from projects, 130

Stretching properties, 118


M 

Mackie Control Universal, 229, 267

Add new buttons, 277

Arrow buttons, 282

Audio/video buttons, 279

Channel section, 273

Control buttons, 274

Display buttons, 276

Fader banks, 276

Footswitches, 274

Jog dial, 283

Markers, 277

Modifiers, 279

Project buttons, 280

Timeline, 280

Transport buttons, 281

View buttons, 278

Window buttons, 278


Main window, 16

Markers, 83–87


Adding, 120

Beat anchors and markers for loop clips, 121

Command markers, 85

Deleting, 120

In the Chopper, 96

Marker bar, 21

Moving, 120

Reset stretching markers, 120

Stretch markers for loop clips, 120

Tempo/key/time signature markers, 91

Time markers, 84


Media files

Adding from Media Manager, 79

Adding to projects, 31

Exporting loops from projects, 130

Extracting from CD, 32

Previewing in Chopper, 95

Previewing in Explorer, 30
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Reloading, 122 Panic button, 222 
Replacing, 122 Patch maps, 223 
Resolving offline, 79 Piano roll editor, 213 
Saving track properties to, 123 Playback devices, 222 
Searching, 75 Playing from external devices, 222 
Tagging, 71 Preferences, 260 

Media libraries Processing events, 198 
Tagging files, 71 Program change automation, 142 

Media library Program change keyframe, 210 
Adding media files, 70 Quantizing, 216, 221 
Backing up, 75 Recording, 189 
Creating new, 69 Rendering, 222 
Opening, 69 Resetting ports, 222 
Removing media files, 71 Routing to hardware, 222 

Media Manager, 32, 69 Selecting notes, 195 
Adding custom columns, 80 Signal flow, 27–28 
Adding media from, 79 Step recording, 191 
Automatically hiding Search pane, 80 Sysex keyframes, 211 
Customizing view, 80 Timecode synchronization, 226, 228 
Moving columns, 80 Track envelopes and keyframes, 208 
Moving the Search pane, 80 Track Properties, 202 
Options, 81 Track properties, 202 
Resizing columns, 80 Tracks, 35 
Resolving offline media, 79 Unfreezing tracks, 189 
Searching for media files, 75 MIDI Clip Properties window, 212 
Showing/hiding columns, 80 MIDI control surface setup, 229, 283, 285 

Media Manager window, 23 MIDI merge recording, 192 
Merging controller data from MIDI clips, 212 MIDI merging controller data, 212 
Metronome, 180 MIDI track envelopes and keyframes, 208 

Adjusting volume, 181 MIDI tracks 
MIDI, 187, 223, 228 Adjusting clip properties for, 123 

Adding notes, 196 Device selection, 19 
Adding tracks, 187 Freezing, 188 
Assigning patch maps, 225 Mixer setup (external), 179 
Automating VSTi parameters, 211 Mixing Console, 23 
Choosing a drum map for a track, 226 adding assignable FX, 155 
Configuring input filters, 205 adding busses, 155 
Controller automation, 141 adding tracks, 155 
Controller envelopes, 208 adding/editing effects, 176 
Creating patch maps, 224 adding/editing track effects, 156 
Deleting controller envelopes, 146 adjusting assignable effects input levels, 177 
Deleting notes, 196 adjusting assignable effects panning or volume, 177 
DLS sets, 222 adjusting bus panning/volume, 167 
Drum maps, 194, 225 adjusting bus/assignable effects send levels, 157 
Editing drum maps, 225 adjusting track panning/volume, 160 
Editing events, 37 bus channel strips, 164 
editing frozen tracks, 189 change a bus’s output device, 166 
Editing patch maps, 224 changing a bus’s name, 165 
Exporting files, 228 changing a track’s automation mode, 158 
Filtering events, 198 changing assignable effect chain’s name, 176 
Freeze track, 19 changing effects chain’s output device, 177 
Inline editing, 193 changing pre/post routing for busses, 168 
List editor, 216 changing track’s input/output device, 158 
MIDI merge recording, 192 Channel List pane, 153 
Notes and frequencies, 220 Channel Strips, 154 
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Channel strips, 155

FX Send (Assignable Effects) channel strips, 175

Input bus channel strips, 169

inverting track’s phase, 159

monitoring bus levels, 166

monitoring output levels, 177

muting or soloing a bus, 167

muting or soloing a track, 159

muting/soloing an assignable effects chain, 177

Routing surround through, 237

toolbar, 151

View pane, 153

window, 151


Mixing to a single track, 129

Monitor for video editing, 234

Monitoring external sources, 175

Moving


Events, 37

Tracks, 40


Moving a section label, 68

Moving rendering templates, 49

Moving sections, 67

Multichannel MIDI files, 187

Multipurpose slider, 41

Multistream MIDI files, 187

Mute automation, 137

Muting


Editing volume automation, 42

Tracks, 42


N 

Note durations, 198

Note velocity, 198


O 

Offsetting tracks, 298

One-shots


Clips, 34

Selecting in the Chopper, 100


Online help, 15

Opening


Media files, 31

Projects, 30


Other preferences tab, 263

Overview of ACID, 16


P 

Painting events, 35, 36

Palettes, 73


Assigning buttons, 74

Clearing buttons, 74

Creating, 73


Panic button, 222

Panning


Adjusting for input bus, 171

Automation, 138


Pan types, 113, 241

Surround, 239

Tracks, 41, 112–146


Panning, audio

Envelope, 142


Pasting

Events, 55

In ripple mode, 63

Tracks, 41


Patch maps, 223

Piano roll editor, 196, 213


Adding note events, 214

Continuous controller information, 215

Deleting note events, 216

Editing note events, 214

Previewing MIDI, 213

Quantizing note events, 216

Selecting note events, 215

Snap to scale, 216

Undoing and redoing, 216


Pitch shifting

Clips, 93

Events, 64, 93

Projects, 91


Playing projects, 45

Bypassing audio effects during playback, 46

Playing from the cursor position, 45

Playing the entire project, 45

Using playback options, 45

Using the transport bar, 45


Plug-In Manager

Using ReWire devices, 135

Using soft synths, 136


Plug-In Manager window, 24

Plug-Ins, See Effects

Post-roll, 183

Preferences


Audio, 255

Audio device, 257

Display, 263

Editing, 261

Envelope colors, 263

External Control & Automation tab, 265

General, 254

MIDI, 260

Other, 263

Sync, 262

Track colors, 263


Pre-roll, 184

Previewing clips, 103

Previewing media


Chopper window, 95

Explorer window, 30


Processing MIDI, 198

Program change keyframes, 210
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Projects 
Adding media, 31

Key, 91

Opening, 30

Playing, 45

Properties, 29

Publishing to the Internet, 50

Rendering, 47

Saving, 46

Starting, 29

Tempo, 90

Time signature, 91


Properties 
Clip, 115, 212

Event, 64

MIDI track, 202

MIDI track, 174-180, 202

Project, 29

Track, 115


Proxy file, 315

Publishing projects, 50


Creating personal accounts, 50

Uploading, 50


Punch-in, 183


Q 

Quantize MIDI, 198

Quantizing MIDI 

In the list editor, 221

In the piano roll editor, 216


R 

Real-time rendering, 50

Recording, 179


Arming tracks, 180

Into a time selection, 183

Into an event, 183

Into an event with time selection, 183

MIDI tracks, 189

Specifying storage folder, 185

Starting and stopping, 182

Using an input bus, 184


Redo, 44

Series of edits, 44


Reference library, 75

Sony Sound Series Loops and Samples, 75
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